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Preface

This preface introduces information sources that can help you use the application and this guide.

Using Oracle Applications

To find guides for Oracle Applications, go to the Oracle Help Center at http://docs.oracle.com/.

Documentation Accessibility

For information about Oracle's commitment to accessibility, visit the Oracle Accessibility Program website.

Contacting Oracle

Access to Oracle Support

Oracle customers that have purchased support have access to electronic support through My Oracle Support. For
information, visit My Oracle Support or visit Accessible Oracle Support if you are hearing impaired.

Comments and Suggestions

Please give us feedback about Oracle Applications Help and guides! You can send an e-mail to:
talent_acquisition_doc_feedback_ww_grp@oracle.com.

ORACLE
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1 Getting Started

Taleo Performance Administration Basics

Auxiliary Navigation Bar

The auxiliary navigation bar gives access to various information such as setup configuration, online help, customer
support, and product version. This bar also contains the Sign out option.

Breadcrumb Trail

The breadcrumb trail located at the top of each page allows you to see where you are located within the application and
to jump to previously viewed pages. The breadcrumb trail is only available in navigation mode; it disappears when you
are in editing mode. You can also select the Configuration link in the navigation ribbon to return to the top level of the
Configuration Module.

Employee Center Configuration

Administrators are able to customize the layout and look of the Performance Management landing page, the Employee
Center, using newly available widgets.

Customers can choose to display or hide the following four widgets on the Employee Center:

Instructions - this widget uses a rich text editor to allow customers to easily enter special announcements,
instructions, links to internal portal or graphics or other custom employee resources.

My Tasks
My Goal Plan
My Network

The ability to select what is displayed on the Employee Center provides users with a streamlined and customized
landing page that displays only widgets and information that is relevant to each customer's implementation. For
example, if a customer is not implementing the Goal Plan module, Administrators can disable that widget and it will
not display in the Employee Center. The system dynamically optimizes the real estate of the full page by expanding the
widgets that are selected.
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Configuration

Settings
Name Location
Employee Center Configuration Taleo Performance (Configuration) > [Performance] >

Administration > [Employee Management] > Employee Center
Configuration

Currently there is one instruction widget per zone. This is not customizable by OLF.

Recently Viewed Items

The Recently Viewed Items pane contains direct links to the last ten pages you most recently accessed (according to
your permissions) during the current session or previous ones. They can be pages where you made modifications or
simply pages that you accessed without making modifications. To access a recently viewed item, simply click the item.

More Info

Whenever a description is available below a page title, the More info link is displayed. This link gives you access to
contextual online help. A More link is also available whenever a listing of elements is not completely displayed. In such a
case, clicking on More will provide all the information.

History

The History section is used throughout Taleo Performance to present useful tracking details on an element. The three
most recent events are displayed in the History section. To view a more complete listing of events, click More.

The History section contains the following information.

- By: The “actor” (person or system) who performed the event. To obtain basic information about the “actor”,
click the actor's name.

- Date and Time: Date and time when an event occurred.
- Details: Information regarding the event.

- Event: The event or action performed on an element.

Languages

Taleo products are available in different optional languages.
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Not all languages are available for all Taleo products and languages must be activated by the system administrator
before they can be used in an application.

The preferred language of a user is set in the user’s account by the system administrator. The preferred language is
used by the system as the default content language which is the same across all Taleo products. If a product does not
support the same set of content languages, it will have its own preference configuration.

In Taleo applications, the languages in which an item is available are indicated in the Languages field. When creating or
editing an item, the user can choose the base language as well as the languages in which an item will be available. The
base language of an item is the item’s reference language, usually used as a reference for other languages or fallback
display in list mode. The user’s preferred language is used as the default base language when the user creates an item.
The base language of an item can be changed at any time by the user. A language must be activated before it can be
designated as a base language.

When multiple languages are used for an item, the Earth icon is displayed. Hovering the mouse over the icon displays
the languages activated for the item. When only one language is used for an item, the name of the language is
displayed. When only one language is used in a company, there is no special indicator.

Languages - Settings and Preferences
The following settings and preferences are used to configure languages.

Setting Description Default Value Location

List of application languages, presented = French, English, Configuration > [General Configuration]
according to the organization's German, Spanish ~ Settings

preferences. The application language is

the language in which a product can be

viewed. This is a private setting. Contact

Oracle Support for details.

Application Languages

Configuration > [General Configuration]
Settings

Correspondence Language Indicates the correspondence language.

Configuration > [General Configuration]
Settings

Content Language Indicates the content language.

Preference

Application Language

Correspondence Language

Content Language

ORACLE

Description

Allows users who log in using Single Sign-on to
change their application language.

Indicates the preferred correspondence
language of a user.

Indicates the preferred content language of a
user.

Location

Configuration > [SmartOrg] Administration >
[Users] User Accounts > General Preferences
Recruiting Center > Resources > My Setup

Configuration > [SmartOrg] Administration >
[Users] User Accounts > General Preferences
Recruiting Center > Resources > My Setup

Configuration > [SmartOrg] Administration >
[Users] User Accounts > General Preferences
Recruiting Center > Resources > My Setup
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Element Language Configuration

Language configuration is used throughout the Administration module. It allows you to create elements in several
languages. Only languages that are activated appear in the Language list.

Field Description Applicable to Header
Configure Opens the Language Configuration page on which you Language list Language
can set the base language (default) as well as whether a Configuration

language is Draft, Not Used or Active.

Deactivate Deactivates the selected language. Language list Language
Configuration

Language Displays the base language for the element as well as all Entity/Element Language
other activated languages. The element must be defined in Configuration
all activated languages.

Refresh Updates the current window by displaying the information in  Language list Language
the selected language. Configuration

Supported Languages

The languages supported for Oracle Talent Acquisition Cloud products as well as specific features are listed below. For
details regarding language availability for Oracle Learn Cloud and Oracle Taleo Business Edition, see the documentation
for those products.

« Scheduling Center: All listed languages are supported except Portuguese (Portugal).
- Assessment: All listed languages are supported except Indonesian (Bahasa).

- OBIEE: All listed languages are supported except Indonesian (Bahasa), Lithuanian, Malaysian (Malay), Serbian,
Slovenian.

- Resume Parsing: Resume parsing is delivered using a third party partner service. The functionalities are
deliveredas is. Customers needing additional or different resume parsing capabilities should explore partner

services.
Language Locale Recruiting and Performance Mobile Sourcing Resume Parsing
Onboarding
Bulgarian bg Available Available
Chinese (China) zh_CN Available Available Available Available
Chinese (Taiwan) = zh_TW Available Available Available Available
Croatian hr Available Available
Czech cs Available Available Available
Danish da Available Available
Dutch nl Available Available Available Available Limited
English en Available Available Available Available Supported
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Language Locale Recruiting and Performance Mobile Sourcing Resume Parsing
Onboarding
English (U.K.) en_GB Available Available Available Available Supported
Finnish fi Available Available Available
French (Canada) = fr Available Available Available Limited
French (France) fr_FR Available Available Available Available Limited
German de Available Available Available Available Limited
Greek el Available Available
Hungarian hu Available Available Available
Italian it Available Available Available Available Limited
Indonesian in Available Available Available
(Bahasa)*
Japanese ja Available Available Available Available
Korean ko Available Available Available Available
Lithuanian* It Available Available
Malaysian ms Available Available
(Malay)*
Norwegian no Available Available Available
Polish pl Available Available Available Available
Portuguese pt_BR Available Available Available Available Limited
(Brazil)
Portuguese pt Available Available Available
(Portugal)*
Romanian ro Available Available Available
Russian ru Available Available Available Available
Serbian* sr (sh) Available Available
Slovak sk Available Available Available
Slovenian* sl Available Available
Spanish es Available Available Available Available Limited
(Worldwide)
Swedish sv Available Available Available Available
Thai th Available Available Available
Turkish tr Available Available Available
5
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Selector Windows

Selector windows are used throughout the application. They allow you to select various elements (values) according
to where you are in the application. The type of selector window (single or multiple) varies. Selector windows contains
filters allowing you to quickly find items in a list.

Selection Lists

Selection Lists are a type of field also referred to as dropdown lists, or selectors. They provide a list of valid values
for filling in a field. Some Global selection lists are delivered pre-defined so they can be used across Taleo products.
Customers can also create Performance-specific selection lists for use in creating user-defined fields in the application.

Global Selection List

A global selection list is a list of elements (values) used to define a field, that can be used by several Taleo products and
that can only be viewed and edited.

These global selection lists are available in the Configuration menu, under Selection Lists:

Education Levels
Employee Statuses

- Job Levels

- Job Types

- Schedules

- Shifts

- Travels

« Currency

Global selection lists can be edited, that is system-defined items can be added or removed. Users will only see the items
selected by the system administrator.

Performance Selection List

A Performance selection list is a list of elements (values) used to define a field, that can be used to create a user-defined
field (UDF) in Performance. Performance selection lists can be can be viewed, edited, and created at Configuration
[Taleo Performance] Selection Lists. They can be used in several modules of Taleo Performance: such as Performance
Reviews, Goal Plans, Development Plans, and the Employee Information section of the Talent Profile.

Configuration

Setting

Name Location

Global Selection Lists Configuration > Selection Lists

Performance Selection Lists Configuration > [Taleo Performance] Selection Lists
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Rich Text Editor

The Rich Text Editor enables users to edit and format text contained in competency definitions, correspondence,
requisitions, requisition templates and review forms (definitions, sections and section items). Text formatted with the
editor is presented to users in the TE applications with the specific formatting defined in the editor.
The Rich Text Editor contains standard text processing tools such as:

- cut, copy, and paste functions

- font types and sizes

- bold, italics, and underline

- text and background color

- left, right, and center alignment

- numbered and bulleted lists

- spell checker

Image or Link Insertion

Image or link insertion may only be available via the enlarged view of the editor, accessible when you first click the
Enlarged View icon.

Spell Checker

The spell checker uses the application language, not the content language. The spell checker is available in several
languages.

Internet Explorer 8

Users on Internet Explorer 8 may experience issues with the toolbar icons operating as expected. Users who experience
this issue may either try viewing the page in Compatibility Mode, or use the Rich Text Editor in another browser such as
another version of Internet Explorer or Firefox.

Copying and Pasting Text

When copying content from MS Word and pasting it in the Rich Text Editor tool, some reformatting may be required
due to the complexities of mapping MS Word formatting to the Rich Text Editor. Capabilities supported by the Rich Text
Editor tool are presented in the following table.

Item Description

Bold Full support for the bold style.

Italic Full support for the italic style.

Underline Full support for the underline style.

Heading styles and fonts Heading styles as well as fonts used in heading styles are preserved. Fonts not used in heading styles

are treated as a default normal style.

Font name (font face) Font names (font faces) are generally preserved, even those that are not part of the Rich Text Editor's
natively supported fonts (Arial, Comic Sans MS, Courier New, Tahoma, Times New Roman, Verdana).
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Item

Font size

Text color
Text background color
Hyperlinks

Bulleted and numbered lists

Line spacing

Images

Tables
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Description

The Rich Text Editor supports seven sizes. A "best guess" font size conversion is done by the system.
Conversion of font sizes may not be accurate in some unspecified cases (depending on browser, MS
Word version, etc.).

Full support for text color.

Full support for text background color.

Full support for hyperlinks.

Lists should be created using the bullets, numbering and multilevel list features in MS Word. List types
that do not conform to the recommended practice are not supported.

The bullet type is preserved (bullet or number), but the symbol (circle, square, etc.) or notation
(number, roman numerals, alphabetical) will be replaced by the browser's defaults.

Numbering continuation between two distinct numbered lists is not supported.

The color of the bullet is not preserved.

Spacing around list blocks is browser-specific.

Indentation level is preserved if made using the indent buttons. Custom indentations made using the

MS Word ruler is not supported.

No line spacing information is preserved. All custom line spacing is converted to a single line. The only
exceptions are:

- Headings: the line spacing is browser-specific.
- Lists: line spacing is browser-specific.
Images are not supported and will not be included.
Table row and column dimensions are preserved.
The presence or absence of borders is preserved.
Colors are not preserved, default is black. Background and border colors are not preserved.
Styles are not preserved, default is solid line.
Custom widths are not preserved, default is 1px.
Custom table and cell widths are converted to their pixel / percent equivalent. This conversion runs

differently, based on the browser being used. This may result in discrepancies from the original table.
Merged cells are preserved.

Recommended Practices for Constructing MS Word Documents to Minimize Reformatting Required When Pasting

Content Into the Rich Text Editor

In general, the less complex the MS Word document is, the less reformatting a user will need to do when copying
content from MS Word and pasting it in the Rich Text Editor. Below are some recommendations for creating MS Word

templates.

Use the more common fonts that come with MS Word, such as:

- Arial

. Times New Roman
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« Courier New
- Verdana
» Comic MS Sans
Avoid using images in the MS Word template documents, as they are not supported in the Rich Text Editor.

Avoid using the horizontal ruler to customize indent lines, as this type of formatting is not supported in the Rich Text
Editor. Use the standard indent buttons.

Minimize the use of custom line spacing, as this is not supported in the Rich Text Editor.
Avoid using colored bullets in the MS Word template documents, as they are not supported in the Rich Text Editor.

Avoid using custom ruler indentation on bullets, as custom indentation on bullets is not supported in the Rich Text
Editor. Use standard indent buttons.

Avoid mixing bullet types in the MS Word template documents, as mixed bullet types are not supported in the Rich Text
Editor.

Create lists using the standard bullet types, numbering, multilevel list and indent features available in MS Word.

Session Timeout Notification Process

A session timeout notification process is used throughout all applications to inform users that the session is about to
end and to remind users to save any desired information before the timeout delay is over.

When the application has been idle for 30 minutes, a pop-up window notifies the user that the application requires
attention.

When the user accesses this application, a pop-up window lets him reset the application and indicates the remaining
time before the session expires. If the user does not reset the application within the defined delay, the user is signed out
of the application and will need to sign in again.

Taleo Regional Settings

Regional Settings

Regional settings are used to configure settings which control the number, date, currency, and language formats for a
locale.

In the Regional Settings page, the Identifier list varies according to languages activated in the Oracle Talent Acquisition
Cloud (OTAC) products. For example, if an organization only supports English (en) and French (fr), the Identifier list will
contain en and fr as well as all specific locale identifiers related to fr and en, that is, fr-FR, fr-CA, en-GB, en-Au, etc.

The regional settings of a locale consist of four elements:

Number: Defines the decimal symbol, digit grouping, maximum number of decimals, negative number format,
etc.
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- Currency: Defines the decimal symbol used for currencies, the default currency, the maximum number of

decimals for currencies, etc.

- Date: Defines the date format used in the application. A date can be represented by text, number or a

combination of both.

- Language: With each locale, comes a set of predefined values that are specific to the specified language,
regardless of the country or region.

Configuring the Number Format

Configuration > [SmartOrg] Administration > Regional Settings

Click Edit next to Number.

P UWN

Click Done.

Configuring the Currency

Click the name of an identifier.

Select a value for each setting.

Configuration > [SmartOrg] Administration > Regional Settings

Click Edit next to Currency.

P UWN

Click Done.

Click the name of an identifier.

Select the values for each setting.

Configuring the Date Format

Configuration > [SmartOrg] Administration > Regional Settings

1. Click the name of an identifier.

2. Click Edit next to Date.

3. Select a value for each setting. See Date Format Properties.

4. Click Done.

Date Format Properties

Date Format

Full date format
Long date format

Medium date format

Short date format

Shortest date format

ORACLE

Description

Date represented by the day of the week, month, date and year. Default is EEEE, MMMM D, YYYY.
Maximum number of characters: 255.

Date represented by month, date and year. Default is MMMM D, YYYY. Maximum number of
characters: 255.

Date represented by date, month and/or year. Default is D-MMM-YYYY. Maximum number of
characters: 255. In the case of regions that do not use commas, periods or slashes with dates, an
additional format is included that is specific to the region. When no date format is selected, the
medium format is the default format used by the application.

Date represented by date, month and/or year. Default is DD/MM/YY. Short date formats are used for
lists and calendars. Numeric values only.

Date represented by date and month. Default is DMMM. Shortest date format are used in candidate
files and other lists that include many columns.
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Date Format Details Description
Text A date element that always appears in the form of text, such as days of the week, will be displayed

in long form if four letters are used for its representation. If less than four letters are used, the date
element will appear in an abbreviated form. For example, configuring a date format using "EEE" would
produce "Fri" for Friday, while using "EEEE" would produce the long form "Friday".

Numbers The system adds zeros to single numbers in certain cases. For example, if the date element "DD" is part
of the date format, the ninth day of the month will be displayed with a leading zero, thus, "09". If the
date element is "D", however, the system will display "9" without a leading zero.

Text and Numbers When the date format element is composed of one or two characters, a numeric value results. For
example, if the date format element is "M" or "MM", the month of February will be depicted as "2" and
"02" respectively. On the other hand, a date format element made up of three or more characters will
result in a textual representation of the date: in the case of "MMM", February will appear as "FEB", if
"MMMM" is used, February will be displayed as "February".

Date Format Syntax Meaning Presentation Example (US locale)
Y Year Numeric 2009
M Month of the year Alphanumeric July, Jul. or 07
D Day of the month Numeric 10
H Hour AM/PM (1-12) Numeric 12
h Hour of the day (0-23) Numeric 22
m Minute of the hour Numeric 38
S Seconds Numeric 59
E Day of the week Textual Tue, Tuesday
a AM/PM marker Textual PM
K Hour in AM/PM (0-11) Numeric 0
‘ Escape for text Delimiter ‘
“ Single quotation mark (twice the escape Literal
character)

Selecting a Preferred Locale

More than one locale must be available.

Configuration > [SmartOrg] Administration > [SmartOrg] Regional Settings
1. Click the name of a locale identifier.
2. Click the General tab.
3. Select a value.
4. Click Done.

The selected locale is displayed by default when more than one locale is available.

n
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Taleo Performance Setting Management

Taleo Performance Product Settings

The following table lists all product settings that are related to Taleo Performance. Most settings are found under
Configuration > [Taleo Performance] Administration > [Global Configurations] Settings . When found under a
different product or section, the full path is indicated.

There are different types of product setting security levels:

« Public - are viewable and editable by customers.

- Protected - are viewable by customers but only editable by Taleo staff (specifically users with a 'support' role).

- Private - are viewable and editable only by Taleo staff (specifically users with a 'support’ role).

Setting Name

Candidate Search
Contextualization

Employee Search
Contextualization
Configuration

Maximum Number of
Results for Advanced
Search

Maximum Number of
Results for Basic Search

Maximum Number of
Results for Best Fit

Working Days

ORACLE

Setting Description Possible Values Security Level Setting Category

Applies the search - Yes Public Advanced Search
restrictions as defined on
the user groups. Enabling » No (default)
this setting will determine

if candidate searches are

restricted to user groups

visibility property.

Applies the search - Yes Public Advanced Search
restrictions as defined for
the user groups. Enabling + No(default)
this setting will determine

if searches are restricted

to the user groups visibility

property.

Indicates the maximum - 500 (default) Private Advanced Search
number of items to appear
in the advanced searches.

Indicates the maximum - 500 (default) Private Advanced Search
number of items to appear
in the basic searches.

Indicates the maximum - 500 (default) Private Advanced Search
number of items to appear
in the best fit searches.

Indicates the days of the - Any day of the week Public Calendar
week that are considered
working days. This setting
serves to calculate the
duration-based deadlines
of review tasks. This setting
is shared with the setting

of the same name in Taleo
Onboarding. Changing

Default is Monday,
Tuesday, Wednesday,
Thursday, Friday
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Setting Name

Enable Career
Management

Maximum Number of
Career Steps

Maximum Number of
Scenarios

Job Certifications
Advanced Search Field
Configuration

Job Competencies
Advanced Search Field
Configuration

Job Field Advanced
Search Field
Configuration

Job Level Advanced
Search Field
Configuration

Other Competencies in
Advanced Search Field
Configuration

Enable Competency
Context Management

Activity Category
Criterion In Advanced
Search

Activity Name Criterion in
Advanced Search

ORACLE

Setting Description

the setting in either place,
affects both products.

Enables Career
Management functionality
in the application.

Determines the maximum
number of steps within a
scenario.

Determines the maximum
number of scenarios
allowed for an employee.

Indicates if the job
certification criteria is
available in the Advanced
Search.

Indicates if the job
competency criteria is
available in the Advanced
Search.

Indicates if the job field
criteria is available in the
Advanced Search.

Indicates if the job level
criteria is available in the
Advanced Search.

Indicates if the section
"Other Competencies" is
available in the advanced
search.

Enables the use of
competency contexts
for competencies. A
competency context
provides the ability to
define a specific context
in which a competency
is available so that only
employees who work
for those specified
organizations, locations
and/or job fields are able to
view.

Indicates whether the
"Activity Category"
criterion is available in
the development activity
advanced search.

Indicates whether

the "Activity Name"
criterion is available in
the development activity
advanced search.

Possible Values

- Yes

« No (default)

- 5(default)

- 3 (default)

- Yes (default)
- No

«  Yes (default)
- No

- Yes (default)

- No

«  Yes (default)
- No

- Yes (default)

- No

- Yes

« No (default)

« Yes (default)
- No

- Yes (default)
- No

Security Level

Protected

Public

Public

Public

Public

Public

Public

Public

Public

Public

Public

Chapter 1
Getting Started

Setting Category

Career Management

Career Management

Career Management

Career Management Search

Career Management Search

Career Management Search

Career Management Search

Career Management Search

Competency Management,
under Configuration >
[General Configuration]
Settings

Development Activity
Search

Development Activity
Search
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Setting Name

Competency Criterion In
Advanced Search

Enable Development
Activity Advanced Search

Job Field Criterion In
Advanced Search

Job Level Criterion In
Advanced Search

Job Role Criterion In
Advanced Search

Location Criterion In
Advanced Search

Employee Job Role
Advanced Search Field
Configuration

Organization Criterion In
Advanced Search

Development Activity
Sharing

Development Activity
Assignment Limit

ORACLE

Setting Description

Indicates whether the
"Competency" criterion
is available in the
development activity
advanced search.

Indicates if the Advanced
Search feature for
development activity is
available.

Indicates whether the "Job
Field" criterion is available
in the development activity
advanced search.

Indicates whether the "Job

Level" criterion is available

in the development activity
advanced search.

Indicates whether the "Job
Role" criterion is available
in the development activity
advanced search.

Indicates whether the
"Location" criterion
is available in the
development activity
advanced search.

Indicates if the Employee
Job Role field is available
as an option for advanced
search.

Indicates whether

the "Organization”
criterion is available in
the development activity
advanced search.

Allows users to share their
custom development
activities either at the time
of archiving or once the
activity is archived. This
setting applies only if the
Enable Activity Sharing
setting is set to Yes.

Determines the maximum
number of employees

to whom a development
activity can be assigned at
one time.

Possible Values Security Level

-« Yes (default) Public
- No

«  Yes (default) Public
- No

« Yes (default) Public
- No

- Yes (default) Public
- No

«  Yes (default) Public
- No

«  Yes (default) Public
- No

-« Yes (default) Private
- No

«  Yes (default) Public
- No

- Yes (default) - - Public

Sharing the activity
is possible when
archiving the activity
or once the activity is
archived.

- No - Sharing the
activity is only
possible once the
activity has been
archived.

- 10 (default) Public

Chapter 1
Getting Started

Setting Category

Development Activity
Search

Development Activity
Search

Development Activity
Search

Development Activity
Search

Development Activity
Search

Development Activity

Search

Person Search

Development Activity
Search

Development Planning

Development Planning
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Setting Name

Development Activity
Average Rating
Computation Delay

Development Activity
Rating Mandatory

Development Activity
Sharing With Any
Employees

Development Activity
Sharing With Direct
Reports and Peers

Development Activity
Sharing With Network
People

Development Planning
Default Approval Request
Duration

Enable Activity Sharing

Enable Custom Contexts
Managing

Enable Development
Activity Rating

Enable Development
Activity Recommendation

Enable Development
Planning

Enable Development Plan
Printing

Maximum Number of
Activities Recommended

ORACLE

Setting Description

Indicates time in minutes
allowed before the
development activity
average rating is computed.

Forces users to provide
a rating when archiving
development activities.

Allows users to share their
custom development
activities with any
employees in the
organization.

Allows managers to share
their custom development
activities with their direct
reports and peers.

Allows users to share their
custom development
activities with people in
their network including tag
filters.

Determines the default
number of days before
the development planning
approval request is
considered late.

Allows users to share their
custom development
activities.

Indicates if users can create
user-defined contexts.

Allows users to rate
development activities after
archiving them.

Allows users to recommend
development activities.

Enables Development
Planning functionality in
the application.

Enables the development
plan printing feature in the
application.

Determines the maximum
number of activities
recommended to an
employee.

Possible Values

- 5(default)

«  Yes (default)
- No

«  Yes (default)
- No

«  Yes (default)
- No

-« Yes (default)
- No

- 1(default)

- Yes (default)
- No

- Yes (default)
- No

- Yes (default)
- No

- Yes (default)
- No

- Yes

« No (default)

- Yes

« No (default)

- 10 (default)

Security Level

Protected

Public

Public

Public

Public

Public

Public

Public

Public

Public

Public

Private

Public

Chapter 1
Getting Started

Setting Category

Development Planning

Development Planning

Development Planning

Development Planning

Development Planning

Development Planning

Development Planning

Development Planning

Development Planning

Development Planning

Development Planning

Development Planning

Development Planning
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Setting Name

Maximum Number
of Context Items per
Development Activity

Maximum Number of
Items per Development
Activity Context

Number of Most Relevant
Activities Displayed in
Search

Display Employee Metrics

Employee Metrics User-
Defined Fields Search
Configuration

Employee User-
Defined Fields Search
Configuration

Enable LinkedIn
Integration

Enable Spell Checker

Enable Talent Profile

Supporting Tools
Displayed by Default

ORACLE

Setting Description

Determines the maximum
number of context items
that a user can select when
linking an activity.

Determines the maximum
number of items per
context (O, L, F, etc.) when
managing development
activities.

Determines the default
number of most relevant
activities displayed in the
activity search. This setting
determines the number

of top rated activities
displayed by default when
the search result grid first
displays, so that the list
does not open empty.

Determines if the employee
metrics will be shown

on the back side of the
performance cards.

Manages the Employee
Metrics UDFs used in
Advanced Search and filters
within the Talent Browser
and Talent Pools.

Manages the Employee
UDFs used in Advanced
Search and filters within the
Talent Browser and Talent
Pools.

Used to enable LinkedIn
Integration for the

Talent Profile Properties
configuration; and the Work
Experience, Education and
Certification sections of the
Talent Profile.

Indicates if the Spell
Checker functionality is
available.

Indicates if the Talent
Profile page is displayed.

Controls the display of the
Supporting Tools window
in all sections of Taleo

Possible Values

Security Level

- 5(default) Protected
- 1(default) Protected
- 5(default) Public

- Yes (default) Public

- No

- Yes Protected
« No (default)

«  Yes (default) Public

- No

« Yes (default) Public

- No

- Yes Public

« No (default)

Chapter 1
Getting Started

Setting Category

Development Planning

Development Planning

Development Planning

Global Settings

Global Settings

Taleo Performance
Configuration >

[Taleo Performance]

> Administration >
[Employee Management]
Global Settings

Taleo Performance
Configuration >

[Taleo Performance]

> Administration >
[Employee Management]

Global Settings

Global Settings

Global Settings

Global Settings
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Setting Name

Feedback Requests Use
Ratings

Enable Feedback Approval

Enable Public Access to
Feedback

Allow Feedback Deletion

ORACLE

Setting Description Possible Values Security Level
Performance in which

it appears. When set to

Yes the setting makes the
Supporting Tools window
open (or expanded) by
default. When set to No the
setting makes the window
closed (or collapsed) by
default. No is the initial
default value for this setting
when the application is first
opened. In either case the
window includes its own
expand/collapse button
that allows you to open or
close it as needed.

Determines if the 5-star - Never Public
rating scale is displayed in

feedback requests. + Always (default)

- Askuser-an
additional option is
shown on the Request
Feedback form for
the user to specify
whether to allow
or not the target
recipients to provide
rating information as
part of the feedback

This setting enables - Yes Public
feedback approval and
controls if the approver + No (default)
selector and details

are displayed. It also

controls the activation

of the approval workflow

mechanism. Also when set

to yes, the Status column is

available in the Sent view of

the Feedback Journal.

The feedbacks a user can - Yes Public
see depend on this setting.

When Igrivate feedback ¢ + No (default)
is enabled the user sees

feedback entries only when

they are the author or

recipient of the feedback.

When public feedback is

enabled, the user also sees

all feedback provided about

themselves or their direct

reports.

Indicates whether it will - Yes (default) Public
be possible for the user to
remove feedback entries
from the feedback journal
or not.

- No

Chapter 1
Getting Started

Setting Category

Feedback

Feedback

Feedback

Feedback
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Setting Name

HR Administration
Maximum Items

Sender Email Address

Sender Email Address
Alias

Show Job Role Name or
User Title

Enable Job Position to
Override Job Role or Job
Title

Talent Profile Competency
Grouping

Timeout Maximum

Inactive Interval

Timeout Maximum Ping
Number

Timeout Ping Frequency

Timeout Reminder Delay

Business Goal Default
Measurement Type

ORACLE

Setting Description

Number of items displayed
in the HR Administration
framework.

Default email address used
in the system-generated
emails sent to the Taleo
Performance users.

Name assigned to the
email sender. Aliases are
multilingual, but if no
value is provided in a given
language, the English value
is used by default.

Indicates whether it is
the job role name or the
user title that is used as
the employee's title in the
application.

For implementations using
Position Management,

use to indicate whether

or not to use Job Position
to override the Job Role

or User Title in applicable
areas of the application.
(This is a setting introduced
in Feature Pack 13B.)

Indicates how
competencies are to be
grouped on the Talent
Profile, that is by type or by
group.

Maximum inactive interval,
in milliseconds, for a user
logged in.

Number of unreceived
pings before the session is
terminated.

Frequency of pings in
milliseconds.

Time in milliseconds before
session timeout reminder is
displayed.

Indicates the default
“Measurement Type” field

Possible Values

- 1000

- Any email address

- Any name

- English (Default):
Human Resources.
French: Resources
Humaines. French
(France): Resources
Humaines.

- Job Role Name
(default)

. User Title

- Default value is Yes
(true). Allows the job
position to override
the job role and user
title in the application.

- No (false) removes the
job position override
of the other values.
Either the job role or
job title is displayed
based on the setting
Show Job Role Name
or User Title.

- By Competency Type
(default)

- By Competency Group

- 1800000 (default)

« 2 (default)

. 300000 (default)

- 300000 (default)

- Qualitative

Security Level

Private

Public

Public

Public

Public

Public

Private

Private

Private

Private

Public

Chapter 1
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Setting Category

Global Settings

Global Settings

Global Settings

Global Settings

Global Settings

Global Settings

Global Settings

Global Settings

Global Settings

Global Settings

Goals Management
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Setting Name

Editable Business Goal
Actual Value

Employee Goal Default
Update Delay

Enable Business Goal
Management

Enable Business Project
Management

Enable Goals
Management

Goals Management
Default Approval Request
Duration

Organization Content
Languages

ORACLE

Setting Description

value when creating a
business goal.

Indicates if the
“Quantitative Actual Value”
field is editable by the

end user. This field could
be blocked from being
modified if, for example, it
is populated by an external
system.

Indicates the default
“Update Delay” field value
(in days) when creating an
employee goal When the
specified delay is expired,
a Late icon is shown in the
list of employee goals.

Enable business goal
management. When
enables, employee goals
can be aligned to business
goals.

Enable business

project management
within business goal
management. Allows
employee goals to be
aligned on projects. Allows
managers to manage
projects (My Projects
section). If the setting

is to be deactivated

but there are already
employee goals aligned
to projects, employee
goals will continue
displaying the business
goal alignments as well as
project alignments.

Enables Goals Management
functionality in the
application for employees.
The activation of this
setting does not enable
business goals, which

are enabled by a specific
setting.

Determines the default
number of days before the
goal approval request is
considered late.

List of content languages

available in the application,
presented according to the
organization's preferences.

Possible Values

Quantitative (default)

Yes

No (default)

5 (default)

Yes

No (default)

Yes

No (default)

Yes

No (default)

1 (default)

English (default)

Security Level

Public

Public

Protected

Protected

Protected

Public

Private

Chapter 1
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Setting Category

Goals Management

Goals Management

Goals Management

Goals Management

Goals Management

Goals Management

Languages
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Setting Name

Organization Content
Locales

Preferred Language
Display Activation

Allow Mentor to Break
Mentoring

Employee Goals
Accessible To Mentors

Enable Mentoring

Maximum Mentees Per
Mentor

Review Accessible To
Mentors

Cancel Pending Multi-
Rater Requests On
Transfer

Delete Manager's Ratings
And Comments On
Transfer

Display Current Review
Status

ORACLE

Setting Description

The locales used to manage
content in the application
that are not covered by

the setting "Organization
Content Languages", like
the custom text in career
section, which can be
overwritten by activated
locales.

Indicates if the "Language
of Correspondence" is
displayed or not in the
"Preferences" of the user
setup in User Management
or in My Setup.

Allows mentors to break the
mentoring relationship with
mentees.

Enables mentors to see
their mentees' employee
goals and goal plan.

Indicates if the mentoring
functionality is available.

Indicates the maximum
number of mentees a
mentor can have. There
is no hardcoded limit, but
it is recommended to not
exceed 10.

Enables mentors to see
their mentees' performance
review.

Cancel pending multi-rater
requests when transferring
reviews.

Delete the manager's
ratings and comments
when transferring reviews.

Determines if the current
review status will be shown
in the Review section

on the back side of the
performance cards. When
displayed, it corresponds
to the rating of the most
recent assigned review. The
most recent review is based
on the date of the manager
assignment. In the event

Possible Values

- No default

«  Yes (default)
- No

- Yes (default)
- No

- Yes

« No (default)

- Yes

« No (default)

- 5(default)

- Yes

« No (default)

- Never
- Always (default)

. Ask user

- Never
- Always (default)

- Askuser

« Yes (default)
- No

Security Level

Private

Private

Public

Private

Public

Public

Private

Public

Public

Public

Chapter 1
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Setting Category

Languages

Languages

Mentoring

Mentoring

Mentoring

Mentoring

Mentoring

Performance Management

Performance Management

Performance Management
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Setting Name

Effective Date Of Last
Review

Enable Performance
Management

Enable Offline Review

Number Of Reviews For
Performance Indicator
Calculation

Rating

Review Assignment Batch
Commit

Review Assignment Batch
Size

Review Generation Batch
Commit

ORACLE

Setting Description

that two reviews have the
same manager assignment
date, the most recent is
determined as follows:

- based on the review
period end date,

- then based on the
review period start
date,

- and then based on
the review generation
time/date stamp.

Indicates the effective

date to be used for the last
review. The purpose of this
setting is to calculate what
the most recent review is.
The most recent review
score can then be copied
from the Historical Review
table to the Employee
Metrics table and displayed
in the Talent Profile and

on the Talent Cards

throughout the application.

Enables Performance
Management functionality
in the application.

Allows to activate or
deactivate the offline
review capabilities.

Indicates the number of
last focal reviews used to
calculate the performance
indicator, displayed in the
employee's succession
plan.

Rating

Number of reviews to

be assigned and tasks
created before a commit is
performed within a single
scheduled task.

Number of reviews to

be assigned in a single
scheduled task before the
next scheduled task.

Number of reviews to be
generated before a commit
is performed within a
single scheduled task. For

Possible Values

Security Level

Review Cycle End Public
Date

Review Request
Period End Date

Review Request
Reference Date

Close Review Action

Date (default)

Yes Protected
No (default)

Yes Private
No (default)

1 (default) Public
Yes Private

No (default)

20 (default) Private
250 (default) Private
20 (default) Private

Chapter 1
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Setting Category

Performance Management

Performance Management

Performance Management

Performance Management

Performance Management

Performance Management

Performance Management

Performance Management

21



Talent Acquisition Cloud

Implementing Performance

Setting Name

Review Generation Batch
Size

Review User Interface
Version 2

Default Successor
Readiness Value For
Matching

Enable Succession Matrix

Enable Succession
Planning

Maximum Number of
Succession Plan Options

Maximum Number of
Succession Pool Options

Succession Planning
Default Approval Request
Duration

Enable Talent Pool

Enable Team
Management

Job Position
Configuration

ORACLE

Setting Description

example, among the 250
reviews to be generated
within a scheduled task,
proceed in bunches of 20
between each commit.

Number of reviews to

be generated in a single
scheduled task before the
next scheduled task.

Determines if Performance
Reviews use the Version

2 user interface which
provides performance
improvements.

Default suggested
readiness value (in number
of days) when matching
successors to an open
requisition. O means ready
now.

Indicates if the succession
matrix mode is enabled.

Enables Succession
Planning functionality in
the application.

Determines the maximum
number of options within a
succession plan.

Determines the maximum
number of options within a
succession pool.

Determines the default
number of days before
the succession approval
request is considered late.

Enables the Talent Pool
functionality in the
application.

Enables Team Management
features such as Employee
Change Requests and
Manager Self-Service.

Behavior with the
corresponding job position
when moving an employee
to another manager.

Possible Values

- 250 (default)

- Yes

« No (default)

- 0 (default)

«  Yes (default)
- No

- Yes

+ No (default)

« 20 (default)

- 100 (default)

- 1(default)

- Yes

» No (default)

- Yes

« No (default)

- Move also the job
position if applicable

- Leave job position to
the current manager
(default)

- Prevent moving the
employee

Security Level

Private

Private

Public

Public

Protected

Public

Public

Public

Private

Public

Public
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Setting Category

Performance Management

Performance Management

Succession Planning

Succession Planning

Succession Planning

Succession Planning

Succession Planning

Succession Planning

Talent Pools

Team Management

Team Management
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Setting Name

Organizational Chart
Pager Threshold

Team Management
Default Approval Request
Duration

Matrix Management
Enabled

Extended Matrix
Management

Maximum Number of
Matrix Managers

Maximum Number of
Matrix Management
Requests

Employee Change Matrix
Management Behavior

Enable DDI Integration

DDI Integration -
Leadership Mirror URL

DDI Integration -
SSOSaltKey

DDI Integration -
SSOSaltValue

ORACLE

Setting Description

Indicates how many
employee cards are
displayed under a manager
card before the pager
mechanism is used in the
organizational chart.

Determines the default
number of days before
the team management
approval request is
considered late.

Enables matrix
management
functionalities allowing a
manager to delegate his
tasks to another manager.

Indicates if matrix manager
relationships also apply

to the direct reports of
delegated employees.

Indicates the maximum
number of matrix manager
relationships that can be
set for an employee.

Indicates the maximum
number of matrix
management requests a
manager can have at the
same time.

Behavior Indicates

how matrix manager
relationships are handled
when an employee changes
manager.

Enables DDI Integration
to provide access to the
Leadership Mirror system.

Indicates the URL of the
Leadership Mirror system.

Indicates the value of the
SSOSaltKey, which is equal
to the vkey of the company
and is generated when the
company is originally set
up for Leadership Mirror.
The passed username will
be validated against the
company identified by the
vkey.

The value of the
SSOSaltValue is the
secret key, which can be

Possible Values

« 25 (default)

- 1(default)

- Yes

« No (default)

+ Yes

« No (default)

« 5 (default)

- 5(default)

- Keep matrix managers

- Remove matrix
managers (default)

- Yes

« No (default)

https://Im.ddiworld.com

None

None

Security Level

Public

Public

Public

Public

Public

Public

Public

Private

Private

Private

Private

Chapter 1
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Setting Category

Team Management

Team Management

Matrix Management
under Configuration >
[SmartOrg] Settings

Matrix Management
under Configuration >
[SmartOrg] Settings

Matrix Management
under Configuration >
[SmartOrg] Settings

Matrix Management
under Configuration >
[SmartOrg] Settings

Matrix Management
under Configuration >
[SmartOrg] Settings

Global Settings

Global Settings

Global Settings

Global Settings
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Setting Name

Autosave

Enable Global
Accessibility

Autosave Interval

Number of Mentees Per
Page

Setting Description

anything an organization
specifies. The SSOSaltKey
and SSOSaltValue must
match in the client's

setup for generating the
Leadership Mirror URLs.
As a multi-valued key, each
value refers to a different
company.

Indicates if autosave is
being used and whether
it occurs between periods
of inactivity (Idle) or at
the same set interval,
regardless of system
activity (Automatic).

Enables global accessibility
to activate accessibility
features for all users.

Indicates the amount of
time between automatic
saves.

The maximum number

of mentees that can be
displayed on a single page
in the mentoring center.

Customizable Online Help

Possible Values

- Disabled (default)
- Idle

- Automatic

- Yes

« No (default)

« 2 minutes
- 5 minutes (default)
- 10 minutes

« 20 minutes

5 (default)

Security Level

Public

Public

Public

Public
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Setting Category

Global Settings

Global Settings

Global Settings

Global Settings

The Customizable Online Help feature provides your organization the ability to present contextual, customizable online
help to your users. Configuration settings allow you to contextualize the presentation of online help at the Performance
module level (reviews, goals, feedback, etc.). For each module you'll have the ability to display your organization's own

custom content. Users will access it through the right side Supporting Tools pane which displays for each module. With
this feature you can make available to your users, from within the application, your organization's relevant help content;
such as internal policies and procedures, forms, and help videos.

Customizable Online Help Versus Standard Online Help.

Customizable Online Help - Is created by your organization, with your own content on your website or server. You can

configure your URLs into Performance to display content in the right side Supporting Tools pane.

f Note: It is the customer's responsibility to ensure their custom help is accessible to end-users if it is hosted on
a server with restricted access.

ORACLE
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Standard Online Help - Is the default Oracle Taleo Standard Online Help content, which can be displayed from the
Supporting Tools pane. It can be contextual in the sense the content provided can be at the level in the documentation
relevant to the application module.

f Note: This is the same content as delivered in the main Help Center, the complete contents of which are
accessible via the Resources link on the navigation toolbar at the top right of each page.

Display of Help in the Right Side Supporting Tools

When activated in configuration, the right side Supporting Tools pane displays in the application module using a
collapsible/expandable style.

- When the pane is collapsed the Help button always displays below the Show Tools button, if both are enabled.
- When the pane is expanded the Show Tools and Help display as tabbed frames, if both are enabled.

Here are some tips about the sizing of the custom help display window:

- The internal size of the HTML frame is adaptive to the window height and fixed in width to 177 pixels.
- Some websites use code that prevents them from being embedded within another frame.

- There are methods for creating web pages your organization can use to have your hyperlinks launch popup
windows. These may present a better way to organize help content for display, such as having a main page of
help topic links leading to separate popup pages for each help topic.

Configuring the Customizable Help Display

For each Performance system module there are a pair of corresponding configuration settings: Activation and URL. With
these settings, the right side Supporting Tools pane for each module can be configured to one of three display options:

1. No Help Display - Use the Activation setting for a module to activate the display of the Help tab in the
Supporting Tools pane. The default setting is No (false or deactivated).

2. Customizable Online Help - Use the URL setting to display your organization's customized online help, by
entering the URL path of the website where your content is stored into the applicable value field. Do this for
each implemented language. This should be the path to the location where your policies, procedures, articles,
video clips, etc. are accessible.

3. Standard Online Help as a default - Use the URL setting to display the default Standard Online Help, by
copying the default URL for each implemented module and language (from a list provided at the bottom of the
configuration page), and pasting it into the applicable Value field.

About the Use of Language Values in Configuration

On the Custom Help URL page, the list of language values displayed corresponds to the language(s) activated for a
customer. The customer can create their own custom help in each language they've activated in Performance, and they
can locate each language version on a separate URL page. They then configure the custom online help feature, for each
applicable module, by entering their appropriate language specific URL(s) into the matching language value field(s). The
result is the custom help displayed in the Supporting Tools pane will be the language version associated to the language
that the user is currently logged in with.

If the customer chooses to display the standard online help rather than their own custom help, they can also configure
the language display of the help presented for each module. On the Custom Help URL page, the list of Default URL
Values displayed corresponds to the language(s) activated for a customer, as well as the section of the standard online
help that documents the module. The customer copies the appropriate default url value(s) from the list, and pastes
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them into the appropriate language fields above. The result is the standard help displayed in the Supporting Tools pane
will be the language version associated to the language that the user is currently logged in with.

Configuration

The customizable, contextualized online help configuration settings are listed in the following table. These are located at
the navigation Configuration > [Taleo Performance] > Settings > [Product Settings] > [Refine By] Category = Help.
All are Public settings, meaning the administrator can configure them.

Setting Name

Custom Help Business Goals URL
Custom Help Career Plan URL

Custom Help Development Plan URL
Custom Help Feedback Journal URL
Custom Help Goal Plan URL

Custom Help Job Position Profile URL
Custom Help Mentoring Center URL
Custom Help My Projects URL

Custom Help Performance Review URL
Custom Help Review Cycle Analytics URL
Custom Help Succession Plan URL
Custom Help Talent Browser URL
Custom Help Talent Pools URL

Custom Help Talent Profile URL

Setting Name

Custom Help Business Goals Activation
Custom Help Career Plan Activation
Custom Help Development Plan Activation
Custom Help Feedback Journal Activation
Custom Help Goal Plan Activation

Custom Help Job Position Profile
Activation

Custom Help Mentoring Center Activation

Custom Help My Projects Activation

ORACLE

Description

Indicates the target URL for the Business Goals custom help.
Indicates the target URL for the Career Plan custom help.
Indicates the target URL for the Development Plan custom help.
Indicates the target URL for the Feedback Journal custom help.
Indicates the target URL for the Goal Plan custom help.

Indicates the target URL for the Job Position Profile custom help.
Indicates the target URL for the Mentoring Center custom help.
Indicates the target URL for the My Projects custom help.
Indicates the target URL for the Performance Review custom help.
Indicates the target URL for the Review Cycle Analytics custom help.
Indicates the target URL for the Succession Plan custom help.
Indicates the target URL for the Talent Browser custom help.
Indicates the target URL for the Talent Pools custom help.

Indicates the target URL for the Talent Profile custom help.

Setting Description

Activate or deactivate the setting for the Business Goals custom help.
Activate or deactivate the setting for the Career Plan custom help.
Activate or deactivate the setting for the Development Plan custom help.
Activate or deactivate the setting for the Feedback Journal custom help.
Activate or deactivate the setting for the Goal Plan custom help.

Activate or deactivate the setting for the Job Position Profile custom help.

Activate or deactivate the setting for the Mentoring Center custom help.

Activate or deactivate the setting for the My Projects custom help.
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Setting Name Setting Description
Custom Help Performance Review Activate or deactivate the setting for the Performance Review custom help.
Activation
Custom Help Review Cycle Analytics Activate or deactivate the setting for the Review Cycle Analytics custom help.
Activation

Custom Help Succession Plan Activation Activate or deactivate the setting for the Succession Plan custom help.

Custom Help Talent Browser Activation Activate or deactivate the setting for the Talent Browser custom help.
Custom Help Talent Pools Activation Activate or deactivate the setting for the Talent Pools custom help.
Custom Help Talent Profile Activation Activate or deactivate the setting for the Talent Profile custom help.

Note: The existing setting Supporting Tools Displayed by Default controls the display mode of the Supporting
#  Tools pane on the right side of the screen. It is located at Configuration [Taleo Performance] Administration
[Global Configurations] Settings. This is also a Public setting, meaning the administrator can configure it.

Configuring Custom Online Help Properties

You want to configure custom online help for the various modules and languages your organization has implemented in
Performance.
Configuration > [Performance] Settings > [Product Settings]

1. Set the Refine By field to Category.

2. Set the field on the immediate right to Help, and click Refresh.

The list of settings is reduced to 28 help-related settings. For each of 14 affected modules in Performance there
are two settings each: Custom Help Activation and Custom Help URL.

3. Click the Custom Help Activation setting for the appropriate module.
When the Custom Help Activation page opens, click Edit.
4. Set the Value to Yes or No.

No=False, the help pane is deactivated and does not display in the Supporting Tools. Yes=True, the help pane is
activated and displays in the Supporting Tools.

5. Click Save.
6. Return to Product Settings and repeat steps 3 through 5 for each module your organization has implemented in
Performance and wants to display custom help for.

The Help pane in the Supporting Tools is activated for each of the modules your organization wants to display custom
help for.

Configure the Custom Help URL settings for the same set of modules.

Configuring Custom Help URLs

You want to configure custom online help for the various modules and languages your organization has implemented in
Performance.
Configuration > [Performance] Settings > [Product Settings]

1. Set the Refine By field to Category.

2. Set the field on the immediate right to Help, and click Refresh.
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The list of settings is reduced to 28 help-related settings. For each of 14 affected modules in Performance there
are two settings each: Custom Help Activation and Custom Help URL.
3. Click the Custom Help URL setting for the appropriate module.

When the Custom Help URL page opens, click Edit.
4. You have the following options for configuring URLs for each appropriate language:
o If there is no content to display or a language is not implemented, leave the field blank.
o Inthe appropriate language field type in the URL for the web page hosting your own organization's
custom content.
o Or, to display content from the standard online help, copy the appropriate URL value for the appropriate
language from the Default Value list, and paste it into appropriate language field.

You can display either your own custom help content, or standard online help content, but not both.

The standard online help content that will be displayed in the supporting tools pane is content from the Help
Center, from a chapter relevant to the module you are configuring.

Click Save.
6. Return to Product Settings and repeat steps 3 through 5 for each module your organization has implemented in
Performance and wants to display help for.

w

The Help pane in the Supporting Tools is now configured to display either no custom help, your organization's custom
help content, or content from the standard online help.

Corporate Branding

The corporate branding offers administrators the ability to change the color theme and the company logo to be used
throughout both Taleo Performance and Taleo Recruiting.

Corporate branding is configured in one single location and applies to all Taleo products together. In addition to the
Oracle Fusion Skyros default theme, additional application themes are offered to better accommodate your corporate
branding. The theme is set by the system administrator and once defined, is the same for all users of Oracle Taleo
Performance and Recruiting.

Available Themes

On the Default Theme page these theme colors are available:

- Oracle Fusion Skyros - The Oracle Fusion Skyros theme is the default theme for new customers. Existing
customers will keep their current theme, but have the possibility to change the default theme to Skyros in the
product settings. The main difference from existing themes is the Skyros header, which is blue. Because of
the blue header, organization logos that have a white background are not recommended for use with the new
theme.

Taleo - This is the traditional Taleo green look. It offers organizations a look that is both modern and bright.
- Aqua - This theme has light shades of blue, providing a bright yet tranquil look.

- Sand - This theme presents shades of brown and tan and will suit companies that want a more earth-toned
feel.

- Silver - This theme presents shades of gray and corresponds to the most conservative theme available, aside
from the Ice theme.

Ice - This theme is similar to Aqua and offers a cool, tranquil look using shades of blue.
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The product setting Overlay Organization Logo is available for use in conjunction with the Skyros theme. This setting

only works with the Skyros theme. Logos with a transparent background are required for this setting. Transparent PNG's
are supported and recommended. For the best user experience, recommended practice is the logo used with the Skyros
theme should be a light color, preferably white, with a transparent background.

It is possible for organizations to use their own logo in place of the Oracle or Taleo logo to appear in the upper left-hand
region of a page. To display properly, the downloaded logo image should satisfy the following criteria:

- When adding a company logo image, it must be properly sized in the application. It is displayed in the top left
of each page in Taleo Enterprise. There can only be one static logo regardless of which modules are in use. The
maximum image size is 280 x 40 pixels and smaller images should not be resized to equal the maximum, as
this affects resolution and readability. The image must be horizontally aligned to the left and vertically aligned

to center.

- As for the image format, it must be a .png file type.

Corporate Branding Default Settings

Setting Name

Overlay Organization Logo

Default Theme

Configuration

Default value at migration

OverlayCompanyLogo.png

Current

The following configuration settings control corporate branding.

Setting Name

Default Theme

Organization Logo

Overlay Organization Logo

Description

Provides the ability to view and edit the
organizational display theme.

Provides the organization logo displayed in the
applications Ul. Supported format for the logo
is PNG, with maximum dimensions of 280 x 40
pixels.

Provides the organization logo displayed in the
applications Ul where a single color logo with
transparent background is required. Supported
format for the logo is PNG, with maximum
dimensions of 280 x 40 pixels.

Defining the Application Color Theme

Defining the application color theme allows the administrator to select the display color theme used throughout the user
interface of Oracle Taleo Performance and Recruiting products.

Configuration > [General Configuration] Settings

Defaults value for new zone

OverlayCompanyLogo.png

Oracle Fusion Skyros

Location

Configuration > [General Configuration]
Settings > [Category] User Preferences >
Default Theme

Configuration > [General Configuration]
Settings > [Category] Corporate Branding >
Organization Logo

Configuration > [General Configuration]
Settings > [Category] Corporate Branding >
Overlay Organization Logo

1. In the Product Settings page set Refine By to Category, set the Category to User Preferences, and click Refresh.
2. Inthe results list select the Default Theme setting.

ORACLE
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3. Inthe Default Theme page, click Edit next to the page title.
4. Inthe Editor page, select the desired theme in the Value section.

By default, the Oracle Fusion Skyros theme is selected.
5. Click Save.

When next accessing the Performance user interface the selected theme will be applied. Note that the color theme
setting is global and therefore is the same for all users and products.

Changing the Company Logo
Changing the company logo is done to either replace the Taleo logo that is shown by default, or to replace your
company's logo that is already displayed with a new one.

The maximum space available to hold the company logo is 280 x 40 pixels.
The file type must be PNG.
Configuration > [General Configuration] Settings

In the Product Settings page set Refine By to Category, set Category to Corporate Branding, and click refresh.
In the results list select the Organization Logo setting.
In the Organization Logo page, click Edit next to the page title.
In the Editor page:
o click Browse to find the image file of the logo you wish to use; or

PUWUNA

o click Remove the file if you want to remove the company logo used in order to re-apply the Taleo default
logo.

By default, the Taleo logo is used when no other logo is selected.

5. Click Save.

When next accessing the Performance user interface the selected logo will be displayed in the upper-left corner of the
page, where the Taleo logo was previously shown. Note that the logo setting is global and therefore is the same for all
users.

Spell Check

The spell check feature offers the ability to see misspelled words as you type comments in self-assessments, employee
performance reviews and feedback request/response forms providing Rich Text Format and to select a replacement
from a list of suggested words or accept the word as is.

When entering a comment, the misspelled words are indicated by a wavy red underline as you type and replacements
are proposed in the right-click menu. When a misspelled word is accepted as is, it is added to the user's temporary
library and will be saved for the current session only, which means that an accepted word in one session will be
considered a mistake in another, unless it is accepted again and added to the temporary library for that session.

The language dictionary used to verify the spelling is automatically set to the selected application language. The
currently supported languages for version 10 are da, de, en-uk, en-us, es, fi, fr, it, nl, no, pt, pt-br and sv (by default, en is
en-us).

The spell check feature is enabled or disabled via the Enable LinkedIn Integration setting via Configuration > [Taleo
Performance] Settings .
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Enabling the Spell Check Feature

Enabling the spell check feature activates the related feature in Taleo Performance and gives the user the ability to see
misspelled words as comments are typed and allows to select a replacement from a list of suggested words or to accept
the word as is.

Configuration > [Taleo Performance] Settings

1. Inthe Product Settings page, select the Enable Linkedin Integration setting.
2. Inthe Enable Spell Checker page, select Edit next to the title page
3. Inthe Editor page, make sure the Value is set to Yes.

By default, the spell checker option is set to Yes, therefore enabled.

Disabling the Spell Check Feature

Disabling the spell check feature deactivates the related feature in Taleo Performance and removes the ability for the
user to see misspelled words as comments are typed as well as to select a replacement from a list of suggested words or
to accept the word as is.

Configuration > [Taleo Performance] Settings

1. Inthe Product Settings page, select the Enable LinkedIin Integration setting.
2. Inthe Enable Spell Checker page, select Edit next to the title page
3. Inthe Editor page, set the Value to No.

By default, the spell checker option is set to Yes, therefore enabled.

Creating the Legal Agreement to be Shown to Users at Log In

Creating the legal agreement allows the user to actually write the content of the agreement.

Configuration > [Security] Legal Agreements

To be entitled to perform this task, the user must have the following user type permission:

Manage legal agreements

1. Inthe Legal Agreements page, click Create.
2. Inthe creation page, enter the code, name and text of the agreement.

The text can be formated as desired using the editing options.

3. Click Save.

The newly created agreement is shown in the list of available legal agreements.

For the legal agreement to be displayed, it must first be activated and then set to be displayed.

Activating the Legal Agreement

Activation of a legal agreement is required for it to be displayed.

Configuration > [Security] Legal Agreements
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To be entitled to perform this task, the user must have the following user type permission:

Manage legal agreements
The desired legal agreement must be created.

1. Inthe Legal Agreements page, click the name of the legal agreement you wish to activate.
2. In the specific Legal Agreement page, click Activate.

If another agreement is already active, a message will inform you the activation of the current agreement will
deactivate the other one, since only one agreement at a time can be active.

3. Click Yes to make the current agreement active.

In the list of legal agreements, the Active status will display next to the agreement.

For the agreement to actually be displayed to users, the related security policy setting has to be set to Yes.

Displaying the Legal Agreement to Users at Log In

Displaying the legal agreement is done by setting the related security policy to Yes.

Configuration > [Security] Security Policies

To be entitled to perform this task, the user must have the following user type permission:

Manage legal agreements
Before setting the legal agreement to be displayed, it needs to be created and activated.

1. Inthe Security Policies page, click Edit next to Sign In.
2. Inthe Security Policies Editor page, select Yes for the Show the legal agreement to users at login.
3. Click Save.

The legal agreement is now configured to be displayed and will be shown to all users before they log into a Taleo
product.

Job Role, Job Title and Job Position Setting Management

This feature provides your organization the ability to configure the display behavior of the Job Role, Job Title and
Job Position fields in applicable areas of Performance Management. This is done using a pair of global configuration
settings: Show Job Role Name or User Title and Enable Job Position to Override Job Role or Job Title.

The settings are described in the following Configuration table. The areas and fields in Performance Management in
which Job Role, Job Title or Job Position are displayed and affected by these settings are detailed in the reference table
titled Applicable Fields Using Job Role, Job Title and Job Position.

Configuration

The display of Job Role, Job Title and Job Position in many parts of the application can be controlled by the
configuration settings in the following table. The settings are located in Configuration under the following navigation:
[Taleo Performance] Settings > [Product Settings] > [Refine By] Keyword > Job Role).
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Setting Name

Show Job Role Name or
User Title

Enable Job Position to
Override Job Role or Job
Title.

Description

Use to specify whether
the Job Role name or the
User Title is displayed

in applicable areas of
the application. (This is

a setting introduced in
Feature Pack 7.5.)

For implementations using
Position Management,

use to indicate whether

or not to use Job Position
to override the Job Role

or User Title in applicable
areas of the application.
(This is a setting introduced
in Feature Pack 13B.)

Possible Values

Security Level

Job Role Name Public
(default)

User Title

Default value is Yes Public

(true). Allows the job
position to override
the job role and user
title in the application.

No (false) removes the
job position override
of the other values.
Either the job role or
job title is displayed
based on the setting
Show Job Role Name

or User Title.

Applicable Job Role, Job Title and Job Position Fields
Applicable Fields Using Job Role, Job Title and Job Position

Chapter 1
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Setting Category

Global

Global

Application behavior with respect to the display of the Job Role, Job Title and Job Position fields is standardized in
Performance Management, as summarized in the following table:

Applicable Fields Using Job Role, Job Title and Job Position

Application Area

Collaboration

Development Plan

Development Plan

Goal Plan

People Selector

ORACLE

Application Sub-Area

My Network / Expand employee

Admin access development plan /

request approval, Job Title

Print Title

Admin access Goal Plan / request

approval, Job Title

Search result, Job Title

Application Behavior Prior to 13B

Uses either Job Role or Job Title
based on setting "Show Job Role
Name or User Title".

Uses either Job Role or Job Title
based on setting "Show Job Role
Name or User Title".

Uses either Job Role or Job Title
based on setting "Show Job Role
Name or User Title".

Uses either Job Role or Job Title
based on setting "Show Job Role
Name or User Title".

Uses either Job Role or Job Title
based on setting "Show Job Role
Name or User Title".

Application Behavior After 13B

No change.

No change.

Checks setting "Enable Job
Position to Override Job Role or
Job Title."

No change.

No change.
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Applicable Fields Using Job Role, Job Title and Job Position

Application Area

People Selector

Application Sub-Area

Tool tip, Job Title

Performance Card / Employee Card Job Title

Performance Review

Performance Review

Performance Review

Review Hub

Review Hub

Review Hub

Review Hub

Review Hub

General Information, Job Title

Review tab/view, General
Information section, Author Job
Title and Job Title

Print Job Title, Author Job Title

Employee card, Job Title

List view, Job Title

Matrix view, Job Title

Employee detail, Job Title (header)

Employee detail, Job Title (in
metrics detail list)

Application Behavior Prior to 13B

Uses either Job Role or Job Title
based on setting "Show Job Role
Name or User Title".

Uses Job Position always when
exists.

Uses either Job Role or Job Title
based on setting "Show Job Role
Name or User Title".

Uses either Job Role or Job Title
based on setting "Show Job Role
Name or User Title".

Uses either Job Role or Job Title
based on setting "Show Job Role
Name or User Title".

Uses Job Position always when
exists.

Uses Job Role Name.

Uses Job Position always when
exists.

Uses Job Position always when
exists.

Uses Job Position always when
exists.
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Application Behavior After 13B

No change.

Checks setting "Enable Job
Position to Override Job Role or
Job Title."

No change.

Checks setting "Enable Job
Position to Override Job Role or
Job Title."

No change.

Checks setting "Enable Job
Position to Override Job Role or
Job Title."

No change.

Checks setting "Enable Job
Position to Override Job Role or
Job Title."

Checks setting "Enable Job
Position to Override Job Role or
Job Title."

Checks setting "Enable Job
Position to Override Job Role or
Job Title."

Succession Plan Admin access Succession Plan/ Uses either Job Role or Job Title No change.
request approval, Job Title based on setting "Show Job Role
Name or User Title".
Talent Browser Organization Chart view, Card, Uses Job Position always when Check setting "Enable Job Position
Employee Title exists. to Override Job Role or Job Title."
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Applicable Fields Using Job Role, Job Title and Job Position

Application Area

Talent Browser

Talent Browser

Talent Browser

Talent Pool

Talent Pool

Talent Pool

Talent Pool

Talent Pool

Talent Pool

Talent Profile

Talent Profile

Talent Profile

ORACLE

Application Sub-Area

Request Employee Change dialog

Matrix manager Add page, Job
Title

Snapshot Card, Manager and
Employee Title

Member tab, list view, Job Title

Detail tab, user list view, Job Title

Member tab, matrix view,
Employee details

Detail tab, chart cell view, Job Title

Add people to Talent Pool with
People Selector

In pool Details tab, pool context,
Job Role name

General section header, Job Title

Employee Information section

Print Title

Application Behavior Prior to 13B

Uses either Job Role or Job Title
based on setting "Show Job Role
Name or User Title".

Uses either Job Role or Job Title
based on setting "Show Job Role
Name or User Title".

Uses Job Position always when
exists.

Uses Job Position always when
exists.

Uses Job Position always when
exists.

Uses Job Position always when
exists.

Uses Job Position always when
exists.

Uses either Job Role or Job Title
based on setting "Show Job Role
Name or User Title".

Not using Job Position. Label is Job
Title but content is really Job Role.

Uses Job Position always when
exists.

Uses Job Position always when
exists.

Uses either Job Role or Job Title
based on setting "Show Job Role
Name or User Title".
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Application Behavior After 13B

No change.

No change.

Checks setting "Enable Job
Position to Override Job Role or
Job Title."

Checks setting "Enable Job
Position to Override Job Role or
Job Title."

Checks setting "Enable Job
Position to Override Job Role or
Job Title."

Checks setting "Enable Job
Position to Override Job Role or
Job Title."

Checks setting "Enable Job
Position to Override Job Role or
Job Title."

No change.

No change.

Checks setting "Enable Job
Position to Override Job Role or
Job Title."

Checks setting "Enable Job
Position to Override Job Role or
Job Title."

Checks setting "Enable Job
Position to Override Job Role or
Job Title."
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Applicable Fields Using Job Role, Job Title and Job Position

Application Area

Talent Search

Talent Snapshot Card

Talent Snapshot Card

Talent Snapshot Card

Talent Snapshot Card

Application Sub-Area

Search result list view, Job Title

Employee Title

Current Position

Manager Title

Succession Plan, Successor Title

Product Resources

Application Label Customization

Application Behavior Prior to 13B

Uses either Job Role or Job Title
based on setting "Show Job Role
Name or User Title".

Uses Job Position always when
exists.

Uses Job Position always when
exists.

Uses Job Position always when
exists.

Uses Job Position always when
exists.

Chapter 1
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Application Behavior After 13B

No change.

Checks setting "Enable Job
Position to Override Job Role or
Job Title."

Checks setting "Enable Job
Position to Override Job Role or
Job Title."

Checks setting "Enable Job
Position to Override Job Role or
Job Title."

Checks setting "Enable Job
Position to Override Job Role or
Job Title."

This enhancement provides the ability for text strings available in the Taleo Performance's user interface to be
customized to the specific terminology used by clients.

The customization is performed in the TexTool application. The label changes can be done by Taleo consultants during

implementation or by technical support via service requests.

Labels can be modified for any active language in a live production zone.

In order to modify labels, the following tasks need to be performed:

- In Taleo Performance, identify the resource ID associated to the labels to be changed.

- In TexTool, create a project associated with the customer, modify the labels and apply the project.

When labels are customized, it is important for clients to update their documentation accordingly, as Taleo provides all
documentation materials based on the default labels.

ORACLE
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Displaying Resource Identifiers

The Display Resource Identifiers user type permission is required.

Configuration > [Product] Administration > Resource Administration
1. Click Show Identifiers.
2. Close this window.

Starting with the next page that is displayed, resource IDs will be displayed in front of each element of the application.

Displaying Resource Identifiers in Taleo Performance

The Display Resource Identifiers user type permission is required.

1. Login to Taleo Performance as a support user.
2. Select via Resources > My Setup > Miscellaneous Preferences > Display resource identifiers.
3. Click Save and navigate to a different part of Taleo Performance.

The resource IDs are displayed.

You can return to My Setup and clear the option to hide the resource IDs.

Hiding Resource Identifiers

Resource Identifiers must be displayed.

The Display Resource Identifiers user type permission is required.

Configuration > [Product] Administration > Resource Administration
1. Click Hide Identifiers.
2. Close this window.

Starting with the next page that is loaded, resource IDs will no longer be displayed in front of each element of the
application.

Removing History Elements

Removing history elements reduces the number of irrelevant history tracking events.

A mechanism automatically deletes history elements older than their defined retention period. This is applied to
SmartOrg and Performance specific elements.
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Performance Management

Element Retention (Months)
User-defined Selections 12
Talent Pool Management Center 12
Performance Management Center 12
Chart Configuration 12
Matrix Configuration 12
Competency Goal 14
Pool Item 14
Pool 14
Message Templates 12
Documents 12
Paragraphs 12
Product Setting 12
User Account (user access) 6
Review Text 12
Review Definition 12
Review Cycle 12
Business Goal 14
Business Project 12
Business Theme 12
Business Period 12
Employee Goal 14
Employee Goal Plan 14
Goal Template 12
Succession Plan 14
Development Activity 14
Development Plan 14
Development Plan Template 12
Development Activity 12
Development Activity Category 12
Mentoring Relationship 14
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Performance Management

Element Retention (Months)
Rating Dimension 12
Rating Model 12
Partners 12

Taleo Configuration / SmartOrg

Element Retention (Months)
Welcome Center Content 12
Seats 12
Coverage Areas 12
Message Templates 12
Documents 12
Paragraphs 12
Messages 12
Product Setting 24
User Types 12
User File 18
Groups 12
User Account (user access) 6
Configuration Profile 12
Organizations 18
Organization Level 18
Location 18
Location Level 18
Job Field 18
Job Field Level 18
Business Organization 18
Business Organization Level 18
Positions 18
Competencies 18
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Taleo Configuration / SmartOrg
Element

Competency Categories
Competency Groups
Competency Context
Competency Definition Context
Guidance Plan

Rating Dimension

Rating Model

Job Role

Job Role Context

Job Profile Classification

ORACLE
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Retention (Months)

18
18
18
18
18
18
18
18
18

18
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2 User Account Administration

User Account Management

User Account

A user account is created for each user who has access to Oracle Talent Acquisition Cloud (OTAC) applications on a

regular or occasional basis.

User accounts are defined by system administrators in SmartOrg. (Navigation: Configuration > [SmartOrg]
Administration > [Users] User Accounts.) When creating a user account, system administrators define several elements.

Element

Personal Information

Employee Information

Account Information

ORACLE

Description

Basic information such as first name, last name, title, employee ID. The Employee ID field is necessary
in order to create the employee record when being fed over from an external system.

Address information.

Email information. The Email Address and Current logged-in user password fields are mandatory. If
the zone uses Taleo login, the field Current logged-in user password is displayed and you must provide
your credentials to modify the user’s password. If the zone is configured to use SSO, the field is not
displayed.

Phone information.

Department information.

Used for Taleo Performance and Dynamic Approval Routing. Once information in this section is
provided, both an employee and a candidate file are created for this user and this operation cannot be
reverted. Note that only employees can be users of Taleo Performance. Fields to complete are:

- Employee picture
- Employee status

- Employee manager

- Organization, Location, Job Role

Any time one of the following events occurs, an entry is added to the Employee History section:
updates to employee status; updates to manager, new organization or location; new job role. An entry
is recorded whether the change was made directly on the user account page, in Taleo Performance or
through SmartOrg integration. The Employee History section is only displayed in Show mode.

Contains information such as user name, password, external user identifier.

This is where you can perform actions such as generating a new password, deactivating the user
account, locking the user account, transferring and delegating tasks to another user.

The Current logged-in user password field is mandatory. If the zone uses Taleo login, the field Current

logged-in user password is displayed and you must provide your credentials to modify the user’s
password. If the zone is configured to use SSO, the field is not displayed.
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Element

User Types

User Groups

Coverage Areas

General Preferences

User Account General Preferences

General preferences are assigned to each user account.

Description

Chapter 2

User Account Administration

User types assigned to the user account. Each user account is assigned at least one user type for which
a series of permissions are granted.

User groups to which the user is part of.

Functional domains to which a user has access. For example, development plans and goal plans in
Performance, requisitions and search in Recruiting. Functional domains are tied to Organizations,
Locations and Job Fields. The configuration is not mandatory.

General preferences are assigned to each user account, for example, frequent collaborators and
approvers, preferred content language.

A user's general preferences are defined by system administrators in the User Account feature available in SmartOrg.
Most general preferences can be modified by users in Recruiting, in the My Setup feature, to fit their personal

preferences.

Certain user account general preferences are tied to a configuration setting. When this is the case, the setting sets a
value for an entire zone, the user account general preference sets a value for a specific user, then that specific user can

set his/her own personal preference (see table below).

User Account General Preference
(SmartOrg Administration > User
Accounts > General Preferences)

Accessibility Features

Candidate List Content

Content Language
Correspondence Language

Country

ORACLE

Setting
(Configuration > Settings)

Accessibility Features

Content Language

Correspondence Language

User Personal Preference
(Recruiting Center > Resources >
My Setup)

Accessibility Features

Candidate List Content

Content Language

Correspondence Language

Note: It is important at deployment to review the defaults for the Default Recruiter and Default Hiring
Manager user preferences in My Setup. By default, if there is no Default Recruiter or Default Hiring Manager
o specified for a user's preference, when the user creates a requisition he/she will be automatically listed as
#  the "Recruiter” on the requisition. If a user has his/her name in the Default Hiring Manager field, this will take
precedence and the user will have his/her name appear in the Hiring Manager field rather than the Recruiter
field. For proper behavior of managers, it is recommended to specify this information automatically upon
integration imports of manager User data.

Comments

By default, shows only candidates
that are in selection process (if
relevant).
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User Account General Preference Setting

(SmartOrg Administration > User

Accounts > General Preferences)

Default Distance Unit
Default Hiring Manager
Default Recruiter
Default Text Size
Default Theme

Display candidates on first CSW
step

Display Question Details in
Libraries

Enable eShare Email for Response
Center Access

Enable Recruiting Activity
Monitoring

Fax Notification

Frequent Collaborators
Identifier Content

Integration Profile Type

Last Update

Offer Frequent Approvers

Place of Residence

Preferred Non-Electronic Media

Requisition File Automatic Filling

Requisition Frequent Approvers
Selected Item Default Color
Sorting Key

SSO Preferred Application
Language

Tab displayed when accessing a

candidate file from a list

Tab displayed when accessing a
candidate file in navigation

Time Zone

ORACLE

(Configuration > Settings)

Default Distance Unit

Default Text Size

Default Theme

Enable eShare Email for Response
Center Access

Fax Notification

Selected Item Default Color

Time Zone

User Personal Preference
(Recruiting Center > Resources >
My Setup)

Default Distance Unit
Default Hiring Manager
Default Recruiter
Default Text Size

Default Theme

Display Question Details in
Libraries

Enable eShare Email for Response
Center Access

Fax Notification

Frequent Collaborators
Identifier Content

Integration Profile Type

Last Update

Frequent Approvers - Offer
Place of Residence

Preferred Non-Electronic Media

Requisition File Automatic Filling

Frequent Approvers - Requisition
Selected Item Default Color

Sorting Key

Tab displayed when accessing a
candidate file from a list

Tab displayed when accessing a
candidate file in navigation

Time Zone

Chapter 2
User Account Administration

Comments

See Note above.

See Note above.

Sends notifications to users by fax,
not by email.

Indicates if the user will use the
"automatic filling" option of the
requisition file.

Allows users who log in using
Single Sign-0On to change their
application language.
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User Account General Preference Setting User Personal Preference Comments
(SmartOrg Administration > User (Configuration > Settings) (Recruiting Center > Resources >
Accounts > General Preferences) My Setup)
When managing by candidate When managing by candidate
When managing by offer When managing by offer
Workflow Event Notification Workflow Event Notification Workflow Event Notification Keeps the user informed of

workflow events by email.

Zip Code Used in search preferences, with
the location (place of residence)
and last update.

User Account Status

A user account is assigned a status.

- Active: Only the name and description can be modified.

- Inactive: Only the status can be modified. The only possibility is to go back to the Active status. Inactive users
cannot be selected.

- Deleted: The user account has been deleted.

- Locked: The user account has been locked. The user cannot access Oracle Talent Acquisition Cloud (OTAC)
products.

- Expired:

Employee Information

Employee information is specific to Performance and to Recruiting for the Dynamic Approval Routing feature.

Employee information is defined in the User Accounts feature available in SmartOrg.

Certain fields in the Employee Information section are not mandatory. However, when fields in this section are
populated, the Organization and Location fields become mandatory.

If inserting a picture of the employee, the file limit is 20 KB and the only supported format is .jpg. Note that the
uploaded file is cropped from the center to obtain a square (so make sure the picture is correctly centered) and it is then
resized to 48 X 48 pixels which results in about 5 KB.

An employee can have one of the following statuses:
- New: New employees currently in an onboarding process.

« Current: Default value.
« Former Employee
If no data is entered in the Job Role and Employee Status fields, default values are assigned automatically by the

system, which are Employee and New respectively.
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Any time one of the following events occurs, an entry is added to the Employee History section: updates to employee
status; updates to manager, new organization or location; new job role. An entry is recorded whether the change was
made directly on the user account page, in Taleo Performance or through SmartOrg integration. The Employee History
section is only displayed in Show mode.

User Account - Other Configuration Tasks

Creating a User Account

The Manage user accounts user type permission is required.

In the Employee Information section, certain fields are not mandatory. However, when fields in this section are
populated, the Organization and Location fields become mandatory.

In the Employee Information section, if no data is entered in the Employee Status and Job Role fields, these fields will be
populated with their default values, Current and Employee.

Configuration > [SmartOrg] > Administration > User Accounts

Click Create.

Specify the language in which you want to create the user account.
Complete the fields in each section presented by the User Account Wizard.
Click Next to navigate between sections.

5. Click Finish.

The user account appears in the User Accounts list.

P UWNA

If the Employee Information section is completed, the user's profile is updated and the person is considered an
"employee." Employees are used in Taleo Performance and the Dynamic Approval Routing.

Editing a User Account

The Manage user accounts user type permission is required.
Configuration > [SmartOrg] > Administration > User Accounts

1. Click a user account.

2. Click Edit next to the section you want to modify.
3. Make required changes.

4. C(lick Save.

Activating a User Account

The Manage user accounts user type permission is required.
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Configuration > [SmartOrg] > Administration > User Accounts

1. Click a user account.
2. Click Activate in Account Information.
3. Click Yes.

Deactivating a User Account

The Manage user accounts user type permission is required.
You need to transfer the user's tasks to another user.

This feature may be useful for contract or temporary workers who assist on a assignment but who may leave and later
return to an organization. When these workers return, you can reactivate the user account without having to reset their
group association (because they are still tied to their user groups).

Configuration > [SmartOrg] > Administration > User Accounts

1. Click a user account.
2. Click Deactivate in Account Information.
3. Click Yes.

Deleting a User Account From the User Account Page

The Manage user accounts - Including HMRS fields user type permission is required..
Configuration > [SmartOrg] Administration > User Accounts

1. Locate the user in the User Accounts list.
2. Click Delete in the Actions column.
3. The action(s) you perform next vary depending on whether the user account is associated with an employee.

o If the user account is associated with an employee who owns requisitions, templates or folders, or was
assigned yet uncompleted actions, or reports to a manager, or has pending tasks or work items, perform
the steps in the wizard.

o If the user account is associated with someone for whom none of the previous conditions applies, click
Yes.

Once deleted, the user account status is set to Deleted and the user account is deactivated.

To permanently delete employee data related to the employee, including employee metrics and all Taleo Performance
data (as might be required in EMEA and other regions), see Employee Information Deletion Task.

Deleting the User Account of an Employee Using the Wizard

The Manage users - Including HMRS fields user type permission is required.

Configuration > [SmartOrg] Administration > User Accounts
1. Click the user account you want to disable.
2. Inthe Employee Information section, click Terminate.
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The wizard is displayed.
3. Perform the steps in the wizard.

The user account has Deleted status and therefore is no longer displayed on the User Accounts page if Active is selected
in the View field. The Employee Status value is changed to Former Employee.

To permanently delete employee data related to the employee, including employee metrics and all Taleo Performance
data (as might be required in EMEA and other regions), see Employee Information Deletion Task.

Deleting the User Account of an Employee Manually

The Manage users - Including HMRS fields user type permission is required.
Configuration > [SmartOrg] Administration > User Accounts

Click user account you want to disable.

Edit the Employee Information section as necessary.

Set employee status to Former Employee.

Provide a termination date.

Remove the manager.

Transfer direct reports to another manager if applicable.
Transfer ownership of talent pools and positions to another user.
Transfer pending tasks to another user.

Return to the User Accounts page, locate the user account in the list and click the corresponding Delete in the
Actions column.

10. Click Yes.

Once deleted, the user account status is Deleted and the user account is deactivated.

VOO UAhWNRA

To permanently delete employee data related to the employee, including employee metrics and all Taleo Performance
data (as might be required in EMEA and other regions), see Employee Information Deletion Task.

Assigning a User Type to a User Account

The Manage user accounts user type permission is required.
Configuration > [SmartOrg] > Administration > User Accounts

Click a user account.

Click Edit next to User Types.
Click Add next to User Types.
Select one or several user types.
5. Click Select.

The user types appear in the User Types list.

PUWAUNA
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Removing a User Type Assigned to a User Account

The Manage user accounts user type permission is required.
Configuration > [SmartOrg] > Administration > User Accounts

1. Click a user account.
2. Click Edit next to User Types.
3. Click Remove next to the user type.

The user type is no longer displayed.

Assigning a user type to the user account.

Associating a Configuration Profile to a User Account

The Manage user accounts user type permission is required.

Each user account is assigned one configuration profile. If no configuration profile is used, the default value of each
setting is used.

Changes made to a configuration profile are applied the next time a user linked to this configuration profile logs in.
Configuration > [SmartOrg] > Administration > User Accounts

Click a user account.

Click Edit next to Account Information.
Choose a configuration profile.

Click Save.

P UWNa

Assigning a Personal Coverage Area to a User Account

The Manage user accounts permission is required.
Configuration > [SmartOrg] Administration > User Accounts

Click a user account.

Click Create next to Personal Coverage Areas.

Click Add next to Functional Domains.

Select the desired functional domains then click Select.

Click Save.

If desired, specify organizations, locations and/or job fields for the coverage area.

cuhlhunNA

If no Organization-Location-Job Field structure is specified, then the coverage area will apply to all
organizations, locations and job fields .
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Locking a User Account
Allows a system administrator to lock a user account if, for example, the user was fired.

The Manage user accounts user type permission is required.
Configuration > [SmartOrg] > Administration > User Accounts

1. Click a user account.
2. Click Lock in Account Information.
3. Click Yes.

Deactivating the user account.

Transferring the user's tasks.

Unlocking a User Account

Allows a system administrator to unlock a user account if, for example, a user enters an incorrect password too many
times and the system locks the account.

The Manage user accounts user type permission is required.
Configuration > [SmartOrg] > Administration > User Accounts

1. Click a user account.
2. Click Unlock in Account Information.
3. Click Yes.

Generating a Password for a User Account

Allows a system administrator to generate a password for a user if, for example, the user does not have his/her
username handy or does not have an e-mail address to receive a temporary access code.

The Manage user accounts user type permission is required.
Configuration > [SmartOrg] > Administration > User Accounts

1. Click a user account.

2. C(lick Generate Password.

3. Specify if you want to send the password in an e-mail. The user will be forced to change his/her password at
next login.

4. Enter your password in the Current logged-in user password field.

If the zone uses Taleo login, the field is displayed and you must provide your credentials to modify the user’s
password. If the zone is configured to use SSO, the field is not be displayed.

5. Click Yes.
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The newly created password displayed on screen is masked with asterisks to protect the information from potential
shoulder surfing attacks. You can momentarily select the "Show password" check box to view the password when it is
considered safe to do so.

Task Delegation
Users may have the ability to delegate tasks to another user for a short preset period of time.

Task delegation is useful during the time a user is on vacation or on a sick leave. When selecting a user (new owner) to
whom tasks will be delegated, the following rules apply:

- The new owner must have the same user type permissions (constraints not included) as the current owner.
- The new owner must be at least in all the same groups as the current owner.

- If the current owner is an eShare user (not a Taleo application user), the new owner must also be an eShare
user.

Note: When a user delegates tasks to an alternate user, if the user is a collaborator on a requisition, the

f alternate user must also be made collaborator on that requisition in order to perform the same actions as
the user. The system does not automatically allow the delegated to interact as a collaborator on behalf of the
original user.

Delegating Tasks

The Manage user accounts user type permission is required.

For a user to be valid for delegation, the following rules must be applied:

- The new owner must be different from the current owner.

- Itis always possible for a Recruiting Center user to be the new owner.

Configuration [SmartOrg] > Administration > User Accounts

Click a user account.

Click Delegate in Account Information.
Select a user.

Select From and To dates.

Click Save.

VuhWN

Transferring Tasks

The Manage user accounts user type permission is required.

If the work items transferred belong to an employee, the designated user must also be an employee.
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The owner of the work items transferred must have the same user type as the designated user.

Configuration > [SmartOrg] > Administration > User Accounts

1. Click a user account.

2. Click Transfer in Account Information.
3. Select a user.

4. Click Save.

Tasks have been transferred permanently to another use.

Deleting the user account.

User Type Management

User Type

A user type is composed of a set of permissions from multiple functional domains. These permissions provide access to
various products and control what a user associated to the user type can do.

User types are centrally managed in SmartOrg for all products. Default user types are provided with the system. System
administrators can also create new user types.

Users are assigned a user type and one user can be associated to several user types. For example, the Recruiter and
Administrator user types for Recruiting, and the Manager user type for Performance.

Note:
- Itis recommended to leave untouched the default user types.

f - When creating a user type, it is recommended to duplicate an existing user type that has been
validated in the zone already to work properly.

- If possible, use a single user type which combines all necessary permissions.

User Type Permission
User type permissions grant users access to specific features and contexts in a product or application.

Permissions are organized by functional domains (core products):

- Recruiting

- Integration

- Configuration
« Performance
- Grid

- Compensation

51
ORACLE



Talent Acquisition Cloud Chapter 2
Implementing Performance User Account Administration

- Learning

- Reporting and Analytics
- Mobile

- Common

Functional domains are then separated into sub-domains. Depending on the amount of permissions in a sub-domain,
permissions may be grouped into sections. When permissions are grouped into sections, system administrators can
select the desired section in a drop-down list and quickly see the permissions grouped in that section.

Example of how permissions are organized in a functional domain

Functional Domain Recruiting

Sub-Domain Requisitions

Section Requisition Types

Permission Allow access to professional requisitions
Permission Allow access to hourly requisitions

Permission Allow access to campus requisitions

Permission Allow access to contingent requisitions
Permission Allow access to executive requisitions
Permission Allow access to pipeline - general requisitions
Permission Allow access to pipeline - executive requisitions

Functional domains are displayed in bold when permissions have been granted. Also, the Expand All button allows
system administrators to see at a glance all domains, sub-domains and permissions granted to a user type.

If a system administrator modifies the permissions associated with a user type, the changes affect all users who have
been assigned the user type.

For alist of default user types and their default permissions, refer to the document entitled Default User Types and
Permissions.

Taleo Performance User Permissions

The security model used in Taleo Performance, represented by user type permissions, enables granular combinations of
user access rights to be configured.

Access to Taleo Performance features are controlled by user type permissions. Permissions are organized by functional
domains. For instance, Goal Plans, Performance Reviews and Employee Profiles are specific domains that can have
unique user permissions configured for each user type. For each domain, the administrator can configure whether the
user type will have read-only access (View) or full edit rights (Manage). With a goal plan a line manager may have View
and Manage permissions, while with an employee profile the line manager may only be able to view it.
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View and Manage permissions can be applied to the user’s own data, their direct reports, the employees of those direct
reports, employees within the user’s coverage area and individuals the person mentors.

f Note: Having manage access does not imply view access, it must also be selected.

Permissions are cumulative and the most expansive access related to those permissions is applied to the actions of a
user. For instance a user may be assigned a line-manager user type, which enables them to edit the goals of their direct
reports only. In addition, the user may also be associated with a user type that provides view and manage permissions
for goal plans associated with the same group as the user, which would then allow the user to edit non-direct report
goals.

As user permissions are not confined to a specific user type or profile, access typically limited to admin users can

be given to any user. The configuration setting Access administration tools enables any user to have access to HR
Administration Tools from their home page. A typical user with Access administration tools enabled for a functional
domain can only see employees they have access to, such as direct reports or those within a group, and do not have
access to all employees like an admin user. For instance, a manager could have access to all direct reports from HR
Administration Tools > Performance Reviews and be able to perform actions from there instead of having to access
them individually from Manager Center > Performance Review.

Default User Types

Taleo Performance provides three basic user types that can be used as the foundation for configuring different user
types for your implementation.

Depending on the requirements of your organization and the modules that are used, your may need to create a number

of customized user types. Most users typically fall into an employee, manager, or administrator category and the default
user types make it easy to create your customized user types accordingly.

Taleo Performance Default User Types

Name Code
HR Administrator PM_HR_ADMINISTRATOR
Manager PM_MANAGER
System Administrator PM_SYSTEM_ADMIN
Employee PM_EMPLOYEE

HR Administrator

The HR Admin user type provides access to HR Administration Tools, options for managing workflow processes of
items like performance reviews and goal plans, as well as general administrative oversight into your Taleo Performance
implementation.

The ability to use the HR Administration Tools is the most important part of the HR Administrator's permissions.

These tools enable the administrator to troubleshoot approvals and restart them or complete them as necessary. This
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enables the administrator to act as the first line of support and potentially quickly resolves problems for managers and
employees.

It is recommended that there be at least one individual assigned to the HR Administrator - Global role, to ensure
that there is never an object (goal plan, succession plan, performance review, career plan) that does not have an HR
Administrator responsible for it.

Manager

The manager user type gives managers access to work with information on their reports for all functionalities across
Taleo Performance.

Managers can view and edit information for their employees in each of the modules. By default, managers have read
and write access to their direct reports and subsequent levels of employees.

Employee

The employee user type is for those users in an organization, who do not have line manager or system admin duties
and do not require access to HR Administration Tools or the Manager Center.

By default, an employee has read and write access to their own records and information, but not those of anyone else.

Default User Type Permissions

This table indicates which permissions the three default user types have, along with encompassing the domains and
permissions a Taleo Performance user could reasonably be expected to need.

Domain Permission Employee HR Manager -
Administrator -  Global
Global

Recruiting > Candidates General > Security level for external candidates

(in edit mode) > confidential

General > Security level for external candidates = Yes Yes Yes
(in edit mode) > general

General > Security level for external candidates
(in edit mode) > restricted

General > Security level for external candidates
(in view mode) > confidential

General > Security level for external candidates = Yes Yes Yes
(in view mode) > general

General > Security level for external candidates
(in view mode) > restricted

General > Security level for internal candidates
(in edit mode) > confidential

General > Security level for internal candidates = Yes Yes Yes
(in edit mode) > general
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Domain

Performance > Performance Reviews

Performance > Succession Plans

ORACLE

Permission

General > Security level for internal candidates
(in edit mode) > restricted

General > Security level for internal candidates
(in view mode) > confidential

General > Security level for internal candidates
(in view mode) > general

General > Security level for internal candidates
(in view mode) > restricted

Access administration tools

Manage

Manage > If this user is one of the authors
Manage > If this user is the direct manager
Manage > If this user is a higher level manager
Manage > If this user is a matrix manager

Manage > If it belongs to the user's coverage
area

Manage > If this user is a mentor

Manage > If it belongs to the user's coverage
area or it is associated to a group to which this
user belongs

View

View > If this user is one of the authors

View > If this user is the direct manager

View > If this user is a higher level manager
View > If this user is a matrix manager

View > If it belongs to the user's coverage area
View > If this user is a mentor

View > If it belongs to the user's coverage area
or it is associated to a group to which this user
belongs

Access administration tools

Allow nominations

Manage

Chapter 2
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Employee HR Manager -
Administrator -  Global
Global
Yes Yes Yes
Yes
Yes
Yes Yes
Yes
Yes
Yes
Yes Yes
Yes
Yes
Yes
Yes
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Domain

Performance > Goal Plans

ORACLE

Permission

Manage > If this user is the direct manager of
the related job position

Manage > If this user is a higher level manager
of the job position manager

Manage > If this user is a higher level manager
of the job position manager

Manage > If this user is a matrix manager

Manage > If it belongs to the user's coverage
area

Manage > If it belongs to the user's coverage
area or it is associated to a group to which this
user belongs

View

View > If this user is the direct manager of the
related job position

View > If this user is a higher level manager of
the job position manager

View > If this user is a higher level manager of
the job position manager

View > If this user is a matrix manager

View > If it belongs to the user's coverage area
View > If it belongs to the user's coverage area
or it is associated to a group to which this user
belongs

Access administration tools

Manage

Manage > If this user is one of the authors
Manage > If this user is the direct manager
Manage > If this user is a higher level manager
Manage > If this user is a matrix manager

Manage > If it belongs to the user's coverage
area

Manage > If this user is a mentor
Manage > If it belongs to the user's coverage
area or it is associated to a group to which this

user belongs

View
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Employee HR Manager -
Administrator -  Global
Global
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes Yes
Yes
Yes
Yes
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Domain

Performance > Career Plans

Performance > Development Plans

ORACLE

Permission

View > If this user is one of the authors

View > If this user is the direct manager

View > If this user is a higher level manager
View > If this user is a matrix manager

View > If it belongs to the user's coverage area
View > If this user is a mentor

View > If it belongs to the user's coverage area

or it is associated to a group to which this user
belongs

Manage

Manage > If this user is one of the authors
Manage > If this user is the direct manager
Manage > If this user is a higher level manager
Manage > If this user is a matrix manager

Manage > If it belongs to the user's coverage
area

Manage > If this user is a mentor

Manage > If it belongs to the user's coverage
area or it is associated to a group to which this
user belongs

View

View > If this user is one of the authors

View > If this user is the direct manager

View > If this user is a higher level manager
View > If this user is a matrix manager

View > If it belongs to the user's coverage area
View > If this user is a mentor

View > If it belongs to the user's coverage area

or it is associated to a group to which this user
belongs

Access administration tools

Chapter 2
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Employee HR Manager -
Administrator -  Global
Global
Yes Yes
Yes
Yes
Yes
Yes Yes
Yes
Yes
Yes
Yes Yes
Yes
Yes
Yes
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Domain

Performance > Employee Metrics

ORACLE

Permission

Manage

Manage > If this user is the owner

Manage > If this user is the direct manager
Manage > If this user is the high level manager
Manage > If this user is a matrix manager

Manage > If it belongs to the user's coverage
area

Manage > If this user is a mentor

Manage > If it belongs to the user's coverage
area or it is associated to a group to which this
user belongs

View

View > If this user is the owner

View > If this user is the direct manager

View > If this user is a higher level manager
View > If this user is a matrix manager

View > If it belongs to the user's coverage area
View > If this user is a mentor

View > If it belongs to the user's coverage area
or it is associated to a group to which this user
belongs

Manage

Manage > If this user is the owner

Manage > If this user is the direct manager
Manage > If this user is the high level manager

Manage > If this user is a matrix manager

Manage > If it belongs to the user's coverage
area

Manage > If this user is a mentor
Manage > If it belongs to the user's coverage
area or it is associated to a group to which this

user belongs

View

Chapter 2
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Employee HR Manager -
Administrator -  Global
Global
Yes
Yes Yes
Yes
Yes
Yes
Yes Yes
Yes
Yes
Yes
Yes
Yes
Yes
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Domain

Performance > Team Management

Performance > Administration

Performance > Employee Profile

ORACLE

Permission

View > If this user is the owner

View > If this user is the direct manager

View > If this user is a higher level manager
View > If this user is a matrix manager

View > If it belongs to the user's coverage area
View > If this user is a mentor

View > If it belongs to the user's coverage area
or it is associated to a group to which this user
belongs

Access

Access > If this user is the direct manager
Access > If this user is a higher level manager

Access > If it belongs to the user's coverage
area

Access > If it belongs to the user's coverage
area or it is associated to a group to which this
user belongs

Access Talent Browser

Access administration tools

Access centralized search

Access Reporting

Access Manage Matrix Manager

Access application in maintenance mode

Allow system administration

Manage

Manage > If this user is the owner

Manage > If this user is the direct manager
Manage > If this user is the high level manager
Manage > If this user is a matrix manager

Manage > If this user is a mentor

Chapter 2
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Employee HR
Administrator -
Global
Yes

Yes Yes
Yes
Yes

Yes Yes

Yes

Manager -
Global

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes
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Domain

Performance > Business Goals

Grid > Knowledge Exchange

Grid > Solution Exchange

Compensation > Compensation Data

ORACLE

Permission Employee

Manage > If it belongs to the user's coverage
area

Manage > If it belongs to the user's coverage

area or it is associated to a group to which this

user belongs

View Yes
View > If this user is the owner Yes
View > If this user is the direct manager

View > If this user is the high level manager

View > If this user is a matrix manager

View > If this user is a mentor

View > If it belongs to the user's coverage area

View > If it belongs to the user's coverage area

or it is associated to a group to which this user
belongs

Manage

View

Access Knowledge Exchange

Manage Knowledge Exchange

Access Solution Exchange

Manage Solution Exchange

Manage compensation history
View compensation history

View compensation history > If this user is the
owner

View compensation history > If this user is the
direct manager

View compensation history > If this user is a
higher level manager

View compensation history > If it belongs to the
user's coverage area

View compensation history > If it belongs to
the user's coverage area or it is associated to a
group to which this user belongs

Chapter 2
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HR

Administrator -
Global

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Manager -
Global

Yes

Yes

Yes

Yes
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Domain Permission Employee
myTaleo > Administration Access the administration section

myTaleo > Dashboards Access default dashboard

Common > Pools Manage

Manage > If this user is the pool owner or a pool
user

Manage > Allow creating and deleting pools
View
View > If this user is the pool owner or a pool
user
Learning > Global Learning Access Learn
Learning > Learn Access Learn as a default user
Access Learn as a supervisor
Access Learn as an administrator
Access Learn as user 1
Access Learn as user 2

Access Learn as user 3

Configuring User Types

Creating a User Type

Chapter 2

User Account Administration

HR
Administrator -
Global

Yes

Yes

Manager -
Global

Yes

Yes

Yes

When creating a user type, it is recommended to duplicate an existing user type that has been validated in the zone

already to work properly.
The Manage user types user type permission is required.
Configuration > [SmartOrg] Administration > User Types

1. Click Create.
2. Enter a code and a name.
3. Enter a description to clarify the intent of the user type.

The description is displayed in the user type selector and listed under the user account definition page.

4. Select Active from the Status list so it can be added to user accounts and groups, otherwise select Inactive.

L4

Click Save.

6. Click the Arrow icon beside the functional domain you want to configure and click Edit to display the user type

permissions.
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7. Select the required view and manage permissions and click Save.

Changing a User Type Status
The Manage user types user type permission is required.

Configuration > [SmartOrg] Administration > User Types
1. Click a user type.
2. Click Edit next to Properties.
3. Select either Active or Inactive from the Status list.
4. Click Save.

If changed to Active, the user type can now be associated with a user account or group and the status Active appears in

the User Types list. If changed to Inactive, the user type cannot be associated to any new user accounts or groups, but
will remain valid for those it is already associated with.

Deactivating a User Type
The Manage user types user type permission is required.

The user type must have the Active status.

Configuration > [SmartOrg] Administration > User Types
1. Click a user type.
2. Click Edit next to Properties.
3. Select Inactive in the Status field.
4. Click Save.

The status Draft appears in the User Types list.

Duplicating a User Type
The Manage user types user type permission is required.

Configuration > [SmartOrg] Administration > User Types

1. Locate the user type you want to duplicate.

2. From the Actions column, click Duplicate for the user type.

3. Change the code, name and description as required.
When you have more than one language, after entering the name for the initial language, click Refresh and
select the next language from the list and click Refresh again. Enter the required value for that language and
then choose the next language, click Refresh and repeat the process.

4. C(Click Save.

On the user type definition page, your actions are displayed in the History section. On the User Types page, the new
user type is displayed and its status is Active.

Editing User Type Properties
The Manage user types user type permission is required.
Configuration > [SmartOrg] Administration > User Types

1. Click a user type.

2. Click Edit next to Properties.

3. Make the required changes to the code, name and description.
4. C(lick Save.
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62



Talent Acquisition Cloud Chapter 2
Implementing Performance User Account Administration

Dissociating All Users from a User Type
The Manage user types user type permission is required.
Configuration > [SmartOrg] Administration > User Accounts

In the Refine by field, select User Type.

In the adjacent field, enter a word or part of a word found in the name of the user type you want to delete.
Click Refresh.

Click a name displayed in the User Accounts list.

Click Edit next to User Types.

Locate the user type you want to remove and click Remove in the Actions list.

Click Save.

Repeat steps 4 to 7 for each user who has the user type you want to delete.

PN UARWNA

The user type is no longer displayed in the User Types list.

Granting a User Type Permission
The Manage user types user type permission is required.
Configuration > [SmartOrg] Administration > User Types

1. Click a user type.

2. Click a functional domain.

3. Click Edit next to the sub-domain.

4. Select the permissions you want to grant.
5. Click Save.

All users assigned with this user type now have the selected permissions.

Revoking a User Type Permission
The Manage user types user type permission is required.

Configuration > [SmartOrg] Administration > User Types
1. Select a user type.
2. Click the functional domain (and in some cases the sub-domain) containing the permission.
3. Click Edit next to the section containing the permission you want to revoke.
4. C(lear the check box next to the permission you want to revoke.
5. Click Save.

On the user type definition page, your actions are displayed in the History section. The users who have the user type will
no longer have the permissions you revoked.

User Group Management

User Group

A user group is a group of people who need to have access to the same information for example, a group of people who
works on the same requisitions.
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User groups are used in Recruiting, Taleo Performance, and Reporting and Analytics.

The creation of groups typically simplifies the work of an organization because each group has access only to the
information that its members need.

One group, called the Main Group, is created by default for all users within an organization. The Main Group's
Organization- Location-Job Field structure cannot be modified.

The creation of user groups by system administrators involves:

- Defining a name for the group.

- Selecting users belonging to the group.

- Defining the coverage areas of the group to specify the product areas to which the group has access, that is
selecting domains and sub-domains and linking them to organizations, locations and job fields.

For Reporting, group creation also involves:

- Creating a folder in Business Objects.
- Selecting groups that have the reporting domain tied to it to define who gets access to the reports within that
folder.

Special rules regarding user groups:

- Users should be removed from the Main Group after being added to a specific group.

- To gain access to elements associated to a particular group, users must belong to that group.

- Itis possible to delete a group only if all its members belong to at least one other group.

- Itis not possible to delete a group if a user is associated to this group.

- Itis not possible to delete a group if elements (such as requisitions) remain associated to the group.

- If a user is removed from a group and the user owns one or more element (such as requisitions) associated with
this group, the elements will appear in red in the system (for example, in the requisition list) to indicate that
there is a conflict.

System administrators have the ability to assign a default user group to newly created users. The Default User Groups
setting, available under the General Configuration settings, can be used to indicate which user group new users will
be automatically assigned. The default user group is automatically assigned only when no user group was manually
assigned during the user account creation process. When the setting value is left empty, no default user group is
assigned when creating new users. See Assigning a Default User Group.

User Group Management

User groups are used in Recruiting, Taleo Performance and Reporting and Analytics.

« Recruiting Center

o Itis possible to create a user and to not link the user to a user group. In Recruiting Center, it is
recommended that users belong to at least one user group if they are a recruiting user who creates,
approves or manages requisitions. If a user is authorized to search, the user will be able to view
candidates of all Organization-Location-Job Field structures unless a user group using the recruiting
search domain.
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o Search and requisition are independent domains that can be individually applied to a user group.

o If users do not belong to a group linked to the Requisition domain, and they are a Recruiting user, the
user will only see requisitions they own or collaborate on or without restriction (All) if so authorized. The
user will not see information in or by group, even if their user type permission state otherwise — since
there are no groups linked to the user to view. In addition, the user will not see information in or by group,
even if their user type permission state otherwise — since there are no groups linked to the user to view.

- Taleo Performance

o Users will only see the data of the domain that belongs to their group, provided they have the proper user
type permission.

o Itis possible to create a user and not link the user to a group for a given domain. For all sub-domains
(except for the Employee Succession Search) users will not be able to see information in or by group,
even if their user type permission state otherwise — since there are no groups linked to the user to view.

If a user is authorized to search (sub-domain Employee Succession Search), the user will be able to view
employees of all Organization-Location-Job Field structures.

- Reporting and Analytics

o The reporting administrator creates documents within the reporting and analytics environment.
These include Web Intelligence Documents, Analytics, Advanced Analytics, Single Dashboards, Tiered
Dashboards, Hyperlinks, Desktop Intelligence Documents and imported files (PDF, XLS, DOC, TXT, etc...)

o Each reporting document is filed into a "folder."

o Each reporting folder can be linked to one or more reporting groups containing the reporting domain.

o Users can belong to one or more groups that have the reporting domain associated, Reporting
Administrator ties these groups to reporting folders where reporting and analytic documents are filed.

o Users only have access to the documents included in the folders to which their group(s) are linked. With
the exception of reporting administrators, if a user has no groups linked to a reporting domain, he/she
will not be able to see any reports.

o When generating a report data presented is still derived by user's access in that application (Recruiting
Center or Performance)

Creating a User Group

The Manage groups user type permission is required.
Configuration > [SmartOrg] Administration > User Groups

1. Click Create
2. Complete the New Group page.

3. If your organization activated more than one language, enter values for each of the other languages, being sure
to click Refresh after you select a new language and before you enter the values for that language.

4. C(lick Save.

The system displays the user group. If you display the list of user groups, the new user group appears there.
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Adding a User to a User Group

The Manage groups user type permission is required.
You must create a user group before you can add users to it.
Configuration > [SmartOrg] Administration > User Groups

1. Click a user group.

2. Click Add next to Users.

3. Click the check box next to each user you want to add to the user group.
4. Click Select.

The user is displayed in the Users list.

Removing a User from a User Group

The Manage groups user type permission is required.
Configuration > [SmartOrg] Administration > User Groups

1. Click a user group.
2. C(lick Show next to Users.
3. Inthe Actions column, click Remove next to the user you want to remove.
The user is no longer displayed in the Users list. The History section is not updated automatically but if you move to

a different page and then display the user group definition page anew, the action you performed is displayed in the
History section.

If you remove a user from a group and the user owns one or more requisitions associated with this group, the
requisitions will appear in red in the Requisitions list to indicate that there is a conflict. To revert the situation, re-enter
the owner of the requisitions in the group, reassign each requisition owned by this user to a new user who belongs to
the same group, reassign each requisition owned by this user to a group to which the owner used to belong.

Deleting a User Group

The Manage groups user type permission is required.

It is not possible to delete a group if requisitions or templates remain associated to the group.

Configuration > (SmartOrg) Administration > User Groups
1. Inthe User Groups list, locate the user group you want to delete.
2. C(lick Delete in the Actions column.
3. Click Yes.

The user group is removed from the User Groups list.
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Assigning a Default User Group

Configuration > [General Configuration] Settings
In the Refine by field, select Name.

Type Default User Group in the field.

Click the setting name.

Click Edit.

Click Add.

Select one or multiple user groups.

Click Select.

Click Done.

When creating new users, the selected user groups will be assigned if no user group was manually assigned during the
user account creation process.
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Coverage Area

A coverage area is a combination of functional domains, Organizations, Locations and Job Fields that together
determine the scope of information available to a specific user group.

The coverage areas of a group define exactly what kind of information is available to the group's members. A coverage
area typically contains domains (and perhaps subdomains), which are core products, and Organizations, Locations
and Job Fields. The combination of domains, Organizations, Locations and Job Fields associated with a coverage area
determine the scope of information available to the group for that area.

Adding a Coverage Area to a User Group

Allows the system administrator to limit the information available to a user group by specifying core products and
Organizations, Locations and Job Fields.

The Manage groups user type permission is required.
You must create a user group before you can add coverage areas to it.
Configuration > [SmartOrg] Administration > User Groups

Click a user group.

Click Create next to Coverage Areas.

Click Add next to Functional Domains.

Select the domain/subdomain you want to make available to the user group.
Click Select.

6. Click Save.

The domains you selected are displayed in the Functional Domains section of the Coverage Area page.

uhWNRA
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Removing a Coverage Area from a User Group
Allows a system administrator to reduce the kinds of information currently available to the user group.

The Manage groups user type permission is required.

Configuration > [SmartOrg] Administration > User Groups

1. Click a user group.

2. Click Show next to Coverage Areas.

3. Click Remove next to the coverage area you want to remove.
4. Click Yes.

The coverage area is no longer displayed in the Coverage Areas list. The History section is not updated automatically
but if you move to a different page and then display the user group definition page anew, the action you performed is
displayed in the History section.

Adding Organizations, Locations and Job Fields to a Coverage
Area

Allows the system administrator to further define which information will be available to members of the user group
according to organizations, locations and job fields.

The Manage groups user type permission is required.
You must add functional domains to a coverage area before you can add Organization, Location and Job Field values.

Configuration > [SmartOrg] Administration > User Groups

1. Ona Coverage Area page, click Add next to the type of item you want to add: Organizations, Locations or Job
Fields.

2. After the system displays the corresponding selector page, click the check box next to each item you want to
add to the coverage area.

3. Click Select.

4. You can repeat the previous steps if you added Organization elements, for example, and you also want to add
Location and Job Field elements.

The Organization, Location and Job Field elements you added are displayed in the corresponding sections of the
Coverage Area page.

Removing Organizations, Locations and Job Fields from a
Coverage Area

The Manage groups user type permission is required.

Configuration > [SmartOrg] Administration > User Groups

1. Click a user group.
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2. Click Show next to Coverage Areas.
3. Click a coverage area.
4. On the Coverage Area page, click Remove next to the item you want to remove.

The Organization, Location or Job Field element you removed is not longer displayed in the corresponding section of
the Coverage Area page.

Reducing the Scope of a Coverage Area

You can remove functional domains, Organizations, Locations and Job Fields if you want to reduce the scope of a
coverage area.

Configuration > (SmartOrg) Administration > User Groups

Click a user group.

. Click Show next to Coverage Areas.

Click the coverage area you want to modify.

. You can perform any of the following steps.

o Toremove a functional domain, Organization, Location or Job Field, click the corresponding Remove in
the Actions column.

o To remove all Organizations, all Locations or all Job Fields, click Remove All next to the corresponding
item.

The items you removed are no longer displayed the Coverage Areas page. The actions you performed are displayed in
the History section of the user group definition page.

Configuration Profiles

Configuration Profile

A configuration profile is a set of settings which control how the application behaves for a specific set of users to better
fit the user experience.

It is through the configuration profile that different product behaviors can be achieved such as a streamlined manager
product experience vs. a more robust recruiter product experience. Users may have the same set of permissions which
grant access to specific features, but how a user is presented access to the features is then further controlled by the
configuration profile designation.

In addition to user types (which define user access to specific features via permissions and product access) and user
groups (which further define access to elements and functions based on Organization-Location-Job Field, users are
assigned a configuration profile which defines what they will see in the Recruiting Center.

Configuration profiles are created in SmartOrg. Once created, a configuration profile is assigned to Recruiting Center
users via their user account. Therefore, depending on the user signing into the application, elements displayed to the
user will vary depending on the configuration profile associated to the user.
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Three default configuration profiles are provided:

+ Recruiter
- Hiring Manager
» Hourly Manager

System administrators can edit the settings for these default configuration profiles and can also create new
configuration profiles. Changes made to a configuration profile are applied the next time a user linked to this
configuration profile logs in. For a list of configuration profile settings, see Configuration Profile Settings.

System administrators have the ability to assign a default configuration profile to newly created users. The Default
Configuration Profile setting, available under the General Configuration settings, can be used to indicate which
configuration profile new users will be automatically assigned. The default configuration profile is automatically
assigned only when no configuration profile was manually assigned during the user account creation process. When the
setting value is left empty, no default configuration profile is assigned when creating new users. See Assigning a Default
Configuration Profile.

Configuration Profile Settings

Configuration Profile Setting Description

About Link in Auxiliary Menu Display the about link in the auxiliary menu.

Advanced Search "Save Query" Button Displays the "Save Query" button in the advanced search page.

Advanced Search Links Displays the advanced search links.

Advanced Search Toolbar Displays the advanced search toolbar.

Auxiliary Navigation Bar Displays the auxiliary navigation bar.

Candidate File Creation Indicates the files used to create a candidate.

Candidate List Format Candidate list format available for users having this configuration profile.

Center Stage - Separator Line Display a line between the Welcome title and the content of the main center stage (this line helps to

help distinguish the title from the body portion of the page).

Center Stage - Welcome Title Display the Welcome message when users first log in and are presented the Recruiting center stage.
Center Stage Configuration Determine which center stage combination is used.
Center Stage Footer Text Indicates if the center stage footer is displayed.
Communication Channel - Custom Link Contains the link text towards the custom page in the communication channel.
Communication Channel - Custom Link Contains the tooltip text for the link towards the custom page in the communication channel.
Tooltip
Communication Channel - Custom Link Indicates the URL of the custom page in the communication channel.
URL
Communication Channel - Custom Text Contains the text to be displayed in the custom communication channel.
Communication Channel - Custom Title Contains the title to be displayed in the custom communication channel.
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Configuration Profile Setting

Communication Channel - HTML Custom
URL

Communication Channel Mode
Core Navigation Bar

Customer Support Section
Customer Support Text

Default "Advanced Search" Field
Configuration

eLearning Section URL

Oracle Support Link in Auxiliary Menu
Recruiting Header Text

Release Notes

Requisition File Automatic Filling
Requisition File Creation

Requisition List Format

Search Widget

Default Value for the Show Information

Filter

Show information for Filter Visibility

Training Section URL

View or Edit Requisition File

Welcome Center Content

Chapter 2
User Account Administration

Description

Indicates the URL of the HTML custom page in the communication channel.

Indicates the "Communications" channel mode to be used.
Displays the core navigation bar.

Enable the customer support section.

Contains the text to be displayed in the customer support section.

Displays the selection of fields that are available to the user when performing an advanced search.

Indicates the target URL to the eLearning section.

Display the Support link in the auxiliary menu.

Displays the Recruiting header text.

Display the release note information when accessing the application, according to the user's profile.
| want to use the "automatic filling" option of the requisition file.

Indicates the files used to create a requisition.

Requisition list format available for users having this configuration profile.

Displays the search widget.

Determines the default value of the Show Information filter which controls the requisitions displayed in
the Requisitions list and center stage channels.

Possible values are: Requisitions | own (default); Requisitions | collaborate on; Requisitions | own or
collaborate on; Requisition in my coverage area, | own or collaborate on; All requisitions.

Indicates whether the context filter control is displayed on the Recruiting requisition list and
homepage.

Indicates the target URL to the training section (Oracle University). The URL is http://
education.oracle.com/pls/web_prod-plg-dad/ ou_product_category.getPage?p_cat_id=356.

File used for viewing or editing a requisition.

Indicates which customized content and layout will be used in the Welcome Center.

Creating a Configuration Profile

The Manage configuration profile user type permission is required.
Configuration > [SmartOrg] Administration > [Users] Configuration Profiles

Click Create.

Provide a code and a name.

Click Save.

Click configuration profile settings and set them as desired.

PUWUNA
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5. Click Save.

Activating a Configuration Profile

A configuration profile must have the Draft or Deactivated status.
The Manage configuration profile user type permission is required.
Configuration > [SmartOrg] Administration > [Users] Configuration Profiles

1. Click a configuration profile.
2. C(lick Activate.

Associating a Configuration Profile to a User Account

Configuration > [SmartOrg] Administration > [Users] User Accounts

Click a user account.

Click Edit next to Account Information.
Select a configuration profile.

Click Save.

PUWNa

Deactivating a Configuration Profile

A configuration profile must be activated.
The Manage configuration profile user type permission is required.
Configuration > [SmartOrg] Administration > [Users] Configuration Profiles

1. Click a configuration profile.
2. C(lick Deactivate.

Deleting a Configuration Profile

The Manage configuration profile user type permission is required.
The configuration profile must have the Draft or Inactive status.
Configuration > [SmartOrg] Administration > [Users] Configuration Profiles

1. Click Delete next to the configuration profile.
2. Click Yes.
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Assigning a Default Configuration Profile

Configuration > [General Configuration] Settings
In the Refine by field, select Name.

Type Default Configuration Profile in the field.
Click the setting name.

Click Edit.

Click Search.

Select a configuration profile.

Click Select.

Click Save.

When creating new users, the selected configuration profile will be assigned if no configuration profile was manually
assigned during the user account creation process.

NV A WNA

Transferring an Employee's User Account Information

Transferring an employee's user account information in SmartOrg allows you to transfer all the tasks and objects owned
by the user/employee and the related employees to a designated user.

Typically, transferring a user having Taleo Performance roles should be preceded by an organization chart and position
update.

If the transferred user is also an employee, the designated user must also be an employee.

The transferred user must have the same roles and product accesses as the designated user.

Configuration > [SmartOrg] Administration > [Users] User Accounts
1. Inthe User Accounts page, select the user for which you want to perform a transfer.
2. Inthe User Account page of the selected user, click Transfer next to Account Information.
3. Inthe Transfer pop-up window, specify the name of the designated user of the transfer by selecting the right
user in the User Selector window.

4. Click Save.

The following tasks, if existing, will be transferred to the designated user:

Request to complete a performance review
Request to approve a performance review
Request to approve a succession plan
Request to approve a succession pool

Request to approve a goal plan
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Employee Information Deletion Task

Employee Information Deletion Task

System administrators use the employee information deletion task to permanently delete information related to former
employees' employment at the organization (as might be required by law in EMEA and other regions).

The Person Model

The following "objects" are associated with a person:

« User Account - to access the system with granted permissions.
- Candidate Account —to apply for jobs through the career section.
- Profile - to store the common profile. Employee and candidate share the same profile.

- Employee - to store employee-related data.

Employee

Profile

Candidate User
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When candidates are hired, a user account and an employee associated with their profile are created:

- As an employee, the profile is maintained through Taleo Performance talent profile.

- As a candidate, the profile is maintained through Recruiting and the career section.

Employee Information Deletion Strategy

Employee information deletion task permanently deletes employee-specific data only. The candidate account and
common profile are unaffected. This enables a person to be rehired in the future by the organization. The person can
remain in current pools and succession plans. The candidate account can eventually be deleted through a distinct task if
Recruiting is available in the system.

Deleted Not Deleted
Employee Specific Data Other Taleo Performance Data
Employee Metrics - Business Goals
Pictures - Projects
Job History - Sent Feedbacks
Matrix Management - History of actions taken by the employee
Remaining Tasks Profile and Candidate Data

Compensation History General Profile (Education, Experience, Certifications, Preferences, etc)

Goal Plans, Goals, Tasks (aligned
goals will be unlinked)

Job Submissions

. . Offers
Performance Reviews & Review
History Talent Pools & Succession Plans

Career Plans Remains as member (now as an external candidate)
Development Plans User Specific Data
Received Feedbacks o . .
Remains in the system but inactive
Sent Feedback Requests

Employee Information Deletion Rules
Employee-related information can be permanently deleted provided all of the following conditions are met:

- The Employee Status of the user account is Former Employee (this is typically achieved by deleting the user
account (status: Deleted)).

- The employee must not be the owner manager of positions. A transfer of ownership is required prior to
deletion.

- The employee must not be the owner of talent pools. A transfer of ownership is required prior to deletion.

Employee Information Deletion Process
Employee information deletion is a four step process:

1. User account deletion (see Deleting a User Account From the User Account Page, Deleting the User Account of
an Employee Using the Wizard and Deleting the User Account of an Employee Manually).
2. Deletion task creation (see Creating a Deletion Task).
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3. Preview of employees to be deleted (see Previewing Employees to be Deleted).
4. Execution of the deletion task (manually or, more often, automatically according to the date and frequency
chosen by the administrator).

Limitations

No archiving capabilities at this time.
- A user account cannot be permanently deleted from the system.
o User accounts, once deleted, are no longer displayed but remain in the system.
o The user accounts do not contain employee-related data.

Products for which the data will not be automatically deleted by the employee information deletion task:
o Learn
o Evaluation Management
o Assessment
o Screening Services
o Analytics
o Any other external products integrated with Oracle Talent Acquisition Cloud (OTAC)

Deleting a User Account From the User Account Page

The Manage user accounts - Including HMRS fields user type permission is required..
Configuration > [SmartOrg] Administration > User Accounts

1. Locate the user in the User Accounts list.
2. C(lick Delete in the Actions column.
3. The action(s) you perform next vary depending on whether the user account is associated with an employee.

o If the user account is associated with an employee who owns requisitions, templates or folders, or was
assigned yet uncompleted actions, or reports to a manager, or has pending tasks or work items, perform
the steps in the wizard.

o If the user account is associated with someone for whom none of the previous conditions applies, click
Yes.

Once deleted, the user account status is set to Deleted and the user account is deactivated.

To permanently delete employee data related to the employee, including employee metrics and all Taleo Performance
data (as might be required in EMEA and other regions), see Employee Information Deletion Task.

Deleting the User Account of an Employee Using the Wizard

The Manage users - Including HMRS fields user type permission is required.

Configuration > [SmartOrg] Administration > User Accounts
1. Click the user account you want to disable.
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2. Inthe Employee Information section, click Terminate.

The wizard is displayed.
3. Perform the steps in the wizard.

The user account has Deleted status and therefore is no longer displayed on the User Accounts page if Active is selected
in the View field. The Employee Status value is changed to Former Employee.

To permanently delete employee data related to the employee, including employee metrics and all Taleo Performance
data (as might be required in EMEA and other regions), see Employee Information Deletion Task.

Deleting the User Account of an Employee Manually

The Manage users - Including HMRS fields user type permission is required.
Configuration > [SmartOrg] Administration > User Accounts

Click user account you want to disable.

Edit the Employee Information section as necessary.

Set employee status to Former Employee.

Provide a termination date.

Remove the manager.

Transfer direct reports to another manager if applicable.
Transfer ownership of talent pools and positions to another user.
Transfer pending tasks to another user.

Return to the User Accounts page, locate the user account in the list and click the corresponding Delete in the
Actions column.

10. Click Yes.
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Once deleted, the user account status is Deleted and the user account is deactivated.

To permanently delete employee data related to the employee, including employee metrics and all Taleo Performance
data (as might be required in EMEA and other regions), see Employee Information Deletion Task.

Creating a Deletion Task

The Access Deletion Tasks permission is required (User Types > [Functional Domains] Configuration > Data Lifecycle
Management).

Configuration > Operations > Deletion Tasks

Click Create.

Select Employees, click Next.

Select Permanently delete, click Next.

Click the check box next to each criterion you want to include and click Next.

Enter values for the Name, Code, Status, Start Date, Recurrence fields and click Next.
6. Review your selections and click Finish.

UubhUWUNRA

The task is displayed in the Tasks list. If you selected a date and frequency for the task, the task will run automatically on
the dates that correspond to your selections.
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Previewing Employees to be Deleted

The Access Deletion Tasks permission is required (User Types > [Functional Domains] Configuration > Data Lifecycle
Management).

Configuration > Operations > Deletion Tasks

1. Inthe Task list, click the task you want to examine.
2. Click Count.
3. Click the x out of y total items link to view the list of former employees to be deleted.

Prevent Updating Internal System User

Customer administrator users cannot fully manage internal system users (such as Support and CS Synchronization).

Internal system users are protected and cannot be deleted or fully updated. Certain internal system user fields also
cannot be updated.

Customer administrator users cannot access, view, update or delete protected internal system users and certain related
fields. This feature is not visible to customers except when error messages are generated as a result of having attempted
to update or delete protected internal system users and fields.

Filter Out Internal Users

Internal users are filtered out of User Exports. Internal users were filling the user export list where the Customer only
needs to see standard users.

Internal users are dedicated technical users required by the application to work properly.

| ?’ Note: Only support users can see Internal users in SmartOrg.

System User Check Box
The System User check box is only visible to system users when they are managing other users.

The System User check box is available in SmartOrg Administration, in the Personal Information section of user
accounts.
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5 Organizational Structure Administration

Organizations, Locations and Job Fields (OLF)

Fundamental Data Structure: Organization-Location-Job Field
(OLF)

The data structure enables each customer to customize Oracle Talent Acquisition Cloud (OTAC) products such that
they reflect how the customer does business. Each customer's organization is defined as a combination of three main
elements: Organizations, Locations, Job Fields (OLF). OLF is also referred to as contextualization.

Organization describes the hierarchical structure of an organization. Up to 20 organization levels can be created. The
system proposes the following organization structure, but other terms may be chosen to better reflect the hierarchical
structure of a company:

- Company

- Sector
Department
Division

Location represents a geographical area, such as a country or state. Locations are listed in a hierarchical order, from the
broadest geographical area (often a country) to increasingly specific areas (work location). Up to 5 location levels can be
created. Locations must be associated to network locations used for various purposes, mainly integration with external
systems, using a common and standard universal structure. Oracle strongly recommends defining a zip code for the
location. A common location structure is:

- Country

- State/Province
Region

- City

« Work Location

Worker locations can be mapped to the Location structure. The worker location is used as an employee (post-hire)
function whereas the location (in OLF) is meant for recruiting purposes. For example, a location could be 100 Main
Street and a worker location could be "Sector 44" or "Cubicle A". Worker locations are not created in Configuration.
Worker locations are typically imported from an external HRMS system. Once worker locations are imported, worker
locations can be mapped to the Location structure via Integration or by the system administrator in Configuration. Any
Location element can be given the Worker Location and the Worker Location Address properties. System administrators
can then configure worker locations to appear in requisitions, offers, correspondences, requisitions lists, and candidates
lists just like any other fields. For details, see Worker Location.

Job Field represents the employment sectors or domains. Up to 4 job field levels can be created. Job fields must also
be mapped to the network job fields, again to have a common language with the external world, be for posting or
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integrations. This mapping also serves to inherit existing classification for competencies. The system proposes the
following job field structure, but other terms may be chosen to better reflect the structure of a company:

- Category

« Function

- Specialty
Contextualization, that is the Organization-Location-Job Field structure associated to an element, represents the
framework the application uses to organize, classify, link, match or search for information in the application. Although
Organization-Location-Job Field structures are configured with the help of an Oracle representative during the
implementation phase, modifications to structure elements can be done in maintenance mode at any time. It is possible

to customize the system to reflect a company's unique structure and make modifications to Organization-Location-Job
field elements in real time so that the data accounts for any changes in the structure.

There are several key elements of the Oracle Talent Acquisition Cloud (OTAC) products that are tied to the Organization-
Location-Job field structure such as candidate selection workflows, requisitions and requisition templates, message
templates, user management, prescreening, approvals, etc.

The purpose of contextualizing an element is to make the element relevant according to a specific context. Below is an
example of contextualization with candidate selection workflows. The CSW1 would not be available to the user for this
requisition, because the last level of its Location does not match that of the requisition. The CSW2 could be available to
the user for this requisition. The parent element of the lowest level of the requisition for each dimension (Organization,
Location or Field) must be the same as the lowest level of the workflow for each dimension.

Example:

Requisition:
- Organization: Urban transportation
- Location: United States/California/Los Angeles
- Job Field: Bus driver

- Organization: Urban transportation
- Location: United States/California/San Jose
- Job Field: Bus driver

- Organization: Urban transportation
+ Location: United States

- Job Field: Bus driver

When using contextualization, the system applies the AND operator between Organizations, Locations and Job Fields
entities. However, the OR operator is applied between elements of the same entity.

In the following example, a field would be displayed if Canada (or any of its children) AND Architecture were selected.
- Location: Canada

- Job Field: Architecture
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In the following example, a field would be displayed if Canada AND Architecture were selected, or if United States AND
Architecture were selected.

Location: Canada
Location: United States
- Job Field: Architecture

Mapping

Mapping is essential to the Organization, Location, and Job Field (OLF) concept because it allows the creation of an
association between a custom element and a standard element from an external system.

Through mapping, it is possible to organize and exchange data between two or more systems in a compatible format.
Mapping locations, for example, helps the application to communicate location information to job boards when posting
a requisition. The two systems agree that the data structure location will represent a geographical place such as a
country, a state or a city. The systems are then able to swap information based on a mutually comprehensible data
exchange agreement.

Structure Management

The Structure Editor lets you create and delete organization, location, and job field levels according to your
organization's needs. The structure that you establish in the Structure Editor will form the basis of the Organizations,
Locations, and Job Fields throughout the application.

OLF Location Geocoding

When the OLF Location element is created or edited and the ZIP code is provided, the Location element is automatically
geocoded.

The latitude and longitude is populated for the created or edited location element when done in the SmartOrg Ul or by
integration.

Creating the Organization-Location-Job Field Structure

The Manage Foundation Data user type permission is required.

The application must be in implementation mode or maintenance mode.

Configuration > [SmartOrg] Administration

Click Structure Management under Organizations, Locations or Job Fields.
Click Edit.

Click Create to add levels.

Enter a description for each level.

Translate the description into every supported content language.

UAEWNA
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6. In the Displayed column, select the levels that you want to display to the user.
For organizations and job fields, the levels must be displayed in sequence. For example, you can choose to
display levels 1to 3 and not 4, but you cannot display 1, 2, 4, but not 3.

7. Click Save.

Adding a Level to the Organization-Location-Job Field Structure

The Manage Foundation Data user type permission is required.

The application must be in implementation mode or maintenance mode.

Configuration > [SmartOrg] Administration

Click Structure Management under Organizations, Locations or Job Fields.
Click Edit.

Click Create to add levels.

Enter a description for each level.

Translate the description into every supported content language.

In the Displayed column, select the levels that you want to display to the user.

cCUuhUNA

The levels must be displayed in sequence. For example, you can choose to display levels 1to 3 and not 4, but
you cannot display 1, 2, 4, but not 3.

7. Click Save.

Editing a Level in the Organization-Location-Job Field Structure

The Manage Foundation Data user type permission is required.
To edit the description of a level, the system must be in maintenance mode.

To edit which levels are displayed, the system must be in implementation mode or maintenance mode.

Configuration > [SmartOrg] Administration
1. Click Structure Management under Organizations, Locations or Job Fields.
2. Click Edit.
3. Make required changes.
4. Click Save.

Deleting a Level in the Organization-Location-Job Field Structure

The Manage Foundation Data user type permission is required.
The application must be in implementation mode or maintenance mode.

If you want to delete a level in the Organization structure, you must first move elements that are attached to it to
another level. You cannot delete levels if elements are linked to the level.

Configuration > [SmartOrg] Administration
1. Click Structure Management under Organizations, Locations or Job Fields.
2. Click Edit.
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3. Click Delete next to the desired level.

Element Management

The Element Management feature allows a system administrator to view the properties of the Organizations-Locations-
Job Fields structure and to manage their children.

Creating an Element for the Organization-Location-Job Field
Structure

The Manage Foundation Data user type permission is required.
The application must be in implementation mode or maintenance mode.
Entering a sequence number will overwrite the default alphabetical sequencing available in the system.

For an element to be active, all of its parents must be active. If not, the Active (Pending) status will appear in the Status
column.

Configuration > [SmartOrg] Administration
1. Click Element Management under Organizations, Locations or Job Fields.
2. C(lick Create next to Children.
3. Complete the fields.
4. Click Save.

Editing an Element in the Organization-Location-Job Field
Structure

The Manage Foundation Data user type permission is required.

The application must be in implementation mode or maintenance mode.

Configuration > [SmartOrg] Administration
1. Click Element Management under Organizations, Locations or Job Fields.
2. Click Edit in the Actions column.
3. Make the required changes.
4. Click Save.

Moving an Element in the Organization-Location-Job Field
Structure

The Manage Foundation Data user type permission is required.

The application must be in implementation mode or maintenance mode.
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Configuration > [SmartOrg] Administration

Click Element Management under Organizations.

In the list of Children, select the element that you want to move.

Click Move.

Specify under which organization you want to move the selected element.
Click Save.

VuhWN2

Deleting an Element

The Manage Foundation Data user type permission is required.

The application must be in implementation mode or maintenance mode.

Configuration > [SmartOrg] Administration
1. Click Element Management under Organizations, Locations or Job Fields.
2. Inthelist of Children, select the desired element.
3. Click Delete.

If the organization, location or job field that you want to delete has elements, you must reassign the elements
to another organization, location or job field. Click OK in the message box. When the selector opens, you

can reassign the elements by selecting a new organization, location or job field. All the elements (templates,
requisitions and candidates) associated to the organization, location or job field are now reassigned to the
organization, location or job field selected above.

Adding an Element to the Location or Job Field Structure

The Manage Foundation Data user type permission is required.

The application must be in implementation mode or maintenance mode.

Configuration > [SmartOrg] Administration
1. Click Element Management under Organizations, Locations or Job Fields.
2. Click Add next to Children.
3. Select the desired element.
4. Click Select.

Element Deactivation

Over time, Taleo clients might need to deactivate or reactivate certain Organization-Location-Job Field elements in
SmartOrg to ensure that the foundation data structure reflects changes to their business process structure.

Reports mention whether the status of an Organization-Location-Job Field element is Active or Inactive. In addition, if
you deactivate Organization-Location-Job Field elements, they are no longer displayed in the Recruiting Center but if
elements or users are part of requisitions, templates, questions, tasks, candidates, etc. and the elements or users are
deactivated afterward, that information is retained for reporting purposes.

If a parent Organization, Location, or Job Field element is deactivated or reactivated, all child elements are updated to
have the same state as the parent element.
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If an Organization-Location-Job Field element is part of a record (e.g., requisition or candidate file) and the element is
deactivated, the system continues to display the element in the record. The Organization-Location-Job Field element
is not displayed, however, in Organization-Location-Job Field selectors (e.g., Location Selector) if a user creates a new
record or edits an existing one. Recruiting Center users can delete a deactivated Organization-Location-Job Field
element from an existing record.

Deactivation is available via Taleo Connect Client (TCC). This can be done by changing the status of the Organization-
Location-Job Field element.

Deactivating an Organization, Location or Job Field Element

The Manage Foundation Data user type permission is required.

Before you deactivate an Organization-Location-Job Field element, you should carefully review all associated objects
(that is, requisitions, message templates, agencies, etc.) and assign a different Organization-Location-Job Field element
to each object if necessary.

Configuration > [SmartOrg] Administration
1. Click Element Management under Organizations, Locations or Job Fields.
2. If the element you want to deactivate is displayed in the list of Children, click the corresponding Deactivate in
the Actions list.
o If the element is at a lower level, you can drill down to the appropriate level by clicking the element
description in the Description list and then click the corresponding Deactivate.
3. Click OK.

Deactivating an Organization, Location or Job Field Element While
Displayed

The Manage Foundation Data user type permission is required.

Before you deactivate an Organization-Location-Job Field element, you should carefully review all associated objects
(that is, requisitions, message templates, agencies, etc.) and assign a different Organization-Location-Job Field element
to each object if necessary.

Configuration > [SmartOrg] Administration
1. Click Element Management under Organizations, Locations or Job Fields.
2. If the element you want to deactivate is displayed in the list of Children, click the corresponding the element
description in the Description list.
3. Click Deactivate next to the element description near the top of the following page.
4. Click OK.
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Organization-Location-Job Field Behavior of Deactivated
Elements

Context Action Organization-Location-Job Field behavior if
element is deactivated

Agency

Agency View Not displayed
Agency Edit Not displayed
Agency Add Not displayed
Agency - generate new posting Add Not displayed
PDF Form

Any future object configuration such as PDF Add Not displayed

Forms or Screening Services with Organization-
Location-Job Field context

Any future object such as PDF Forms or View Not displayed
Screening Services with Organization-Location-
Job Field context

Any future object such as PDF Forms or Edit Not displayed
Screening Services with Organization-Location-
Job Field context

Automated Tasks for defined Organization-Location-Job Field contexts

Automated Tasks for defined Organization- View Displayed to support historic data integrity
Location-Job Field contexts

Automated Tasks for defined Organization- Edit Displayed if current/historic data selected (to
Location-Job Field contexts allow re-saving and viewing without affecting
data integrity)

Automated Tasks for defined Organization- Add Not displayed
Location-Job Field contexts

Candidate File
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Context Action Organization-Location-Job Field behavior if
element is deactivated

Candidate File View Displayed to support historic data integrity

Candidate File Edit Displayed if current/historic data selected (to
allow re-saving and viewing without affecting
data integrity)

Candidate File Create Not displayed
Candidate Search - New search Organization-Location-Job Field preferences

Candidate Search - New search Organization- Other Not displayed
Location-Job Field preferences

Candidate Search - Run saved search with View Not displayed
Organization-Location-Job Field preferences

Candidate Search - Run saved search with Edit Not displayed
Organization-Location-Job Field preferences

Candidate Search - Run saved search with Add Not displayed
Organization-Location-Job Field preferences

Career Sections Organization-Location-Job Field

Career Sections Organization-Location-Job View Not displayed
Field association

Career Sections Organization-Location-Job Edit Not displayed
Field association

Career Sections Organization-Location-Job Add Not displayed
Field association

Career Sections URL

Career Sections URL View Displayed
Career Sections URL Edit Displayed
Career Sections URL Add Not displayed
Correspondence

Correspondence in Administration menu View Not displayed
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Context Action Organization-Location-Job Field behavior if
element is deactivated

Correspondence in Administration menu Edit Not displayed

Correspondence in Administration menu Add Not displayed

Disqualification Questions

Disqualification Library View Not displayed
Disqualification Library Edit Not displayed
Diversity Forms Add Not displayed

Large User Defined Selections (LUDS)

LUDS View Not displayed

LUDS Edit Displayed if current/historic data selected (to
allow re-saving and viewing without affecting
data integrity)

LUDS Add Not displayed

Offer Data

Offer Data View Displayed to support historic data integrity
Offer Data Edit Displayed if current/historic data selected (to

allow re-saving and viewing without affecting
data integrity)

Offer Data Create Displayed if current/historic data selected (to
allow re-saving and viewing without affecting
data integrity)

Prescreening Questions

Prescreening Library View Not displayed
Prescreening Library Edit Not displayed
Prescreening Library Add Not displayed
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Context

Privacy Agreements

Privacy agreements configuration

Privacy agreements configuration

Privacy agreements configuration

Reports

Reporting - Running Reports

Requisitions

Requisition file data

Requisition file data

Requisition file data

Requisition tree view in Recruiting

Requisition filter by Manager or Recruiter

Requisition Templates

Requisition Templates

Requisition Templates

Requisition Templates

Automated Tasks

Run automated tasks for defined Organization-

Location-Job Field contexts

SmartOrg - Organization-Location-Job Field

SmartOrg - Organization-Location-Job Field

ORACLE

Action

View

Edit

Add

Other

View

Edit

Create

Filter

Filter

View

Edit

Create

Other

View

Chapter 3

Organizational Structure Administration

Organization-Location-Job Field behavior if
element is deactivated

Not displayed

Not displayed

Not displayed

Indicated as "inactivated" in the listing

Displayed to support historic data integrity

Displayed if current/historic data selected (to
allow re-saving and viewing without affecting
data integrity)

Not displayed

Not displayed

Not displayed

Indicated as "inactivated" in the listing

Not displayed

Not displayed

Displayed to support historic data integrity

Invalid; system doesn't allow
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Context Action Organization-Location-Job Field behavior if
element is deactivated

SmartOrg - Organization-Location-Job Field Edit Not displayed
SmartOrg - Organization-Location-Job Field Create Not displayed

SmartOrg - User

SmartOrg - User Admin View Invalid; system doesn't allow
SmartOrg - User Admin Edit Not displayed

SmartOrg - User Admin Create Not displayed

Sources

Source.Tracking config/admin View Not displayed
Source.Tracking config/admin Edit Not displayed
Source.Tracking config/admin Add Not displayed

User Groups

User Groups View Indicated as "inactivated" in the listing
User Groups Edit Not displayed
User Groups Add Not displayed
User Groups - access to candidate/requisition Other Indicated as "inactivated" in the listing

data per segmentation rules

Departments

Departments View Displayed
Departments Edit Displayed
Departments Add Not displayed

Work Locations
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Context

Work Locations

Work Locations

Work Locations

Taleo Performance Flex GUI - Employee

Taleo Performance Flex GUI - Employee

Taleo Performance Flex GUI - Employee

Taleo Performance Flex GUI - Employee

Taleo Performance Flex GUI - Position

Taleo Performance Flex GUI - Position

Taleo Performance Flex GUI - Position

Taleo Performance Flex GUI - Position

Taleo Performance Flex GUI - Job Role (Career)

Taleo Performance Flex GUI - Job Role (Career)

Taleo Performance Flex GUI - Job Role (Career)

Taleo Performance Flex GUI - Job Role (Career)

Action

View

Edit

Add

View

Create

Edit

View

Create

Edit

View

Create

Edit

Taleo Performance Flex GUI - Business Organization

Taleo Performance Flex GUI — Business
Organization

Taleo Performance Flex GUI - Business
Organization

Taleo Performance Flex GUI - Business
Organization

ORACLE

View

Create

Edit

Chapter 3

Organizational Structure Administration

Organization-Location-Job Field behavior if
element is deactivated

Indicated as "inactivated" in the list

Not displayed

Not displayed

Displayed to support historic data integrity

Not displayed

Displayed

Displayed to support historic data integrity

Not displayed

Not displayed

Displayed to support historic data integrity

Not displayed

Not displayed

Displayed to support historic data integrity

Not displayed

Not displayed
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Business Organization Management

Business Organization Structure Management

The Business Organizations section in the SmartOrg page is only available to customers who have purchased Taleo
Performance.

Creating Levels in the Business Organization Structure

A maximum of three levels can be created.
The description must be translated into every supported content language.
Configuration > [SmartOrg] Administration > Business Organizations > Structure Management

Click Edit.

Click Create.

Complete the required fields.
Click Save.

PUWUNA

Editing the Business Organization Structure

The application must be in Maintenance Mode.
Configuration > [SmartOrg] Administration > Business Organizations > Structure Management

1. Click Edit.
2. Make the required changes.
3. Click Save.

Deleting a Business Organization Level

The application must be in Maintenance Mode.
If elements are associated to a level, the level cannot be deleted
Configuration > [SmartOrg] Administration > Business Organizations > Structure Management

1. Click Edit.
2. Click Delete in the Actions column.
3. Click Save.

ORACLE
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Business Organization Element Management

The Element Management feature allows you to view the properties of the business organizations and to manage their
children.

Editing a Business Organization Element

The application must be in Maintenance Mode.

Configuration > [SmartOrg] Administration > Business Organizations > Element Management

1. Click Edit in the Actions column.
2. Make the required changes.
3. Click Save.

Creating a Child for the Business Organization

The application must be in Maintenance Mode.

Configuration > [SmartOrg] Administration > Business Organizations > Element Management

1. Click Create.
2. Complete the New Business Organization page.
3. Click Save.

The child is added to the list of children.

Moving a Child to Another Business Organization

The application must be in Maintenance Mode.

Configuration > [SmartOrg] Administration > Business Organizations > Element Management

1. Click Move in the Actions column of the child you want to move.
2. Specify under which business organization you wish to move the selected element.
3. Click Save.

Activating a Child

Configuration > [SmartOrg] Administration > Business Organizations > Element Management

1. Click Activate in the Actions column of the child you want to activate.
2. Click OK.

The status of the child changes to Active.
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Editing a Child

The application must be in Maintenance Mode.
Configuration > [SmartOrg] Administration > Business Organizations > Element Management

1. Click Edit in the Actions column of the child you want to edit.
2. Make the required changes.
3. Click Save.

Deactivating a Child

Configuration > [SmartOrg] Administration > Business Organizations > Element Management

1. Click Deactivate in the Actions column of the child you want to deactivate.
2. Click OK.

The status of the child changes to Inactive.

Deleting a Child

The application must be in Maintenance Mode.
Elements with children cannot be deleted.
Configuration > [SmartOrg] Administration > Business Organizations > Element Management

1. Click Delete in the Actions column of the child you want to delete.
2. Click OK.

ORACLE
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4 Competency Administration

Working with Competencies

Competency

A competency is a knowledge, skill or ability.

Competencies are contained in the Taleo competencies list, and are configured for use in Taleo Performance. Taleo
competencies can be mapped to job roles and ratings criteria used in performance reviews and succession planning.
There are three types of competencies in the Taleo competencies list.

- Job skills
- Language skills

- Behavioral competencies

By default each competency is associated with one of those three types, however, there will be instances where the
Taleo default settings do not completely align with how an organization views a competency. In this instance you can
override the default competency type association with one of the other types.

A competency can be assessed across one or more dimensions (for example, Last Used, Experience). A separate scale of
values is associated with each dimension.

You can add custom competencies not included in the Taleo standard competencies list. This is made possible by your
default provider code (CUSTOMER_PROVIDER). For more information see Custom Competency Management.

It is also possible to use competencies provided by another vendor. For more information see Third Party Competency
Support.

To edit and activate a competency for use in your organization, it is recommended that you perform the following tasks
in the order they appear here:

Create and activate your rating models.

Create and activate your competency contexts.

Create and activate your competency definition context.

Create and activate competency groups and categories and associate them to competencies to provide users
with various refining options.

5. Edit and activate a competency.

6. Create a guidance plan for the competency.

P WN

Detailed instructions for each of these tasks are documented in separate sections.
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Editing a Competency

You edit a competency when you want to: modify its alias, description or type; add, change or remove its contextual
definitions, competency contexts or sub-competencies; change the competency's rating model (provided the rating
model has never been used in any performance review, job role, job profile classification or position).

To edit competency information, the status of the competency must be Draft or Inactive.

If you want to create a new competency definition and add a competency definition context, you must create the latter
prior to adding it to a definition. See Creating a Competency Definition Context.

If you want to add a competency context, you must create it prior to adding it to a competency.

If you want to assign a new rating model, you must create it prior to adding it to a competency. New rating models may
not be added to competencies that have been used in a review with a prior rating model. See Creating a Rating Model.

Configuration > [Competencies] Competencies
1. In the Competency Management page, click the name of the competency you want to edit. (Alternatively, use
the Refine by list to locate the competency more quickly.)
2. If the status of the competency is Active, in the Actions column, click the corresponding Deactivate to make the
information editable.
Select the language in which you want to make the modifications.
4. You can perform any of the following actions.
o To change the competency's alias, description or competency type, click Edit next to Properties and make
your changes in the Competency Editor page.
o To make changes to the competency's definitions, click Create next to Definitions to create a new
definition or click Edit next to an existing definition to modify the latter.
o To make changes to the competency's contexts, click Add next to Competency Contexts to add a new
context or click Delete next to an existing context to remove it from the list of contexts.
o To assign a different rating model to the competency, click Edit next to Rating Model to select a new
rating model. This change will be possible only if the current rating model has never been used in a
performance review, job role, job profile classification or position.
o To make changes to the competency's sub-competencies, click Create next to Sub-Competencies
to create new sub-competencies, Reorder next to Sub-Competencies to reorder the current sub-
competencies, or Edit next to an existing sub-competency to modify the latter's name.
5. To make the competency available for selection when adding to reviews or job profiles, click Activate next to the
competency's name. Alternatively, you can leave the status as Draft (the competency will remain unavailable for
selection) and activate the competency at a later time.

w

The Competency page automatically displays all your changes.

Adding a Context-Specific Definition to a Competency

A competency might need to be defined differently for different SmartOrg elements in your organization. You can create
multiple competency definitions for a single competency and assign each one to a specific Foundation Data element in
SmartOrg.
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If you plan to assign a competency definition context to a competency definition, you have to first create the context
and activate it in separate operations. See Creating a Competency Definition Context and Activating a Competency
Definition Context.

Configuration > [Competencies] Competencies

1. In the Competency Management page, locate the competency you want to edit and then click its name.
(Alternatively, use the Refine by list to locate the competency more quickly.)

2. C(lick Create next to Definitions.

3. Inthe Competency Definition field, enter the definition you want the system to display to the employees of a
specific SmartOrg element in your organization.

4. C(lick Search next to the Competency Definition Context field, click the radio button next to the context you want
to select and then click Select.

5. Click Save.

The definition is displayed in the Definitions section of the Competency Editor page.

You can add a competency context to the competency if you want.

Editing a Competency's Definition
You can create, edit or delete any context-specific definition associated with a competency.

Configuration > [Competencies] Competencies

1. In the Competency Management page, locate the competency you want to edit and then click its name.
(Alternatively, use the Refine by list to locate the competency more quickly.)

2. If the status of the competency is “Draft” or “Inactive”, proceed immediately to the next step. If you have
already activated the competency (its status is “Active”), click Deactivate next to the name of the competency or
next to the language list.

3. To add a context-specific definition, click Create in the Definitions section, enter a definition and a context, and
then click Save. Repeat this step for each definition and context you want to add.

4. To edit a definition or context, click the corresponding Edit in the Actions column of the Definitions section,
enter your changes and then click Save.

5. To delete a definition, click the corresponding Delete in the Actions column of the Definitions section and then
click Yes to confirm the action.

6. If you deactivated the competency earlier and have no other changes to make, click Activate to make the
competency available to employees for selection. If the current status is “Inactive” and you want to make other
changes, for example, modify the competency contexts, make all the changes before clicking Activate.

The changes you made are reflected in the information displayed on the Competency Editor page.

If you have not already done so, you should activate the competency.

Activating a Competency

Activating a competency makes the competency available to employees so they can add it to their talent profile, and to
managers so they can add it to performance reviews. All competencies have “Draft” status by default and are therefore
unavailable to employees and managers.
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Ensure that the following steps (if applicable to the competency) are completed and that all the information is correct
before you activate a competency. If competency is activated and it contains a rating model, the latter can only be
changed later if it has not been included in performance reviews, job roles, job profile classifications and positions.

- Edit the competency's properties and description.

- Add context-specific definitions if desired.

- Add competency contexts if desired.

- Add a rating model if desired.

- Add sub-competencies if desired.
Configuration > [Competencies] Competencies

1. Onthe Competency Management page, locate the competency you want to activate. (Alternatively, use the
Refine by list to locate the competency more quickly.)

2. Inthe Actions column, click the corresponding Activate.

On the Competency Management page, in the Competencies list, Active is displayed in the Status column and Activate
is no longer displayed in the Actions column.

The competency can no longer be edited or deleted.

Employees can now view and add the competency provided they are part of one of the Foundation Data elements
(in SmartOrg) specified in the Competency Contexts section of the competency. If no Foundation Data elements are
specified, the competency can be viewed and selected by all employees.

The competency is available for use in job roles, positions and performance reviews.

You can create a guidance plan for the competency if you want.

Third Party Vendor Competency Support

While Taleo provides a robust and comprehensive competencies library with each implementation, customers may use
also choose to use their own competencies or those they obtain from third-party providers as well.

This provides customers the ability to choose from a wide range of competency options for their users.

f Note: Third party integration with competency library providers DDI and PDI, through Service Activation
Request with Taleo Support, is no longer supported as of Feature Pack 12B.

System administrators can import competencies using Taleo Connect Client (TCC) integration. They can also use the
Configuration module to configure individual competencies within the library to be displayed. On the Competency
Management page, the Provider column indicates whether the competency is provided by Taleo or the customer. When
customers import or configure their own content they have obtained from a partner, it is seen as coming from the
customer as the provider, not the partner.

In a system with multiple sources, when viewing the competencies for an employee in their talent profile, you can
mouse over the name of the competency to see the name of the provider and competency. If a description is included
with the competency, then an info bubble is available including the vendor name, competency name and description.
This provides a simple way for you to identify the source of the competency.
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Custom Competency Management

As of Feature Pack 13B, customers can now manage their custom competency library as a self service, either directly in
the SmartOrg Ul or through Taleo Connect Client (TCC) integration. Service requests are no longer necessary.

An active custom provider code (CUSTOMER_PROVIDER) is delivered, which allows your organization to create custom
competencies in SmartOrg (Navigation: Configuration > [Competencies] Competency Providers > [Competency
Provider Management]). It is active by default. Foundation Data Management permission is required for a user to
manage custom competencies in SmartOrg.

The competency library provides the ability to filter competencies by provider. On the Competency Management
page, in Refine By select Competency Provider, and choose the custom provider to display custom competencies only
(Navigation: Configuration > [Competencies] Competencies > [Competency Management]).

When Creating a new competency at least a code, a name, and a rating model must be provided.

Once the custom competency is created, the competency can be used the same as other Taleo standard competencies.
You can assign the following attributes:

- Contextual competency definitions
- Rating model

- Competency contexts

- Categories & Groups

- Sub competencies

- Network Locations (new!)

Competency Fields

All fields related to Competencies are presented in the following table. Each entry in the table includes a field or button,
a description, possible values (when they are predefined), the part of the application to which the field applies and the
field's header.

Field Description Applicable to Header

Actions Actions that you can currently Competencies
perform. For example, if a
competency has Draft status,
the Actions column typically has
an Activate icon you can click to
activate the competency.

Activate You click Activate when you Competencies
want to change an item's status
from Draft to Active. While a
competency, rating model, etc.
has Draft status, it can be edited
but it is unavailable to users. After
the status is changed from Draft
to Active, a competency, rating
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Field

Add

Alias

By

Cancel

Code

Competency Category

Competency Context

Competency Definition Context

Competency Group

Competency Type

Create

ORACLE

Description

model, etc. is available but the item

can no longer be edited or deleted.

You click Add to add an instance of

an item (for example, if you want
to add a competency context to a
competency).

You can assign an alias to a
competency. An alias enables you

to provide a term for a competency

that is better suited to your
organization's needs.

The person or group who initiated
the event.

If you don't want to save the
changes you've made on the
current page, click Cancel. The
system typically displays the
previous page.

A unique code associated with an
item.

Competency categories
associated with the competency. A

competency can be associated with

multiple categories. Categories
must have been created and
activated to be available for
selection. Categories provide

filtering options when searching for

competencies.

Uses SmartOrg elements to

limit who can view a specific
competency and add it to a talent
profile.

The context-specific definition is
only displayed to employees who
are part of the SmartOrg element
specified in this field.

Group to which the competency
is associated. Groups must have
been created and activated to be
available for selection. Groups
provide filtering options when
searching for competencies.

The competency types are:
Behavioral, Job-specific and
Language. This option is used to
override the default competency

type.

To create an instance of an item,
click Create.

Applicable to

Competencies

Competencies

Competencies

Competencies

Competencies

Competencies

Competencies

Competencies

Competencies

Competencies

Competencies

Chapter 4
Competency Administration

Header

Properties

Properties

Competency Categories

Competency Context

Definitions

Properties

Properties
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Field

Date and Time

Default Competency Type

Definitions

Delete

Description

Details

Edit

Event

Hide

History

Internal Code

Language

ORACLE

Description

The date and time that an event
occurred regarding a competency.
For example, the date and time
when a sub-competency was
added.

The default competency type
is a static value and serves as a
reference if the type is changed.

The definition that is displayed to
users who are part of a particular
SmartOrg element.

To remove an item, click Delete.
This action cannot typically be
undone afterward.

The competency description
that is displayed if no definitions
are configured in the Definitions
section.

Additional information about an
event that occurred regarding a
competency.

If you want to edit information
and the item (competency, rating
model, etc.) is in Draft status, you
can click Edit.

An action that was performed
regarding a competency. For
example, if you add a sub-
competency, the event is logged in
the History section.

If you don't want to view the
information in a particular section,
you click the corresponding Hide.

This section displays a listing

of all events that have occurred
regarding an item. For example,
the date and time when a
competency definition was added
to a competency. The History
section also indicates the name of
the event, a short description and
the name of the person or group
who initiated the event.

Alternate code assigned to the
competency.

Presents a pull-down menu from
which you can select one of the
activated languages to view the
page information in that specific
language.

Applicable to

Competencies

Competencies

Competencies

Competencies

Competencies

Competencies

Competencies

Competencies

Competencies

Competencies

Competencies

Competencies

Chapter 4
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Header

Properties

Definitions

Properties

Properties
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Field

More

Name

Organizations

Provider

Rating Model (Code and Name)

Refine by

Refresh

Save

Search

Select

Status

Sub-competencies

ORACLE

Description

To see additional information, click
More.

The name of the item (competency,
rating model, etc.).

The organization with which the
definition is associated.

The source of the competency.
By default Taleo's competency
library is included with each
implementation, but customers
may also use their own
competencies as well as those
obtained from third party
providers.

All competencies cannot be
measured using the same metrics.
Rating Model (Code and Name)
displays the name of the rating
model used to evaluate the
competency.

You can limit the items displayed in
a list to those that correspond to a
criterion.

If you change a value in a field that
has a Refresh icon next to it and
then click Refresh, information on
the page is updated to reflect the
change.

To save your changes, click Save.

If Search is next to a field, you can
click Search and the system will
display all of the choices available
for that field

After making selections in a list,
you click Select to confirm your
selections.

The status of the item
(competency, rating model, etc.). If
the competency has Draft status,

it can be edited. If it has Active
status, it has been activated for use
in the system and it can no longer
be edited.

The list of sub-competencies,
which are subsets or components
of the competency.

Applicable to

Competencies

Competencies

Competencies

Competencies

Competencies

Competencies

Competencies

Competencies

Competencies

Competencies

Competencies

Competencies

Chapter 4
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Header

Properties

Properties

Rating Models

Properties
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Working with Competency Groups

Competency Group

Competency groups provide the ability to classify competencies to ease filtering.

Competency groups provide an additional way of organizing competencies. Competencies groups can be defined by
clients and associated to competencies. Groups are used for filtering and display purposes. It is not mandatory to assign
a group to a competency and if no group is associated to a competency, the default Other Competencies group is used.

A competency can be associated to only one group.

Once created and activated, a competency group can be assigned to a competency. The competency group is selected
when defining or editing the properties of a competency.

Competency groups are also used in Talent Profile as there is setting that offers the choice of displaying competencies
by groups or types. When the display by group is selected, all competencies will show according to their associated
group, or under the Other Competencies section for those not associated to a specific group.

When searching for a competency, the competency selector offers a filter by group, to show only competencies of the
selected group, therefore reducing the number of results and facilitating selection.

Configuration

For the competency selector to offer filtering options by group, the groups must first be defined and activated by the
administrator via Configuration > [Competencies] Competency Groups . Once defined, a specific group can be set for
a given competency via Configuration > [Competencies] Competencies .

Location Description

Configuration > [Competencies] To define and edit available competency groups.
Competency Groups

Setting Description Location
Talent Profile Competency Grouping This setting provides the ability to determine Configuration > [Taleo Performance]
how competencies are to be presented in the Settings where Category = Global Settings

Talent Profile, that is either by type or by group

Creating a Competency Group

Creating a competency group provides the ability to define the properties of the groups that will be used to classify
competencies.

The user must have administration permissions and access to competency management.
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Configuration > [Competencies] Competency Groups
1. Inthe Competency Group Management page, click Create next to Competency Groups.
2. Inthe New Competency Group page, provide a unique code and name for the group and enter a description as
needed.

3. Click Save.

If more than one language has been configured, you will need to provide a name for all configured languages
and save each one individually.

The system creates a new competency group for the language currently in context, that is for the base language, and for
all other active languages.

For the newly created competency group to be available for selection when you want to assign a competency group to a
competency, you need to activate the competency group.

Associating a Group to a Competency
This task allows the user to associate a group to a specific competency in order to classify competencies.

The user must have administration permissions and access to competency management.

The competency must be in a draft or inactive status to be edited, and to assign a competency group.

Configuration > [Competencies] Competencies
1. In the Competency Management page, click the name of the competency to which you want to assign a
competency group.
2. Inthe Competency page, click Edit next to Properties.

If the Edit link is not available, this means that the competency is active and cannot be edited; to make a
change, you will first need to deactivate the competency.

In the Competency Editor page, click Search next to the Competency Group field.

Make your choice inn the Competency Selector page and click Select.

Click Save to register your change.

6. If the competency was previously active and you deactivated it, make sure to activate it again.

v AW

The selected competency group will be associated to the competency.

Deleting a Competency Group
Deleting a competency group removes the group from the list of competency groups.

The user must have administration permissions and access to competency management.

If the competency group is associated to a competency, whether active or inactive, deletion will not be permitted.

Configuration > [Competencies] Competency Groups
1. In the Competency Group Management page, locate the competency group to delete and click Delete under
Actions.
2. Confirm the deletion.
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If the competency group is not associated to any competency, the deletion will be executed. However, if the competency
group is associated to any competency in the system, a message informs you that the operation is not possible.

Competency Group Fields

The following table presents a list of all fields related to competency groups in Taleo Performance Administration. Each
entry in the table includes the field name, a description, possible values (when they are predefined), the part of the
application to which the field applies and the field's section header.

Ul Element Description Applicable to Header

Code Unique code assigned to the Competency Groups Properties
competency group.

Name Name of the competency group. Competency Groups Properties

Description Description of the competency Competency Groups Properties
group.

Status Status of the competency group, Competency Groups Properties

which can be Draft, Active or
Inactive. Only active competency
groups will be available as filters
when searching for competencies.

Working with Competency Categories

Competency Category
Competency categories provide an additional way of classifying competencies, therefore facilitating competency search.

Competency categories provide a new way of organizing competencies. The available categories are configurable and
defined by the client. When required, a competency can be associated with one or more categories. The classification of
competencies by categories is only used for searching and filtering purposes and is only available in Taleo Performance.

A competency can be associated to multiple categories.

When searching for a competency, the competency selector offers a filter by category, to show only competencies of the
selected category, therefore reducing the number of results and facilitating selection.

Configuration

For the competency selector to offer filtering options by category, the categories must first be defined and activated by
the administrator via Configuration > [Competencies] Competency Categories . Then, competencies can be added
to the desired categories.
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Location Description
Configuration > [Competencies] To define and edit available competency categories.

Competency Categories

Creating a Competency Category
Creating a competency category provides the ability to define the properties of categories to assigned competencies to.

The user must have administration permissions and access to competency management.

Configuration > [Competencies] Competency Categories
1. In the Competency Category Management page, click Create next to Competency Categories.
2. Inthe New Competency Category page, provide a unique code and name for the category and enter a
description as needed.
3. Click Save.

If more than one language has been configured, you will need to provide a name for all configured languages
and save each one individually.

4. Add the desired competencies to the category by clicking Add next to Competencies.
The system creates a new competency category for the language currently in context, that is for the base language, and
for all other active languages.

For the newly created competency category to be available for selection when you want to assign a competency
category to a competency, you need to activate the competency category.

Associating a Category to a Competency

This task allows the user to associate one or multiple categories to a specific competency in order to classify
competencies and then provide the ability to filter competencies by category when users are searching for a
competency.

The user must have administration permissions and access to competency management.

Configuration > [Competencies] Competency Categories
1. In the Competency Category Management page, click the name of the competency category to which you
want to add a or multiple competencies.
2. Inthe Competency Category page, click Add next to Competencies.
3. Inthe Competency Selector page, select the competencies you want to associate to the competency category.
4. C(Click Select.

The selected competencies will be associated to the competency category.

Associating a Competency to a Category

This task allows the user to associate one or multiple competencies to a competency category.
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The user must have administration permissions and access to competency management.

The competency must be in a draft or inactive status to be edited, and to assign a competency group.

Configuration > [Competencies] Competencies
1. In the Competency Management page, click the name of the competency to which you want to assign a
competency group.
2. Inthe Competency page, click Edit next to Properties.

If the Edit link is not available, this means that the competency is active and cannot be edited; to make a
change, you will first need to deactivate the competency.

In the Competency Editor page, click Search next to the Competency Group field.

Make your choice inn the Competency Selector page and click Select.

Click Save to register your change.

6. If the competency was previously active and you deactivated it, make sure to activate it again.

v AW

The selected competency group will be associated to the competency.

Deleting a Competency Category
Deleting a competency category removes the category from the list of competency categories.

The user must have administration permissions and access to competency management.

If the competency category is associated to a competency, whether active or inactive, deletion will not be permitted.

Configuration > [Competencies] Competency Categories
1. Inthe Competency Category Management page, locate the competency category to delete and click Delete
under Actions.

2. Confirm the deletion.

If the competency category is not associated to any competency, the deletion will be executed. However, if the
competency category is associated to any competency in the system, a message informs you that the operation is not
possible.

Competency Category Fields

The following table presents a list of all fields related to competency categories in Taleo Performance Administration.
Each entry in the table includes the field name, a description, possible values (when they are predefined), the part of the
application to which the field applies and the field's section header.

Ul Element Description Applicable to Header

Code Unique code assigned to the Competency Categories Properties
competency category.

Name Name of the competency category. Competency Categories Properties
Description Description of the competency Competency Categories Properties
category.
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Ul Element Description Applicable to Header
Status Status of the competency category, Competency Categories Properties

which can be Draft, Active or
Inactive. Only active competency
categories will be available as filters
when searching for competencies.

Working with Sub-Competencies

Sub-Competency

A sub-competency is a specific facet of a competency.

If an organization considers a particular competency to be composed of constituent elements, the latter are called sub-
competencies in Taleo Performance.

For example, an organization might decide that written communication, verbal communication and non-verbal
communication are sub-competencies of the behavioral competency “communication”.

Adding a Sub-Competency to a Competency

A sub-competency, a subset of a competency, improves the manager's understanding of a competency by providing
more context. The following steps show how to create a sub-competency and add it to a competency.

A sub-competency can only be added if the competency has “Draft” status. If you have activated the concept, sub-
competencies can no longer be added, edited or deleted.

Configuration > [Competencies] Competencies

1.

2.
3.
4.

5.

6.

In the Competency Management page, navigate to the competency you want to edit and then click its name.
(Alternatively, use the Refine by list to locate the competency more quickly.)

Click Edit next Sub-competencies.

In the Competency Editor page, click Create.

Enter the name you want to assign to the sub-competency in the Sub-competency Name field and then click
OK.

Create the other sub-competencies in a similar manner and then click the arrow keys to reorder sub-
competencies if necessary.

Click Save.

The sub-competencies are displayed on the Competency Editor page in the Sub-competencies section.

You can edit the sub-competency or you can activate the competency if you are sure that all the information is correct
and complete.
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Editing a Sub-Competency
The following steps show how to edit a sub-competency.

Configuration > [Competencies] Competencies

1. In the Competency Management page, navigate to the competency you want to edit and then click its name.
(Alternatively, use the Refine by list to locate the competency more quickly.)

2. If the status of the competency is “Draft” or “Inactive”, proceed immediately to the next step. If you have
already activated the competency (its status is “Active”), click Deactivate next to the name of the competency or
the language list.

Click Edit next to Sub-competencies.
4. Inthe Competency Editor page, you can perform four types of edits.

o You can click Create, enter the name of a new sub-competency in the Sub-competency Name field, and
then click OK.

o You can click a sub-competency, click Edit and then enter a new name in the Sub-competency Name
field, and then click OK.

o You can click a sub-competency and then click Delete to delete it.

W

o You can click a sub-competency and then click the arrow keys to change the sub-competency's position
relative to the others.

5. Click Save.

6. If you deactivated the competency earlier and have no other changes to make, click Activate to make the
competency available to employees for selection. If the current status is “Inactive” and you want to make other
changes, for example, modify the competency contexts, make all the changes before clicking Activate.

On the Competency Editor page, your changes are displayed in the Sub-competencies section.

You can activate the competency if you want to make it available to your users.

Deleting a Sub-Competency

A sub-competency can only be deleted if the competency has “Draft” status. If you have activated the competency, sub-
competencies can no longer be created, edited or deleted.

Configuration > [Competencies] Competencies

1. In the Competency Management page, navigate to the competency you want to edit and then click its name.
(Alternatively, use the Refine by list to locate the competency more quickly.)

2. Click Edit next to Sub-competencies.
3. Inthe Competency Editor page, you can click a sub-competency and then click Delete to delete it.
4. C(lick Save.

On the Competency Editor page, the sub-competency is no longer displayed in the Sub-competencies section.
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Sub-Competency Fields

Chapter 4

Competency Administrat

All fields related to sub-competencies are presented in the following table. Each entry in the table includes a field or
button, a description, possible values (when they are predefined), the part of the application to which the field applies

and the field's header.

Field

Cancel

Create

Delete

Edit

Language

Move the selected item down

Move the selected item up

Refresh

Save

ORACLE

Description

If you don't want to save the
changes you've made on the
current page, click Cancel. The
system typically displays the
previous page.

To create an instance of an item,
click Create.

To remove an item, click Delete.
This action cannot typically be
undone afterward.

If you want to edit information and
the competency is in Draft status,
you can click Edit.

Presents a pull-down menu from
which you can select one of the
activated languages to view the
page information in that specific
language.

If a list of items has two green
icons in the form of arrowheads
next to it, you can click an item in
the list and then click the lower
arrowhead to move the item to a
lower position in the list.

If a list of items has two green
icons in the form of arrowheads
next to it, you can click an item in
the list and then click the upper
arrowhead to move the item to a
higher position in the list.

If you change a value in a field that
has a Refresh icon next to it and
then click Refresh, information on
the page is updated to reflect the
change.

To save your changes, click Save.

Applicable to Header

Competency Editor page

Competency Editor page

Competency Editor page

Competency Editor page

Competency Editor page

Competency Editor page

Competency Editor page

Rating Model Management page
Rating Models page

Rating Model Editor page

Rating Dimension Editor page

Competency Editor page

ion

10



Talent Acquisition Cloud Chapter 4
Implementing Performance Competency Administration

Working with Competency Definition Contexts

Competency Definition Context

A competency definition context is used to display different competency definitions depending on the specified context.

Each competency has one default description. However, an organization can create multiple definitions for a
competency, associating each one with specific parts of the organization, specific locations and/or specific job fields.
When the competency is later displayed to an employee, the competency definition that is displayed varies according to
the employee's organization, location and job field.

If you specify multiple elements from the same category (Organization, Location or Job Field), these elements are
connected by the OR operator and are therefore inclusive. If you add elements from different categories, for example,
an organization and a location, these elements are connected by the AND operator and are exclusive. For example,

if you specified the Finance and Marketing sections of your organization and Portugal and Brazil locations, and then
applied the competency definition context to a competency definition, only employees who worked for the Finance OR
Marketing sections AND worked in Portugal OR Brazil would see the definition.

Competency Definition Contextualization

The contextualization of competency definitions to be included in performance reviews are based on the organization,
location or job field of the employee being evaluated.

This functionality allows system administrators to apply specific competency definitions to specific organizations,
locations and/or job fields so that the corresponding competencies be applied to the corresponding employees. For
example, the description of a competency might be different based on department - the Leadership competency can be
described differently in Sales than in Support.

First, the competency definition context needs to be created and defined via Configuration > [Competencies]
Competency Contexts . Then the competency definition must be created and associated to the desired context via
Configuration > [Competencies] Competencies Configuration > [Competencies] Competencies.

Competency Context

A competency context is used to limit who can view a specific competency, depending on the specified organization,
location or job field, or any combination thereof.

A competency context provides the ability to define a specific context in which a competency is available so that only
employees who work for those specified organizations, locations and/or job fields are able to view.

f Note: Although the creation and management of competency contexts is possible, there is no impact for now
on the display of competencies in the Talent Profile. Competency contexts were created for future use.
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Creating a Competency Definition Context

Creating a competency definition context makes the context available for selection when you are creating separate
competency definitions for specific sectors of the organization, specific locations and/or specific job roles.

The product setting “Enable Competency Context Management” must be set to Yes.
Configuration > [Competencies] Competency Definition Contexts

1. In the Definition Context Management page, click Create.

2. Inthe New Definition Context page, select the language in which you want to create the competency definition

context elements. (You will later have to create competency definition context elements for each of the other

languages that appear in the language list.).

Enter the code and name you want to assign to the competency definition context and then click Finish.

4. Inthe Definition Context page, specify the organizations, locations and/or job fields corresponding to the
definition context by clicking Add next to the appropriate section header.

w

The competency definition context you created and its corresponding organizations, locations and job fields are
displayed in the Definition Contexts list on the Definition Context Management page. The competency definition
context cannot be added to a competency definition, however, until you have activated the definition context.

You can activate the competency definition context if you are certain that all the information is complete and correct
and you want to make the context available for selection in competencies.

Editing a Competency Definition Context

The following steps show how to edit a competency definition context.

Configuration > [Competencies] Competency Definition Contexts

1. In the Definition Context Management page, locate the competency definition context you want to edit in the
Definition Contexts list and then click its name. (Alternatively, use the Refine by list to locate the competency
definition context more quickly.)

2. If the status of the competency is “Draft” or “Inactive”, proceed immediately to the next step. If you have
already activated the competency (its status is “Active”), click Deactivate next to the name of the competency or
the language list.

3. Edit the competency definition context (following certain edits, the system might request you to save your
changes).

4. If you deactivated the competency earlier and have no other changes to make, click Activate to make the
competency available to employees for selection. If the current status is “Inactive” and you want to make other
changes, for example, modify the competency contexts, make all the changes before clicking Activate.

If you display the Definition Context Management page, your changes are displayed.

You can activate the competency definition context if you want to make it available for selection in competencies.
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Activating a Competency Definition Context

Activating a competency definition context allows you to apply it to competency definitions. (When a competency
definition context is first created, it has “Draft” status and cannot be used until its status is changed to “Active”.)

After you activate a competency definition context it cannot be edited or deleted. It is essential, therefore, that you
ensure all the information is complete and correct before you activate a competency definition context.

Configuration > [Competencies] Competency Definition Contexts

1. On the Definition Context Management page, locate the competency definition context you want to activate in
the Definition Contexts list and then click the corresponding Activate in the Actions column. (Alternatively, use
the Refine by list to locate the competency definition context more quickly.)

On the Definition Context Management page, Competency Definition Contexts list, Actions column, the status of the
competency context is “Active”. If you later edit a competency (whose status is “Draft”), and create a context-specific
definition, when you click Search next to the Competency Definition Context field, the definition context you activated is
displayed in the list of available contexts and can be selected.

You can edit the competency's properties and description or add a context-specific definition to the competency.

Duplicating a Competency Definition Context

Duplicating a competency definition context allows you to quickly create a new competency definition context based on
an existing one.

Ideally, you have an existing competency definition context that resembles in most respects the competency definition
context you want to create.

Configuration > [Competencies] Competency Definition Contexts

1. In the Definition Context Management page, locate the competency definition context you want to duplicate in
the Definition Contexts list and then click the corresponding Duplicate in the Actions column. (Alternatively, use
the Refine by list to locate the competency definition context more quickly.)

The status of the existing competency definition context can be “Active” or “Draft”.

2. You can edit the new competency definition context's properties (be sure to assign a unique name for the new
competency definition context), organizations, locations and job fields. Click Save where indicated to save your
changes.

If you return to the Definition Context Management page, the new competency definition context is displayed in
the Definition Contexts list. If you are certain that all the information is complete and correct, you can activate the
competency context definition.

Deleting a Competency Definition Context

A competency definition context can only be deleted if it has “Draft” status. If you have activated the competency
definition context, it can no longer be edited or deleted.
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Configuration > [Competencies] Competency Definition Contexts

1. In the Definition Context Management page, locate the competency definition context you want to delete in the
Definition Contexts list and then click the corresponding Delete in the Actions column. (Alternatively, use the
Refine by list to locate the competency definition context more quickly.)

2. Click Yes to confirm you want to delete the competency definition context.

The competency definition context is no longer displayed in the Definition Contexts list.

Competency Definition Context Fields

All fields related to competency definition contexts are presented in the following table. Each entry in the table includes
a field or button, a description, possible values (when they are predefined), the part of the application to which the field

applies and the field's header.

Field

Actions

Activate

Add

By

Cancel

Category
City

Company

Country

ORACLE

Description

Actions that you can currently
perform. For example, if a
competency has Draft status,
the Actions column typically has
an Activate icon you can click to
activate the competency.

You click Activate when you

want to change an item's status
from Draft to Active. While a
competency, rating model, etc.

has Draft status, it can be edited
but it is unavailable to users. After
the status is changed from Draft
to Active, a competency, rating
model, etc. is available but the item
can no longer be edited or deleted.

Add an item.

The person or group who initiated
the event.

If you don't want to save the
changes you've made on the
current page, click Cancel. The
system typically displays the
previous page.

Broadest unit within a job field.
A city.

The broadest unit in the
organization

A territorial division that has
independent status and contains
a body of people of one or more
nationalities.

Applicable to Header

Definition Context Management
page

Definition Context page

Definition Context page

Definition Context page

Job Field Selector page
Location Selector page

Organization Selector page

Location Selector page
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Field

Create

Date and Time

Delete

Department

Details

Division

Duplicate

Edit

Event

Finish

Function

Hide

History

ORACLE

Description

To create an instance of an item,
click Create.

The date and time that an event
occurred regarding a competency.
For example, the date and time
when a sub-competency was
added.

To remove an item, click Delete.
This actions cannot typically be
undone afterward.

The broadest unit in the
organization under Company.

Additional information regarding
an event that occurred involving a
competency.

The broadest unit in the
organization under Department.

To create a new item, it is often
quicker to duplicate an existing
item and then edit the duplicate. To
duplicate an item, click Duplicate
and then make your changes.

If you want to edit information
and the item (competency, rating
model, etc.) is in Draft status, you
can click Edit.

An action that was performed
regarding a competency. For
example, if you add a sub-
competency, the event is logged in
the History section.

When you have completed all the
steps related to a task and do not
need to make any more changes,
click Finish to complete the task.

Broadest unit in a job field under
Category.

If you don't want to view the
information in a particular section,
you click the corresponding Hide.

This section displays a listing

of all events that have occurred
regarding an item. For example,
the date and time when a
competency definition was added
to a competency. The History
section also indicates the name of
the event, a short description and
the name of the person or group
who initiated the event.

Chapter 4
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Applicable to Header

Definition Context Management
page

Definition Context page

Definition Context page

Organization Selector page

Definition Context page

Organization Selector page

Definition Context page

Definition Context page

Definition Context page

New Definition Context page

Job Field Selector page

Definition Context page

Definition Context page
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Field

Job Fields

Language

Locations

More

Name

Organizations

Refine by

Refresh

Remove

Remove All

Save

ORACLE

Description

Only employees who belong to
these job fields can view and add
the competency to a talent profile.

Presents a pull-down menu from
which you can select one of the
activated languages to view the
page information in that specific
language.

Only employees who are part of
these locations can view and add
the competency to a talent profile.

To see additional information, click

More.

The name of the item (competency,
rating model, competency context,

etc.).

Only employees who are part of
these organizations can view and
add the competency to a talent
profile.

You can limit the items displayed in

a list to those that correspond to a
criterion.

If you change a value in a field that
has a Refresh icon next to it and
then click Refresh, information on
the page is updated to reflect the
change.

Removes a specific entry from a
list.

Removes all entries from a list.

To save your changes, click Save.

Applicable to

Definition Context Management
page
New Definition Context page

Definition Context page

Definition Context Management
page

Definition Context page
Definition Context Management
page

New Definition Context

Definition Context page

Definition Context Management
page

Definition Context Management
page

Organization Selector page
Location Selector page

Job Field Selector page
Definition Context Management
page

New Definition Context page
Definition Context page
Organization Selector page
Location Selector page

Job Field Selector page

Definition Context page

Definition Context page

Definition Context page

Chapter 4
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Header
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Field Description Applicable to Header
Select After making selections in a list, Organization Selector page
you click Select to confirm your
selections. Location Selector page

Job Field Selector page

Specialty Broadest unit in a job field under Job Field Selector page
Function.

State/Province One of the constituent units Location Selector page
of a nation having a federal
government.

Status The status of the item Definition Context Management
(competency, rating model, page

competency context, etc.). If the
competency has Draft status, it can  New Definition Context page
be edited. If it has Active status,

it has been activated for use in Definition Context page
the system and it can no longer be
edited.

World Region Largest geographic area, typically = Location Selector page

containing a continent.

Working with Rating Models

Rating Model

A rating model is used to define the scale upon which a given competency, goal or performance review item is assessed.
The rating model provides the ability to define a numerical value and a text description for each value on a rating scale.

When assessing an employee's or candidate's performance of a competency or goal, an accurate picture results when
you can rate the individual's performance of each dimension. A rating model is made of five different dimensions and
their corresponding rating values. Of the five dimensions, four are active by default (Experience, Proficiency, Last Use
and Interest) and one is editable (Performance Rating). A rating model can be applied to multiple competencies or goals.

?’ Note: The four default dimensions cannot be used with performance reviews.

There are three default types of rating models:
- Taleo Behavioral Rating Model, assigned by default to behavioral competencies
- Taleo Language Rating Model, assigned by default to language skills

- Taleo Technical Rating Model, assigned by default to job specific competencies

17
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The rating model's dimension values must be set and ordered in an ascending order, that is the lowest rating first, with
the lowest numeric value, and the highest rating last, with the highest value. Rating models containing descending
rating values are not supported in performance review overall rating calculations.

Any rating model and their respective rating values cannot be edited or deleted after they have been activated.

The display of each rating model dimension in the Talent Profile is determined by the Talent Profile Competency
Configuration settings.

Creating a Rating Model
Creating a rating model provides the ability to associate this rating model to competencies or performance reviews.

Configuration > [Competencies]

1. On the Rating Model Management page, click Create.
In the language list, select the language in which you want to create the rating model elements. (You will later
have to create rating model elements for each of the other languages that appear in the language list.)

3. Specify a code and name, as well as a description if so desired.

Click Save.

5. Inthe Rating Model page, it is possible to edit the properties of the current rating model, change the order of
the dimensions and to manage the Performance Rating dimension.

6. To create the rating values for the Performance Rating dimensions:

a. Inthe Rating Model page, click the name of the Performance Rating dimension.

b. Inthe Rating Dimension page, click Edit next to Properties if you need to edit the properties of the
dimension.

c. To create the rating values for that dimension, click Create next to Rating Values.

d. Inthe New Rating Value page, enter the name and numeric value you want to assign to the rating value
(e.g. Novice; 1) and then click Save. The rating value name and value are displayed in the Rating Values
section.

e. Once all rating values are created, click Reorder next to Rating Values and make sure to order the rating
values by ascending order, that is the lowest rating at the top, with the lowest numeric value, and the
highest rating at the bottom, with the highest value. Note that although the system lets you create rating
models with descending rating values, these are not supported in performance review overall rating
calculations.

f. Once all the rating values created and ordered as desired, you can activate the rating dimension by
clicking Activate. This action activates only the dimension, not the rating model

7. Back on the Rating Model page, you can change the display order of the dimensions by clicking Reorder next to
Dimensions.

>

The rating model appears in the list on the Rating Models Management page but it cannot be used until it has been
activated.

You can activate the rating model if you want to make it available for selection in competencies.

Editing a Rating Model

The following steps show how to edit a rating model.

18
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You can only edit a rating model whose status is still “Draft”.

Configuration > [Competencies]

1. In the Rating Model Management page, locate the rating model you want to edit in the Rating Models list and
then click its name. (Alternatively, use the Refine by list to locate the rating model more quickly.)

The status of the existing rating model must be “Draft”.

2. Edit the rating model (following certain edits, the system might request you to save your changes).

If you display the Rating Model Management page, your changes are displayed.

You can activate the rating model if you want to make it available for selection in competencies.

Duplicating a Rating Model
Duplicating a rating model allows you to quickly create a new rating model based on an existing one.

Ideally, you have an existing rating model that resembles in most respects the rating model you want to create.
Configuration > [Competencies]

1. In the Rating Model Management page, locate the rating model you want to duplicate in the Rating Models list
and then click the corresponding Duplicate in the Actions column. (Alternatively, use the Refine by list to locate
the rating model more quickly.)

The status of the existing rating model can be Active or Draft.

2. You can edit the rating model's name and the Performance Rating dimension to assign the values you want the
new model to have.

If you display the Rating Model Management page, the new rating model is displayed in the Rating Models list.

If you are sure that all the information is complete and correct, you can activate the rating model.

Activating a Rating Model

Activating a rating model allows you to add it to competencies. (When a rating model is first created, it has Draft status
and cannot be added to competencies until its status is changed to Active.)

Once you activate a rating model it cannot be edited or deleted. It is essential, therefore, that you ensure all the
information is complete and correct before you activate a rating model.

Configuration > [Competencies]

1. In the Rating Model Management page, locate the rating model you want to activate in the Rating Models list
and then click the corresponding Activate in the Actions column. (Alternatively, use the Refine by list to locate
the rating model more quickly.)

The rating model can be used as the default rating model for a competency or it can be used in a performance review.

Though not a requirement, you can add the rating model to a competency.
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Adding a Rating Model to a Competency
Adding a rating model to a competency (the competency's status must be “Draft”) replaces the default rating model.

You have to create and activate a rating model before you can add it to a competency.
You can change the rating model associated with a competency provided the competency's status is Draft.
Configuration > [Competencies] Competencies

1. Inthe Competency Management page, locate the competency you want to edit and then click its name.
(Alternatively, use the Refine by list to locate the competency more quickly.)

2. Click Edit in the Rating Model section.

3. Click Search next to the Rating Model field, click the radio button next to the rating model you want to assign to
the competency and then click Select.

4. Click Save.

The rating model you selected is displayed on the Competency Editor page in the Rating Model section.

Though not a requirement, you can edit a sub-competency.

Deleting a Rating Model
If you want to delete a rating model and its status is “Draft”, follow the instructions in this section.

A rating model can only be deleted if it has Draft status. If you have activated the rating model, it can no longer be
edited or deleted.

Configuration > [Competencies]

1. When the Rating Model Management page is displayed, locate the model you want to delete in the list and then
click the corresponding Delete in the Actions column. (Alternatively, use the Refine by list to locate the rating
model more quickly.)

2. Click Yes to confirm you want to delete the rating model.

The rating model no longer appears in the list on the Rating Models Management page.

Rating Model Fields

All fields related to Rating Models are presented in the following table. Each entry in the table includes the field name,
a description, possible values (when they are predefined), the part of the application to which the field applies and the
field's header.

Field Description Applicable to Header
Code Code of the rating model, whichis = Rating Model Properties
mandatory.
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Field

Code

Date and Time

Description

Description

Details

Dimension Type

Event

Language

More

Name

Name

Name

Numeric Value

Status

ORACLE

Description

Code of the rating model
dimension, which is editable
only for the Performance Rating
dimension.

The date and time that an event
occurred regarding a competency.
For example, the date and time
when a sub-competency was
added.

Description of the rating model.

Description of the rating model
dimension, which is editable
only for the Performance Rating
dimension.

Additional information regarding
an event that occurred regarding a
competency.

There are five types of dimensions:
Proficiency,Experience, Last Used,
Interest and PerformanceRating.
Only the Performance Rating
dimension is editable; all other
dimensions are created and
activated by default.

An action that was performed
regarding a competency. For
example, if you add a sub-
competency, the event is logged in
the History section.

Presents a pull-down menu from
which you can select one of the
activated languages to view the
page information in that specific
language.

To see additional information, click
More.

Name of the rating model, which is
mandatory.

Name of the rating model
dimension, which is editable
only for the Performance Rating
dimension.

Name of the rating value.

Numeric value to be associated to
the rating value. This value will be
used to calculate the performance
review's overall rating.

Status of the rating model, which
can be Draft, Active or Inactive. The

Applicable to

Rating Dimension

Rating Model

Rating Model

Rating Dimension

Rating Model

Rating Dimension

Rating Model

Rating Model

Rating Model

Rating Model

Rating Dimension

Rating Dimension

Rating Dimension

Rating Model

Chapter 4
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Header

Properties

History

Properties

Properties

History

Properties

History

History

Properties

Properties

Rating Values

Rating Values

Properties
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Field Description Applicable to Header

Draft status only occurs at creation
time. Once the rating model has
been activated once, its status will
either be Active or Inactive. It can
never go back to a Draft status.

Status Status of the rating model Rating Dimension Properties
dimension, which is always Active
for the Proficiency, Experience,
Last Used and Interest dimensions.
For the Performance Rating
dimension, the status can be Draft,
Active or Inactive. The Draft status
only occurs at creation time. Once
the Performance Rating dimension
has been activated once, its status
will either be Active or Inactive. It
can never go back to a Draft status.

Working with Guidance Plans

Guidance Plan

Customers create and manage guidance plans using the Configuration module.

A guidance plan is additional text that assists managers in understanding a competency. It is composed of two types of
content: BARS content and writing assistant content. Both sets of content are tied to the rating model associated with
the competency.

- BARS (Behaviorally Anchored Rating Scales) content provides a manager with examples of behaviors for a
given competency.

- Writing assistant content provides sample content that a manager can use when assessing a competency.

A guidance plan enables the organization to add additional descriptions to each value in a Taleo Performance rating
model. Managers later see these descriptions when rating a competency that uses the rating model. A manager can

use one of the predefined comments when writing comments for a competency that includes the rating model on a
performance review. The comments in a guidance plan are only suggestions; a manager is free to select a comment and
then edit it or to enter an original comment.

f Note: Third party integration of guidance plans through Service Activation Request with Support is not
available as of Feature Pack 12B. There is no Taleo Connect Client support for importing guidance plans.

Creating a Guidance Plan - Properties

Creating a guidance plan provides BARS content and writing assistant content that assist the manager in understanding
a competency in general and specifically its associated rating model. BARS content provides a manager with examples
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of behaviors for a given competency. Writing assistant content provides sample content that a manager can use when
assessing a competency.

While creating a guidance plan, you have to provide the name of the competency with which the plan will be associated.
For this reason, you typically edit and activate a competency before creating the corresponding guidance plan.

Configuration > [Competencies] Guidance Plans

1. In the Guidance Plan Management page, click Create.

2. (lick the language list and click a language in which you want to create guidance plan elements. (You will later
have to create guidance plan elements for each of the other languages that appear in the language list.)

3. Enter the name and description you want to assign to the guidance plan in the corresponding fields.

4. C(lick Search next to the Competency field, click the radio button next to the competency to which you want to
add the guidance plan and then click Select.

5. Click Search next to the Rating Dimension field. Click the radio button that corresponds to the dimension and
rating model (the one that will be used in the performance review or the one associated with the competency)
and then click Select. Click Next.

The system displays the Behavioral Anchor Ratings and Writing Suggestions section.

Populating a Guidance Plan - BAR Ratings and Writing
Suggestions

Populating a guidance plan with BAR ratings and writing suggestions allows you to provide a text description for each
element in the behavioral anchor rating (BAR) set associated with a specific competency and dimension, and to provide
examples of comments that a manager can select and edit when making a BAR selection.

Creating a guidance plan - properties
Configuration > [Competencies] Guidance Plans

1. In the Guidance Plans page, in the Behaviorally Anchored Rating Scales and Writing Suggestion section, you
can replace the default BAR descriptions with ones better suited to the needs of your organization. Click Edit in
the left column next to a BAR description you want to replace, enter a new description in the Description field
and then click Save. Replace other BAR descriptions in a similar manner if desired.

2. Inthe same page and in the same section, you can replace the default writing suggestions with ones better
suited to the needs of your organization. In the column at the right, click Edit next to a writing suggestion
you want to replace, enter a new suggestion in the Description field and then click Save. Replace other writing
suggestions in a similar manner if desired.

3. Click Next and then click Finish.

On the Guidance Plan Management page, the Guidance Plan list displays the new guidance plan. The plan's status is
“Draft”; your changes will not be displayed in the competency's rating dimension until you have activated the guidance
plan.

You can activate the guidance plan if you are sure that all the information is complete and correct.

Editing a Guidance Plan

The following steps show how to edit a guidance plan.
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You can only edit a guidance plan whose status is still “Draft”.

Configuration > [Competencies] Guidance Plans

1. In the Guidance Plan Management page, locate the guidance plan you want to edit in the Guidance Plans list
and then click its name. (Alternatively, use the Refine by list to locate the guidance plan more quickly.)

2. Edit the guidance plan (following certain edits, the system might request you to save your changes.

If you return to the Guidance Plan Management page, your changes are displayed.

You can activate the guidance plan if you want to make it available for selection.

Duplicating a Guidance Plan
Duplicating a guidance plan allows you to quickly create a new guidance plan based on an existing one.

Ideally, you have an existing guidance plan that resembles in most respects the guidance plan you want to create.
Configuration > [Competencies] Guidance Plans

1. In the Guidance Plan Management page, locate the guidance plan you want to duplicate in the Guidance Plans
list and then click the corresponding Duplicate in the Actions column. (Alternatively, use the Refine by list to
locate the guidance plan more quickly.)

The status of the existing guidance plan can be Active or Draft.

2. You can edit the new guidance plan's properties (be sure to assign a unique name for the new guidance plan),
behaviorally anchored rating scales and writing suggestion. Click Save where indicated to save your changes.

If you return to the Guidance Plan Management page, the new guidance plan is displayed in the Guidance Plans list.

If you are certain that all the information is complete and correct, you can activate the guidance plan.

Activating a Guidance Plan

Activating a guidance plan allows you to add it to competency rating dimensions. (When a guidance plan is first created,
it has Draft status and cannot be added to competency rating dimensions until its status is changed to Active.)

After you activate a guidance plan it cannot be edited or deleted. It is essential, therefore, that you ensure all the
information is complete and correct before you activate a guidance plan.

Configuration > [Competencies] Guidance Plans

1. In the Guidance Plan Management page, locate in the Guidance Plans list the guidance plan you want to
display in a competency's rating dimension and then click the corresponding Activate in the Actions column.
(Alternatively, use the Refine by list to locate the guidance plan more quickly.)

The guidance plan will be employed whenever the competency and dimension are included in a performance review.
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Deleting a Guidance Plan

A guidance plan can only be deleted if it has “Draft” status. If you have activated the guidance plan, it can no longer be
edited or deleted.

Configuration > [Competencies] Guidance Plans

1. In the Guidance Plan Management page, locate the guidance plan you want to delete in the list and click the
corresponding Delete in the Actions column. (Alternatively, use the Refine by list to locate the guidance plan
more quickly.)

2. Click Yes to confirm you want to delete the guidance plan.

The guidance plan no longer appears in the list on the Guidance Plan Management page.

Guidance Plan Fields

All fields related to Guidance Plans are presented in the following table. Each entry in the table includes a field or button,
a description, possible values (when they are predefined), the part of the application to which the field applies and the
field's header.

Field Description Applicable to Header

BAR for (rating value) Rating suggestion for each value Guidance Plan Behaviorally Anchored Rating
of the selected rating model Scales and Writing Suggestions
dimension.

By Person or group who initiated the = Guidance Plan History
event.

Code Code of the guidance plan, which is' Guidance Plan Properties
mandatory.

Competency Competency for which the Guidance Plan Properties

specified rating and comment
suggestions are to be displayed.

Date and Time Date and time that an event Guidance Plan History
occurred regarding a competency.
For example, the date and time
when a sub-competency was

added.
Description Description of the guidance plan. Guidance Plan Properties
Details Additional information regarding Guidance Plan History
an event that occurred involving a
competency.
Event Action that was performed Guidance Plan History

regarding a competency. For
example, if you add a sub-
competency, the event is logged in
the History section.
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Field

Name

Rating Dimension

Status

Suggestion for (rating value)

ORACLE

Description Applicable to

Name of the guidance plan, which = Guidance Plan
is mandatory.

Specific rating model dimension Guidance Plan
for which the specified rating and

comment suggestions are to be

displayed.

Status of the guidance plan, which = Guidance Plan
can be Draft, Active or Inactive. The

Draft status only occurs at creation

time. Once the guidance plan has

been activated once, its status will

either be Active or Inactive. It can

never go back to a Draft status.

Comment suggestion for each Guidance Plan
value of the selected rating model
dimension.
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Header

Properties

Properties

Properties

Behaviorally Anchored Rating
Scales and Writing Suggestions
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5 Job Role Administration

Working with Job Roles

Job Role

Ajob role is an entity in the system for classifying a certain job. It can be linked to a generic job type.

It is important to understand the relationship between the following concepts: job role, job position, job role context and
job profile classification. A job role can be considered to be a “generic” job that includes job properties, requirements
(certifications and competencies), a job description, qualifications and responsibilities. An example of a job role is
executive secretary. A job position, on the other hand, is a specific instance of a job role. When a position is created
based on a job role, the position includes the job role's description and requirements. A job role context offers the

ability to provide different job descriptions for specific organizations, locations, job fields or job levels (SmartOrg
elements). This means that a distinct job description will be displayed to users who belong to a specific organization,
location, job field or job level. In other words, job role contexts provide the opportunity to contextualize a job role and
consequently a position according to users' SmartOrg information. Similarly, job profile classification provides the ability
to contextualize the certifications and competencies associated with a job position. When creating a job position, the HR
administrator can click “Apply preselected profile requirement”, which will add the competencies (and respective values)
and certifications to the job position.

A job role must be activated to be available for use with job position creation.

Viewing a Job Role
Job roles can be viewed at any time.

Configuration > [SmartOrg] Administration > [Job Roles] Job Roles

1. In the Job Role Management page, click the name of the job role you want to view.
2. If the information that you want to view is not displayed, click the corresponding Show.

Depending on a job role's status, you can edit, duplicate, activate, deactivate or delete the job role while it is in view
mode.

Creating a Job Role
Creating a job role allows you to create an entity in the system for classifying a certain job.

Configuration > [SmartOrg] Administration > [Job Roles] Job Roles

1. In the Job Role Management page, click Create.

2. Inthe Job Role Wizard page, complete all mandatory fields, enter information in optional fields if desired and
then click Next.
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3.

4.

5.

In the following page of the wizard, Job Description section, enter a description, qualifications and
responsibilities in the corresponding fields if desired and then click Next.

If you are satisfied with the job role properties and job description as they appear in the summary, click Finish
to save the job role.

The system displays the details of the new job role on a new page. To add a certification or competency, in the
Requirements section, click the corresponding Add, complete the fields on the Certification Editor page or the
Competency Editor page and then click Save. You can add multiple certifications and competencies.

The information you entered is displayed on the Job Role page. If you click the Job Role Management breadcrumb at
the top of the page to return to the Job Role Management page, the job role is displayed in the list.

The job role must be activated before it is available for selection.

Editing a Job Role

Configuration > [SmartOrg] Administration > [Job Roles] Job Roles

1.
2.

3.

In the Job Role Management page, click the name of the job role you want to edit.
Click the link (Edit, Add, Delete) that corresponds to the section you want to edit and the type of change you
want to perform.

If the information you want to edit is hidden from view, click the corresponding Show.

If the system displays an “Editor” page, make your changes on that page and then click Save.

On the Job Role page, your changes are displayed.

Duplicating a Job Role

Duplicating a job role allows you to quickly create a new role based on an existing one.

Ideally, you have an existing job role that resembles in most respects the job role you want to create.

Configuration > [SmartOrg] Administration > [Job Roles] Job Roles

1.

2.

In the Job Role Management page, locate the job role to be duplicated and click the corresponding Duplicate in
the Actions column.
In the Job Role Wizard page, complete all mandatory fields, enter information in optional fields if desired and
then click Next.
In the following page, enter a description, qualifications and responsibilities in the corresponding fields if
desired and then click Next.
If you are satisfied with the summary, click Finish to save the job role.
A new page is displayed that includes the details of the new job role. In the Requirements section, you can
perform any or all of the following steps.
o To edit a certification or competency displayed, click the corresponding Edit, edit the fields and then click
Save.
o To add a certification or competency, click the corresponding Add, complete the fields and then click
Save.
o To delete a certification or competency, click the corresponding Delete in the Actions column.

If you want to add to the job role a definition that will only be available for selection by employees who are part
of particular parts of the organization, work in specific locations or have specific job fields, or combinations
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thereof, click Add next to Definitions. Enter a description, qualifications and responsibilities if desired, click
Search and select a job role context based on Foundation Data in SmartOrg, and then click Select and Save.

In the Job Role page, your changes are displayed. If you click the Job Role Management breadcrumb at the top of the
page, the new job role is displayed in the Job Roles list on the Job Role Management page.

The job role is not available for selection until you change its status to Active.

Activating a Job Role

Activating a job role allows you to change its status from Draft or Inactive to Active and thereby make the job role
available for selection.

To activate a job role, its current status must be Draft or Inactive. Also, the Name field must be translated into all active
content languages.

Configuration > [SmartOrg] Administration > [Job Roles] Job Roles

1. Inthe Job Role Management page, locate the job role you want to activate and click the corresponding Activate
in the Actions column.

The status of the selected job role is Active and the job role is available for selection.

Deactivating a Job Role

Deactivating a job role allows you to change a job role's status from Active to Inactive and thereby remove it from the list
of job roles available for selection.

To be able to deactivate a job role, its current status must be Active.
Configuration > [SmartOrg] Administration > [Job Roles] Job Roles

1. In the Job Role Management page, locate the job role you want to deactivate and click the corresponding
Deactivate in the Actions list.

In the Job Role Management page, Status column, the status of the job role is Inactive.

If you later want to make the job role available for selection, you must change its status to Active.

Deleting a Job Role

You can only delete a job role whose status is Draft.
Configuration > [SmartOrg] Administration > [Job Roles] Job Roles

1. In the Job Role Management page, locate the job role you want to delete and click the corresponding Delete in
the Actions list.

The job role is no longer displayed in the Job Roles list on the Job Management page.
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Job Role Fields

All fields related to the configuration of job roles are presented in the following table, along with a description and
related possible values when predefined. Each entry also indicates the type of information the field applies to and the
related header.

Field Description Applicable to Header

Actions Section that shows all the possible = Job Roles Requirements
actions that can be performed with
respect to the selected element.

Asset Value that indicates that an Job Roles Requirements
element is not a requirement for
the job but it would be a good thing
to have.

Category The most general section of ajob ~ Job Roles Job Field
field, Category indicates in which
area the job is located.

Certification Indicates a particular training that = Job Roles Requirements
the person has received.

Competency Indicates an ability that is either a Job Roles Requirements
requirement or an asset for the job.

Description Provides information about the job. Job Roles Job Description

Director Indicates a person who supervises, Job Roles Properties
controls, or manages.

Entry Level Indicates a person who has no Job Roles Properties
previous experience.

Executive Indicates a person who has Job Roles Properties
administrative or managerial
authority in an organization.

Function Refers to the type of work the job Job Roles Job Field
entails.
Importance Indicates whether the elementisa = Job Roles Requirements

requirement or an asset.

Individual Contributor Indicates a person who is able to Job Roles Properties
work on his/her own.

Job Codes Indicates the various external job Job Roles Properties
codes associated with this job role.
These job codes are imported via
Taleo Connect.

Job Field Indicates the area of work of the Job Roles Properties
position.
Job Level Indicates the level of the positionin Job Roles Properties

the hierarchy.
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Field

Job Role Context

Manager

Manager With Direct Reports

Manager Without Direct Reports

Quialifications

Required

Responsibilities

Senior Executive

Specialty

Status

ORACLE

Description Applicable to

Provides further details about the = Job Roles
context (location, organization,
name, code, etc.) of a job role.

Indicates a person who is Job Roles
responsible for planning and

directing the work of a group of

individuals, monitoring the group's

work, and taking corrective action

when necessary. Managers might

manage workers directly or they

might manage supervisors who in

turn manage workers.

Indicates a person who has Job Roles
managerial responsibilities and
subordinates.

Indicates a person who has Job Roles
managerial responsibilities but
does not have any subordinates.

Indicates the qualifications Job Roles
required for the job.

Value that indicates that an Job Roles
element is mandatory.

Indicates the responsibilities that Job Roles
come with the job.

Indicates a person who is a chief Job Roles
executive officer, chief operating

officer, chief financial officer or

someone in charge of a principal

business unit or function.

Refers to a specific type of job. Job Roles

Status of the selected element. Job Roles
Possible values are:

- Draft - When in Draft status,
an element can be edited
but it cannot be applied or
associated with another
element. To use an element,
you have to change its
status from Draft to Active.
If the status of an element
is changed from Draft to
another status, the element
can never have Draft status
again. Only elements whose
status is Draft can be deleted.

- Inactive - While an element
has Inactive status, it can
be edited but it cannot be
applied or associated with
another element. To use
an element whose status is
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Header

Definitions

Properties

Properties

Properties

Job Description

Requirements

Job Description

Properties

Job Field

Properties
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Field Description Applicable to Header

Inactive, you have to activate
it.

Active - An element whose
status is Active can be edited,

applied or associated with
another element.

Target rating value Indicates the ideal value a Job Roles Requirements
candidate would attain for a
competency.

Team Leader Indicates a person who is in charge  Job Roles Properties
of a group.

Weight The weight represents a Job Roles Requirements

percentage that establishes

the relative importance of a
competency or certification
among the competencies and the
certifications. Weight is used to
calculate the best-fit match when
searching for successors.

Working with Job Role Contexts

Job Role Context

A job role context allows you to define a job role description that is only available to employees who are part of
particular parts of your organization or in specific locations, job fields or job levels, or who satisfy any combination of
these Foundation Data elements (from SmartOrg).

In addition to having a default job role description, your organization might want to define different descriptions for
parts of the organization or for employees who work in specific locations, job fields or job levels.

If you specify multiple selections within one category, such as Organizations, those selections are inclusive. If you
specify selections from more than one category (for example, an Organization selection and a Location selection), the
combination of element categories is exclusive.

A job role context must be activated to be available for use with job profile creation.

Viewing a Job Role Context

Job role contexts can be viewed at any time.

Configuration > [SmartOrg] Administration > [Job Roles] Job Role Contexts
1. Inthe Job Role Context Management page, click the name of the job role context you want to view.

2. If the information you want to view is not displayed, click the corresponding Show.
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Depending on a job role context's status, you can edit, duplicate, activate, deactivate or delete the job role context while
itis in view mode.

Creating a Job Role Context

Creating a job role context allows you to later add it to a job role to “contextualize” the latter based on the OLF structure
(Foundation Data from SmartOrg).

In Configuration > [SmartOrg] Settings , the Enable Job Role Context Management value must be set to Yes.
Configuration > [SmartOrg] Administration > [Job Roles] Job Role Contexts

1. Inthe Job Role Context Management page, click Create.

2. Inthe New Job Role Context page, complete all mandatory fields, enter information in optional fields if desired
and then click Finish.

3. To add particular parts of your organization to the job role context, in the Job Role Context page click Add next
to Organizations, click the check box next to each part of the organization (on the Organization Selector page)
you want to add and then click Select.

4. You can add locations and/or job roles to the job role context in a similar manner.

On the Job Role Context page, the information you entered is displayed in the Properties, Organizations, Locations and
Job Fields sections. If you added multiple selections within one category in step 3 and/or step 4, those selections are
inclusive (use the OR operator). If you added selections from more than one category (for example, an Organization
selection and a Location selection), those selections are exclusive (use the AND operator). If you click the Job Role
Context Management breadcrumb at the top of the page, the job role context you created is displayed in the Job Profile
Contexts list.

The job role context must be activated before it is available for selection in a job role.

Editing a Job Role Context

Configuration > [SmartOrg] Administration > [Job Roles] Job Role Contexts

1. Inthe Job Role Context Management page, click the name of the job context you want to edit.

2. (lick thelink (Edit, Add, Remove, Remove All) that corresponds to the section you want to edit and the type of
change you want to perform.

If the information you want to edit is hidden from view, click the corresponding Show

3. If the system displays an “Editor” page, make you changes in that page and then click Save.

On the Job Role Context page, your changes are displayed.

Duplicating a Job Role Context
Duplicating a job role context allows you to quickly create a new job role context based on an existing one.

Ideally, you have an existing job role context that resembles in most respects the job role context you want to create.
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Configuration > [SmartOrg] Administration > [Job Roles] Job Role Contexts

1. In the Job Role Context Management page, locate the job role context you want to duplicate and click Duplicate.

2. Inthe New Job Role Context page, complete all mandatory fields, enter information in optional fields if desired
and then click Finish.

3. Inthe Job Role Context page, edit the language, Properties, Organizations, Locations and Job Fields sections of
the new job role context.

If you click the Job Role Context Management breadcrumb at the top of the page, the new job role context and its
information are displayed in the Job Role Contexts list.

The job role context must be activated before you can add it to a job role.

Activating a Job Role Context

Activating a job role context allows you to change the status of the context from Draft or Inactive to Active and thereby
have the context displayed in the list of available contexts.

To activate a job role context, its current status must be Draft or Inactive.
Configuration > [SmartOrg] Administration > [Job Roles] Job Role Contexts

1. Inthe Job Role Context Management page, locate the job role you want to activate and click the corresponding
Activate in the Actions column.

The status of the selected job role context is now Active.

Deactivating a Job Role Context

Deactivating a job role context allows you to change its status from Active to Inactive. This action in turn allows you to
remove the context from the list of contexts available for selection.

You can only deactivate a job role context whose current status is Active.
Configuration > [SmartOrg] Administration > [Job Roles] Job Role Contexts

1. In the Job Role Context Management page, locate the job role context in the list and click the corresponding
Deactivate in the Actions column.

2. Click Deactivate.

The status of the selected job role context is now Inactive in the Actions column.

To “reactivate” a job role context, its status must be set to Active.

Deleting a Job Role Context

Ajob role context can only be deleted if its status is Draft.
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Configuration > [SmartOrg] Administration > [Job Roles] Job Role Contexts

1. In the Job Role Context Management page, locate the job role context you want to delete and click the
corresponding Delete in the Actions column.

The job role context is deleted from the Job Role Contexts list on the Job Role Context Management page.

Job Role Context Fields

All fields related to the configuration of Job Role Contexts are presented in the following table, along with a description
and related possible values when predefined. Each entry also indicates the type of information the field applies to and
the related header.

Field Description Applicable to Header

Actions Section that shows all the possible = Job Role Context Job Role Contexts
actions that can be performed with
respect to the selected element.

Job Fields Indicates the job fields associated = Job Role Context Job Role Contexts
with a job role context. The values
for this field come from selections
made in the Job Field selector.

Locations Indicates the locations associated Job Role Context Job Role Contexts
with a job role context. The values
for this field come from selections
made in the Location selector.

Organizations Indicates the organizations Job Role Context Job Role Contexts
associated with a job role context.
The values for this field come
from selections made in the
Organization Selector.

Status Status of the selected element. Job Role Context Properties
Possible values are:

Draft - When in Draft status,
an element can be edited

but it cannot be applied or
associated with another
element. To use an element
whose status is Draft, you
have to change its status from
Draft to Active. If the status of
an element is changed from
Draft to another status, the
element can never have Draft
status again. Only elements
whose status is Draft can be
deleted.

Inactive - While an element
has Inactive status, it can
be edited but it cannot be
applied or associated with
another element. To use
an element whose status is
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Field Description Applicable to Header
Inactive, you have to activate
it.
- Active - An element whose
status is Active can be edited,

applied or associated with
another element.

Working with Job Profile Classifications

Job Profile Classification
A job profile classification allows you to define a specific, reusable job classification context for a job role.

A job profile classification allows you to define different certification and competency descriptions for specific parts of
the organization, locations, job fields, job levels or combinations thereof. A contextual job classification overwrites the
default certifications and competencies for the defined context.

When you are creating a job profile classification, you can add or change certifications and competencies but you
cannot remove them. For example, if one of the competencies for a product manager is leadership, while you are
defining a job profile classification you can modify the required rating based on the context or add a new competency to
the position but you cannot remove the leadership competency from the context.

You must activate a job profile classification if you want to make it available for use with job profile creation.

Viewing a Job Profile Classification

Job profile classifications can be viewed at any time.

Configuration > [SmartOrg] Administration > [Job Roles] Job Roles

1. Inthe Job Profile Classification Management page, click the name of the job profile classification you want to
view.
2. If the information you want to view is not displayed, click the corresponding Show.

Depending on a job profile classification's status, you can edit, duplicate, activate, deactivate or delete the job profile
classification while it is in view mode.

Creating a Job Profile Classification

Creating a job profile classification allows you to create a specific, reusable job classification context for a job role.

Configuration > [SmartOrg] Administration > [Job Roles] Job Profile Classifications

1. Inthe Job Profile Classification Management page, click Create next to Job Profile Classifications.
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2. Inthe New Job Profile Classification page, complete all mandatory fields, enter information in the optional fields
if desired and then click Finish.

3. Inthe Job Profile Classification page, you can add certifications to the job profile classification by clicking Add
next to Certifications in the Requirements section. After specifying the certification, importance and weight,
click Save.

4. Inthe Job Profile Classification page, you can add competencies to the job profile classification by clicking Add
next to Competencies in the Requirements section. After specifying the certification, importance and weight,
click Save.

5. To add particular parts of your organization to the job profile classification, in the Job Profile Classification
page, click Add next to Organizations, click the check box next to each part of the organization (on the
Organization Selector page) you want to add and then click Select.

6. You can add locations, job fields and/or job levels to the job profile classification in a similar manner.

On the Job Profile Classification page, the information you entered is displayed in the Requirements, Organizations,
Locations, Job Fields and Job Levels sections. If you added multiple selections within one category in steps 5 and/or 6,
those selections are inclusive (use the OR operator). If you added selections from more than one category (for example,
an Organization selection and a Location selection), those selections are exclusive (use the AND operator). If you click
the Job Profile Classification Management breadcrumb at the top of the page, the job profile classification is displayed in
the Job Profile Classifications list.

The job profile classification must be activated before it is available for selection.

Editing a Job Profile Classification

Configuration > [SmartOrg] Administration > [Job Roles] Job Profile Classifications

1. In the Job Profile Classification Management page, click the name of the job profile classification you want to
edit.

2. (lick thelink (Edit, Add, Delete, Remove, Remove All) that corresponds to the section you want to edit and the
type of change you want to perform.

If the information you want to edit is hidden from view, click the corresponding Show.
3. If the system displays an “Editor” page, make your changes and then click Save.

On the Job Profile Classification page, your changes are displayed.

Adding an Organization to a Job Profile Classification

You can add an organization to a job profile classification to “contextualize” the classification.

Configuration > [SmartOrg] Administration > [Job Roles] Job Profile Classifications

1. Inthe Job Profile Classification Management page, click the name of the classification to which you want to add
an organization.

2. Inthe Job Profile Classification page, click Add next to Organizations.

3. Inthe Organization Selector page, click the check box next to the organization(s) you want to add and then click
Select.

In the Job Profile Classification page, the selected organizations are now displayed in the Organizations section.
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Adding a Location to a Job Profile Classification

You can add a location to a job profile classification to “contextualize” the classification.

Configuration > [SmartOrg] Administration > [Job Roles] Job Profile Classifications

1. Inthe Job Profile Classification Management page, click the name of the job profile classification to which you
want to add a location.

2. Inthe Job Profile Classification page, click Add next to Locations.
3. Inthe Location Selector page, click the check box next to the location(s) you want to add.
4. Click Select.

On the Job Profile Classification page, the selected locations are now displayed in the Locations section.

Adding a Job Field to a Job Profile Classification

Adding a job field to a job profile classification allows you to contextualize the latter.

Configuration > [SmartOrg] Administration > [Job Roles] Job Profile Classifications

1. In the Job Profile Classification Management page, click the name of the classification to which you want to add
ajob field.

2. Inthe Job Profile Classification page, click Add next to Job Fields.

3. Inthe Job Field Selector page, select the check box next to the job field(s) you want to add.

4. Click Select.

The selected job fields are now displayed in the Job Fields section of the Job Profile Classification page.

Adding a Job Level to a Job Profile Classification

Adding a job level to a job profile classification allows to use that job level as an applicable context for the classification.
For example, an organization may have sales organizations in both the United States and Canada. The Sales Manager
Job profile is the same, with the exception that the Managers in Canada have the competencies of being fluent in
French. In such a situation, the organization might want to create a Job Profile Classification called “Canada” that is
relevant in that location for Manager-level employees.

Configuration > [SmartOrg] Administration > [Job Roles] Job Profile Classifications

1. In the Job Profile Classification Management page, click the name of the job profile classification to which you
want to add a job level.

2. Inthe Job Profile Classification page, click Add next to Job Levels.
3. Inthe Job Level Selector page, click the check box next to each job level you want to add.
4. C(lick Select.

On the Job Profile Classification page, the selected job levels are now displayed in the Job Levels section.
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Duplicating a Job Profile Classification

Duplicating a job profile classification allows you to quickly create a new job profile classification based on an existing
one.

Ideally, you have an existing job profile classification that resembles in most respects the job profile classification you
want to create.

Configuration > [SmartOrg] Administration > [Job Roles] Job Profile Classifications

1. In the Job Profile Classification Management page, locate the classification you want to duplicate and click the
corresponding Duplicate in the Actions column.

2. Inthe New Job Profile Classification page, complete all mandatory fields, enter information in optional fields if
desired and then click Finish.

3. Anew page is displayed that includes the details of the new job profile classification. In the Requirements
section, you can perform any or all of the following steps.

o To edit a certification or competency displayed, click the corresponding Edit, edit the fields and then click
Save.

o To add a certification or competency, click the corresponding Add, complete the fields and then click
Save.

o To delete a certification or competency, click the corresponding Delete in the Actions column.

4. To add particular parts of your organization to the job profile classification, in the Job Profile Classification page
click Add next to Organizations, click the check box next to each part of the organization (on the Organization
Selector page) you want to add and then click Select.

5. You can add locations and/or job roles to the job role context in a similar manner.

On the Job Profile Classification page, the information relative to the new classification is displayed. If you added
multiple selections within one category in step 4 and/or step 5, those selections are inclusive (use the OR operator). If
you added selections from more than one category (for example, an Organization selection and a Location selection),
those selections are exclusive (use the AND operator). If you click the Job Profile Classification breadcrumb at the top of
the page, the new job profile classification is displayed in the Job Profile Classifications list.

The job profile classification is not available for selection until you change its status to Active.

Activating a Job Profile Classification

Activating a job profile classification allows you to change its status from Draft or Inactive to Active. A job profile
classification is only available for selection if its status is Active.

To activate a job profile classification, its current status must be Draft or Inactive.
Configuration > [SmartOrg] Administration > [Job Roles] Job Profile Classifications

1. Inthe Job Profile Classification Management page, locate the job profile classification you want to activate and
click the corresponding Activate in the Actions column.

The status of the selected job profile classification is now Active and the classification is available for selection.
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Deactivating a Job Profile Classification

Deactivating a job profile classification allows you to change its status from Active to Inactive and thereby remove it
from the list of job profile classifications available for selection.

To deactivate a job profile classification, its current status must be Active.
Configuration > [SmartOrg] Administration > [Job Roles] Job Roles

1. In the Job Profile Classification Management page, locate the job profile classification that you want to
deactivate and click the corresponding Deactivate.

In the Job Profile Classification Management page, Status column, the status of the job profile classification is Inactive.

If you later want to make the job profile classification available for selection, you must change its status to Active.

Deleting a Job Profile Classification

A job profile classification can only be deleted if its status is Draft.
Configuration > [SmartOrg] Administration > [Job Roles] Job Profile Classifications

1. Inthe Job Profile Classification Management page, locate the classification you want to delete and click the
corresponding Delete in the Actions column.

The job profile classification is deleted and is no longer displayed in the Job Profile Classification list on the Job Profile
Classification Management page.

Job Profile Classification Fields

All fields related to the configuration of job profile classifications are presented in the following table, along with a
description and related possible values when predefined. Each entry also indicates the type of information the field
applies to and the related header.

Field Description Applicable to Header

Actions Section that shows all the possible = Job Profile Classifications Requirements
actions that can be performed with
respect to the selected element.

Certification Indicates a particular training that = Job Profile Classifications Requirements
the person has received.

Competency Indicates an ability that is either Job Profile Classifications Requirements
required or an asset for the job.

Importance Indicates whether the elementisa = Job Profile Classifications Requirements
requirement or an asset.
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Field

Job Fields

Job Levels

Locations

Organizations

Status

Target rating value

Weight

ORACLE

Description

Indicates the job fields associated

Applicable to

Job Profile Classifications

with a job role context. The values
for this field come from selections
made in the Job Field Selector.

Indicates the job levels associated

Job Profile Classifications

with a job role context. The values
for this field come from selections
made in the Job Level Selector.

Indicates the locations associated

Job Profile Classifications

with a job role context. The values
for this field come from selections
made in the Location Selector.

Indicates the organizations

Job Profile Classifications

associated with a job role context.
The values for this field come
from selections made in the
Organization Selector.

Status of the selected element.

Job Profile Classifications

Possible values are:

Indicates the ideal value a

Draft - When in Draft status,
an element can be edited

but it cannot be applied or
associated with another
element. To use an element
whose status is Draft, you
have to change its status from
Draft to Active. If the status of
an element is changed from
Draft to another status, the
element can never have Draft
status again. Only elements
whose status is Draft can be
deleted.

Inactive - While an element
has Inactive status, it can

be edited but it cannot be
applied or associated with
another element. To use

an element whose status is
Inactive, you have to activate
it.

Active - An element whose
status is Active can be edited,
applied or associated with
another element.

Job Profile Classifications

candidate would attain for a
competency.

Percentage that indicates the

Job Profile Classifications

importance attributed to a section
in the calculation of the overall
score.

Chapter 5
Job Role Administration

Header

Job Fields

Job Levels

Locations

Organizations

Properties

Requirements

Requirements
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Working with Job Positions

Job Position

A job position is a specific instance of a job role.

It is important to understand the relationship between the following concepts: job role, job position, job role context and
job profile classification. A job role can be considered to be a “generic” job that includes job properties, requirements
(certifications and competencies), a job description, qualifications and responsibilities. An example of a job role is
executive secretary. A job position, on the other hand, is a specific instance of a job role. When a position is created
based on a job role, the position includes the job role's description and requirements. A job role context offers the
ability to provide different job descriptions for specific organizations, locations, job fields or job levels (SmartOrg
elements). This means that a distinct job description will be displayed to users who belong to a specific organization,
location, job field or job level. In other words, job role contexts provide the opportunity to contextualize a job role and
consequently a position according to users' SmartOrg information. Similarly, job profile classification provides the ability
to contextualize the certifications and competencies associated with a job position. When creating a job position, an HR
administrator can click “Apply preselected profile requirement” to add the competencies (and respective values) and
certifications to the job position.

The competencies and certifications can be copied from the job role with a single click, and then modified to suit the
requirements of the job position. In this case, the competencies and certifications replace those defined by the job role.

The job description information—description, qualifications, responsibilities—from the job role cannot be modified for
the job position.

A job position must be activated to be available for use with performance management.

Viewing a Job Position

Job positions can be viewed at any time.

Configuration > [SmartOrg] Administration > [Job Positions] Job Positions

1. In the Job Position Management page, click the name of the job position you want to view.
2. If the information you want to view is not displayed, click the corresponding Show.

Depending on a job position's status, you can edit, duplicate, activate, deactivate or delete the job position while it is in
view mode.

Creating a Job Position

Creating a job position allows you to create an occurrence of a job role. Job positions are hierarchical and only the ones
highest in the hierarchy are managed in the system.

Because a job position is attached to a job role, the latter must be created prior to the creation of a job position.
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Configuration > [SmartOrg] Administration > [Job Positions] Job Positions

In the Job Position Management page, click Create.
In the New Job Position page, complete all mandatory fields and enter information in optional fields if desired.
Click Finish.
A new page is displayed that includes the details of the new job position. In the Requirements section, you can
perform any or all of the following steps.
o To edit a certification or competency displayed, click the corresponding Edit, edit the fields and then click
Save.
o To add a certification or competency, click the corresponding Add, complete the fields and then click
Save.
o To delete a certification or competency, click the corresponding Delete in the Actions column.

PN

o Toremove all certifications or all competencies, click the corresponding Delete All.

o To add certifications and competencies regarding the job role and job classification based on Foundation
Data (from the OLF structure), click Apply Preselected Profile Requirements.

If you click the Job Position Management breadcrumb at the top of the page, the job position you created is displayed in
the Job Positions list.

The job position must be activated before it is available for selection.

Editing a Job Position

Configuration > [SmartOrg] Administration > [Job Positions] Job Positions

1. In the Job Position Management page, click the name of the job position you want to edit.

2. (lick thelink (Edit, Add, Delete, Delete All) that corresponds to the section you want to edit and the type of
change you want to perform.

If the information you want to edit is hidden from view, click the corresponding Show.

3. If the system displays an “Editor” page, make your changes in this page and then click Save.

On the job position page, you changes are displayed.

Duplicating a Job Position
Duplicating of a job position allows you to quickly create a new job position from an existing one.

Ideally, you have an existing job position that resembles in most respects the job position you want to create.
Configuration > [SmartOrg] Administration > [Job Positions] Job Positions

1. In the Job Position Management page, locate the job position you want to duplicate and click the corresponding
Duplicate in the Actions column.

2. Inthe New Job Position page, complete all mandatory fields, enter information in optional fields if desired and
then click Finish.

The page corresponding to the new job position you created is displayed.
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The job position is not available for selection until you change its status to Active.

Activating a Job Position

Activating a job position allows you to change a job position's status from Draft or Inactive to Active so the job position
can later be attached to a job role.

To activate a job position, its status must be Draft or Inactive.
Configuration > [SmartOrg] Administration > [Job Positions] Job Positions

1. Inthe Job Position Management page, click the name of the job position you want to activate.
2. Click Activate.

The selected job position is now active (and consequently available for selection).

Deactivating a Job Position

Deactivating a job position allows you to change its status from Active to Inactive and thereby remove it from the list of
job positions available for selection.

To deactivate a job position, its status must be Active.
Configuration > [SmartOrg] Administration > [Job Positions] Job Positions

1. In the Job Position Management page, click the name of the job position you want to deactivate and click
Deactivate.

In the Job Position Management page, Status column, the status of the job position is Inactive.

If you later want to make the job position available for selection, you must change its status to Active.

Deleting a Job Position

A job position can only be deleted if its status is Draft.
Configuration > [SmartOrg] Administration > [Job Positions] Job Positions

1. Inthe Job Position Management page, locate the job position you want to delete and then click the
corresponding Delete in the Actions column.

The job position is deleted and is no longer displayed in the list of job positions.
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Job Position Fields

Fields related to the configuration of job positions are presented in the following table. Each entry in the table includes a
field or button, a description, possible values (when they are predefined), the part of the application to which the field or
button applies, and the header of the field or button.

Field

Actions

Asset

Certification

Competency

Criticality

Department

Description

Employee

Importance

Job Role

Location

Manager

ORACLE

Description

Section that displays all the
possible actions that can be
performed with respect to the
selected element.

Value indicates that an item is not a
requirement but it would be a good
thing to have.

Indicates a particular training that
the person has received.

Indicates an ability that is either a
requirement or an asset for the job.

Indicates the level of importance.

Indicates the department in which
the position is found. Value for
this field comes from a selection
you made using the Department
selector.

Field where you can enter a
description of the position.

Indicates the name of the
employee currently in the position.
Value for this field comes from

a selection you made using the
Employee selector.

Indicates whether the element is a
requirement or an asset.

Indicates the job role to which this
position is related. Value for this
field comes from a selection you
made using the Job Role selector.

Indicates the location of the
position. Value for this field comes
from a selection you made using
the Location selector.

Indicates the name of the manager
for the position. Value for this field
comes from a selection you made
using the Manager selector.

Applicable to

Job Position

Job Position

Job Position

Job Position

Job Position

Job Position

Job Position

Job Position

Job Position

Job Position

Job Position

Job Position
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Header

Requirements

Requirements

Requirements

Requirements

Properties

Properties

Properties

Properties

Requirements

Properties

Properties

Properties
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Field

Number of Openings

Opening Status

Organization

Parent

Required

Status

Target Rating Value

Target Start Date

ORACLE

Description

This field is not used for Taleo
Performance. It is used by Taleo
Recruiting.

Indicates whether the position is
open and needs to be filled.

Indicates the organization under
which the position is found.
Value for this field comes from

a selection you made using the
Organization selector.

Positions are structured in a
hierarchy. This field indicates the
“parent” position of the current
one. Value for this field comes from
a selection you made using the
Parent selector.

Value indicates that an element is
mandatory.

Status of the selected element.
Possible values are:

- Draft - When in Draft status,
an element can be edited
but it cannot be applied or
associated with another
element. To use an element
whose status is Draft, you
have to change its status from
Draft to Active. If the status of
an element is changed from
Draft to another status, the
element can never have Draft
status again. Only elements
whose status is Draft can be
deleted.

- Inactive - While an element
has Inactive status, it can
be edited but it cannot be
applied or associated with
another element. To use
an element whose status is
Inactive, you have to activate
it.

- Active - An element whose
status is Active can be edited,
applied or associated with
another element.

Indicates the ideal value a
candidate would attain for a
competency.

Indicates the ideal date when the
candidate would start working in
the position.

Applicable to

Job Position

Job Position

Job Position

Job Position

Job Position

Job Position

Job Position

Job Position
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Header

Properties

Properties

Properties

Properties

Requirements

Properties

Requirements

Properties
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Field

Weight

Description Applicable to

Percentage that indicates the Job Position
importance attributed to a section

in the calculation of the overall

score.

Header

Requirements

ORACLE
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6 Correspondence and Feedback
Administration

Working with Message Documents

Documents and Paragraphs

Documents provide structure and paragraphs provide content for message templates, which are used to send emails to
users of Taleo Performance.

Content can relate to things such as, feedback requests, reviews, goal plans, or succession plans. Multiple paragraphs
can be added to a text document, while a filed-based document consists of a PDF source file. Only a single document
can be added to a message template.

Creating Paragraphs

Paragraphs provide content for text documents and can contain Taleo Performance variables, formatted text,
hyperlinks, and images.

Public paragraphs can be added to multiple documents, while private paragraphs are created within a specific document
and can only be used with it. Unless you are only using private paragraphs, you should create and activate public
paragraphs before creating documents.

To Create a Public Paragraph
Configuration > [Taleo Performance] Administration > [Global Configurations] Documents

1. Click Paragraph List and click Create.
2. Enter a Code and mandatory Name.
3. Copy and paste required variables into the text editor.

Ensure you copy and paste the variables exactly as they are in the Available Variables list or they will not
work as expected. If intending to use in a Summary Email, be sure to select the variable(s) that are specific to
Summary Emails, i.e., {Summary-Email.PendingDevelopmentPlanApprovalTaskLink}.

4. Use the text editor to enter paragraph content.

5. Click Save.

The paragraph is added to the system and you can click Activate to make it available to be used in documents.

You can select it from the Paragraph List to edit the content or deactivate it.

To Create a Private Paragraph
A text document must exist.
Configuration > [Taleo Performance] Administration > [Global Configurations] Documents

1. Select a document and click Create in the Paragraphs section.
2. Enter a Code and mandatory Name.
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3. Copy and paste required variables into the text editor.

Ensure you copy and paste the variables exactly as they are in the Available Variables list. If intending to use
in a Summary Email, be sure to select the variable(s) that are specific to Summary Emails, i.e., {Summary-
Email.PendingDevelopmentPlanApproval TaskLink]}.

4. Use the text editor to enter the required paragraph content.

5. Click Save.

The new paragraph is automatically activated and added to the document and listed in the Paragraphs section.

You can reorder the paragraphs as needed.

Creating Documents
Two types of documents can be created: text documents and file-based documents.

Text documents are created from paragraphs and are listed as HTML format in the Document list. They serve as a
container for paragraphs, which can be added, created, deleted and reordered within the document.

f Note: To see whether a document's paragraphs are private or public, view the paragraph's history. If the
history includes a Paragraph Created event, without a subsequent Paragraph Activated event, it is private.

File-based documents are created by adding a PDF file, which becomes the static content of the document. It is listed as
PDF format in the Document list.

To Create a Text Document
Configuration > [Taleo Performance] Administration > [Global Configurations] Documents

1. Click Create a text document.
Enter the Code and mandatory Name and click Save.

3. Select the name of the document and click Add to add an existing active public paragraph or click Create to
make a private paragraph.
See To Create a Private Paragraph for details.

4. Click Reorder to change the sequence of the paragraphs if required.
You can click Edit beside a paragraph to open the Paragraph Editor and modify it, but any changes made to
public paragraphs will impact any other documents using them.

5. Click Activate.

The document is available in the Document Selector to be added to a message template.

You can click Remove to delete a paragraph from the document. If you remove a public paragraph it is still available;
however, if you remove a private paragraph it is deleted from the system.

To Create a File-Based Document
Configuration > [Taleo Performance] Administration > [Global Configurations] Documents

Click Create a file-based document.

Enter the Code, mandatory Name, and Description.

Click Browse and select the PDF to be used as the content for the document.
4. Click Save.

WN =

It is added to the Document list, in Draft status.
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Select the document and change the status to Active to enable it to be added to a message template.

Activating Documents and Paragraphs

Documents and paragraphs must be activated so they are available in the Document Selector and Paragraph Selector
list and can be used.

The status of a paragraph needs to be active before it can be selected and added to a document, while a document
needs to be active before it can be selected and added to a message template. When you deactivate an item that is
part of a message template, it is still included in that message template. You can also change the status for an item's
languages; however, the base language must remain active for active items.

To change the status, select the item and then click Activate or Deactivate as required.

When changing the status for the language of an item, select the language, click Refresh and then click Activate or
Deactivate.

f Note: While you can activate and deactivate items, once activated an item cannot be returned to Draft status
and subsequently deleted. Only Draft items can be deleted.

Document Fields

All fields related to Documents are presented in the table below, along with a description and possible values, when
predefined. Each field also indicates the type of information it applies to and the related header.

Field Description Applicable to Header

Available Variables This field contains variables that New Paragraph Properties
you can add to your paragraph.

Code Alpha-numerical code used to Document Properties
identify an element (document,
paragraph, etc.) The code is usually
shown along with the name in a
listing.

Create a file-based document This button opens the new Document Documents
document page. The properties
section is the same whether
you create a text or a file-based
document. However, once you
have set the document properties,
you now have access to the
Attached File section.

Create a text document This button opens the new Document Documents
document page. The properties
section is the same whether
you create a text or a file-based
document. However, once you
have set the document properties,
you now have access to the
Paragraphs section..

Edit this paragraph Column that shows the Edit linkto = Document Paragraphs
modify the content of a paragraph.
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Field

File Name

Format

Name

Preview

Remove

Reorder

Status

Text

ORACLE

Description

Field indicating the name of the file
attached to the document, in case
of a file-based document.

Indicates the format of the
document. Possible values are PDF
or HTML.

Alpha-numerical value indicating
the name of an element
(document, paragraph, etc.). The
name is usually shown along with
the code in a listing.

Button that allows to see a preview
of the document.

Button that allows to remove a
paragraph from a document.

This action does not delete the
paragraph from the list of available
paragraphs.

Button that opens the Reorder
Paragraphs page, where the order
of paragraphs included in the
document can be defined.

Status of the selected element.
Possible values are: Draft - When
in a Draft status, an element can
only be edited but not applied or
associated to another element. To
be able to use a Draft element, it
must first be activated. Once the
status of an element has changed
from Draft to another status, it
can never be in a Draft status
again. Only draft elements can

be deleted. Inactive - When in an
Inactive status, an element can
only be edited but not applied or
associated to another element. To
be able to use an Inactive element,
it must first be activated. Active

- When in a Active status, an
element can be edited, applied or
associated to another element.

Field where you enter the text
content of your paragraph as well
as all the variables that you want to
include.

Applicable to

Document

Document

Document

Document

Document

Document

Document

New Paragraph

Chapter 6
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Header

Attached File

Documents

Properties

Paragraphs

Paragraphs

Paragraphs

Properties

Properties
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Working with Message Templates

Message Template

A message template serves as a model for email messages that are sent via Taleo Performance.

Correspondence can be sent for various situations, each corresponding to a different message template type. These
message templates are created from text document or from file-based documents. After they have been created and
activated, they can be selected as feedback correspondence or as reminder and summary emails.

There are many different types of templates, each corresponding to a specific situation:

- Standard notification for feedback approval completion

- Standard notification for a feedback approval

- Standard notification for review process assignment

- Standard notification for review process completion

- Standard notification for goal plan approval task assignment

- Standard notification for goal plan approval completion

- Standard notification for succession plan approval task assignment

- Standard notification for succession plan approval completion

- Standard notification for employee change approval task assignment
- Standard notification for employee change approval completion

- Standard notification for development plan approval task assignment
- Standard notification for development plan approval task completion
- Standard notification for review feedback request

- Standard notification for review feedback response

- Standard notification for employee goal feedback request

- Standard notification for employee goal feedback response

- Standard notification for succession plan feedback request

- Standard notification for succession plan feedback response

- Standard notification for career plan feedback request

- Standard notification for career plan feedback response

- Standard notification for development plan feedback request

- Standard notification for development plan feedback response

- Standard notification for a feedback request sent from journal

- Standard notification for a response to a feedback request sent from journal

- Standard notification for summary email
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Viewing a Message Template

Viewing a message template allows you to view its properties, content and history information.

Configuration > [Taleo Performance] Administration > [Global Configurations] Message Templates

1. In the Message Templates page, click the name of the message template that you want to view.
The message template information displays in the Template page, which presents the name of the selected template
next to the page title.

Once displayed in view mode, the message template can then be edited, activated or deactivated and previewed.

Creating a Message Template
Creating a message template allows to define a template to be used as a model when creating email messages.

Configuration > [Taleo Performance] Administration > [Global Configurations] Message Templates

1. In the Message Templates page, click Create next to Templates.
2. Inthe New Message Properties page, enter the appropriate information.

Make sure to select the proper type as this determines in which situation the template will be used.

If needed, variables can be used in the To, Cc, Bcc and Subject fields.

3. Click Save.

4. Back to the Template page, create the content of the template by either clicking Select a document or Custom
Content.

5. Depending on the previous step, do one of the following.

o If selecting a document, in the Paragraph-Based Document Selector page, select the document you wish
to use as a template.

o If creating custom content, in the Message Template Content Editor page, type in the content of the
message and insert variables as needed by clicking on the desired variable when the cursor is at the
desired insertion point in the message box.

6. Click Save.

The properties and content of the newly created message template display in the Template page.

Once created, the message template needs to be activated to make it available when selecting an email message for
notifications and correspondence.

Editing a Message Template
Editing a message template is used to modify the properties or the content of a message template.

Editing a message template is possible at all times. It is however suggested to deactivate the template before modifying
it.
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Configuration > [Taleo Performance] Administration > [Global Configurations] Message Templates

1. In the Message Templates page, click the name of the message template that you want to modify.
2. Inthe Template page, depending on the type of changes to make, do one of the following:
o Click Edit next the Properties to modify the properties of the message template.

o Click Select Document or Custom Content, depending on the existing content of the message to modify
the template. For example, if the template included customized content, selecting a document instead
won't be possible.

3. Click Save.

The changes made are automatically reflected in the template and in all future emails based on the template.

If you had deactivated the template, make sure to activate it again.

Previewing a Message Template
Previewing a message template allows to see how the entire content looks.

Configuration > [Taleo Performance] Administration > [Global Configurations] Message Templates

1. In the Message Templates page, click the name of the message template you wish to preview.
2. Inthe Message page, click Preview next to Content.

The message template displays in the preview page, as it will be when sent as an email.

Activating a Message Template

Activating a message template is done to make the template available for selection when creating messages.

Configuration > [Taleo Performance] Administration > [Global Configurations] Message Templates

1. Inthe Message Templates page, under Templates, click the name of the message template you want to activate.
2. Inthe Template page, click Activate next to the name of the message template, on the title line.

The message template shows an Active status.

Below are tasks related to message templates.

Deactivating a Message Template
Deactivating a message template is used to remove it from the list of available templates.

A message template must be active in order to be deactivated.
Configuration > [Taleo Performance] Administration > [Global Configurations] Message Templates

1. In Message Templates page, click the name of the message template that you want to deactivate.
2. Inthe Template page, click Deactivate next to the name of the message template, on the page title line.
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The message template shows an Inactive status.

If you want to make the template available again, you will need to reactivate it.

Deleting a Message Template

Deleting a message template is used to remove it definitely from the list of templates.

Only draft message templates can be deleted.

Chapter 6
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Configuration > [Taleo Performance] Administration > [Global Configurations] Message Templates

1. Inthe Message Templates page, locate the message template that you want to delete.

2. Click Delete.

The message template no longer shows in the template list.

Message Template Fields

All fields related to Message Templates are presented in the table below, along with a description and possible values,
when predefined. Each field also indicates the type of information it applies to and the related header.

Field

Available Variables

Bcc

Cc

Code

Custom Content

Description

ORACLE

Description

This field contains variables that
you can insert in a paragraph.
When a type of variable is selected
in the first listing, the related
variables are displayed in the
second listing and can be selected
for insertion into a paragraph.

Name of the people who will
receive the message without
having their name showing in the
recipient list.

Name of the people copied in the
message.

Alpha-numerical code used to
identify a message template. The
code is usually shown along with
the name in a listing.

Link that opens the Message
Template Content Editor, where
you can enter content for your
message template.

This field is where you can enter
a description for your message
template.

Applicable to

Message Templates

Message Templates

Message Templates

Message Templates

Message Templates

Message Templates

Header

Properties

Properties

Properties

Properties

Content

Properties
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Field

Document used for message
content

Name

Preview

Select Document

Send as read-only attachment

Status

Subject

Text

To

Type

ORACLE

Description

Name of the document used in the
content of the message template.

Alpha-numerical value indicating
the name of a message template.
The name is usually shown along
with the code in a listing.

Link that opens a preview of the
message template.

Link that opens the Paragraph-
based Document Selector, from
which you can select a document
that will be used in your message
template.

When activated, this field indicates
that the message will be sent as
an attached file and cannot be
modified.

Status of the selected element.
Possible values are:

- Draft - When in a Draft status,
an element can only be edited
but not applied or associated
to another element. To be
able to use a Draft element,
it must first be activated.
Once the status of an element
has changed from Draft to
another status, it can never
be in a Draft status again.
Only draft elements can be
deleted.

- Inactive - When in an Inactive
status, an element can only
be edited but not applied
or associated to another
element. To be able to use an
Inactive element, it must first
be activated.

- Active - When in a Active
status, an element can be
edited, applied or associated
to another element.

Subject of the message.

Shows the content of the message
template.

Name of the recipient of the
message.

Type of the message template.
Possible values are:
- Standard notification for
feedback approval completion
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Applicable to

Message Templates

Message Templates

Message Templates

Message Templates

Message Templates

Message Templates

Message Templates

Message Templates

Message Templates

Message Templates

Header

Content

Properties

Content

Content

Properties

Properties

Properties

Content

Properties

Properties
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Field

ORACLE

Description

Standard notification for a
feedback approval

Standard notification for
review process assignment

Standard notification for
review process completion

Standard notification for
goal plan approval task
assignment

Standard notification for goal
plan approval completion

Standard notification for
succession plan approval task
assignment

Standard notification for
succession plan approval
completion

Standard notification for
employee change approval
task assignment

Standard notification for
employee change approval
completion

Standard notification for
development plan approval
task assignment

Standard notification for
development plan approval
task completion

Standard notification for
review feedback request

Standard notification for
review feedback response

Standard notification for
employee goal feedback
request

Standard notification for
employee goal feedback
response

Standard notification for
succession plan feedback
request

Standard notification for
succession plan feedback
response

Standard notification for
career plan feedback request

Standard notification
for career plan feedback
response

Applicable to
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Header
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Field Description Applicable to Header

Standard notification for
development plan feedback
request

Standard notification for
development plan feedback
response

Standard notification for a
feedback request sent from
journal

Standard notification for
a response to a feedback
request sent from journal

Message Document and Message Template Variables

The following table lists all the variable categories as well as all corresponding variables that can be used in message
documents and templates.

Variable Category or Variable

Approval-Process-Context
Approval-Process-
Context.ApprovalProcessContextOwnerEmail

Approval-Process-Context.ResultComments

Development-Plan.DevelopmentPlanLink

EmployeeChangeRequest

EmployeeChangeRequest.EmployeeChangeReqt

EmployeeChangeRequest.EmployeeChangeReqt

EmployeeChangeRequest.EmployeeChangeReqt

EmployeeChangeRequest.EmployeeChangeReqt

ORACLE

Description

Category of variables associated with the
context of the approval process.

Email address of the person who requested the
approval.

List of approver comments, in the following
form:

- first comment (first approver name)
- second comment (second approver name)
« third comment (third approver comment)

- andsoon

Clickable link for going directly to a
development plan requiring approval.

Category of variables associated to employee
change requests.

Status of the employee change request.

Job role of the employee before the change
request.

Location of the employee before the change
request.

Email address of the current manager of
the employee, that is before the change is
performed.

Applicable to

Message Documents and Templates

Message Documents and Templates

Message Documents and Templates

Message Documents and Templates

Message Documents and Templates

Message Documents and Templates

Message Documents and Templates

Message Documents and Templates

Message Documents and Templates
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Variable Category or Variable

EmployeeChangeRequest.EmployeeChangeReqt

EmployeeChangeRequest.EmployeeChangeReqt

EmployeeChangeRequest.EmployeeChangeReqt

EmployeeChangeRequest.EmployeeChangeReqt

EmployeeChangeRequest.EmployeeChangeReqt

EmployeeChangeRequest.EmployeeChangeReqt

EmployeeChangeRequest.EmployeeChangeReqt

EmployeeChangeRequest.EmployeeChangeReqt

EmployeeChangeRequest.EmployeeChangeReqt

EmployeeChangeRequest.EmployeeChangeReqt

EmployeeChangeRequest.EmployeeChangeReqt

EmployeeChangeRequest.EmployeeChangeReqt

EmployeeChangeRequest.EmployeeChangeReqt

EmployeeChangeRequest.EmployeeChangeReqt

EmployeeChangeRequest.EmployeeChangeReqt

EmployeeChangeRequest.EmployeeChangeReqt

EmployeeChangeRequest.EmployeeChangeReqt

ORACLE
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Description

First name of the current manager of the
employee, that is before the change is
performed.

Full name (First Initial Last) of the current
manager of the employee, that is before the
change is performed.

Last name of the current manager of the
employee, that is before the change is
performed.

Middle initial of the current manager of
the employee, that is before the change is
performed.

Name prefix of the current manager of
the employee, that is before the change is
performed.

Name suffix of the current manager of
the employee, that is before the change is
performed.

Name of the current organization for which
works the employee, that is before the change
is performed.

Email address of the employee for whom an
employee change is performed.

First name of employee for whom an employee
change is performed.

Full name (First Initial Last) of employee for
whom an employee change is performed.

Last name of employee for whom an employee
change is performed.

Middle initial of employee for whom an
employee change is performed.

Name prefix of employee for whom an
employee change is performed.

Name suffix of employee for whom an
employee change is performed.

Email address of the new manager, that is the
manager to whom the employee is requested to
change to.

First name of the new manager, that is the
manager to whom the employee is requested to
change to.

Full name of the new manager, that is the
manager to whom the employee is requested to
change to.

Applicable to

Message Documents and Templates

Message Documents and Templates

Message Documents and Templates

Message Documents and Templates

Message Documents and Templates

Message Documents and Templates

Message Documents and Templates

Message Documents and Templates

Message Documents and Templates

Message Documents and Templates

Message Documents and Templates

Message Documents and Templates

Message Documents and Templates

Message Documents and Templates

Message Documents and Templates

Message Documents and Templates

Message Documents and Templates
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Variable Category or Variable

EmployeeChangeRequest.EmployeeChangeReqt

EmployeeChangeRequest.EmployeeChangeReqt

EmployeeChangeRequest.EmployeeChangeReqt

EmployeeChangeRequest.EmployeeChangeReqt

EmployeeChangeRequest.EmployeeChangeReqt
EmployeeChangeRequest.EmployeeChangeReqt
EmployeeChangeRequest.EmployeeChangeReqt

Feedback-Request

Feedback-Request.DueDate

Feedback-Request.FeedbackReplyAuthorName

Feedback-Request.GoalBusinessPeriodName

Feedback-Request.Priority

Feedback-Request.RequesterName

Feedback-Request.SubjectEmployeeName
Feedback-
Request.SuccessionPlanPositionName
Feedback.FeedbackAuthorName

Feedback.RequesterName

Feedback.SubjectEmployeeName

Goal-Plan

Goal-Plan.GoalPlanApprovalStatus

ORACLE
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Description

Last name of the new manager, that is the
manager to whom the employee is requested to
change to.

Middle initial of the new manager, that is the
manager to whom the employee is requested to
change to.

Name prefix of the new manager, that is the
manager to whom the employee is requested to
change to.

Name suffix of the new manager, that is the
manager to whom the employee is requested to
change to.

New job role requested for the employee.

New location requested for the employee.

New organization requested for the employee.

Category of variables associated to feedback
requests and responses.

Date by which a feedback response is
requested.

Name of the user who has been asked to
provide feedback.

Name of the business period associated to
the goal when feedback is requested for an
employee goal plan.

Priority level of the feedback request.
Name of the user requesting feedback.

Name of the employee about whom feedback is
requested.

Name of the position for which feedback is
requested.

This is the approver who is providing approval
of the feedback request.

This is the person who is providing feedback
and making the request to have it approved.

This is the name of the employee about whom
feedback is requested. In the case that the
feedback is requested on a succession plan this
variable will be empty.

Category of variables related to an employee's
goal plan.

Approval status of the goal plan, which can be:
Not Started, In Progress, Approved or Rejected.

Applicable to

Message Documents and Templates

Message Documents and Templates

Message Documents and Templates

Message Documents and Templates

Message Documents and Templates
Message Documents and Templates
Message Documents and Templates

Message Documents and Templates

Message Documents and Templates

Message Documents and Templates

Message Documents and Templates

Message Documents and Templates

Message Documents and Templates

Message Documents and Templates

Message Documents and Templates

Message Documents and Templates

Message Documents and Templates

Message Documents and Templates

Message Documents and Templates

Message Documents and Templates
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Variable Category or Variable

Goal-Plan.GoalPlanBusinessPeriodName

Goal-Plan.GoalPlanEmployeeEmail

Goal-Plan.GoalPlanEmployeeFirstName

Goal-Plan.GoalPlanEmployeeFullName

Goal-Plan.GoalPlanEmployeelLastName

Goal-Plan.GoalPlanEmployeeMiddlelnitial

Goal-Plan.GoalPlanEmployeeNamePrefix

Goal-Plan.GoalPlanEmployeeNameSuffix

Goal-Plan.GoalPlanLink

Goal-Plan.GoalPlanManagerEmail

Goal-Plan.GoalPlanManagerFullName

Review-Employee
Review-Employee-Request
Review-Employee-

Request.EmployeeJobRoleDescription

Review-Employee-
Request.EmployeeJobRoleName

Review-Employee-
Request.EmployeeJobRoleQualifications

Review-Employee-
Request.EmployeeJobRoleResponsibilities

Review-Employee-
Request.ReviewDefinitionTitle

Review-Employee-Request.ReviewEndDate

Review-Employee-
Request.ReviewGroupProcessOwnerEmail

ORACLE

Chapter 6

Correspondence and Feedback Administration

Description

Name of the business period that is covered by
the goal plan.

Email address of the employee who is the
subject of the goal plan.

First name of the employee who is the subject
of the goal plan.

Full name (First Initial Last) of the employee
who is the subject of the goal plan.

Last name of the employee who is the subject
of the goal plan.

Middle initial of the employee who is the
subject of the goal plan.

Name prefix of the employee who is the subject
of the goal plan, such as Dr.

Name suffix of the employee who is the subject
of the goal plan, such as PhD.

Clickable link for going directly to a goal plan
requiring approval.

Email of the current manager of the employee
who is the subject of the goal plan.

Full name (First Initial Last) of the current
manager of the employee who is the subject of
the goal plan.

Category of variables associated to employee
self-assessments.

Category of variables associated to employee
reviews generated for a given request.

Description of the employee's job role.

Name of the employee's job role.

Qualifications tied to the employee's job role.

Responsibilities tied to the employee's job role.

Title of the review definition used to generate

the employee's review.

End date of the review period, which is the
same as for the review request.

Email address of the review group
administrator, which is the HR Administrator
who is the owner of the reviews belonging to
the review group.

Applicable to

Message Documents and Templates

Message Documents and Templates

Message Documents and Templates

Message Documents and Templates

Message Documents and Templates

Message Documents and Templates

Message Documents and Templates

Message Documents and Templates

Message Documents and Templates

Message Documents and Templates

Message Documents and Templates

Message Documents and Templates

Message Documents and Templates

Message Documents and Templates

Message Documents and Templates

Message Documents and Templates

Message Documents and Templates

Message Documents and Templates

Message Documents and Templates

Message Documents and Templates
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Variable Category or Variable

Review-Employee-

Request.ReviewGroupProcessOwnerEmployeeld

Review-Employee-
Request.ReviewGroupProcessOwnerFullName

Review-Employee-
Request.ReviewRequestAssignmentDate

Review-Employee-

Request.ReviewRequestEmployeeEvaluationTas}

Review-Employee-
Request.ReviewRequestName

Review-Employee-
Request.ReviewRequestProcessOwnerEmail

Review-Employee-

Request.ReviewRequestProcessOwnerEmployee

Review-Employee-
Request.ReviewRequestProcessOwnerFullName

Review-Employee-

Request.ReviewRequestSelfEvaluation TaskAssig

Review-Employee-Request.ReviewStartDate

Review-Employee-Request.ReviewType

Review-Employee.Department
Review-Employee.Email
Review-Employee.Employeeld
Review-Employee.FirstName

Review-Employee.FullName

Review-Employee.LastName
Review-Employee.Middlelnitial

Review-Employee.NamePrefix

Review-Employee.NameSuffix

Review-Employee.ReviewClosedDate

ORACLE
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Description

Employee Id of the review group administrator,
which is the HR Administrator who is the owner
of the reviews belonging to the review group.
Full name (First Initial Last) of the review group
administrator, which is the HR Administrator
who is the owner of the reviews belonging to
the review group.

Date the reviews are generated, as per the
review request

Date on which reviews become available to the
manager.

Name of the review request associated to the
review.

Email address of the administrator of the
associated review request.

Employee Id of the administrator of the
associated review request.

Full name (First Initial Last) of the administrator
of the associated review request.

Date on which the self-assessment become
available to the employee, as per the self-
assessment assignment date defined on the
review request.

Start date of the review period, which is the
same as for the review request.

Review type, as specified in the associated
review request.

Department of the employee being evaluated.
Email of the employee being evaluated.
Employee Id of the employee being evaluated.
First name of the employee being evaluated.

Full name (First Initial Last) of the employee
being evaluated.

Last Name of the employee being evaluated.
Middle initial of the employee being evaluated.

Name prefix of the employee being evaluated,
such as Dr.

Name suffix of the employee being evaluated,
such as PhD.

Date the self-assessment was completed and
closed.

Applicable to

Message Documents and Templates

Message Documents and Templates

Message Documents and Templates

Message Documents and Templates

Message Documents and Templates

Message Documents and Templates

Message Documents and Templates

Message Documents and Templates

Message Documents and Templates

Message Documents and Templates

Message Documents and Templates

Message Documents and Templates
Message Documents and Templates
Message Documents and Templates
Message Documents and Templates

Message Documents and Templates

Message Documents and Templates
Message Documents and Templates

Message Documents and Templates

Message Documents and Templates

Message Documents and Templates
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Variable Category or Variable

Review-Employee.ReviewDraftDate

Review-Employee.ReviewOverallScore

Review-

Employee.ReviewOverallScoreComment

Review-

Employee.ReviewOverallScoreRatingValue

Review-

Employee.ReviewOverallScoreRatingValueName

Review-Employee.ReviewReleasedDate

Review-Employee.ReviewStatus

Review-Employee.Title

Review-Employee.WorkPhone

Review-Employee.WorkPhoneExtension

Review-Manager

Review-Manager.Department

Review-Manager.Email

Review-Manager.Employeeld

Review-Manager.FirstName

Review-Manager.FullName

Review-Manager.LastName

Review-Manager.Middlelnitial

Review-Manager.NamePrefix

Review-Manager.NameSuffix

ORACLE
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Description

Date the employee wrote his self-assessment.

Performance review's overall rating given by the
manager.

Global comment provided by manager in the
Summary section of the review.

Rating value associated to the overall rating of
employee's self-assessment, taken from the
rating model of the review, such as ‘5. This
value is set based on the calculated overall
rating and the rounding value.

Name associated to the rating value, such as
‘Outstanding Performance'.

Date the self-assessment was released by the
employee.

Status of the self-assessment, which can be:
New, Draft, To Be Approved, Under Approval,
Approved, Released, Acknowledgment
Requested, Acknowledged, Cancelled, Closed.

Title of the employee being evaluated.

Work phone number of the employee being
evaluated.

Work phone extension of the employee being
evaluated.

Category of variables associated to
performance reviews performed by managers.

Department of the manager completing the
performance review.

Email address of the manager completing the
performance review.

Employee Id of the manager completing the
performance review.

First name of the manager completing the
performance review..

Full name (First Initial Last) of the manager
completing the performance review.

Last name of the manager completing the
performance review.

Middle initial of the manager completing the
performance review.

Name prefix of the manager completing the
performance review, such as Dr.

Name suffix of the manager completing the
performance review, such as PhD.

Applicable to

Message Documents and Templates

Message Documents and Templates

Message Documents and Templates

Message Documents and Templates

Message Documents and Templates

Message Documents and Templates

Message Documents and Templates

Message Documents and Templates

Message Documents and Templates

Message Documents and Templates

Message Documents and Templates

Message Documents and Templates

Message Documents and Templates

Message Documents and Templates

Message Documents and Templates

Message Documents and Templates

Message Documents and Templates

Message Documents and Templates

Message Documents and Templates

Message Documents and Templates
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Variable Category or Variable

Review-
Manager.ReviewAcknowledgementRequestedDe
Review-Manager.ReviewApprovedDate
Review-Manager.ReviewCancelledDate
Review-Manager.ReviewClosedDate
Review-Manager.ReviewDraftDate

Review-

Manager.ReviewEmployeeAcknowledgementCol
Review-
Manager.ReviewEmployeeAcknowledgementDat
Review-Manager.ReviewFinal Comment

Review-Manager.ReviewMeetingComment

Review-Manager.ReviewMeetingDate

Review-Manager.ReviewOverallScore

Review-Manager.ReviewOverallScoreComment

Review-
Manager.ReviewOverallScoreRatingValue

Review-
Manager.ReviewOverallScoreRatingValueName

Review-Manager.ReviewReleasedDate

Review-Manager.ReviewStatus

Review-Manager.Title

Review-Manager.WorkPhone

Review-Manager.WorkPhoneExtension

ORACLE
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Description

Date a review acknowledgment was requested.

Date the employee's performance review was
approved.

Date the employee's performance review was
cancelled.

Date the employee's performance review was
finalized and closed.

Date the manager wrote the employee's
performance review.

Comments provided by the employee when
acknowledging the review meeting.

Date the manager has set the meeting
acknowledgment.

Comments provided by the manager when
closing the employee's performance review.

Comments provided by the manager upon
acknowledgment of the review meeting.

Date of the review meeting.

Overall rating given by the manager when
closing the review.

Comments provided by the manager when
closing the review.

Rating value associated to the manager's
overall rating of the employee's performance
review, taken from the rating model of the
review, such as ‘5'. This value is set based on
the calculated overall rating and the rounding
value.

Name associated to the rating value, such as
‘Outstanding Performance'.

Date the employee's performance review was
released by the manager.

Status of the employee's performance review,
which can be: New, Draft, To Be Approved,
Under Approval, Approved, Released,
Acknowledgment Requested, Acknowledged,
Cancelled, Closed.

Title of the manager completing the employee's
performance review.

Work phone number of the manager

completing the employee's performance review.

Work phone extension of the manager

completing the employee's performance review.

Applicable to

Message Documents and Templates

Message Documents and Templates

Message Documents and Templates

Message Documents and Templates

Message Documents and Templates

Message Documents and Templates

Message Documents and Templates

Message Documents and Templates

Message Documents and Templates

Message Documents and Templates

Message Documents and Templates

Message Documents and Templates

Message Documents and Templates

Message Documents and Templates

Message Documents and Templates

Message Documents and Templates

Message Documents and Templates

Message Documents and Templates

Message Documents and Templates
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Variable Category or Variable

Review.ReviewLink

Succession-Plan

Succession-Plan.SuccessionPlanApprovalStatus

Succession-Plan.SuccessionPlanDescription
Succession-
Plan.SuccessionPlanJobPositionDescription
Succession-

Plan.SuccessionPlanJobPositionEmployeeFirstN.

Succession-
Plan.SuccessionPlanJobPositionEmployeeFullNa

Succession-
Plan.SuccessionPlanJobPositionEmployeelastNi

Succession-
Plan.SuccessionPlanJobPositionEmployeeMiddle

Succession-
Plan.SuccessionPlanJobPositionEmployeeName|

Succession-
Plan.SuccessionPlanJobPositionEmployeeName!

Succession-
Plan.SuccessionPlanJobPositionManagerEmail

Succession-
Plan.SuccessionPlanJobPositionManagerFullNar

Succession-
Plan.SuccessionPlanJobPositionName

Succession-Plan.SuccessionPlanLink
Summary-
Email.PendingDevelopmentPlanApproval TaskLir

Summary-
Email.PendingFeedbackApprovalTaskLink

Summary-
Email.PendingGoalPlanApprovalTaskLink

ORACLE
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Description

Clickable link for going directly to performance
review requiring approval.

Category of variables associated to an
employee's succession plan.

Approval status of the succession plan, which
can be Not Started, In Progress, Approved or
Rejected.

Description of the succession plan, wish is
currently only displayed in the HR Admin Tools.

Description of the job position for which the
succession plan has been created.

First name of the current job position
incumbent for which the succession plan has
been created.

Full name (First Initial Last) of the current job
position incumbent for which the succession
plan has been created.

Last name of the current job position
incumbent for which the succession plan has
been created.

Middle initial of the current job position
incumbent for which the succession plan has
been created.

Name prefix of the current job position
incumbent for which the succession plan has
been created, such as Dr.

Name suffix of the current job position
incumbent for which the succession plan has
been created, such as PhD.

Email address of the manager responsible for
the job position.

Full name (First Initial Last) of the manager
responsible for the job position.

Name of the job position.
Clickable link for going directly to a succession
plan requiring approval.

Clickable link for going directly to Development
Plan tasks that need completing.

Clickable link for going directly to Feedback
tasks that need completing.

Clickable link for going directly to Goal Plan
tasks that need completing.

Applicable to

Message Documents and Templates

Message Documents and Templates

Message Documents and Templates

Message Documents and Templates

Message Documents and Templates

Message Documents and Templates

Message Documents and Templates

Message Documents and Templates

Message Documents and Templates

Message Documents and Templates

Message Documents and Templates

Message Documents and Templates

Message Documents and Templates

Message Documents and Templates

Message and Documents Templates

Message and Documents Templates

Message and Documents Templates

Message and Documents Templates
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Variable Category or Variable

Summary-
Email.PendingReviewApprovalTaskLink

Summary-
Email.PendingReviewWorkflowTaskLink

Summary-
Email.PendingSuccessionPlanApprovalTaskLink

Task

Task-Participant

Task.AssigneesNames

Task.AssignmentDate
Task.CreationDate
Task.DueDate

Task.Name

Task.OwnerEmailAddress

Task.OwnerFax

Task.OwnerFirstName

Task.OwnerFullName

Task.OwnerLastName

Task.OwnerTelephone

Task.Priority Type

Task.Status

Task.Type

ORACLE
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Description

Clickable link for going directly to Performance
Review tasks that need completing.

Clickable link for going directly to Workflow
tasks that need completing.

Clickable link for going directly to Succession
Plan tasks that need completing.

Category of variables associated to tasks.

Category of variable associated to the
participant of the task, which is the employee to
whom the task is assigned.

Full name (First Initial Last) of all participants,
coma separated.

Date the task is assigned.
Date the task was initially created by the owner.
Due date of the assigned task.

Name of the task, copied from the task
definition.

Email address of the owner of the task, which
can be the manager or the HR administrator,
depending on the task, as defined in the User
Account.

Fax number of the owner of the task, which
can be the manager or the HR administrator,
depending on the task, as defined in the User
Account.

First name of the owner of the task, which
can be the manager or the HR administrator,
depending on the task.

Full name (First Initial Last) of the owner of
the task, which can be the manager or the HR
administrator, depending on the task.

Last name of the owner of the task, which
can be the manager or the HR administrator,
depending on the task.

Telephone number of the owner of the
task, which can be the manager of the HR
administrator, depending on the task, as
defined in the User Account.

Task priority type, such as Low, Normal, High.
Status of the task, which can be CANCELLED,
COMPLETED, ERROR, IN_PROGRESS, NOT_
STARTED, ON_HOLD

Type of the assigned task, which can be Self-
Assessment, Employee Performance Review,

Applicable to

Message and Documents Templates

Message and Documents Templates

Message and Documents Templates

Message Documents and Templates

Message Documents and Templates

Message Documents and Templates

Message Documents and Templates
Message Documents and Templates
Message Documents and Templates

Message Documents and Templates

Message Documents and Templates

Message Documents and Templates

Message Documents and Templates

Message Documents and Templates

Message Documents and Templates

Message Documents and Templates

Message Documents and Templates

Message Documents and Templates

Message Documents and Templates
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Variable Category or Variable Description Applicable to

Feedback Request, Network Invitation, Goal
Plan Approval, Succession Plan Approval, etc.

TaskParticipant.EmailAddress Email address of the participant of the task,as =~ Message Documents and Templates
defined in the User Account.

TaskParticipant.Fax Fax number of the participant of the task, as Message Documents and Templates
defined in the User Account.

TaskParticipant.FirstName First name of the participant of the task, as Message Documents and Templates
defined in the User Account.

TaskParticipant.FullName Full name (First Initial Last) of the participant of Message Documents and Templates
the task, as defined in the User Account.

TaskParticipant.LastName Last name of the participant of the task, as Message Documents and Templates
defined in the User Account.

TaskParticipant.Telephone Phone number of the participant of the task, as Message Documents and Templates
defined in the User Account.

Summary Emails

Multiple task notifications can now be aggregated into a single email.

Summary emails provide Managers and HR Administrators with a single email that includes deep links to their pending
tasks. Instead of receiving a single email for each pending task reminder, a summary email can now be sent that
categorizes and quantifies tasks within the Performance Management module. Each of these categories contain a link
that takes the user to the login page and then directly to the relevant module to complete the task. The summary emails
are automatically updated as the tasks are completed. For example, if a notification is configured to get sent weekly and
a Manager completes 7 out of 9 Review tasks, the summary email sent the following week will only list 2 pending Review
tasks. If a user has no tasks pending, the summary email will not get sent.

Manager and HR Admin task types that are supported:

- Review Approval

« Review Workflow

- Goal Plan Approval

« Succession Plan Approval

- Development Plan Approval
- Feedback Approval

o Note: There are other task types available for non-Managers and non-HR Administrators, however, summary
#  emails support only Manager and HR Admin task types. All other employees will receive standard notification
emails, not summary emails.

As with existing notification functionality, System Administrators configure the notifications by selecting/creating
the message template, determining which tasks should be triggered, and how often the email will be sent. First,
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Administrators create or select the message template to be used in the summary email. The Standard notification for
summary email template is available for summary emails along with the Available Variables to support summary emails.

The appropriate variables must be selected in this template in order to select the corresponding tasks in the summary
email in the next step. For example, if you want to include Review Approval tasks in the summary email, the {Summary-
Email.PendingReviewApprovalTaskLink} variable must be selected in the template. Next, the parameters of the email
are configured in the Global Configuration Summary Email Editor which is found in the Performance Management
Configuration > Global Configurations > Summary Emails.

In the example above, all 6 available Summary Email Task Types have been selected. Each time a summary email
reminder goes out, it will aggregate each of these task types and include the links to take users directly to the
incomplete tasks. At this time 6 is the maximum number of separate summary emails that may be activated at one time.
Each task type can be used only once in summary emails. For example, if Succession Plan Approval is selected for use
on 1summary email, then it is not available for use in another summary email; they are mutually exclusive. This tends to
be sufficient as most tasks are cycle dependent.

The following image is an example of a summary email.
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Summary Email for Julia Savard

Human Resources [hr-v13cs1@invalidemail.com]

Sun 10/6/2013 12:01 AM
Lan Pham

| Message € this_message_in_html.html (1 KB)

Dear Julia Savard,

Please review the following outstanding task list and take necessary action(s). You
can click on the link(s) below and it will take you to your task page.

Review Workflow task(s): 6

Review Approval task(s): 1

Feedback Approval task(s): 0
Development Approval task(s). N/A
Goal Plan Approval task(s): N/A
Succession Plan Approval task(s): N/A

For more detailed information on setting up and configuring notifications, including Summary Emails, please refer
to the Oracle Taleo Enterprise Oracle Taleo Performance Cloud Service Administration Guide, "Correspondence and
Feedback Administration" Release 13C or later.

Configuration
One global configuration setting to support summary emails is available.

User Type Permission

Name Location

Summary Emails Taleo Performance > Configuration > [Taleo Performance] >
Administration > [Global Configurations] > Summary Emails

To Create a Summary Email

A paragraph with the appropriate Summary Email variables, a Summary Email document and a Standard notification for
summary email template need to be created and available for use.

Configuration > [Taleo Performance] Administration > [Global Configurations] > Summary Emails

1. Select Create.

2. Enter a Code, the Start Date of when this email is to begin, and the frequency this email is to be sent by
selecting a value in Repeat dropdown.

3. Search for the Summary Email message template and select.
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4. Select the tasks to be used in the email and select Save.

The summary email is now configured and will be sent automatically at the time intervals defined.

Flexibility for Message Sensitivity Level

Each notification and email message sent by Oracle Taleo Enterprise can be set to a specific sensitivity level. This
feature applies to messages sent from the Recruiting Center, Evaluation Management, Onboarding (Transitions), Legacy
Onboarding, Performance, and SmartOrg.

Each notification and email message can have its own sensitivity level. A "Sensitivity" drop-down menu was added to
the message template editor. A system administrator could, for example, configure specific messages as being Private
(such as messages sent to internal candidates) while keeping a Normal sensitivity level on other messages.

Configuration

A global setting controls the sensitivity level of messages sent by Oracle Taleo Enterprise products. This setting provides
the sensitivity levels supported by Microsoft Outlook (Confidential, Normal, Personal, Private).

Setting Description Default Value Location
Mail Sensitivity Sensitivity of email messages sent from = Normal Configuration > [General Configuration]
the system. Settings

Possible values are:

Confidential
Normal
Personal

Private

System administrators can now override this global setting by configuring the sensitivity level of specific email
messages. This is done via the message template editor, by using the new "Sensitivity" drop-down menu.

Five sensitivity levels are available:

- Default
- Normal
- Private
- Personal

- Confidential

Selecting the "Default” sensitivity level means that email messages sent using this message template will use the
sensitivity level defined in the "Mail Sensitivity" global setting.
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Working with Feedback Correspondence

Setting Feedback Requests and Responses

Messages templates can be set for feedback requests, responses, and approvals and then selected as an email
notification to be sent to the user's email address when a feedback is requested or provided. If you want to incorporate a
feedback approval process, see Feedback Approval for setting and message template details.

Configuration > [Taleo Performance] Administration > [Global Configurations] Message Templates

Configuration > [Taleo Performance] Administration > [Global Configurations] Feedback Correspondence

1. From the Message Templates page create, either from an existing document or from scratch, the feedback
message template with the desired request or response notification type and the Feedback-Request variable
group.

2. Activate the feedback request or feedback response message template to make it available for selection.

3. From the Feedback Correspondence page, click Edit to select the desired feedback request template and/or
feedback response template for the desired modules.

Feedback notifications are available for feedback requests or responses originating from goal plans,
performance reviews succession plans, career plans, development plans and the feedback journals.

4. Save your selections.

If no message template displays in the list or if the one you just created does not appear, make sure you have
activated the template.

The message template you have selected will be sent when a feedback request or response is sent, with the information
as per the chosen variables in the message template.

Configuring Feedback
Even if feedback is always available, there are a few settings that provide the ability to define the behavior of feedback.

Configuration > [Taleo Performance] Administration > [Global Configurations] Settings

1. Refine the settings to find the Feedback category settings.
2. Depending on the desired feedback behavior, define settings.

Feedback Approval
This allows feedback to be reviewed and approved before being sent to recipients.

Feedback approval consists of the following:
- approval can be requested when responding to a feedback request or when providing unsolicited feedback

- the person providing feedback has the option to select anyone as the feedback approver
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- requesting feedback creates an approval task for the approver, subsequently rejecting feedback creates a
resubmit task for the provider

- notification of feedback approval and rejection tasks can be displayed in Taleo Inbox

- selecting an approver is optional, not selecting one sends the feedback directly to the recipient

Configuration

Configuration > [Taleo Performance] Settings
Name Description

Enable Feedback Approval Enables feedback approval functionality in the system. It controls if the approver selector and
details are displayed in the feedback form and if the Status column is displayed in the Sent view of
the Feedback Journal. It also controls the approval workflow mechanism. Disabled by default.

The following message templates are used for feedback approval.

Configuration > [Taleo Performance] Message Templates

Type Description

Standard notification for feedback approval This is used when the approver has made a decision on the feedback. If it is approved, it is sent

completion to the recipient. If it is rejected, the feedback author can update the feedback and resubmit it for
approval.

Standard notification for a feedback approval This is used to notify someone they have been asked to approve feedback.

These message template variables are used to identify the employees and subjects of the feedback approval.

Configuration > [Taleo Performance] Message Templates

Variable Description

{Feedback.FeedbackAuthorName} This is the approver who is providing approval of the feedback request.
{Feedback.RequesterName} This is the person who is providing feedback and making the request to have it approved.
{Feedback.SubjectEmployeeName} This is the subject of the feedback. It can be an employee or it can be an object, such an employee

goal or development activity.

Feedback Deletion

The Feedback Deletion feature provides customer system administrators having the Integrator role the ability to
remove feedback comments and ratings from Performance that is deemed inappropriate, inaccurate or not adhering
to organizational communication and feedback policies. Feedback deletion is done with the Taleo Connect Client (TCC),
using an addition to the Performance PIP (product integration pack).
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Introduction.

Inappropriate or inaccurate feedback may be entered into Performance by end-user "providers" of feedback. The
administrator may perform feedback deletion as needed, or as a regularly scheduled task (for example 3-4 times per
year). The deletion process involves the administrator performing an export of feedback content to a CSV file. Since
providers often enter feedback content using a rich text editor field, the exported content can contain HTML formatting
code that makes it hard to read the content in the CSV file. This formatting code must be removed upon export for the
administrator to be able to read the feedback content.

The system administrator uses the TCC to perform the following steps:

1. Use TCC to export the feedback content to a CSV file and run a transformation to cleanse the CSV file of rich
text formatting code.

2. Use Excel to select rows in the CSV file for removal, and then use the TCC to run an import operation to delete
them from the production database.

To Perform Feedback Deletion

Prerequisites

- System administrator access with Integrator role.
- Access to, working knowledge of and experience with using TCC.

- Zip file (feedbackdelete.zip) with template files listed below.

Note: Obtain the Zip file from one of the two following locations:
1. My Oracle Support (MOS). Where the Performance 13C Release Notes are posted. (URL https://
o mosemp.us.oracle.com/epmos/faces/DocumentDisplay)
4 2. Taleo Knowledge Exchange. In the Topics > Enterprise Taleo Performance > Documents section. (URL
http://knowledgeexchange.taleo.com/login.jspa)
Unzip the template files (especially template.txt and transformfeedback.xsl) to a directory on your local
machine and have them available for when you perform the feedback deletion process.

ZIP File Contents
File Name Purpose

template.txt Template TXT header file for your use. Specifies header information for the CSV export file. This file is
needed to do the rich-text-to-plain-text column transformation. The post-processing transformation is
done post-export, since this type of transformation is typically not done for regular TCC exports.

transformfeedback.xsl Template XSL transformation file for your use. Specifies processing information for post-processing
transformation of CSV export file. This file is needed to convert rich text file to plain text. The post-
processing transformation is done post-export, since this type of transformation is typically not done
for regular TCC exports.

feedback_sqg.xml Example XML export file provided for your reference. Specifies what needs to be exported and in
what format: columns, aliases for columns, paths for the columns, filters, what output format will be
defined for the export file (e.g. CSV or TXT), and whether the output file will contain a header row.
The feedback_sqg.xml is created using the New Export Wizard. In the example procedure below, we are
recommending using the wizard to generate the version of this file needed for the export.

feedbackExport_cfg.xml Example XML configuration file provided for your reference. Specifies names and locations of how
to get export data (Request, e.g. feedback_sq.xml); where to store the output (Response, e.g. export
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ZIP File Contents

File Name Purpose

CSV); what template to be used for the export (e.g. template.txt), and whether any post-processing file
(transformfeedback.xsl) is used. The feedbackExport_cfg.xml is created using the New Configuration
Wizard. In the example procedure below, we are recommending using the wizard to generate the
version of this file needed for the export.

Process Example. The following is an example detailing the steps in the Feedback Deletion process:

Step One: Use TCC to export the feedback content to a CSV file and run a transformation to cleanse the CSV file of rich
text formatting code.

In this step you export feedback content to a CSV file. Feedback content can contain HTML formatting code if it was
originally entered using the rich text editor field. The export includes a post-processing transformation to cleanse the
CSV file's feedback content of any such HTML code, making the feedback content readable as plain text.

Open TCC

a. Click the start icon for the TCC.

b. On the Ping the Taleo Product screen enter the following:
- Endpoint server.

« Host server.

- Authentication information.

c. Click Ping.

Create Export

a. In the menu bar select New > Export Wizard.

b. In Select an Exportable Entity, choose the Feedback data model.

c. In Template, select Create New Export.

d. Click Finish. The New Export screen opens.

e. In Outline, click General.

f. In the General section, under Other Information, set the Export Mode to T-XML.
g. In Outlineg, click Projections.

h. Build the list of columns for the export file (e.g. Author First and Last, Comment ID#, Feedback Content). Under
Model Entity Structure select a field desired for your export file and drag/drop it into the Projections section. (For
example: Author Last Name, Author First Name, ID Number and Feedback Content. It may be all you may need are ID
Number and Feedback Content.)

o Note: It may be all you need are the ID Number and Feedback Content fields in your CSV file to locate any bad
#  content. Other useful fields might be one of the dates (Creation, Last Modified, or Sent.) You can make this
determination of what fields to export to the CSV file.
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f Note: You do not need to add aliases for the fields. The template.txt headers override any aliases created for
the export columns on this page.

i. In Outline, click Filters.

j. Click Add to specify filter values to reduce the number of rows of data exported. For example, you might want to
narrow down the date to when the content was last updated, in which case you define a filter condition against Last
Modified field.

k. In the Filter dialog select Add a Simple Filter option.
1. In the One Parameter Operator Filter section enter the following:
- Set Value to Last Modified Date.
- Set Data Type to Field.
- Set Operator to Greater Than or Equal To.
- Set the second Value to the last date you checked for inappropriate data (e.g. 6-months ago on 2013-07-02).
- Set the second Data Type to Date.

This fictional example reduces the export data to content entered on or after July 2, 2013, the last time you checked for
inappropriate data. Another useful set of filter columns might be Author First and Last Name, if you want to only export
feedback provided by a particular person.

m. Save the modifications to the file as feedback2_sg.xml on your local directory.

Create the Configuration

a. To set up the configurations select New > Configuration Wizard.

b. On the Content screen, set to Based on Export Specification and set the filename to feedback2_sqg.xml. Click Next.

¢. On the Environment Information screen, set the Product to yours (such as Performance 13C), and the Endpoint to your
zone (such as Default W03953.wwcorp.net).

d. Click Finish. The New Configuration, General screen displays.
e. Set up the Request and Response information.

Under Request, set the Format to SQ-XML. Select Pre-defined Value and in File enter feedback2_sq.xml file.

Under Response, set the response type to Text. Select Pre-defined Value and in File enter the desired export
CSV file name (e.g. feedbackexportl.csv).

f. Under Outline, select Post-Processing to add the post-processing transformation that converts the rich text to plain
text. Click Add.

g. Select "Add a new XSL based transformation step" and click OK.
h. The Post-processing screen opens.

i. In Transform with XSL, fill-in the location of the XSL transformation file (transformationfeedback.xsl) and header
template file (template.txt) on your local machine.

j. Set the export mode to T-XML and the output format to Text.
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Note: The columns in the export file must match those in the template.txt and transformfeedback.xsl files.

f You will need to edit the files to ensure the columns and column orders match. It is critical that the listed
column order must match, and as best practice, the field name labels match the referenced columns, so they
are consistent.

k. Save the configuration file to your local machine as feedbackexport1_cfg.xml.
Run the Export Process With Transformation

a. Click the Process (Gear) button on the top toolbar to start the export with transformation.
b. The URL link to the output file appears in the right side TCC Monitoring pane.
c. Click the link to view the CSV output file.

d. The feedback content is stripped of any HTML formatting code, converted to plain text, and transformed to CSV
format.

e. The CSV output file bears the filename you gave it on the New Configuration, Post-processing page.

Step Two: Use Excel to Select Rows in the CSV File for Removal, Then use the TCC to Run an Import Operation to Delete
Them from the Production Database.

In this step use excel to select rows in the CSV file for removal, and then use the TCC to run an import operation to
delete them from the production database.

Use Excel to Select Rows in the CSV File for Removal
a. Open the output CSV file from Step One (e.g. feedbackexportl.csv) in Excel.

b. Review the feedback content for each row to identify any inappropriate or inaccurate feedback that needs to be
deleted.

¢. Manually remove the rows of data for all desired content you do not want deleted from the database, leaving only the
header row and the rows for the undesired content you want to delete.

d. Save your changes as feedbackdeleteinput.csv.

Use the TCC to Run an Import Operation to Delete Them from the Production Database
Create a New Import

a. From the menu bar Select File > New > Import Wizard.

b. In the Select a Service section select Feedback.

¢ In the Template section, select "Use the following import template”. In Template select "Basic Feedback delete". Click
Finish.

d. Save the import file as feedbackdelete_ld.xml. Use the File Type selector to apply the type *_ld.xml.
e. Open the feedbackdelete_ld.xml file if it is not already open.

f. Under Outline select Columns.

g. Set the column you want to have appear in the feedback delete input file (e.g. the ID Number).
Create the Import Configuration

a. From the menu bar select File > New > Configuration.
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b. On the Content screen select "Based on Input Specification, and set File to feedbackdelete_ld.xml. Click Next.

. On the Environment Connectivity screen enter the Product (e.g. Performance 13C) and Endpoint server for your
zone(e.g. W03953.wwcorp.net).

d. Click Finish.

e. Enter the Request input file (feedbackdeleteinput.csv) and Response output file (feedbackdeletoutput.csv).
f. Save the file as feedbackDelete_cfg.xml.

Run the Import Deletion Process

a. Click the Process button.

b. The URL link to the feedback delete output file (feedbackdeleteoutput.csv) displays in the TCC Monitoring pane. Click
the link to open the output file.

c. You can check TCC log and the output file for deletion success or failure for each row.
What the User Sees in Feedback

Feedback deletion does not delete the feedback request or cancel a task. It clears the inappropriate feedback content
and rating value from the feedback-related tasks and feedback journal. The comment text field is blanked out. The
feedback rating that goes along with the comment is also reset to "Not Rated".
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7 Employee Management Administration

Employee Reconcile Feature

The employee reconcile feature is offered as a service through Taleo Connect Client where two employee records can be
merged.

The employee reconcile feature allows for data elements that exist in two records for a single person to be merged into
a single, surviving record in the system. This feature addresses limitations in reconciling duplicate records that may
exist in the system for candidates, users and employees. It eliminates duplicate entries for employees by allowing for
the system to merge data from one employee record to another employee record. In cases where there is duplicate
candidate data, the system allows for the candidate data to be replaced.

This feature is leveraged exclusively through integration and does not have a user interface component.

The typical scenario for using this feature would be to recover from an employee import mistake that has occurred. The
reconciliation could also be used to merge an existing candidate record with an employee record imported from an HRIS
system. It is not expected to have duplicate employees in the system for which we have both engaged processes. For
example, it is not likely that one record has a series of goals and another record for the same person is included in a
succession plan and has had multiple reviews.

Working with Team Management

Team Management

Team Management provides managers with a self-service tool for performing employee changes and maintaining
information about their employee-manager relationships.

In the Talent Browser, a manager can request a change for members of his team. The manager can either take an
individual he sees on his team and request that he be managed by someone else, or request that someone who is not
shown on his team be added to his direct reports. As part of this process, the manager can also update data about the
employee.

Depending on the standard field configuration for team management, the manager can have the ability to edit an
employee's manager, current job role, location and organization. These changes can be configured to require approval.
In such cases, the approval workflow must also be specified as part of the configuration.

In the event that a manager would like to remove a direct report from his team but does not know the name of the new
manager, he can simply leave the manager name blank. The HR administrator will be required to assign the employee a
new manager in order to approve the request.
Following is a list of possible team management actions:

- Add an employee from another team

- Add a matrix manager

- Change an employee's manager, thus moving the employee to another team
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- Change an employee's organization

- Change an employee's location

- Change an employee's job field

Each type of change can be set to require approval, but a justification is always required for a change to be processed.

All requested or rejected changes are indicated on the employee's card in the Talent Browser.

Enabling Team Management

Enabling Team Management gives authorized users the possibility of performing employee change requests.

Configuration > [Taleo Performance] Settings

1. Inthe Product Settings page, find and select the setting Enable Team Management.
2. Inthe Enable Team Management page, click Edit.
3. Inthe editor page, in the Value section, select Yes.

By default, Team Management is set to No, thus disabled.

4. C(Click Save.

When enabled, Team Management is available to HR administrators via the Navigation bar's HR Administration
dropdown.

Once enabled, Team Management functions can be disabled again if needed.

Defining the Job Position Behavior

Defining the job position behavior consists in specifying how the job position will be handled when an employee is
moved from one manager to another.

Configuration > [Taleo Performance] Settings

1. Inthe Product Settings page, find and select the setting Job Position Configuration.
2. Inthe Job Position Configuration page, click Edit.

3. Inthe Editor - Job Position Configuration page, in the Value section, select the desired behavior to be applied to
the job position when an employee is moved from one manager to another.

o Move also the job position if applicable - When an employee move is requested and approved, the job
position will also be moved.

By default, the job position of an employee remains with the current manager.

4. C(lick Save.

Depending on the selection behavior, when an employee move is performed in Taleo Performance, the job position
will either be moved to the new manager or remain with the current manager. The employee move might even not be
allowed.
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Configuring Team Management

Configuring Team Management allows system administrators to select the information that can be changed by
authorized users when approving employee change requests and to define the applicable approval workflow.

Configuration > [Taleo Performance] Administration > [Employee Management] Team Management
Configuration

1. In the Team Management Configuration page, click Edit next to Standard Fields.
2. Inthe Standard Field Availability Editor page, determine which information can be edited and if editable,
indicate if approval is required.

If approval is not required, any employee change that is requested will be applied automatically.
Click Save.
Back to the Team Management Configuration page, click Edit next Approval Workflow.

In the Approval Workflow Editor page, select from the available user roles the ones to which you want to grand
approver rights and click Add.

v AW

You can also select a specific user to be part of the approval workflow by clicking Add Users.

6. To define the order in which the approval is to be performed, sort the approvers sequentially by using the up
and down arrows.
7. Click Save.

The Team Management Configuration page will show the information as it was defined.

Matrix Management

Matrix management provides the ability to assign employees, for a specific period, to matrix or proxy managers that can
participate in reviews, goals and any other tasks on behalf of the primary manager.

Matrix management is a technique of managing an organization (or, more commonly, part of an organization) through
a series of dual-reporting relationships instead of a more traditional linear management structure. In its simplest form,
a matrix configuration may be known as a cross-functional work team, which brings together individuals who report to
different parts of the company in order to complete a particular project or task. Another example would be an employee
who is managed by multiple supervisors, where the primary manager has named matrix managers for his employees.
In all such cases, the matrix managers need to participate in the tasks related to the employees they were assigned,
whether that be to write a performance review, approve a goal plan or even to assign development activities.

The matrix management feature provides important management functions:

- Allows managers to share their work responsibilities and administrative tasks with matrix managers who may
act on their behalf.

- Allows managers or HR administrators to appoint temporary resource managers. In case that a primary
manager is unavailable or on a leave, their tasks and performance management functions may be conducted
by the matrix manager.

- Allows matrix managers to participate in performance management functions of employees who work in cross
functional teams. It is important to note that to be entitled to participate in a review, matrix managers must also
be made review collaborators.
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Matrix managers are also added to the security relationships as matrix managers. In other words, matrix managers have
both ownership and matrix manager security access.

A matrix manager can participate in various performance management processes such as reviews, goals, development
plans, and succession plans. They may participate by conducting the tasks and actions of the primary manager or by
directly providing input to these processes. However, for a matrix manager to edit or write an employee review, it must
also be assigned as a review collaborator.

In Taleo Performance, matrix management is performed via the Talent Browser and provides the following capabilities:

- Delegated Employee View - This view of the organizational chart allows a matrix manager to view all employees
that have been delegated to him, indicated by a dotted line. The delegated employee performance card
indicates also the number of matrix managers each has.

- Manage Matrix Management Relationships - Via the “Manage Matrix Manager” action, a user can appoint
a matrix manager to all or some of his employees and assign his tasks. When managing matrix managers,
managers can add or remove matrix managers they have assigned as well as view a list of the employees they
have delegated to each matrix managers.

- Task Delegation - When a manager chooses to delegate his tasks to the matrix manager, the tasks that would
normally go to the primary manager are also be sent to the matrix manager, and therefore show in both the
primary manager and the matrix manager's task list. The tasks that are delegated are those that are in relation
to the delegated employees; for instance, tasks like network invitation sent to the primary manager would not
be delegated to the matrix manager. Once the task is completed by either the original manager or one of the
matrix managers, the task is considered complete and it is deleted from the task list.

- Matrix Manager as Review Approvers - A matrix manager may be selected as an approver type in a review's
approval workflow. In such a scenario, the matrix manager will be notified when a review reaches the approval
stage in the workflow and will be able to approve/reject the review as desired.

- Searching Amongst Delegated Employees - A user that has been named matrix manager can use the People
Selector to search for people amongst their delegated employees.

There are various tasks and actions that a matrix manager may perform. In order for the matrix manager to receive
tasks and complete the associated actions, the primary manager must have also delegated his tasks to matrix manager.
Following is a table listing all the actions than can be performed by matrix managers versus those allowed to review
collaborators.

Task or Action Tasks that can be done by a collaborator Tasks that can be done by a matrix manager*

Write Employee Review (initial, rejected or Yes No
restarted review)

Submit for Approval No Yes
Reopen for Approval No Yes
Decide on Approval No No (unless the matrix manager is defined

as an approver in the review workflow
or the original approver has delegated
his tasks to this matrix manager)

Release Employee Review No Yes
Request Acknowledgment No Yes
Acknowledgment No No

The matrix manager cannot acknowledge
the review on behalf of the employee
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Task or Action Tasks that can be done by a collaborator Tasks that can be done by a matrix manager*

even if the "Allow manager to override
employee acknowledgment" setting
is active in review process definition.

Send Review Back to Employee No Yes
Cancel Review No No
Transfer Review No No
Manager Review Collaborators No No
Notified of task 'Write Employee Review' or Yes Yes

'Reopen for Approval' via Task List
Notified of task 'Submit for Approval', 'Release’, No Yes

'Request Acknowledgment' or 'Close’ via Task
List

*Note that if a matrix relationship is created before review generation, the matrix manager is automatically added as a
review collaborator and therefore be able to perform the tasks allowed to collaborators.

Like the primary manager, the matrix manager is entitled to send a review back to an employee under the following
conditions:

- Aslong as the review is in a Draft status and not yet submitted for approval, and
- If the review request configuration indicates that this action is possible (via the setting 'Allow Manager to
Restart Review Workflow'
HR administrators are can configure matrix management options as follows:
- View, edit, and delete matrix management relationships created by managers, for any coverage area.

- Create new matrix management relationships on behalf of managers, for any coverage area. The managers are
in turn entitled to view, edit, and delete those matrix relationships created by the HR administrator.

Configuration
Matrix management functions are optional and must be configured with the proper settings and user permissions.

Settings from Configuration > [SmartOrg] Settings

Setting Name Setting Description Possible Values Security Level Setting Category
Matrix Management Enables matrix « Yes Public Matrix Management
Enabled management

functionalities allowing a + No (default)

manager to delegate his
tasks to another manager.

Extended Matrix Indicates if matrix manager - Yes Public Matrix Management
Management relationships also apply
to the direct reports of + No (default)
delegated employees.
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Setting Name Setting Description Possible Values Security Level Setting Category
Maximum Number of Indicates the maximum - 5(default) Public Matrix Management
Matrix Managers number of matrix manager

relationships that can be

set for an employee.
Maximum Number of Indicates the maximum - 5(default) Public Matrix Management
Matrix Management number of matrix
Requests management requests a

manager can have at the

same time.
Employee Change Matrix Indicates how matrix - Keep matrix managers Public Matrix Management

Management Behavior manager relationships are
handled when an employee

changes manager.

Remove matrix
managers (default)

In addition to the configuration settings, users need to have specific permissions granted to be allowed to perform

matrix management functions.

Permissions Configuration > [SmartOrg] Administration > [Users] User Accounts

Permission Name

Performance > Team Management > Access Talent Browser

Performance > Performance Reviews > View - If the user is a matrix
manager

Performance > Performance Reviews > Manage - If the user is a
matrix manager

Performance > Goal Plans > View - If the user is a matrix manager
Performance > Goal Plans > Manage - If the user is a matrix
manager

Performance > Career Plans > View - If the user is a matrix manager

Performance > Career Plans > Manage - If the user is a matrix
manager

ORACLE

Setting Description

This permission grants the user access to the Talent Browser. This
permission must be granted in conjunction with the appropriate View/
Manage permission listed below.

If a user has this permission, he will be entitled to perform matrix
management requests; however, to perform delegated tasks, he will
need, for each context, to have the View - If the user is a matrix manager
or the Manager - If the user is a matrix manager permission.

**|f an organization wants to let the managers perform matrix
management requests but not any employee change requests, the
administrator needs to disable the editability of all Team Management
Standard Fields (such as the manager, organization, location, and job
role).

This permission allows the user to view and/or manage performance
reviews if designated as a matrix manager.

This permission allows the user to view and/or manage goal plans if
designated as a matrix manager.

This permission allows the user to view and/or manage career plans if
designated as a matrix manager.
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Permissions Configuration > [SmartOrg] Administration > [Users] User Accounts

Permission Name

Performance > Development Plans > View - If the user is a matrix
manager

Performance > Development Plans > Manage - If the user is a matrix
manager

Performance > Employee Metrics > View - If the user is a matrix
manager

Performance > Employee Metrics > Manage - If the user is a matrix
manager

Performance > Employee Profile > View - If the user is a matrix
manager

Performance > Employee Profile > Manage - If the user is a matrix
manager

Performance > Team Management > Access administration tools

Performance > Team Management > Access Manage Matrix Manager

Setting Description

This permission allows the user to view and/or manage development
plans if designated as a matrix manager.

This permission allows the user to view and/or manage employee
metrics if designated as a matrix manager.

This permission allows the user to view and/or manage talent profiles if
designated as a matrix manager.

This permission grants the user access to the HR Administration Tools.
This permission, in conjunction with 'View as another employee' is
required to allow an HR administrator to manage (create, view, edit,
delete) matrix management relationships.

This permission is required for the logged in user to have the option
available from their card in the Talent Browser.

Aside from the configuration settings and permission, the matrix manager role has been added to the list of available
roles in the Role Selector when setting the approvers of a review definition. Furthermore, the matrix manager can also

be designated as a calibrator.

Team Management Fields

Fields related to team management in Taleo Performance Administration are presented in the following table. Each
entry in the table includes a field or button, a description, possible values (when they are predefined), the part of the
application to which the field applies and the field's section header.

Field Description

Add Users Link opening the User Selector to
choose specific users to include in

the approval workflow.

Shows the defined roles
responsible for the approval of
team management changes, in the
applicable order.

Approval Workflow

ORACLE

Applicable to Header

Team Management Approval Workflow

Team Management Approval Workflow
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Field

Approval Workflow

Assignment Correspondence

Available Approval Roles

Completion Correspondence -
Approval

Completion Correspondence -
Rejection

Completion Correspondence -
Termination

Current Job

Editable

Location

Manager

Name

Organization

Requires Approval

Description

Box that lists all selected roles to be
part of the approval workflow for
team management changes. In Edit
mode, the roles can be reordered
as desired using the up and down
arrows.

Field that indicates the message
template to use when an approval
task is assigned.

Box that lists all the roles that
are available for approving team
management changes.

Field that indicates the message
template to use when an approval
process is completed by an
approval.

Field that indicates the message
template to use when an approval
process is completed by a
rejection.

Field that indicates the message
template to use when an approval
process is terminated.

Field used to change the current
job of an employee.

Option that indicates whether the
field is editable or read-only.

Field used to change the location
of an employee.

Field used to change the manager
of an employee.

Column heading showing the
name of standard fields where
changes can be made

Field used to change the
organization of an employee.

Option that indicates whether a
change to the value of the field
needs to be approved.

Employee Metrics

Applicable to

Team Management

Team Management

Team Management

Team Management

Team Management

Team Management

Team Management

Team Management

Team Management

Team Management

Team Management

Team Management

Team Management
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Header

Approval Workflow

Approval Workflow

Approval Workflow

Approval Workflow

Approval Workflow

Approval Workflow

Standard Fields

Standard Fields

Standard Fields

Standard Fields

Standard Fields

Standard Fields

Standard Fields

Employee metrics represent employee information that can be used for analysis or calibration purposes or to show
summary information about an employee.

ORACLE
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The employee metrics that are configured to be displayed and/or edited are reflected in various locations:

- in the Talent Profile

- in the employee's performance card and summary profile

- in the Employee Details window, available from the performance card

 in the Talent Snapshot
Employee metrics can also be used as dimension types for the X and Y axes in matrices. This can affect which people

are automatically rated on a matrix and which people can have their metrics updated. Users with fewer employee metric
user permissions will typically see a larger unrated population.

If configured to be editable, the employee metrics under the Metrics section of the Talent Profile will be editable by the
authorized users.

Users need to have the proper user type permissions to be entitled to view and/or edit the employee metrics.

The Potential, Promotability Readiness, Reassignment Candidate, Risk of Loss, and Impact of Loss employee metrics
can also be customized to have values that better represent your company's terminology and use of these metrics.

Please refer to the list of employee metrics to see which metric can be displayed or available where.

Configuration
The metrics are by default not displayed and not editable.

Metric configuration is performed via the following:

Location Description
Configuration > [Taleo Performance] This section allows to define which metrics are to be displayed and which ones are to be editable.
Administration > [Employee Metrics can only be edited via the Talent Profile.

Management] Metrics Configuration

Permissions and settings:

Permissions: Configuration > [SmartOrg] Administration > [Users] User Accounts

Permission Name Setting Description

Performance > Employee Metrics > View This permission grants the user read-only access to metrics configured
to be displayed.

Performance > Employee Metrics > Manage This permission grants the user write access to metrics configured to be
editable.

Compensation > Compensation Data > View compensation history This permission grants the user read-only access to compensation
history information. If the user does not have this permission, no
compensation metrics will be seen.
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Showing Rating Metrics as Real Values

Metrics related to ratings can be configured to display as the actual values of the rating model instead of as the
normalized values used for calculations and updates.

Various metrics are used in the application to display ratings on the employee. However, for some of these metrics,
the only information available is the normalized rating, that is a calculation of the actual rating expressed as a value
between 0% and 100%. As this percentage value does not provide significant meaning to the customer, settings are
offered to provide the possibility for customers to display the ratings as their actual values.

Note that those real ratings will only apply for displaying the metric values; the normalized ratings will still be used for all
calculations and updates on the values.

CALCULATION FORMULA
N=Normalized Rating Value
C=Current Rating Numerical Value
L= Lowest Rating Numerical Value

H=Highest Rating Numerical Value

Normalized Value Current Value
N=(C-L)/(H-L) C=(N*(H-L)+L

For the system to display the current metric ratings, a new service has been developed to retrieve the normalized value.
This service then uses a setting and the rating dimension configured for this metric to determine the way to display the
rating.
The ratings that can be shown as the actual values, and not normalized, are the following:

- Review - Current Review Status

- Review - Last Focal Review Rating

- Employee - Review Rating

- Employee - Competency Rating

- Employee - Goal Rating

Configuration

The following settings provide the ability to configure ratings to show as real values. It is important to note that these
settings do not affect the performance review itself but just the employee metrics related to ratings.

Configuration > [General Configuration] Settings

Setting Name Setting Description Possible Values Security Level Setting Category
Metric Rating Display Indicates the display format - Asa percentage - Public General Settings
of rating values, based on a Rating displayed as a

set of predefined formats.
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Configuration > [General Configuration] Settings

Setting Name

Metric Rating Model
Rounding

"Review Rating" Metric
Rating Model

"Goal Rating" Metric
Rating Model

"Competency Rating"
Metric Rating Model

ORACLE

Setting Description

Indicates the rounding
percentage used to
determine the rating value
corresponding to a given
score.

Indicates the rating model
used to determine the
available values for the
"Employee — Review
Rating" metric.

Indicates the rating model
used to determine the
available values for the
"Employee - Goal Rating"
metric.

Indicates the rating model
used to determine the
available values for the
"Employee - Competency
Rating" metric.

Possible Values

normalized value (e.g.
70%)

« In numeric format
(default) - Rating
displayed as a
rounded numerical
value (e.g. 4)

- In numeric format
with rating scale -
Rating displayed as
a rounded numerical
value with the
applicable rating scale

(e.8-4[1,5])

- In text format - Rating
displayed as a textual
rating (e.g. Excellent)

» In text and numeric
format - Rating
displayed as a textual
rating and a rounded
numerical value (e.g.
Excellent (4))

Any chosen value between

1and 100.

Any active rating model

Any active rating model

Any active rating model

Chapter 7
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Security Level

Public

Public

Public

Public

Setting Category

General Settings

General Settings

General Settings

General Settings
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Ratings Displayed as Actual Values

Ratings that can be displayed as  Available in the Metrics section Available on the Performance Available on the Employee
actual values of the Talent Profile Card Details window

Review - Current Review Status Talent Profile - Metrics section Yes Yes

Review - Last Focal Review Rating = Talent Profile - Metrics section Yes Yes

Employee - Review Rating Talent Profile - Metrics section No No

Employee - Competency Rating Talent Profile - Metrics section No No

Employee - Goal Rating Talent Profile - Metrics section No No

To Configure Employee Metrics Permissions

Configuration > [Taleo Performance] Administration > [Employee Management] Metrics Configuration

1. Click Edit.
2. Inthe Display column, select the checkbox for the metrics you want users to see.

3. Inthe Edit column, select the checkbox beside the metrics you want users to be able to modify in the Talent
Profile.

Not all metrics can be made editable.

Selected metrics are displayed in a user's talent profile.

Employee Metrics Fields

All of these fields can be enabled and disabled for your system as required, but only the employee metrics (in the
Employee section) can be edited in the Talent Profile, as indicated in the table. The * indicates the metrics are
configurable and may not have the default values.

Metrics Available Available in the Available on Available on Can be set to be Always available  Always available
Metrics section of Performance Card Employee Details editable (in the in matrices in charts, for
the Talent Profile Talent Profile analysis and
only) calibration
Position - Critical Yes Yes Yes No No Yes
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Metrics Available

Succession
- Number of
Successors

Succession
- Interim
Replacement

Succession -
Replacement
Name

Succession - Bench
Strength

Succession
- Number of
Succession Plans

Career - Number of
Career Scenarios

Career - Job Role
in Career Plan

Goal - Status

Goal - Average
Progress

Goal - Last Update

Review - Current
Review Status

Review - Last Focal
Review Rating

Review - Current
Review Rating

Review - Current
Review Section
Rating

Employee - Review
Rating

Employee -
Competency
Rating

Employee - Goal
Rating

ORACLE

Available in the
Metrics section of
the Talent Profile

Yes

Yes

Yes

Yes

Yes

Yes

No. This metric
was added

for calibration
purposes.

Yes

Yes

Yes

Yes

Yes

No. This metric
was added for
review calibration
purposes.

No. This metric
was added for
review calibration
purposes.

Yes

Yes

Yes

Available on
Performance Card

No

Yes

Yes

Yes

No

Yes

No. This metric
was added

for calibration
purposes.

Yes

Yes

Yes

Yes

Yes

No. This metric
was added for
review calibration
purposes.

No. This metric
was added for
review calibration
purposes.

No

No

No

Available on
Employee Details

Yes

Yes

Yes

Yes

No

Yes

No. This metric
was added

for calibration
purposes.

Yes

Yes

Yes

Yes

Yes

No. This metric
was added for
review calibration
purposes.

No. This metric
was added for
review calibration
purposes.

No

No

No
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Can be set to be
editable (in the
Talent Profile
only)

No

No

No

No

No

No

No

No

No

No

No

No

Not applicable.

Not applicable.

Yes

Yes

Yes

Always available
in matrices

No

No

No

No

No

No

No

No

No

No

No

No

No

Yes

Yes

Yes

Always available
in charts, for
analysis and
calibration

No

No

No

No

No

No

No

No

Yes

No

No

No

Yes

Yes

Yes

Yes

Yes
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Metrics Available

Employee -
Potential*

Employee - Risk of
Loss*

Employee - Impact
of Loss*

Employee -
Reassignment
Candidate*

Employee -
Promotability
Readiness*

Employee - Gap
Analysis Score

Employee - Years
in Industry

Employee - Years
in Management

Development
- Number of
Activities

Development
- Development
Overall Progress

Development - Has
Development Plan

Compensation -
Current Salary

Compensation -
Salary Increase

Compensation -
Target Bonus

Compensation -
Non-vested Stock

ORACLE

Available in the
Metrics section of
the Talent Profile

Yes

Yes

Yes

Yes

Yes

Yes

Not applicable.
This information
always shows

in the Job
Preferences
section.

Not applicable.
This information
always shows

in the Job
Preferences
section.

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Available on
Performance Card

Yes

Yes

Yes

No

No

No

Not applicable.

Not applicable.

Yes

Yes

No

Yes

Yes

Yes

Yes

Available on
Employee Details

Yes

Yes

Yes

No

No

No

Not applicable.

Not applicable.

Yes

Yes

No

Yes

Yes

Yes

Yes
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Can be set to be
editable (in the
Talent Profile
only)

Yes

Yes

Yes

Yes

Yes

No

Not applicable.

Not applicable.

No

No

No

No

No

No

No

Always available
in matrices

Yes

Yes

No

No

Yes

No

Yes

Yes

No

No

No

No

No

No

No

Always available
in charts, for
analysis and
calibration

Yes

Yes

No

No

Yes

No

Yes

Yes

No

Yes

No

No

No

No

No
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Importing Employee Metrics via TCC

You can use Taleo Connect Client (TCC) to import some employee metrics, which can then be viewed in the Talent
Profile.

In TCC you can complete an import (both update and merge) of the following EmployeeMetrics fields: LastReviewScore,
EmployeePotential, and EmployeeRiskOfLoss.

Only these metrics can currently be imported via TCC.

Example TCC file structure for updating employee metrics:

<?xml version="1.0" encoding="UTF-8"?>
<load:load productCode="S01006" model="http://www.taleo.com/ws/s0800/2009/01" root="Employee"
operation="update" locale="en" header="true" delimiter="," quote="&quot;" xmlns:load="http://www.taleo.com/
ws/integration/load">

<load:columns>

<load:column parameter="1" type="DATA" path="TalentUser,ArUser,EmployeeID" searchType="SEARCH"
searchTarget="../.." localeType="NONE"/>

<load:column parameter="1" type="DATA" path="EmployeeMetrics,LastReviewScore" ignoreEmpty="true"
localeType="NONE" />

<load:column parameter="1" type="DATA" path="EmployeeMetrics,EmployeePotential,Code" searchType="SEARCH"

searchTarget="." ignoreEmpty="true" localeType="NONE"/>
<load:column parameter="1" type="DATA" path="EmployeeMetrics,EmployeeRiskOflLoss,Code" searchType="SEARCH"
searchTarget="." ignoreEmpty="true" localeType="NONE"/>

</load:columns>
<load:processingInstructions/>
</load:load>

Customizable Metrics

The Potential, Promotability Readiness, Reassignment Candidate, Risk of Loss, and Impact of Loss employee metrics
can be configured to use customized values, enabling them to better represent your HR processes and terminology.

The customizable employee metrics are available in the Talent Profile and Talent Snapshot, and in matrices and charts
used with Performance Reviews, Succession Plans, and Talent Pools. They are also displayed when you use filters in the
Review Calibrations, Talent Pools, Nomination Slates, and Talent Browser. Only Potential and Risk of Loss are available
with facets in People Search. The delivered Taleo values are used with these customizable metrics, until you choose to
change them. Your customized values can use any alphanumeric characters in their Code and Name.

Renaming a Customizable Metric Value versus Adding, Removing, Activating and Deactivating.

When only the name of an existing metric value is changed in the configuration, that change is immediately reflected
in Taleo Performance screens. If customized metric values are added, removed, activated, or deactivated, the changes
will only impact metric values used in existing employee records when those values are subsequently changed. This
is because the configuration of the customized values are associated with the metrics themselves, and those values
applied to employee records are stored in separate tables in the system.

For example, when Julia Savard's Potential metric was initially set to High, the available delivered values were High,
Medium, Low. Later, those values were deactivated and the new custom values Good, Average and Poor were created
and activated. Since the value associated with Julia is High, her manager would need to edit her metrics in the Talent

193
ORACLE



Talent Acquisition Cloud Chapter 7
Implementing Performance Employee Management Administration

Profile and select Good from the drop-down list. This would ensure the most up to date customized value is associated
with Julia's Potential metric. If only the names of the original values were changed, her manager would not need to
update the employee records.

Customizable Metrics Use with Matrices and Charts

Some customizable employee metrics are available for use in matrices and charts used with Performance Reviews,
Succession Plans, and Talent Pools.

When using customized metrics values with matrices and charts, only those metric values that are active can be used. If
an employee in a chart or matrix cell is associated with a legacy value that is no longer active, the employee can remain
there and the legacy value is displayed. Other employees cannot be moved into a cell with the inactive legacy value. If all
of the custom values used in a chart or matrix have been replaced, the entire matrix may no longer be usable.

There are additional specific behaviors to be aware of when working with matrices that have customizable metrics
values for dimension types:

- One metric value must map to one division/cell (use only one-to-one mappings) when setting up matrix and
chart cells.

- As matrices can have custom labels, it is possible the labels and cell values do not match.

To prevent these issues from occurring, you should ensure in the Configuration that only properly formatted matrices
and charts with active custom metric values are used with the Performance Review Template, Default Succession Plan
Template, and Talent Pool Template. When changes are made to customizable metrics, they do not automatically get
applied to matrices and charts.

Migrating Promotability Readiness for Use in Matrices and Charts

In Performance Management Feature Pack 12C the Promotability Readiness metric is delivered with these values: Ready
Now, Ready in under 1year, Ready in 1-2 years, Ready in 2+ years. If you are currently using the Promotability Readiness
metric in a prior release with different metric values than these, are upgrading to release 12C, and want to continue
using your prior metric values in matrices and charts, then you will need to map to the previous values used in 12B with
the Taleo Connect Client (TCC).

For example, consider the case of a matrix called All Metrics - Potential and Promotability, where the values for
Promotability Readiness are as follows:

Division Name Label 12B Value 12C Delivered Value
Division 1 Low Above 30 months Ready in 2+ years
Division 2 Medium 15-30 months Ready in 2+ years
Division 3 High 0.0 to 15 months Ready in 1-2 years

While updating, the system uses the later number in the 12B values to select and replace the corresponding configurable
metric value delivered with 12C. In this case the delivered metric value Ready in 2+ years is used for both the previous
Low and Medium values. As a result, employee records previously using the values 15-30 months and Above 30 months
will all display in the Ul as Ready in 2+ years. The matrix will generate error messages because the values have to map
on a one-to-one basis. If you want to return back to using your prior metric values the administrator will need to migrate
them back using TCC.

Maximum Number of Divisions for Customizable Metrics Used in Matrices and Charts
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The maximum number of divisions for customized metrics for use in matrices and charts is as follows:

Customizable Metric Name Matrix Chart
Potential 5 5
Promotability Readiness 5 5
Risk of Loss 5 5
Impact of Loss 0 0

Customizable Employee Metrics Use in the Talent Profile

Only activated employee metric values are available in the Talent Profile's selection lists. However, the metric values
previously used in employee records are not automatically changed even though certain values may be deactivated in
Configuration.

Users can view metrics history in the Talent Profile by clicking the More Actions button at the top of the Metrics section.
The actions list provides the following options:

- Nominate for Position
- Show History
- Create Report

When the user selects the Show History option, the Metrics History dialog provides options for the following employee
metrics:

- Review Rating
- Potential
- Risk of Loss
- Promotability Readiness
- Reassignment Candidate
- Competency Rating
- Goal Rating
- Impact of Loss
Potential, risk of loss and promotability readiness are customizable.

Customizable Metrics Use in the Talent Snapshot

The following metrics are displayed in the Talent Snapshot, all four of which are customizable:
- Potential
- Risk of Loss
« Impact of Loss

- Promotability Readiness

Customizable Metrics Use in the Talent Browser
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The following metrics are displayed in the Talent Browser when Metrics is selected from the General selector, all three of
which are customizable:

- Potential
- Promotability Readiness

- Risk of Loss

Customizable Metrics Use in Filters

Employees can be filtered based on customizable metrics in the following contexts:
- Review Calibrations
- Talent Pool
- Talent Browser

- Nomination Slate

Customizable Metrics Use in Searches
Only the Potential and Risk of Loss customizable metrics are available with facets in People Search.
When metric values are made inactive they are not searchable. Only active values show up in facets.
Customizable Metrics Use in Calibration
Customizable metrics can be calibrated from the following contexts:

- Talent Pool, Matrix mode

- Talent Pool, Chart mode

- Performance Reviews Hub, Matrix mode

- Performance Reviews Hub, Chart mode

- Succession Plan, Matrix mode

Features Removed

The following predefined searches are removed from succession plans: Search for Top Employees, Search for Above
Average Fit Employees, and Search for Fit Employees.

On the Talent Pool pages, the Update Metrics option is removed from the More Actions dropdown list, and now
displays directly on the toolbar on its own, where applicable. In some instances the More Actions dropdown list is
removed from the toolbar.

On the Talent Browser, the Metrics section is removed from the Team Summary page.

Configuration

The following configuration setting is used for customizing the values of the employee metrics Potential, Promotability
Readiness, Reassignment Candidate, Risk of Loss, and Impact of Loss.

f Note: Impact of Loss is a new metric as of Feature Pack 12C.
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User Type Permission
Name Location

Configurable Metrics Configuration > [SmartOrg] Administration > [Users] Configurable
Metrics [Metric Management]

Delivered Values for Customizable Metrics

The delivered values for the customizable metrics are as follows:
- Potential: Low, Medium, High, Not Specified.
- Promotability Readiness: Ready Now, Ready in under 1year, Ready in 1-2 years, Ready in 2+ years.
- Reassignment Candidate: Yes, No.
- Risk of Loss: Low, Medium, High, Not Specified.
- Impact of Loss: Low, Medium, High.

Not Specified is only delivered as a metric value for Potential and Risk of Loss. If you want Not Specified as a value in the
other customizable metrics for your implementation, your system administrator must define it in Configuration.

- Even though not delivered in Configuration, and not initially selectable from dropdown lists, the Not Specified
value will appear in certain employee records at first for Impact of Loss, Reassignment Candidate and
Promotability Readiness. This will occur in records where there are no migrated values to fill the field. The
database will populate such records with Not Specified rather than using a null value.

- To add Not Specified as a valid value on the dropdown lists your system administrator must add it in
Configuration.

- To change an employee record from Not Specified to some other value, the value must first be configured and
available to display on the dropdown lists.

The best practice at startup or beginning migration is to make sure each customizable metric has the full set of values
you want to use, and that one of the values for each metric is set as the default.

Customizable Metrics Configuration Considerations

- When configuring employee metric values you can create new values or edit existing ones. Editable properties
for metric values include reordering the location they display on dropdown lists; editing the names, codes and
icons; activating or deactivating the custom values; and setting a default value.

- When creating a metric value, you may give it an alphanumeric name and represent it with an icon. You can
also edit the name and icon for existing metrics. The image can be a maximum of 16 x 16 pixels, must be
in .gif, .jpeg or .png format, and have a transparent background.

- You can activate a custom metric value for use in the system, and deactivate any delivered or custom values
you no longer want to use. Deactivated (inactive) values will still be displayed for any employee, matrix, or chart
that is using the custom metric, but they will not be available for selection from dropdown lists for any new
employee records, matrices or charts.

To Customize Metric Values

Configuration > [SmartOrg] Administration > [Users] Configurable Metrics > [Metrics Management]
1. Click on the Code label of the employee metric whose values you want to customize.
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The Metric Type screen opens providing you the options to Create, Edit, Activate/Deactivate and Reorder the
values for the selected metric.
2. Toreorder the sequence in which the metric values display in dropdown lists in the application; click Reorder in
the Configurable Metrics section.
a. Highlight an existing metric value name and use the arrows to change its order in the list.
b. Then click Save.
3. To create a new metric value; click Create in the Configurable Metrics section.
a. Enter an alphanumeric Code and Name.
b. Select Default Value if you want this to be a default setting.
c. Click Browse if you want the metric value to be represented by an icon, and navigate to select the image
file off a local machine. Then select Change Picture.
The image can be a maximum of 16 x 16 pixels, must be in .gif, .jpeg or .png format, and have a
transparent background.
d. Click Save.
4. To edit an existing metric value; click Edit in the Actions section.
a. Edit the alphanumeric Code or Name.
b. Select Default Value if you want this to be a default setting.
c. Click Browse if you want to change the icon used to represent the metric value, and navigate to select the
image file off a local machine. Then select Change Picture.
The image can be a maximum of 16 x 16 pixels and must be in .gif, .jpeg or .png format, and have a
transparent background.
d. Click Remove if you want to remove the icon used to represent the metric value.
e. Click Save.
5. To activate or deactivate the existing metric value; click the appropriate button in the Actions section.
a. Click Save.

- The customized values are now available to be used with the employee metric.

- For any custom values you deactivated, the old values will still be displayed for any employee record, matrix, or
chart that is using the custom metric, but they will not be available for any new employee records, matrices or
charts.

- If any changes need to be made to an employee's records containing existing custom metrics, the deactivated
values will not be available for selection.

- When custom values are changed in the Configuration module, the history of those changes are tracked. The
history includes the person who made the change, the customized metric values, and the context from where
the value is changed.

- You can configure matrices and charts to use the customizable metrics as dimension types. Only one-to-one
mappings are allowed when setting up matrix and chart cells.

Talent Profile Configuration

The Talent Profile Management configuration allows system administrators to define what information is displayed
and/or editable on an employee's talent profile. The configuration tools consolidate the settings for each section of the
Talent Profile, allowing the administrator to configure the layout of the entire profile from a single location.
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The overall properties and layout of the Talent Profile, and those of its component sections, are highly configurable. This
allows you to match the information in the Talent Profile to your business needs. You can also create and configure new
custom sections, subsections and user-defined fields; decide which fields to include in each section (including metrics);
and neatly organize section order in the user interface.

The Talent Profile Management configuration section provides the following groups of configuration options:
- Talent Profile Properties - Manage global talent profile configuration properties.
- Talent Profile Section Visibility Groups - Manage talent profile section visibility and availability groups.
- Talent Profile Layout - Configure talent profile section order and layout, and apply visibility groups to control

user access.

The Talent Profile Management configuration section is located at Configuration > [Taleo Performance]
Administration.

Configuration

These settings are included in the Talent Profile configuration.

Setting

Name Description

Talent Profile Properties Allows a system administrator to edit the following global properties of the Talent Profile:
Maximum Number of Historical Reviews; Allow File Attachments; Allow Employees to Upload
Photos; and two API keys for LinkedIn Integration.

Talent Profile Visibility Groups Allows a system administrator to define employee visibility and availability groups, based on
criteria such as organization or location or job role. These can be used to control access to Talent
Profile sections for particular groups of employees.

Talent Profile Layout Allows a system administrator to perform layout changes and customizations to all sections of the

Talent Profile, from one location in Configuration. The page displays links providing quick access
to supporting pages which group together all the functionality for configuring a particular Talent
Profile section.

Configuring Talent Profile Properties
The Talent Profile Properties configuration section allows administrators to edit Talent Profile global properties.

These include:
« Maximum Number of Historical Reviews
- Allow File Attachments
- Allow Employee to Upload Photo
- LinkedIn Integration - API Key
- LinkedIn Integration - API Secret

Also see the Employee Photo Upload section for more details about this feature.
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LinkedIn Integration Configuration

The Talent Profile can be integrated with LinkedIn to allow an employee's LinkedIn profile information to be imported to
and used in the Work Experience, Education and Certification sections of their Talent Profile.

Overview

The LinkedIn Integration feature uses LinkedIn's public interfaces (API's)to allow a LinkedIn user to access their LinkedIn
profile information and transfer it to their Talent Profile.

Business Process Flow

The top-level business process flow for setting up and using the Talent Profile's LinkedIn integration feature is as
follows:

1. Customer sends request form to LinkedIn for the two needed API keys.

2. Customer requests Taleo Support activate the Enable LinkedIn Integration setting for Performance.

3. Taleo Support turns on the Enable LinkedIn Integration configuration setting (Value=yes). This is a Protected
setting.

4. Customer administrator configures Talent Profile Properties with two needed API keys provided by LinkedIn.

5. User accesses their Talent Profile and sees Import from LinkedIn button at header level for the Work Experience,
Education and Certifications sections.

6. User clicks Import from LinkedIn button for a section (e.g. Work Experience).

7. User logs into LinkedIn; views a legal disclaimer; and uses Add dialog to review section profile information
available from LinkedIn.

8. User selects profile information they want to import from LinkedIn to the Talent Profile section they are in, and
clicks Add button to initiate the import.

9. LinkedIn information is transferred to the user's applicable Talent Profile section.

Talent Profile LinkedIn Integration Configuration
Configuring the Talent Profile LinkedIn integration involves the two following settings:

Setting
Name Description Location
Enable LinkedIn Integration - IsnewinFP13B Configuration > [Taleo Performance]
. . Settings > [Product Settings] > [Refine
E_nables users to retru_eve proflle data'from the By] Keyword=Linked > Enable LinkedIn
LinkedIn system and import into their Talent Intecrati
) gration.
Profile.
Is a Protected setting.
Default value is No (Off).
Talent Profile Properties - Was introduced in FP 13A, then updated in FP 13B = Configuration > [Taleo Performance]
with new LinkedIn Integration section. Administration > [Talent Profile

Management] Talent Profile Properties
Enables administrators to configure the & ] P

integration by entering the API keys from
LinkedIn.

LinkedIn Integration section displays on this page
only when the Enable LinkedIn Integration setting
is enabled.
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Talent Profile Properties Configuration Settings

Setting Description

Maximum Number of Historical Reviews Sets the maximum number of historical reviews that can display in the Performance Reviews section of
the Talent Profile.

Allow File Attachments Allows for file attachments in the Talent Profile.
Allow Employee to Upload Photo Allows employees to upload a personal photo from the Talent Profile.

API Key (also named Consumer Key or Dev  Enter key provided by LinkedIn. Used to access their API services. The LinkedIn Integration section
Key) displays only when the Enable LinkedIn Integration setting is configured to Yes.

API Secret Enter key provided by LinkedIn. Used to sign their service requests. The LinkedIn Integration section
displays only when the Enable LinkedIn Integration setting is configured to Yes.

To Configure the Talent Profile Properties

- The Enable LinkedIn Integration setting must be enabled by Support, if your organization wants to use LinkedIn
Integration in the Talent Profile.

- User must have administrator access for this following task.

Configuration > [Taleo Performance] Administration > [Talent Profile Management] > Talent Profile Properties
1. Review current Talent Profile Global Properties.
2. C(lick Edit to change the properties settings.
3. Configure the settings as needed for Maximum Number of Historical Reviews, Allow File Attachments, and/or
Allow Employee to Upload Photo.
4. If LinkedIn Integration is to be used, enter the two API keys provided by LinkedIn for access to their services.
5. Click Save.

The changes made in configuration will be reflected in the Talent Profile user interface.

Make any changes needed to the Talent Profile section layout using the Talent Profile Layout settings pages.

Creating Talent Profile Visibility Groups

Visibility and availability groups are user-defined employee groups, based on such criteria as organization or job role,
that can be used to control access to Talent Profile sections. This feature allows administrators to configure new or

edit existing visibility and availability groups. Administrators can control visibility on each section of the Talent Profile,
customize the profile by population, and take advantage of the user types, groups, OLF they have already configured.

Section Visibility and Availability

Visibility groups are user-defined employee groups, based on such criteria as organization or job role, that can be
used to control access to Talent Profile sections. Administrators configure visibility groups, selectively apply them to
Talent Profile sections, and as a result control the profile sections to be visible or available to those particular groups of
employees. A visibility group is simply a subset of the employees in your organization. For example, you might want to
define a group for American senior executives. The visibility group would be defined using Location equals USA, and
Job Level equals Senior Executives.
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The Visibility and Availability Groups feature provides a second tier of security at the Talent Profile section level.
Visibility groups work in addition to the User Type permissions security, which takes precedence. There are several
Talent Profile related user type functional domains:

- Employee Metrics: Access to employee metrics and user-defined employee metrics and access to General
section.

- Employee Profile: Access to Talent Profile standard and custom sections.
- Performance Review: Access to Review History and General Sections.
- Compensation: Access to Compensation and General Sections.

The visibility group configurations allow an administrator to further restrict access to talent profile sections. Sub-
sections inherit the section security. Visibility groups can be applied in all Talent Profile section configurations, with
exceptions for General and Competencies:

- The General section has no section level availability configuration, as it is always available. It also does not
support the control of section visibility, nor does it have field level visibility configuration.

- The Competencies section does have section level availability configuration, but not section visibility control.
Competencies does have role-based, field level visibility configuration.

Business Process Flow:

1. Administrators create visibility groups using the Talent Profile Visibility Groups pages.
2. Administrators apply visibility groups to sections as needed, using the Talent Profile Layout pages.

3. End-users view and/or edit only those Talent Profile sections their user type permissions and visibility group
settings allow them to.

Talent Profile Visibility and Availability Groups Creation

Administrators use the Talent Profile Visibility Groups pages to create groups of employees whose access to Talent
Profile sections should be controlled in a like manner. (Navigation: Configuration > [Taleo Performance] Administration
> [Talent Profile Management] Talent Profile Section Visibility Groups.) History is tracked when visibility groups are
created, modified or deleted.

Talent Profile Section Visibility Groups Page

Use this page to view read-only information about the section visibility groups, and follow links to create, duplicate or
deactivate groups. The visibility groups can later be applied to configurable Talent Profile sections, other than General.
User-interface (Ul) elements on this page include the following:

Ul Element

Name Description

Refine By Alist of existing visibility groups displays on the page. If the list is longer
than the viewable area use Refine By to pare down the list or search for a
particular group, by keyword or status.

Create Use to open the Talent Profile Section Visibility Group Editor page.

[Group] Name Use to open the Talent Profile Section Visibility Group - [Group Name]
page, to configure the group.

Deactivate Use to deactivate an existing visibility group, so its status is inactive.
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Description

Use to duplicate (make a copy of) an existing visibility group for the
purpose of using the copy as a template for a new group.

Use this page when first creating a visibility group, or when modifying an existing group. Ul elements on this page

include the following:

Ul Element

Name

Code
Name

Status

Description
Save

Cancel

Talent Profile Section Visibility Group - Group Name Page

Description

Use to enter a Code for the group.
Use to enter a Name for the group.

Status will display as Draft until the group properties are entered and
saved. Afterwards the status can register as Active or Inactive.

Use to enter a Description for the group.
Use to Save the new group to the database.

Use to Cancel any unsaved changes.

Use this page to configure the selected visibility group. Ul elements on this page include the following:

Ul Element

Name

Properties

Edit

[Categories]

[Categories] User Groups

Add

Description

Displays the Code, Name, Status and Description of the visibility group.
Use to modify the properties.

Use the categories provided for defining the employee sets to be
included in the visibility group: Organizations, Locations, Job Fields, Job

Levels, user Groups and User Roles.

The User Groups values come from SmartOrg security, user type
permissions configuration (e.g. Administration).

Use to open the [Context] Selector page, where you can select from
among the available valid values for the context (e.g. Location=France.)

The following is an example of how visibility and availability groups can be used to control access to a Talent Profile

section.
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The scenario:
- A custom "Bonus" section has been created for all the executive personnel, and only for them.

- You want to configure security so the executive personnel can view the new Bonus section in their own Talent
Profile.

- And so their peers cannot see each other's Bonus section.

- And so HR administrators can view and edit the Bonus section of all executives.

The solution:
Step One - Create these 3 Visibility Groups:

1. Employee - based on User Role=Employee.
2. HR Admin - based on User Role=HR Administrator.
3. Executive Personnel - based on Job Level=VP and above.
Step Two - In the Talent Profile Layout - "Bonus" section configuration, set up these availability controls:
- This Section will apply to the following profiles (Availability)=Specific Groups Profiles.

- Group Name=Executive Personnel; Include=selected; Exclude=not selected.

Step Three - In the Talent Profile Layout 'Bonus' section configuration, set up these visibility controls:
- Allow the following groups to view and edit this section (Visibility) = Specific Groups.
« Group Name=HR Administrator; Include=Read and write; Exclude=not selected.

- Group Name=Employee; Include=Read and write; Exclude=not selected.

’ -
? Note:

In order to block the peers from viewing each others' bonus, the proper security has to be set at Employee Profile
security domain level. The section visibility configuration is inheriting the Employee Profile domain security.

Configuration
The following configuration settings control the creation and use of visibility and availability groups:

Setting

Name Location Description

Talent Profile Visibility Groups Configuration > [Taleo Performance] Use to create and modify visibility and
Administration > [Talent Profile Management] availability groups.

Talent Profile Layout Configuration > [Taleo Performance] Use to apply the visibility and availability groups

Administration > [Talent Profile Management]  to Talent Profile sections.
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To Create a Visibility Group

Configuration > [Taleo Performance] Administration > [Talent Profile Management] Talent Profile Section
Visibility Groups
1. Click Create.
2. On the Talent Profile Section Visibility Group Editor page, enter a Code, Name and Description for the group.
3. Click Save.
The Talent Profile Section Visibility Group - [Group Name] page opens with the group identifying information
displaying, and the status as Draft.
4. For each applicable group selection criteria (e.g. Organization, Location, Job Level) click Add, use the selection
page to select the identifying criteria, and click the Select button.
5. Click Activate to save the changes and activate the group.

The new group is created and its status is Active.

Use the visibility group to configure access control to Talent Profile sections in the Talent Profile Layout pages.

To Edit a Visibility Group

Configuration > [Taleo Performance] Administration > [Talent Profile Management] Talent Profile Section
Visibility Groups
1. On the Talent Profile Section Visibility Groups page, in the Section Visibility Groups grid, click the linked group
name for the group you want to modify.
2. On the Talent Profile Section Visibility Group - [Group Name] page make any needed edits.
o Optional. Next to Properties, click Edit to access the Talent Profile Section Visibility Group Editor page.
Edit the Code, Name and Description for the group as needed. Click Save or Cancel to return to the Talent
Profile Section Visibility Group - [Group Name] page.
o Optional. Next to each of the needed selection criteria categories, click Add or Remove to modify the
selection criteria.
o Optional. At the top of the Talent Profile Section Visibility Group - [Group Name] page you can also select
from the Duplicate, Activate and Delete actions.

The selected group is modified.

Use the visibility group to configure access control to Talent Profile sections in the Talent Profile Layout pages.

Configuring Talent Profile Layout

The Talent Profile Layout page allows administrators to perform layout changes and customizations to all sections of
the Talent Profile, from one location in Configuration. The page displays links providing quick access to supporting
pages which group together all the functionality for configuring a particular Talent Profile section.

The Talent Profile Layout page provides Details links to editor pages for the following profile sections:
- General
Metrics
Review History
- Compensation
- Competencies
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Employee Information
Education

- Work Experience

- Certifications

- Job Preferences

- Attachments

The Talent Profile Layout configuration options include adding custom sections, reordering the appearance of sections
in the Talent Profile, activating or deactivating sections, and viewing and editing the display details of fields in each
section.

General Section

The administrator can use the Talent Profile Layout configuration settings to:
- Cannot deactivate section.
- Specify language availability and base language.
Edit properties.

- Add fields of the following types: Employee Information UDF, Employee Metric, Employee Metric UDF and
Standard. Fields may only be added below the gray line.

Edit fields to turn on and off read only display. Cannot set to write.

- Configure single record fields, multi-record fields and user-defined fields (UDFs).
Delete fields. Except Current Job, only those below gray line.
Reorder fields. Only those below gray line.

Metrics Section

The administrator can use the Talent Profile Layout configuration settings to:
Deactivate section.
- Set 50/50 Split option.
- Specify language availability and base language.
Edit properties.

- Add fields of the following types: Employee Information UDF, Employee Metric, Employee Metric UDF and
Standard. Fields may only be added below the gray line.

Edit fields to turn on and off read only display. Cannot set to write.
- Configure single record fields, multi-record fields and user-defined fields (UDFs).
Delete fields. Except Current Job, only those below gray line.
Reorder fields. Only those below gray line.
- Add, edit, delete subsections.
Configure section availability and visibility based on groups.

Review History Section

The administrator can use the Talent Profile Layout configuration settings to:

Deactivate section.
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- Specify language availability and base language.

- Edit properties.

- Edit fields to turn on and off read only display. Default setting for all fields is on. Cannot set to write.
- Configure section availability and visibility based on groups.

Compensation Section

The administrator can use the Talent Profile Layout configuration settings to:
- Deactivate section.
- Specify language availability and base language.
- Edit properties.
- Configure section availability and visibility based on groups.

Compensation history data can be configured to display within Taleo Performance.

The talent model includes compensation data elements so that compensation data may be displayed within the Taleo
Performance application. This compensation data can come from Taleo Compensation or from an external HRMS/ERP
system.

The compensation history data is displayed according to metric configuration, availability, and user security access in
the following areas:

- Talent Profile - Displays compensation history data.
- Performance Snapshot Card - Displays compensation data in the Compensation section of the snapshot card.

- Talent Browser - Displays salary, bonus, and stock information for employees.

When compensation history data is available, and the related metric has been configured to display, the following
information is provided in Taleo Performance, when available:

- Employee's current salary

- Employee's salary increase, new salary and effective date

- Employee's bonus amount, bonus plan, target bonus amount and effective date
- Employee's stock grant amount, total non-vested stock and grant date

Compensation history is available from Taleo Compensation through an integration. If Taleo Compensation is activated
in the zone and the integration is configured, the system will automatically transfer all compensation history data into
SmartOrg on a daily basis. If Taleo Compensation is not activated, the client can use the standard integration tools to
transfer the data from an outside ERP system.

Competencies Section

The administrator can use the Talent Profile Layout configuration settings to:
- Deactivate section.
- Specify language availability and base language.
- Edit properties.
- Edit fields to turn on and off read/write display.
- Configure section availability based on groups, but not visibility.
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- Specify whether or not competency section is displayed to role.
- Specify whether the user can add or remove competencies.

For more details see Configuring Talent Profile Competencies.
Employee Information Section

The administrator can use the Talent Profile Layout configuration settings to:
Deactivate section.
- Specify language availability and base language.
Edit properties.
- Set 50/50 Split option.

- Add fields of the following types: Employee Information UDF, Employee Metric, Employee Metric UDF and
Standard. Fields may only be added below the gray line.

Edit fields to turn on and off read and write display.

- Configure single record fields, multi-record fields and user-defined fields (UDFs).
Delete fields.
Reorder fields.

- Add, edit, delete subsections.

- Configure section availability and visibility based on groups.

Job Preferences Section

The administrator can use the Talent Profile Layout configuration settings to:
Deactivate section.
- Specify language availability and base language.
Edit properties.
- Set 50/50 Split option.

- Add fields of the following types: Employee Information UDF, Employee Metric, Employee Metric UDF and
Standard. Fields may only be added below the gray line.

Edit fields to turn on and off read and write display.

- Configure single record fields, multi-record fields and user-defined fields (UDFs).
Delete fields.
Reorder fields.

- Add, edit, delete subsections.

- Configure section availability and visibility based on groups.

Education Section

The administrator can use the Talent Profile Layout configuration settings to:
Deactivate section.
- Specify language availability and base language.
Edit properties.
Edit fields to turn on and off read and write display.
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- Configure section availability and visibility based on groups.

Work Experience Section

The administrator can use the Talent Profile Layout configuration settings to:
- Deactivate section.
- Specify language availability and base language.
- Edit properties.
- Edit fields to turn on and off read and write display.

- Configure section availability and visibility based on groups.

Certification Section

The administrator can use the Talent Profile Layout configuration settings to:
- Deactivate section.
- Specify language availability and base language.
- Edit properties.
- Edit fields to turn on and off read and write display.

- Configure section availability and visibility based on groups.

Attachments Section

The administrator can use the Talent Profile Layout configuration settings to:
- Deactivate section.
- Specify language availability and base language.
- Edit properties.
- Configure section availability and visibility based on groups.

Talent Profile Layout Settings

Ul Element Description

Add Custom Section Allows you to modify the top-level properties of a talent

profile section or create a new one.
Reorder Sections Allows you to reorder the sequence Talent Profile sections
will display in the user interface.

Languages/Refresh Allows you to set the display language to a Talent Profile
section.

Refine By Allows you to refine the list of Talent Profile sections that
appears on the Talent Profile Layout page.

Show/Hide Allows you to toggle on and off a view-only display of the
current layout fields and settings for a Talent Profile section.

Details Allows you to edit the display properties for a selected Talent

Profile section.
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Applicable to...
Talent Profile Layout
page group.

Talent Profile Layout
page group

Talent Profile Layout
page group

Talent Profile Layout
page group

Talent Profile Layout
page group

Talent Profile Layout
page group

Opens Page...

Talent Profile Section
Editor.

Reorder Talent Profile
Sections.

n/a

n/a

n/a

Talent Profile Section -
[Section Name]
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Ul Element Description Applicable to... Opens Page...
Activate/Deactivate Allows you to Activate or Deactivate a section in the Talent Talent Profile Layout n/a

Profile. page group
Split 50/50 Allows you to turn on and off the Split 50/50 (two column) Talent Profile Layout n/a
layout property for a selected Talent Profile section. page group

To Configure Talent Profile Section Layouts
User must have administrator access for this task.

Configuration > [Taleo Performance] Administration > [Talent Profile Management] Talent Profile Layout

1. Optional. To change the language used for display of the section in the profile, select a new language and click
Refresh.

2. Talent Profile sections are listed in the order they would appear in the Talent Profile user interface.

3. Optional. To narrow (shorten) the list of Talent Profile sections on this page (to reduce scrolling for example),
use the Refine By selector, choose an option and then click Refresh.
This does not change the appearance of the sections in the Talent Profile.

4. You can edit the list of sections, and consequently the appearance of the sections on the Talent Profile
by adding custom sections, reordering the sections, renaming them, editing their details, or activating/
deactivating them.

o Click Add Custom Section to create a custom section.

o Click Reorder Sections to change the sequence in which sections display in the Talent Profile user
interface.

o Click Show or Hide to the right of a section name in the list to toggle a view-only display of the section's
fields and properties.

o Click Details for a section in the list to edit its top-level properties, such as rename it.

o Click Activate/Deactivate to the right of a section name in the list to display or remove it from the Talent
Profile page.

f Note: The General section of the Talent Profile cannot be deactivated.

o Select Split 50/50 to utilize a split layout for the section.
5. Save your changes.

The selected sections of the Talent Profile are configured to meet the requirements of your organization, and the results
are displayed in the profile.

Configuring Talent Profile Section Visibility

Visibility and availability groups are user-defined employee groups, based on such criteria as organization or job role,
that can be used to control access to Talent Profile sections.

Talent Profile Section Configuration Using Visibility and Availability Groups

Administrators use the Talent Profile Layout pages to view and apply visibility groups to Talent Profile sections, for the
purpose of controlling which employees can see or edit the sections. (Navigation: Configuration > [Taleo Performance]
Administration > [Talent Profile Management] Talent Profile Layout.)

210
ORACLE



Talent Acquisition Cloud Chapter 7
Implementing Performance Employee Management Administration

Talent Profile Layout Page

Use this page to view information about section visibility and availability settings, and field level visibility and read/write
settings. Also use it to obtain edit access for modifying the settings. You can hide or show the information. Ul elements
on this page relevant to visibility groups include the following:

Ul Element

Name Description

[Sections List] Use to view a list of the existing sections available for your organization's
implementation of the Talent Profile.

[Sections List] Show / Hide Use to Show (view) or Hide the configuration properties for a list of the
existing field level display properties, as well as any applicable visibility
and availability settings, for a section.

[Sections List] Details Use to access the Talent Profile - [Name] page for a particular section,

where you can configure field level display properties, as well as any
applicable visibility and availability settings, for the section.

Talent Profile Section - [Name].

Use this page to configure field level display properties, as well as any applicable visibility and availability settings, for a
selected Talent Profile section. History is tracked when adding or removing visibility groups in a section. Ul elements on
this page relevant to visibility groups include the following:

Ul Element
Name Description

[This section will apply to the following profiles:] This setting controls section availability (i.e. whether or not a section is
available to a group of employees.)

- Ifitis available, it still might be configured to be either visible or not
visible to the group.

- If itis not available to a group it cannot be visible to the group at all.

- This setting is controlled by two radio buttons: All Employee Profiles
and Specific Groups Profiles.

- This set of availability configuration fields will appear on all section
configuration pages except for the General section.

[Allow the following group(s) to view and edit this section:] This setting controls section visibility (i.e. whether or not a section is
visible to a group of employees.)
- To be visible to a group the section must first be available to the
group.
- This setting is controlled by two radio buttons: All Employee Profiles
and Specific Groups Profiles.

- This set of availability configuration fields will appear on all section
configuration pages except for the General and Competencies
sections.

All Employees Profiles This is the default configuration setting for availability of a section.
When selected it means all employees will have this Talent Profile
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Ul Element

Name Description

setting available to them; subject to other visibility group and user type
permission settings.

Specific Groups Profiles Use this setting to make a Talent Profile section available to only specific
groups, subject to other visibility group and user type permission
settings. When this option is selected the Include and Exclude Groups
links activate. Depending on your business needs you can use either of
both to further filter your groups of employees.

Include / Exclude Groups links Use to display a list of all visibility and availability groups you have
defined (except the security user groups). You can choose which groups
to further specifically include or exclude.

- When you specify a group has Include Groups permission, it means
the employees in the group have read/write permissions to the
Talent Profile section.

- When you specify a group has Exclude Groups permission, it means
the employees in the group have neither read nor write permissions
to the Talent Profile section.

« You can also use Edit for Include Groups, to remove the write
permission for the group. You can't do this for Exclude Groups since
they are already excluded from read/write.

Here is an example of how visibility and availability groups can be used to control access to a Talent Profile section.

The scenario:
- A custom "Bonus" section has been created for all the executive personnel, and only for them.

- You want to configure security so the executive personnel can view the new Bonus section in their own Talent
Profile.

- And so their peers cannot see each other's Bonus section.
- And so HR administrators can view and edit the Bonus section of all executives.

The solution:

Step One - Create these 3 Visibility Groups:
1. Employee - based on User Role=Employee.
2. HR Admin - based on User Role=HR Administrator.
3. Executive Personnel - based on Job Level=VP and above.
Step Two - In the Talent Profile Layout - "Bonus" section configuration, set up these availability controls:
- This Section will be on=Specific Groups Profiles.

- Group Name=Executive Personnel; Include=selected; Exclude=not selected.

Step Three - In the Talent Profile Layout 'Bonus' section configuration, set up these visibility controls:
- This section will be viewable and editable by=Specific Groups.
- Group Name=HR Administrator; Include=Read and write; Exclude=not selected.
« Group Name=Employee; Include=Read and write; Exclude=not selected.
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?’ Note:

In order to block the peers from viewing each others' bonus, the proper security has to be set at Employee Profile
security domain level. The section visibility configuration is inheriting the Employee Profile domain security.

To Configure Talent Profile Section Visibility

The Visibility Groups you want to work with are already created.

Configuration > [Taleo Performance] Administration > [Talent Profile Management] Talent Profile Layout
1. On the Talent Profile Layout page, click Details next to the Talent Profile section name you want to set visibility
and availability rules for.
2. On the Talent Profile Section - [Section Name] page, choose an option for "This section will be on".

This setting controls section availability (i.e. whether or not a section is available to a group of employees.) If it is
available, it still might be configured to be either visible or not visible to the group. If it is not available to a group
it cannot be visible to the group at all. This setting is controlled by two radio buttons:

o All Employee Profiles - this section is available to all employees.

o Specific Groups Profiles - this section is available to specific visibility groups.

This set of availability configuration fields will appear on all section configuration pages except for the General
section.

3. On the Talent Profile Section - [Section Name] page, choose an option for "This section will be viewable and
editable by".

This setting controls section visibility (i.e. whether or not a section is visible to a group of employees.) If it is
visible, it still might be configured to be either visible or not visible to the group. If it is not available to a group it
cannot be visible to the group at all. This setting is controlled by two radio buttons:

o All Employees based on Profile Permissions - this section is available to all employees.

o Specific Groups - this section is available to specific visibility groups.

This set of availability configuration fields will appear on all section configuration pages except for the General
section.

When the Specific Groups option is selected, the Include and Exclude Groups links activate. You can choose
which groups to further specifically include or exclude.
o When you specify a group has Include Groups permission, it means the employees in the group have
read/write permissions to the Talent Profile section.
o When you specify a group has Exclude Groups permission, it means the employees in the group have
neither read nor write permissions to the Talent Profile section.
o You can also use Edit for Include Groups, to remove either read or write permission for the group. You
can't do this for Exclude Groups since they are already excluded from read/write..

Availability and visibility rules for the selected group(s) are set for the selected Talent Profile Section(s).

Configuring Talent Profile General Section

Beginning with Feature Pack 13B the Talent Profile's General section is now partially configurable, you can now
customize six of the fields that appear in the General section. The following describes the details of the General section
configuration.
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General Section

The Talent Profile's General section is a partially configurable section, similar to the profile's several other composite
sections. The General section is unique in that it is divided into two regions by a horizontal, thin gray line. The region
above the line contains elements which are not configurable (i.e. Employee Name, and Current Job). Icons are no longer
displayed in the upper, non-configurable region of the General section. Only text labels are used. The region below the
line contains elements which are configurable. None of the fields in the General section are editable by the user.
General Section Configuration

Use the Talent Profile Section--General page to configure the lower region of the General section:

- The two regions combined may have a maximum of up to 7 fields.
- 1field, Current Job, displays above the gray line, cannot be removed, and can be hidden if desired.
- The remaining up to 6 fields appear below the gray line and are display only. They do not support editing.

- The 6 fields may be removed, or added from a list of Standard fields (single-value) and Metric fields, or UDF
fields (non-text, single value).

- One of the standard field options combines Work Phone and Extension into a single field.

- The Add Fields link is only available when there are less than 7 fields on the section. When the section has 7
fields the link display changes to Edit Fields.

- You may reorder fields in the lower region of the General section.
- The configurable region is always 50/50 split into two columns. This is not a configurable attribute.

- Section level visibility and availability configuration is not provided. Field level visibility configuration is not
provided. The General section is available and visible for all employees.

- Add Sub Section is not supported.
- The section cannot be deactivated.

Reorder Talent Profile Section Page

Use this page to reorder the up to 6 fields appearing in the configurable region of the General section. the Current Job
field does not show up in the reorder screen because its position is fixed.

Field Selector Page

Use this page to select and add up to 6 fields to appear in the configurable region of the General section. The system
gives an error message when you try to add more than 7 fields to the General section. The fields allowed in the General
section are:

Field Type Fields / Comment

Standard Single value fields only

- Current Job (always in the section, cannot be
removed, can be hidden)

- Email Address

- Ext.

- Interest in International Assignment
- Location

- Manager
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Field Type Fields / Comment

- Organization

- Willing to Relocate

- Work Phone Number

- Work Phone Number and Extension

« Years in Industry

- Years in Management

Metric All

User Defined Non-text, single value fields only

Work Phone Number and Extension Field

The Work Phone Number and Extension field combines the content of the two fields: Work Phone Number, and
Extension (e.g. "877.394.5644 Ext: 7856"). It can be used to display the content of both on the same line. This field is
also available to the other composite sections of the Talent Profile. The recommended configuration path for migrating

existing customers is as follows:

Existing Configuration Prior to Feature
Pack 13B

"Work Phone Number "=Visible and "Ext."
= Visible

"Work Phone Number "=Visible and
"Ext."=Not Visible

"Work Phone Number "=Not Visible and
"Ext." = Visible

"Work Phone Number "=Not Visible and
"Ext."=Not Visible

Configuration

Recommended Configuration Feature Pack 13B

"Work Phone Number and Extension"=Visible

"Work Phone Number "=Visible and "Ext."=Not Visible

"Work Phone Number "=Not Visible and "Ext." = Visible

"Work Phone Number "=Not Visible and "Ext."=Not Visible

Talent Profile configuration options for these enhancements are available in the following location in the system:

Configuration Settings
Name

General section configuration pages.

ORACLE

Location

Configuration > [Taleo Performance] Administration > [Talent Profile
Management] Talent Profile Layout.
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To add and configure properties for custom sections in the Talent Profile, from the Talent Profile Layout page click the
Add Custom Section link. This opens the Talent Profile Section Editor page.

Use the Talent Profile Section Editor to create a custom section and edit its properties: Name, Code, active and base
languages, Split 50/50 and Profile Field Label Placement.

Administrators can determine how the field names and field values in custom sections and sub-sections display on the
Talent Profile. There are 3 configuration options:

- Default: The field labels and their values display as they always have prior to 15B.

- Above: The field labels display above the field values.

- Inline: The field labels display next to, or on the same line as the field values.

Add Custom Sections Settings

Ul Element

Language

Configure

Code

Name

Split 50/50

Profile Field Label Placement

Description

The selector displays any active languages for the section,
including the base language.

Follow the Configure link to define the section's active and
base languages.

Give the custom section a code (e.g. CUSTOM_PERF_SECT).

Give the custom section a name (e.g. Custom Performance).

Use the Split 50/50 option to allow fields to be displayed in
50/50 layout within a section or subsection.

Note: 50/50 split is allowed for single record

f sections only, such as: General, Metrics, Job
Preferences, or custom sections. It is not allowed
for multiple record sections.

Determines how the field names and field values in custom
sections and sub-sections display on the Talent Profile.

To Add a Custom Section

User must be an administrator to perform this task.

Applicable to

Talent Profile Layout

Talent Profile Layout

Talent Profile Layout

Talent Profile Layout

Talent Profile Layout

Talent Profile Layout

Header

Talent Profile Section
Editor

Language
Configuration page.

Talent Profile Section
Editor

Talent Profile Section
Editor

Talent Profile Section
Editor

Talent Profile Section
Editor

Configuration > [Taleo Performance] Administration > [Talent Profile Management] > Talent Profile Layout > Add
Custom Sections > Talent Profile Section Editor
1. Optional. The Language selector displays the current base language. Click the Configure link to open the
Language Configuration page. Edit the base and active language as needed.

2. Create a custom section by giving it a Code and Name.

ORACLE
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3. Optional. Select Split 50/50 if you want to use that display mode for fields in the section.
4. Save your changes.

The properties for the custom section are defined.

Use the Talent Profile Layout page's features to edit other properties for the section.

Reordering Sections

From the Reorder Talent Profile Sections page you can view and edit the order in which sections appear to users of the
Talent Profile.

Reorder Sections Settings

Ul Element Description Applicable to Header

Talent Profile Sections This text view area lists the activated Talent Profile Sections = Talent Profile Layout. Reorder Talent Profile
in the order they are currently set to appear on the Talent Sections.
Profile user interface. Click on a section name to select and
highlight it.

Up and down arrows. Use the up and down arrows to move a selected section in Talent Profile Layout. Reorder Talent Profile
the list, reordering the section display sequence as a result. Sections.

To Reorder Sections

User must be an administrator to perform this task.

Configuration > [Taleo Performance] Administration > [Talent Profile Management] > Talent Profile Layout >
Reorder Sections > Reorder Talent Profile Sections
1. The page displays the names of all activated sections, in the order of their display sequence, in the Talent
Profile Sections text view area.
2. C(lick on a section name in the list to select and highlight it.
3. Use the up and down arrows to move the section name to its new location in the list.
4. Save your changes.

The display sequence for the sections of the Talent Profile is changed in Configuration and in the Talent Profile user
interface.

Viewing and Editing Talent Profile Section Details

Talent Profile section names are listed directly on the Talent Profile Layout page. Generally each section name has a
Show/Hide link and a Details button located to the right. An administrator can view a section's layout detail settings
using the Show/Hide. They can edit the layout details for a section by using the Details button. The Details button opens
the Talent Profile Section - Section Name page, where detailed editing of the section fields and properties can be done.

Viewing Talent Profile Section Details
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For information on viewing a Talent Profile section's layout details directly on the Talent Profile Layout page, see To View
Section Layout Detail Settings.

Editing Talent Profile Section Details

On the Talent Profile Layout page, when you click on a section's Details button, the Talent Profile - [Section Name] page
opens. It provides editing and customization capability for the fields and properties of the section. You can modify each
section in different ways:

Deactivate the section.
Define the active languages and base language.
- Change the section name.
+ Add a subsection.
- Add fields from a field selector: Standard fields, Employee Metrics, Employee Metrics UDFs, Employee UDFs.
Delete fields.
Define whether fields are displayed or editable.
Reorder fields within the section.
Reorder subsection will take all fields within that subsection with it.
- Save changes to layout.
- View History of changes to sections.

For UDF fields define the Ul types, Ul components and number of lines.

f Note: The same field cannot be selected twice in a section.

Upon saving your edits, the section and field displayed in the user interface reflects the new settings entered in the
configuration. If no fields are configured as displayable for a given section, the section does not display in the Talent
Profile.

To View Section Layout Detail Settings

User must be an administrator to perform this task.

Configuration > [Taleo Performance] Administration > [Talent Profile Management] > Talent Profile Layout
1. Alist of Talent Profile sections displays on the page.

2. For a desired section, click the Show/Hide link to the right of the section name to toggle a view-only display of
the section's fields and their properties.

This is a view-only display and is not editable.

To make edits to the properties for a given section, click the Details link to the right of the section name.

To Edit Talent Profile Section Details

Configuration > [Taleo Performance] Administration > [Talent Profile Management] Talent Profile Layout

1. Alist of the Talent Profile sections is displayed on the page. Click the Details button to the right of the name of a
section you want to edit.
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The Talent Profile Section - [Section Name] page opens, displaying the page title, relevant fields and properties
for the selected section. For example, for the Employee Information section configuration the page name is
Talent Profile Section - Employee Information.

2. Make any desired edits to the section.
o Use Deactivate to the right of the page name to deactivate the section from the Talent Profile display.

o Use Deactivate and Configure to the right of Language to edit the active and base languages.

o Use Edit to the right of Properties to edit the properties of the section: Code, Name and Split 50/50.

o Use Add Fields to include new fields to the section layout.

o Use Add Sub Section to include a new sub section to the section layout.

o Use Edit Fields to edit the properties for the existing fields in the section.

o Use Reorder Fields to edit the display order of the fields in the section.

o Use Delete to remove a field from the section.

3. Save your changes.

- The edited and saved changes are displayed in the Talent Profile user interface.

- If no fields in a section have been selected, that section is not displayed in the Talent Profile.

Talent Profile Section Configuration Fields

Standard and Employee Metric type fields configurable for display in Taleo Performance's Talent Profile are presented
in the following table, by alphabetical order of field name. Entries in the table include the name of the interface element
(field), and a description. Many of the fields are available to be configured into more than one of the Talent Profile
sections. The display of sections and fields in the Talent Profile are highly configurable. The fields you actually see are
subject to your organization's implementation. Some fields have different names in the talent profile display and are

indicated as such.

Name

Achievements

Anticipated Graduation Date

Bench Strength

Bonus
Bonus Plan

Can we Contact the Supervisor

Certification

Certifications

Competencies

ORACLE

Description

Free-form text box indicating additional tasks and achievements. Tasks and Achievements in Taleo
Performance.

Flag indicating that the anticipated graduation date is in the future.

Metric that represents an enumeration value based on the number of successors in the succession
plan for the position. Possible values are: None (no succession plan exists), Poor (no successor has
been defined on the existing succession plan for the position), Average (there is 1 successor) and Good
(there are 2 or more successors). This value is not editable in the Talent Profile.

Amount and/or percentage of the bonus.

Name of the bonus plan.

Flag that indicates whether it is possible to communicate with the supervisor to get further
information.

Name of the certification. When adding a new certification, it must be selected from the Certification
Selector.

Section of the Talent Profile that presents the certifications of the employee.

Sub-section of the Competencies section that lists behavioral competencies.
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Competency Rating

Competency Rating

Critical

Current Position

Current Review Status

Current Salary

Custom Metrics

Development Activities
Development Overall Progress
Development Overall Progress
Education

Education Level

Education Level

Effective Date

Effective Date

Effective Date

Email

Employee Information
Employee Status

Employee's Rating

Employer

End Date

Experience

ORACLE
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Description

Metric that indicates the competency rating on the last closed review, based on the review section
configured to provide the basis for this rating.

Review rating score for only the Competency section of the review. It is possible this value could be
empty, while there is still an overall score. The value is based on the final goal score, which uses the
'‘Competency Rating' Metric Rating Model setting to determine the available values. It is formatted
based on the Metric Rating Display setting.

Metric that indicates whether the position occupied by the employee is critical or not. This value
comes from the Job Position’ s Criticality field in SmartOrg and is not editable in the Talent Profile. The
position is considered critical when the Criticality field value in SmartOrg is 5; all other Criticality field
values (1to 4) represent a non-critical position.

Current position of the employee, as defined in the employee's user account in SmartOrg.

The status of the employee's current review, such as draft or complete.

Annual salary of the employee.

Section of the Talent Profile that shows any user-defined metric field.

Activities the employee engages in to develop their job skills.

The overall progress of the employee's development plan, indicated as a percentage.

The overall progress of the employee's development plan, indicated as a percentage.

Section of the Talent Profile that presents education information about the employee.

Level of education attained, selected from a list of defined levels.

Education level preferred by the employee.

Date on which the new salary starts.

Date on which the bonus is being paid.

The date on which the review was closed and the score added to the historical review table.

Email address of the employee at his current position.

Section of the Talent Profile that presents custom employee information.

Employee status preferred by the employee.

Rating given by the employee for the competency in the last focal review, that displays in the Talent
Profile when the review is closed and the Update Talent Profile option is selected. The text value
however is derived from the rating model associated to the specific behavioral competency. The
display of this dimension in the Competencies section of the Talent Profile is based on a setting defined
in the administration application. The rating can be edited if so configured in the administration

application.

Name of the employer. When adding a new work experience, the employer must be selected from the
Employer Selector.

End date for the job function.
Number of years of experience in the particular competency, which can only be defined and edited by
the employee. The display of this dimension in the Competencies section of the Talent Profile is based

on a setting defined in the administration application. The rating can be edited if so configured in the
administration application.
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Name

Expiration Date
Ext.

Gap Analysis Score

General

Goal Rating

Goal Rating

GPA

Graduation Date
Grant Date

Grant Type

Has Development Plan
Impact of Loss
Increase

Increase Type

Incumbent - Succession Plan List table

Institution

Interest

Interest in International Assignment

Interim Replacement

Interim Replacement - Succession Plan

List table
Issue Date
Job Fields

Job Function

Job Level
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Description

Date the certification expires.
Phone extension of the employee at his/her current position.

The difference between the recommended rating for each competency in a job role and the rating the
employee has for each competency.

Section of the Talent Profile that presents general information about the employee.

Metric that indicates the goal rating on the last closed review, based on the review section configured
to provide the basis for this rating.

Review rating score for only the Goal section of the review. It is possible this value could be empty,
while there is still an overall score. The value is based on the final goal score, which uses the 'Goal
Rating' Metric Rating Model setting to determine the available values. It is formatted based on the
Metric Rating Display setting.

Field that indicates the Grade Point Average, that is the mathematical calculation of where an average
of the grades falls on a defined scale. For example, the value could be 3.44 out of 5.

Date the education was completed and the employee graduated.

Date on which the stocks will be vested.

Type of stock.

Metric that indicates whether the employee has a development plan or not.
Metric that indicates how important the employee is in their job function.
Amount and/or percentage of the salary increase.

Type of salary increase.

The name of the person currently in the position. If vacant, this is blank. This value comes from the
Succession Plan of the employee and is not editable in the Talent Profile.

Name of the educational institution. When adding a new education, the institution must be selected
from the Institution Selector.

Level of interest in the particular competency, which can only be defined and edited by the employee.
The display of this dimension in the Competencies section of the Talent Profile is based on a

setting defined in the administration application. The rating can be edited if so configured in the
administration application.

Willingness to work abroad.

Metric that indicates if an interim replacement has been set for the position occupied by the employee.
This value comes from the Succession Plan of the employee and is not editable in the Talent Profile.

Whether or not this employee is the interim replacement named for the position. This value comes
from the Succession Plan of the employee and is not editable in the Talent Profile.

Date the certification was issued.
Job fields of interest, including category, function and specialty.

Name of the job function. When adding a new work experience, the job function must be selected from
the Job Field Selector.

Job level preferred by the employee.
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Name

Job Position - Succession Plan List table

Job Preferences

Job Type
Languages

Last Review Rating
Last Update

Last Used

Location
Locations
Manager
Manager

Manager's Rating

May we contact the supervisor?

Metrics

Name

New Salary

Number of Activities
Number of Career Scenarios
Number of Succession Plans
Number of Successors
Number/ID

Organization

Organization

Organizations
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Description

Position within a Succession Plan that the employee is denoted as a possible successor. This value
comes from the Succession Plan of the employee and is not editable in the Talent Profile.

Section of the Talent Profile that presents the employee's work preferences. These preferences

are defined by the employee and can later be used by managers to find successors according to
preferences via the Advanced Search options.

Job type preferred by the employee.

Sub-section of the Competencies section that lists language competencies.

Overall rating of the employee's last completed performance review.

The date when the employee last made a change to their goal plan.

Indication of the last time the particular competency was used, which can only be defined and edited
by the employee. The display of this dimension in the Competencies section of the Talent Profile is
based on a setting defined in the administration application. The rating can be edited if so configured
in the administration application.

Location of the work place of the employee, as defined in the employee's user account in SmartOrg.
Locations of interest, including country, state/province, region and city.

Name of the employee's direct manager, as defined in the employee's user account in SmartOrg.

The name of the manager who owns the review.

Rating given by the manager for the competency in the last focal review, that displays in the Talent
Profile when the review is closed and the Update Talent Profile options is selected. The text value
however is derived from the rating model associated to the specific behavioral competency. The
display of this dimension in the Competencies section of the Talent Profile is based on a setting defined
in the administration application. The rating can be edited if so configured in the administration

application.

Flag that indicates whether it is possible to communicate with the supervisor to get further
information.

Section of the Talent Profile that presents employee metrics. This section is only seen by managers for
their direct reports.

Name of the competency that can be added by the employee or drawn from the employee's last focal
review when the Update Talent Profile option is selected.

Amount of the new salary, that is the current salary plus the increase.

The number of development activities in the employee's development plan.

Number of career scenarios the employee has in their career plan.

This metric indicates the number of succession plan this person is part of.

Number of successors included in the succession plan for the employee.

Course number or ID associated with the certification.

Name of the organization responsible for providing the certification.

Organization where the employee works, as defined in the employee's user account in SmartOrg.

Organizations of interest, including company, section, department and division.
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Name

Other Certification
Other Employer
Other Institution
Other Job Function
Other Program
Overall Progress
Phone

Potential

Preferred Job

Preferred Location
Preferred Organization
Proficiency

Program

Promotability Readiness

Readiness

Reassignment Candidate
Replacement Name
Review Rating

Review Rating

Review Status

Risk of Loss

Schedule

Show

Skills
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Description

Field used to specify a certification that is not in the list provided in the Certification Selector.

Field used to specify an employer that is not in the list provided in the Employer Selector.

Field used to specify an education institution that is not in the list provided in the Institution Selector.
Field used to specify a job function that is not in the list provided in the Job Field Selector.

Field used to specify an education program that is not in the list provided in the Program Selector.
The overall completion percentage for each of the goals in the employee's goal plan.

Phone number of the employee at their current position.

Metric that indicates the potential of an employee, that is editable by the manager and not visible to
the employee.

Preferred job fields of the employee, selected from those available within the organization. Includes
category, function and specialty.

Preferred locations of the employee, including country, state/province, region and city.
Preferred organizations of the employee, including company, section, department and division.
Level of expertise an employee has in regards to a particular competency. The display of this
dimension in the Competencies section of the Talent Profile is based on a setting defined in the

administration application. The rating can be edited if so configured in the administration application.

Name of the education program. When adding a new education, the program must be selected from
the Program Selector.

Metric that indicates how much time is required for the employee to be ready for a promotion, that is
editable by the manager and not visible to the employee.

Value used to indicate when the employee will be ready to be placed into a job position in a Succession
Plan. This value comes from the Succession Plan of the employee and is not editable in the Talent
Profile.

Metric that indicates if the employee is available for reassignment, that is editable by the manager and
not visible to the employee.

When there is an interim replacement for the employee, this metric shows the name of the
replacement.

Metric that indicates the review rating the employee received on the last closed performance review.
Overall review rating score given by the manager for the review. The value is based on the final score

of the review, which uses the 'Review Rating' Metric Rating Model setting to determine the available
values. It is formatted based on the Metric Rating Display setting.

Metric that indicates the probable risk level of losing the employee, that is editable by the manager and
not visible to the employee.

Work schedule preferred by the employee.
Field that provides the ability to select the competency information type to be displayed. You can
choose to display General information (such as Proficiency, Experience, Last Used, Interest) or Rating

information (that being the Manager and/or the Employee's Rating).

Sub-section of the Competencies section that lists technical competencies.
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Name

Start Date
Start Date
Status

Still in Position

Stock Grant
Supervisor's Email
Supervisor's Name
Supervisor's Phone
Supervisor's Title
Target Bonus

Tasks and Achievements
Total Not-vested Stock
Willing to Relocate
Willing to Travel

Work Experience

Work Experience

Work Phone Number

Work Phone Number and Extension

Work Experience
Years in Industry

Years in Industry

Years in Management

Years in Management
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Description

Date the education started.
Date the job function started.
Overall status of the employee's current goals.

Flag that indicates that the employee in still working in the related position. Most commonly, this flag is
used when the end date is not specified.

Number of stocks.

Email of the supervisor for the related job function.

Name of the supervisor for the related job function.

Phone number of the supervisor for the related job function.

Title of the supervisor for the related job function.

Amount and/or percentage of the bonus that was targeted.

Free-form text box indicating any other task and achievement.

Total number of stocks that are not yet vested.

Employee's willingness to move to a different location.

Percentage of time an employee is willing to travel for their job.

Section of the Talent Profile that presents information about the work experience of the employee.
Section of the Talent Profile that presents the employee's work experience.

Phone number of the employee at their current position.

Phone number and extension of the employee at their current position, in a single field.
Section of the Talent Profile that presents the employee's work experience.

Number of years of experience in the same industry, for the current position.

Number of years of experience in the same industry, for the current position. Same value as the one
presented in the Job Preferences section.

Number of years of management experience.

Number of years of management experience. Same value as the one presented in the Job Preferences
section.

Talent Profile Custom Section Fields

Selectors for adding custom fields to sections allow the selection of "single record" fields only, not multi-record fields.
Selectable fields during section configuration are available for the following types:

- Standard fields
- Metric fields
- UDF fields

ORACLE
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The available fields for each type are as follows:

Type Fields

Standard « Current Job
- Education Level
- Email address
- Employee Status
- Job Level
- Job Type
- Interest in International Assignment
- Preferred Job
- Preferred Location
- Preferred Organization
» Location
- Manager
- Organization
- Schedule
- Willing to Relocate
- Willing to Travel
- Work Phone Number
- Work Phone Extension
- Yearsin Industry

- Years in Management

Metric - All the existing fields in the Metrics
- All the fields defined through the employee Metrics UDFs

UDF All the fields defined through the employee UDFs

Configuring Talent Profile Competencies

Users can view, add, remove and rate competencies for themselves and for other employees directly in the Talent Profile
user interface, depending on how the system is configured in Talent Profile Layout.

User Type Security

The ability to access and edit employee talent profile competencies can be configured separately for seven different user
types:

1. Employee

2. Manager

3. High-level Manager
4. Matrix Manager
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5. Mentor
6. HR Administrator
7. Other

The user type relates to the talent profile that is viewed. The same user will have different user type access to employee
competency settings, depending on that user's relationship to the user who's talent profile they wish to view. It is
important to note that the user types do not relate directly to the standard user types as defined in SmartOrg.

When Michael Decker views his own talent profile, he is accessing it as an employee and the competency settings for
an employee user type apply. When he views the talent profile of Renee Washington, who is one of his direct reports,
he is accessing it as a manager and the competency settings for a manager user type apply. Chris Baker reports directly
to Renee Washington, so if Michael Decker was to view his talent profile it would be as a high level manger and the
corresponding competency settings are applied.

Visibility Groups

The Competencies section of the Talent Profile has field level visibility, and section level availability configuration, but
not section level visibility configuration. (Other sections except for Competencies and General have both section level
visibility and availability).

To Set Talent Profile Competency Access

By default different settings are enabled for each user role.

Configuration > [Talent Performance] Administration > [Talent Profile Management] Talent Profile Layout >
Competencies > Details > Talent Profile Section - Competencies
1. Click Edit beside the user role you want to configure.
2. Select the desired Displayed and/or Editable check boxes beside the relevant Competency Rating to set the
read/write access.
3. Select User Can Add Competencies and/or User Can Remove competencies if the user requires the ability to
change the competencies associated with an employee.
4. Select Display Competency Section in Talent Profile if you want the section to be displayed for that user role.
5. Click Save when complete.

The competencies are displayed as configured for that specific user role.

Repeat the procedure to configure other user roles.

Talent Profile Competency Fields
These settings can be configured differently for each user roles.

Configuration > [Taleo Performance] Administration > [Talent Profile Management] Talent Profile Layout > Talent Profile Section -
Competencies

Ul Element Description

Competency Rating This refers to the different ratings that can be displayed in the Talent Profile for each of
competencies.

Proficiency
Experience
Interest

Last used
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Configuration > [Taleo Performance] Administration > [Talent Profile Management] Talent Profile Layout > Talent Profile Section -
Competencies

Ul Element Description

Performance Rating (Employee)

Performance Rating (Manager)

Displayed Indicates whether the user has read access to the rating.

Editable Indicates whether the user has write access to the rating.

User Can Add Competencies This setting provides the ability to add competencies from the Talent Profile.
User Can Remove Competencies This setting provides the ability to remove competencies from the Talent Profile.
Display Competency Section in Talent Profile This indicates whether the section is displayed in the Talent Profile.

Deleting Rated Competencies

Typically employees or managers cannot delete a competency from the Talent Profile once it has been rated, but HR
Administrators are able to do so. The correct user type permissions are required and certain administration settings
must be enabled.

Configuration
The table shows permissions for deleting a competency from the Talent Profile.

User Type Permission
Name Description

Performance > Employee Profile > View & Manage High level view and manage permissions are required to be able to select
and delete competencies in the Talent Profile.

Performance > Team Management > Access administration tools This permission is required to indicate the user is an HR administrator.

These settings must be enabled.

Configuration > [Taleo Performance] Administration > [Talent Profile Management] Talent Profile Layout > Talent Profile Section -
Competencies

Name Description
Remove competencies This setting is required to display the Minus icon.
Display competency section in Talent Profile This setting is required for the Competencies section to be displayed in the Talent Profile.
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Configuring User-Defined Fields for the Talent Profile
Users-defined fields can be displayed in the Talent Profile.

If you want additional custom information, you can create employee user-defined fields and employee metrics user-
defined fields. These can then be activated and included in the talent profile. When included on a talent profile you can
decide in which order the fields should be displayed and whether they can be edited.

To Create a User-Defined Field

Creating a user-defined field allows an organization to create and define company specific information that can later be
added to various contexts, according to the context for which it was created.

Configuration > [Taleo Performance] Administration > [Performance Reviews] User-defined Fields
Configuration > [Taleo Performance] Administration > [Goals Management] Employee Goal User-defined Fields

Configuration > [Taleo Performance] Administration > [Goals Management] Competency Goal User-defined
Fields

Configuration > [Taleo Performance] Administration > [Employee Management] Employee Information User-
Defined Fields

Configuration > [Taleo Performance] Administration > [Employee Management] Employee Metrics User-Defined
Fields

1. Inthe User-Defined Field page of the selected context, click Create next to the User-Defined Fields header.
In the New User-Defined Field page, specify the properties of the new field.

Note that once created and saved, only the name can be edited.
Also, if more than one language has been configured, a name will be required for each language before saving
is allowed.
3. Click Save.
The new field displays in the list of User-Defined Fields and is available for selection.

Once created, the user-defined field can be added to a review's custom section, to a goal plan or development plan
template or to the Talent Profile form, depending on the type of field created.

Creating a User-Defined Selection List

Creating a user-defined selection list allows system administrators to create additional selection lists having a set of
user-defined values (or elements.) The selection list may be later used to define a user-defined field. This functionality
can be used in performance reviews, goals plans, development plans or in the employee management section of the
Talent Profile.

Configuration > [Taleo Performance] Administration > [Global Configurations] User-defined Selections
Configuration > [Taleo Performance] Selection Lists

1. Inthe User-Defined Selections page, click Create next to Selections.
2. Inthe New User-Defined Selection page, specify the properties for the new selection.
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3. Click Save.
4. In User-Defined Selection page, click Create next to Elements to define the elements of the list.
5. Inthe New Element page, specify the properties of the new element.
6. Repeat steps 4 and 5 for each element composing the selection list.

The new selection list name displays and is available for use in the list of domain fields when creating user-defined
fields.

Once the properties are created, you must activate at least one value (element) to then activate the selection for the
newly created selection list to be available as a user-defined field to be added in custom sections of performance
reviews, goal plans, development plans and the employee management section of the Talent Profile.

To Add a User-Defined Field to the Talent Profile

Adding a user-defined field to a section of the Talent Profile allows system administrators to display additional
information on the Talent Profile.

For a field to be available for selection to add it to the Talent Profile, it needs to have been previously created
and defined as an Employee Information User-Defined Field or as an Employee Metric User-Defined Field.

User-Defined Fields can be added to Metrics, Employee Information, and Custom sections.

Configuration > [Taleo Performance] Administration > Talent Profile Layout > > Details > Talent Profile Section -
[Section Name]

1. Inthe Content section click Add Fields to open the Field Selector.
2. Inthe Field Selector page, navigate to and select the checkbox for the fields that you wish to add to the Talent
Profile.
3. Click Select to add the field(s) to the section and return to the previous Talent Profile Section - [Section Name]
page.
The fields are automatically added to the Content list and therefore, will be displayed on the Talent Profile form when
applicable.

Once added, the fields can be reordered and display properties set as needed.

To Edit a Talent Profile User-Defined Field

Editing a Talent Profile user-defined field consists of configuring if the field will be editable and how the values of the
field will be presented on the Talent Profile.

For a field to be available for selection to add it to the Talent Profile, it needs to have been previously created
and defined as an Employee Information User-Defined Field or as an Employee Metric User-Defined Field.

User-Defined Fields can be edited in Metrics, Employee Information, and Custom sections.

Configuration > [Taleo Performance] Administration > Talent Profile Layout > > Details > Talent Profile Section -
[Section Name]

1. In the Content section click Edit Fields to open the Talent Profile Section Field Editor.
2. Inthe Field Editor page, edit the Ul Component or Display properties as needed.
3. Click Save. The application returns you to the previous Talent Profile Section - [Section Name] page.

The fields properties are updated, the fields remain displayed in the Content list, and will be displayed on the Talent
Profile form with their new properties.
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To Remove a User-Defined Field from the Talent Profile
Removing a user-defined field from a Talent Profile is done from the Talent Profile Layout configuration.

For a field to be available for selection to add it to the Talent Profile, it needs to have been previously created
and defined as an Employee Information User-Defined Field or as an Employee Metric User-Defined Field.

User-Defined Fields can be removed from Metrics, Employee Information, and Custom sections.

Configuration > [Taleo Performance] Administration > Talent Profile Layout > > Details > Talent Profile Section -
[Section Name]

1. In the Content section click the Delete button on the right side of the row for the field you want to remove.
2. Click OK to the confirmation message.

3. The field is removed from the Content list.

4. Repeat as needed to delete all the fields you want remove from the list.

The fields are automatically removed from the Content list, and will not be displayed on the Talent Profile form.

Employee Photo Upload

Instead of having to use the Configuration module or Taleo Connect Client for uploading photos, employees can upload
a photo for themselves.

Larger Photo Image in the Talent Profile

A large size employee photo image (256 x 256 pixels) can be displayed in the Talent Profile's General section. The larger
photo image is also used in the header section of Native Reports. Elsewhere in the system, such as on the Talent Card,
the photo is resized to a smaller image (48 x 48 pixels).

At migration the system will not automatically display photos from implementations prior to Feature Pack 12C. By
default the larger photo will be shown as a silhouette, as photos from earlier implementations are smaller in size. In this
case employee photos will need to be re-imported in order to have them display on the General section.

Note: There are several ways to get the larger employee photo images to display on the General section:
Manually update a photo within the user's General section.

»
4 - Update a photo through the user's SmartOrg account.
Use the Taleo Connect Client (TCC) to batch load employee photos.

Employee Upload of Photo Image

From the Talent Profile General section, an option is available to browse to a photo in your local network and upload it

to Taleo Performance. You can upload .gif, jpg, and .png files. In instances where a photo isn't a passport style photo,
and you upload a portrait orientated photo, the system will attempt to crop the top part of the photo and display it, while
with a landscape photo it will crop the center of the photo and display it.

Configuration

Requires one Talent Profile setting and ensuring that the correct user type permissions are enabled.
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Configuration > [Taleo Performance] Administration > [Talent Profile Management] > Talent Profile Properties
Name Description

Allow Employee to Upload Photo This is required to have the Change Photo option available when you hover over an
employee photo. Whether you can change your photo, or other employee's photos,
depends on you user permissions.

Configuration > [SmartOrg] Administration
Name Description

[Users] User Accounts Select a User Type and Account  An administrator can upload an employee photo from this setting.
Employee Information section Edit

[Users] User Types Functional Domain=Performance You can assign Manage access for different types of users, and this permission is
Employee Profile Edit Permissions=Manage required to see the Change Photo option and be able to upload a photo.

Talent Search

Talent Search provides a consistent, user-focused, robust method for finding employees and candidates. It consists

of a persistent keyword search box for keyword searches and an advanced search, which combines keywords and
employee parameters. Faceted search enhances the existing search capabilities of Taleo Performance providing users
with dynamic and refined search results. Facets guide the user through a search providing continuous available search
options and results.

f Note: When customizable employee metrics are made inactive they are not searchable; only active values
show up in facets.

Configuring Talent Search

Typically features are enabled with a product setting, but talent search and faceted search results are also configured via
user permissions.

There are also search criteria settings which control which fields can be used when executing an advanced search and a
setting for displaying the fit column in search results.

Configuring Talent Search
Access to the Configuration Module.

1. Enable the Performance > Team Management user type permission for search.

Access centralized search - This permission provides access to the talent search box displayed at the top of
each screen and advanced search. It also provides access to the central talent search page where results are
displayed and advanced searches are run and modified.
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2. Set the Performance user type permissions, which control who the person conducting the search can see when
they use employee metric fields as search criteria.

Employee Metrics > View - This permission enables search results to be limited to certain groups of employees,
such as direct reports or those in the same group, when searches include employee metrics and user-defined
employee metrics fields. The employee metrics are Potential, Promotability, Review Ratings, Reassignment
Candidate, and Risk of Loss. This permission is also required to use Secure Facets.

3. Set Performance > Succession Plan and Common > Pools permissions to enable users to add people to those
modules.

4. Set Configuration > [Taleo Performance] Settings > Employee Job Role Advanced Search Field
Configuration, which adds the employee job role as criteria for advanced searches. By default it is set to Yes.

5. Select which search criteria will be available via the Customize option in Advanced Search.

6. Set the Performance rating settings, which are used for the Ratings facet, along with the Talent Profile metric
Employee - Rating.

Review Rating Metric Rating Model - Indicates the rating model used to determine the available values for the
Employee — Review Rating metric.

Metric Rating Model Rounding - Defines what value the employee ratings are rounded to.

Metric Rating Display - Defines how the rating scale is displayed; as percentage, numeric, text, and so on.

7. Edit Configuration > [Taleo Performance] Settings > Show the 'Fit' Column in Person Search Results, to
change the default behavior and to display the Fit column in search results.

The search results will still be listed by fit percentage, even if the Fit column is not displayed.

Talent Search is available in your system for users and groups with the Access centralized search permission.

Talent Search Configuration Settings

The following settings control the criteria available via the Customize option in Advanced Search. They are also used for
controlling which criteria can be used when running an advanced search in Talent Pools and Succession Plans. Note the
Enable Advanced Search setting for Succession Plans and Talent Pools must be enabled to use advanced search with
those modules.

Configuration > [Taleo Performance] Settings

Setting Name Setting Description Possible Values Setting Category
City Advanced Search Field Indicates if the city field criterion is available - Yes Person Search
Configuration in the advanced search.

No (default)
Competencies Advanced Indicates if the "Competencies" section is - Yes
Search Field Configuration available in the advanced search.

No (default)
Country Advanced Search Field Indicates whether the country field criterion - Yes Person Search
Configuration is available in the advanced search.

No (default)
Employee Job Field Advanced Indicates if the "Employee Job Field" - Yes Person Search
Search Field Configuration criterion is available in the advanced search.

No (default)
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Configuration > [Taleo Performance] Settings

Setting Name

Employee Job Role Advanced
Search Field Configuration

Employee Location Advanced
Search Field Configuration

Employee Metrics User-
defined Fields in Advanced
Search Field Configuration

Employee Manager Name
Advanced Search Field
Configuration

Employee Organization
Advanced Search Field
Configuration

Employee Potential Advanced
Search Field Configuration

Employee Readiness For
Promotion Advanced Search
Field Configuration

Employee Review Rating
Advanced Search Field
Configuration

Employee Risk Of Loss
Advanced Search Field
Configuration

Employee User-defined Fields
in Advanced Search Field
Configuration

Interest In International
Advanced Search Field
Configuration

Job Title Advanced Search
Field Configuration

Management Experience
Advanced Search Field
Configuration

Show the 'Fit' Column in

Person Search Result

Reassignment Candidate
Advanced Search Field
Configuration

ORACLE

Setting Description

Indicates if the "Employee Job Role" criterion
is available in the advanced search.

Indicates whether the employee location
field criterion is available in the advanced
search.

Indicates if the section "Employee Metrics
User-defined Fields" is available in the
advanced search.

Indicates whether the employee manager
name field criterion is available in the
advanced search.

Indicates whether the employee
organization field criterion is available in the
advanced search.

Indicates if the "Potential" field is available in
the advanced search. This field is restricted.

Indicates if the "Readiness" field is available
in the advanced search. This field is
restricted.

Indicates if the "Employee Review Rating"
criterion is available in the advanced search.

Indicates if the "Risk of Loss" field is
available in the advanced search. This field is
restricted.

Indicates if the section "Employee User-
defined Fields" is available in the advanced
search.

Indicates if the "Interest in International
Assignment" field is available in the
advanced search.

Indicates whether the job title field is
available in the advanced Search.

Indicates if the "Management Experience"
field is available in the advanced search.

Indicates whether to show the 'Fit' column
on the results page of a person search.

Indicates if the "Reassignment Candidate"
field is available in the advanced search. This
field is restricted.

Possible Values
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Setting Category

Yes (default) Person Search
No

Yes Person Search
No (default)

Yes Person Search
No (default)

Yes Person Search
No (default)

Yes Person Search
No (default)

Yes Person Search
No (default)

Yes Person Search
No (default)

Yes Person Search
No (default)

Yes Person Search
No (default)

Yes Person Search
No (default)

Yes Person Search
No (default)

Yes Person Search
No (default)

Yes Person Search
No (default)

Yes Person Search
No (default)

Yes Person Search
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Configuration > [Taleo Performance] Settings

Setting Name

State Advanced Search Field
Configuration

Willing To Relocate Advanced
Search Field Configuration

Willing To Travel Advanced
Search Field Configuration

Years In Industry Advanced
Search Field Configuration

Zip/Postal Code Advanced
Search Field Configuration

Setting Description

Indicates whether the state field criterion is
available in the advanced search.

Indicates if the "Willing To Relocate" field is
available in the advanced search.

Indicates if the "Willing to Travel" field is
available in the advanced search.

Indicates if the "Years in Industry" field is
available in the advanced search.

Indicates if the ZIP/Postal Code field is
available in the advanced Search.

Talent Browser

Possible Values

No (default)

- Yes

No (default)

- Yes

No (default)

- Yes

No (default)

- Yes

No (default)

- Yes

No (default)

Chapter 7

Employee Management Administration

Setting Category

Person Search

Person Search

Person Search

Person Search

Person Search

The talent browser provides managers and executives with a flexible, real-time view into their organization.

Some of the talent browser's functionality includes:

- viewing multiple levels with panning, zooming and a mini-organization chart map, for easy navigation

- using the scope options, for viewing multiple levels or just direct reports

- drilling down into the org chart layers, for focusing on specific business units and groups

- filtering by general information, customizable employee metrics, and goal association, for highlighting

employees that meet specific criteria

- accessing an employee's snapshot, to have instant access to their key data

- organizational summary card, providing a roll-up view into the metrics for an entire business unit

Customizable Metrics Use in the Talent Browser

The following metrics are displayed in the Talent Browser when Metrics is selected from the General selector, all three of

which are customizable:

- Potential

- Promotability Readiness

- Risk of Loss

ORACLE
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Configuration

By default, all users should have access to the Talent Browser.

Configuration > [Taleo Performance] Settings
Name Description

Maximum Number of Nodes in the Talent Browser Controls how many employee cards can be displayed at one time,
between 50 and 200. The default is 100.

User Type Permission
Name Description

Performance > Team Management > Access... Controls access to More Actions > Team Summary. This prevents employees from seeing
organizational information for levels above their place in the organizational hierarchy.

To configure the Talent Browser

Configuration > [Taleo Performance] Settings

1. To set which employee metrics can be displayed in the Team Summary, go to Configuration > [Taleo
Performance] Administration > [Employee Management] Metrics Configuration and click Edit and make
the required changes.

Only the Display value is used for the Team Summary in the talent browser. The Edit value applies to the Talent
Profile.

2. To set the number of employees that can be displayed at one time, go to Configuration > [Taleo Performance]
Product Settings > Maximum Number of Nodes in Talent Browser and select a value between 50 and 200.

The default value is 100.

Performance > [Navigation bar] Talent Browser is available.

Talent Snapshot

This provides the ability to view key employee information from different modules in the same place.

It is accessible via the Talent Snapshot icon throughout the system. This includes areas such as the Talent Browser,
Network panel, Search results, Talent Pools, Succession Plans, and Performance Review list.

Employee management configuration settings for metrics, along with user type permissions, control access to Snapshot
information.

The following metrics are displayed in the Talent Snapshot, all four of which are customizable:

- Potential

- Risk of Loss
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- Impact of Loss

- Promotability Readiness

Selecting View Org Chart will display the person as the top node in the Talent Browser.

For information on the details for each module, see the corresponding sections in the Help Center or Taleo Performance
user guide.

The Talent Snapshot summary provides information on the following:

Talent Snapshot Contents (except Performance Card)
Section Included Information

Employee Information Manager, Current Position, Direct Reports, Work Experience, Education. When available, the first five
direct reports, first work experience entry, and first education entry are displayed automatically.

Goal Plan Overall goal plan (total goals, goals aligned to manager, overdue goals, overall progress, approval status,
last updated date), Employee goals (name, alignment, progress, due date).

Development Plan Overall dev plan (total activities, overdue and completed activities, approval status, last updated date),
development activities (name, progress, due date).

Succession Plan Overall succession plan (total number of successors, total number of nominations, bench strength,
successors list, approved, last updated date). This section also includes Employee metrics (Potential,
Risk of Loss, Impact of Loss, Promotability Readiness), Position metrics (Critical Position), and Succession
metrics (Interim Replacement and Number of Succession Plans). A pop up with detailed Succession Plan
information displays if the Number of Succession Plans is hovered over. The metrics can be displayed
even if no succession plan is available.

Career Plan Overall career plan (current job, scenario steps, gap analysis for each step indicating competencies
required for the job). You can switch between scenarios and each one can display the current job and the
first two steps of the plan.

Performance Snapshot Card

The Performance snapshot card contains data on the employee's current salary and compa-ratio, along with data on the
last three closed focal performance reviews and compensation periods. The data that is displayed is impacted by your
user type permissions and whether you have compensation data.

At a minimum, the Performance Review Ratings display one value per review period for the Overall score of the review.
It may also contain Goal section and Competency section scores depending on your review configuration. The most
recent review values displayed are the same as those found in the Metrics section of the Talent Profile. For more details
on how ratings scores are derived and displayed, see the Taleo Performance Review Ratings Orientation Guide.

Compensation data can be brought into Taleo Performance via an integration with Taleo Compensation or by importing
data from a third-party system using Taleo Connect Client (TCC). Regardless of which, batch data import jobs should be
scheduled regularly to ensure the most up to date compensation data is displayed. For integration details, see the Taleo
Compensation and Performance Integration Guide.

While the compensation data values available to both the snapshot and talent profile are the same, they are displayed
differently. The talent profile only displays information when it is available and only displays the most recent individual
values. The snapshot card displays NA when there is no information and displays values based on yearly totals and
availability.
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f Note: Performance and compensation data are independent of each other, therefore it is possible the periods
displayed for each will differ.

Performance Card Contents

Subject

Current Salary
Compa-ratio

Performance Review Ratings

Overall
Goals
Competencies

Review Comments

Compensation History

Salary Increase

Bonus Award

Stock Granted

Configuration

Description

This value is taken from the compensation history table. Depending on when the compensation data was
last updated, it is possible this is not your actual current salary.

This value is taken from the compensation history table. Depending on when the compensation data was
last updated, it is possible this is not your actual current compa-ratio.

Displays the Overall review rating based on the Employee - Review Rating value kept in the historical
review table for the indicated review period. All scores are for completed and closed review periods. No
active scores are included.

Displays the rating for the Goals section of the review. This is based on the Employee - Goal Rating value
kept in the historical review table for the indicated review period. All scores are for completed and closed
review periods. No active scores are included.

Displays the rating for the Competencies section of the review. This is based on the Employee -
Competency Rating value kept in the historical review table for the indicated review period. All scores are
for completed and closed review periods. No active scores are included.

When you select an overall rating, review comments associated with it are displayed here. If no
comments exist, the score is not a clickable link.

These values come from the compensation salary history table associated with the effective date
displayed on the card. The Taleo Enterprise SmartOrg Data Dictionary provides details on compensation
elements.

These values come from the compensation bonus history table associated with the effective date
displayed on the card. As currencies are displayed for both this value and Salary Increase and multiple
currencies are not supported within the same aggregated period, you should use the same currency
whenever possible.

These values come from the compensation stock history table associated with the effective date
displayed on the card.

There are no specific Taleo Performance configuration requirements for this feature; however, you must have the
following View user type permissions and configuration settings to display the data. There is no information available
messages are displayed to users without appropriate permissions.

If Taleo Compensation is activated in the zone, the integration should have been configured to automatically transfer
compensation history data on a regular basis. If Taleo Compensation is not activated, the client can use Taleo Connect
Client (TCC) to transfer compensation data from an outside ERP system.

ORACLE
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User Type Permission
Snapshot Section Required Permission

Employee Information - Employee Profile - required to display Work Experience and Education details. Manager,
Current Position, and Direct Reports are always displayed.

Goal Plan - Goal Plans - required to display the entire section.
Development Plan - Development Plans - required to display the entire section.
Succession Plan - Succession Plans - required to display plan details.

- Employee Metrics - required to display metrics.

Career Plan - Career Plans - required to display the entire section.
Performance Review Ratings « [Performance] Performance Reviews - required to display the entire Performance section.
Compensation History « [Compensation] Compensation Data - required to display the entire Compensation section

and also the current salary and compa-ratio data.

Configuration > [Taleo Performance] Administration > [Employee Management]
Settings Description

Metrics Configuration Affects what is displayed in the Metrics section of the Succession Plan snapshot card.

Configuring Filters

All the filters found in the Filter tabs throughout Taleo Performance modules can be hidden or displayed.

Filter configuration settings control the display of each instance of a filter. It is either displayed or hidden for the entire
system. For example, Willing to Travel is available in filters for Talent Pools, Talent Browser, Review Calibrations, and
Nomination Slates. There is no way for it to only be displayed for pools and the browser, while remaining hidden for
calibrations and nominations.

When searching in the Configuration Module for a field to disable you can refine the list of filter fields by context, which
displays a list with each of the Taleo Performance modules or pages the filter is used. Subsequently selecting one of the
modules displays only those filters used with the module.

Configuration

Go to Configuration > [Taleo Performance] Administration > [Global Configurations] Filters and click Disable or
Enable for the filters as required.
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Attachments

Files can be attached to Performance Reviews, Goal Plans, and the Talent Profile. This enables employees to include
documents that are not kept in Taleo Performance, in support of their achievements and progress for reviews and plans,
such as projects plans, implementation scorecards, or client feedback. Native reporting output files can also be attached
to reporting correspondence. "Attachment" settings are globally applied to all types of attachments, including report
attachments used in native reporting correspondence.-

The files are associated with the highest level object, such as the overall goal plan itself and not a specific employee
goal. Attachments can be viewed by anyone who has view access to the object (goal plan, review, talent profile), while
manage access is required to attach files. Only employees can attach files to their goal plans and performance reviews.
Like other events, adding and removing attachments is included in the object's history.

As a basic service you can attach up to ten files to an object, with a maximum file size of 1mb, depending on system
configuration. If you have already reached your maximum number of attachments you will need to delete a file before a
new one can be uploaded. Once a file has been attached it can be updated, but you must save the file locally, make your
changes, and then re-upload it. A wide range of file types are supported, but those available to you will depend on your
organization's implementation.

f Note: If the file restrictions change over time, it is possible some existing attachments will be for file types and
file sizes that are no longer allowed.

Supported File Types

Type (Extension) Type (Extension)

Word (.doc, .docx) Text (.txt)

HTML page (.htm) Word Perfect (.wpd)

HTML page (.html) Excel (.xIs, .xIsx)

Portable Document Format (.pdf) Zip (.zip)

Rich Text Format (.rtf) OpenOffice Writer (.odt)
Configuration

Clients must request activation of this feature. This feature should not be activated until Taleo has analyzed the impact
it may have on the client's system.

Apart from Attachment Enabled, the General Configuration settings do not need to be configured unless you want to
change the default values for the list of supported files or the size and number of files that can be attached.
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Configuration > [Taleo Performance] Settings
Name Description

Attachment Enabled Protected setting. Taleo Support must enable this setting. By default this setting is disabled. When
enabled, attachment functionality is available for goal plans, performance reviews, and talent
profiles, with the constraints of the other attachment settings applied.

Configuration > [General Configuration] Settings

Name Description

Attachment Format Filter Public setting. By default all supported file types can be uploaded. You can add and remove file
types from the list as required.

Attachment File Maximum Number Protected setting. The maximum number of files that a user can attach to an object is 10.

Attachment File Maximum Size Protected setting. The maximum size for each uploaded file is 1 MB.

Block Macros in Attachments Public setting. The system will scan the attachments for macros. Files containing macros will not
be updated.

After configuring the global settings, specific attachment options must be enabled for goal plans and the talent profile.
Reviews also require the Performance Reviews > Manage - If this user is one of the authors user type permission.

Configuration > [Taleo Performance] Administration

Name Location

Allow File Attachments - [Goal Management] Goal Plan Templates > Goal Plan Name > [Properties]
- [Employee Management] Talent Profile Section Configuration > [Properties]

- [Performance Reviews] Review Cycles > Review Cycle Name > [Review Requests]
Request Name > [Settings]

Native Reports

Predefined, delivered reports can be run from within Oracle Taleo Performance, without the need to move to a different
module or have special access. This enables reports to be quickly and simply generated on common subjects, such as
goal plan status or performance review details. Native reporting lets managers report from within a module, where they
simply select which employees they want to include in the report and what subject they want to report on, based on the
available templates.

Native Reporting is based on the Oracle Business Intelligence Publisher (Bl Publisher or BIP). The content of the
delivered native reports has not changed from prior releases. Report layout may be slightly different due to the change
in reporting technology. Customers are also able to create their own custom reports. The language selected at login
determines which language the report is generated in. The report data displays in that login language, however, the
language of the template reports are shown in the language they were originally created. The report labels display as
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designed in the report template. A separate report template must be created for each language if it is necessary for the
report template and language to match. By default reports are available in Oracle Taleo Performance; however, they can
also be emailed as attachments with additional configuration.

Delivered Reporting Templates
The following report templates are delivered:

- Goal Plan Status - Includes goal plan status information about the selected population. The report focuses
on the plan status and approval date along with useful employee information such as their location and
organization.

- Development Plan Status - Similar to goal plan, except that it deals with development plans.

- Review Status - Includes review status information about the selected population. It is useful for Employee Self-
Assessment and Manager Evaluation statuses along with typical employee information.

- Review History - Includes the historical performance review scores for the selected population. The report
focuses on the goal score, the competency score, and the Overall Review Rating.

- Performance Review Summary - Can include the review status, goal section score, and competency section
score for a designated review cycle and review request.

- Talent Profile - Provides a consolidated view of an employee's information such as their job, work history, skills
and qualifications, performance, and development.

- Organization Chart - Contains the organization charts for all the direct reports under the senior leader specified
in the Select Employee(s) section of the Run a Report dialog. The report can provide a useful tool for compiling
a talent book for the organization, although it is not an exact replica of the Talent Browser. If a manager
has too many direct reports, not all nodes will be shown. It is recommended that each individual manager's
organization chart report should be run separately to include all members.

f Note: The Organization Chart report is not modifiable by customers using Bl Publisher.

Native Reporting Setup

Native Reporting must be configured to be enabled in Oracle Taleo Performance as must the appearance of a large
profile picture in reports, the activation of reports, and the attachment of reports to report correspondence (emails).

Native Reports Configuration
Follow these steps to configure your system to run native reporting:

Step 1: Request Oracle Taleo Support to activate a native reporting server in your Oracle Taleo Performance Cloud
Service zone. Support uses Oracle Taleo Remote Connect Client (RCC) to select Native Reporting and Data Extract in
the JBoss component of the zone setup.

Step 2: Configure setting to enable native reporting in Oracle Taleo Performance.
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Configuration > [Taleo Performance] Settings >

Name

Enable Native Reporting

Description

A Private setting. Enables the native reporting feature in Oracle Taleo Performance. This includes
all of the access links for My Reports and Run Reports found in the user interface along with the
ability to create and run reports.

Step 3: Decide which native reports (from among the delivered templates) are required for your implementation, which
level of users will have access to native reporting, whether attachments will be enabled, and what content should be

included in the email templates.

Step 4: Configure the Oracle Taleo Performance Management settings as follows.

User Type Permission. A user type permission enables user access to native reporting, while multiple variables and
email templates are used to send results to someone.

Configuration > [SmartOrg] Administration > [Users] User Types > Select User Type > Performance > Team Management > Permissions

Name

Access Reporting

Access Report Data

Description

Provides the User Type access to native reports.
Note: The two main conditions for a user to have access to native reporting include:
- Setting "Enable Native Reporting" to Yes.

- Granting the permission "Access Reporting".

Controls who can view XML data generated by reports.

- Only users’ who have this permission granted as well as the Access Reporting permission,
will be able to view and select the Download XML link.

- By default, at upgrade all the existing users prior to 15B.6 that already had Access Reporting
permissions will now also have the new Access Report Data permissions. The Access Report
Data permission will be disabled by default for new users.

Report attachment file size and number. Multiple settings enable reports as attachments to correspondence and control

maximum file number and size.

Configuration > [General Configuration] Settings

Name

Attached File Maximum Size

Attached File Maximum Number

ORACLE

Description

Protected setting. Category is Configuration. The default value is TMB. If a report exceeds the
value it will not be attached to the email notifying the user the report is ready.

Protected setting. Category is Configuration. The default value is 10. If a report exceeds the value
it will not be attached to the email notifying the user the report is ready.

242



Talent Acquisition Cloud
Implementing Performance

Configuration > [Taleo Performance] Settings

Name Description

Chapter 7
Employee Management Administration

Attachment Enabled Protected setting. Category is Global Settings. The default value is No. Enables or disables the
ability to attach files in Oracle Taleo Performance Management..

Email templates and variables. Multiple settings control the use of message templates with report correspondence.

Configuration > [Taleo Performance] Administration > [Global Configurations] Message Templates

Name Description

NR notification for reporting Native reporting correspondence. Intended when the report is completed, without attachment.
NR notification for reporting with attachment Native reporting correspondence. Intended when the report is completed, with attachment.
NR notification for reporting - error Native reporting correspondence. Intended when the report is not completed.
{Report-Notification.ReportName} This is the name of the report as found in the My Reports > Name column or entered in the

Customize this report section when creating a new report.

{Report-Notification.ReportUrl} This is the link to the report in Oracle Taleo Performance. Clicking the link may require you to
login, but will then take you directly to the report.

Configuration > [Taleo Performance] Administration > [Native Reporting] Reporting Correspondence

Name

Correspondence for completed reports

Correspondence for completed reports with attachments

Correspondence for reports not created due to errors

Description

This email is used for emails that do not include an attached report, so you must
ensure the {Report-Notification.ReportUrl} variable is included so recipients can
access the report from Taleo Performance.

This email is used when a PDF report does not exceed the maximum file size limit
and can be sent as an attachment.

This email is used when there is a report creation error.

General Configuration Settings These global settings are private and apply to any products using native reporting in the
zone. Note: Currently Oracle Taleo Performance Management is the only product using native reporting.

Configuration > [General Configuration] Settings > Category=Native Reporting

Name

Maximum Extract Processing Time

Maximum Record Count

ORACLE

Description

Maximum number of minutes for report data to be extracted from the system
before an error occurs.

Maximum number of employees (records) that can be included in a report. The

default of O means this setting must be changed before reports can be generated
successfully.
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Configuration > [General Configuration] Settings > Category=Native Reporting
Name Description

Maximum Report Processing Thread Size Maximum number of reports that can be generated concurrently per client
implementation. When the number of report requests and subsequent processing
threads exceeds this value, report requests will be put in a queue until they can be
processed. The default is 10.

Period Before Request Archival Number or days before a report is archived. This changes the report status to
Archived and moves it from the active My Reports list. The default is 5 days. Note
this has not been implemented in Taleo Performance 12A.

Period Before Request Deletion Number of days before a report is deleted from the system. The days are measured
from the day of the request. The default is 90 days.

Period Before Request Failure Number of days after a report request has been made and a report has not been

generated, that it is considered to have failed. The report status changes to Error.
The default is 1 day.

Step 5: Enable large employee photos for report header sections.

Native Reports display a larger, higher quality employee photo image in the header section. It is the same image as that
for the Talent Profile's General section:

- Image format can be .gif, .jpg. or .png.
- Image size is 256 x 256 pixels, passport style.

Some configuration is needed for the photo to display in the Talent Profile and reports. For details see Employee Photo
Upload.
Step 6: To configure and activate reports, log into Taleo Performance's Configuration module as administrator.

a. Open the Report Definition page. (Navigation: [Taleo Performance] Administration > [Native Reporting]
Administration > Report Definition. Repeat the following substeps for each desired report.

b. Click on the Report Definition name to open and view its properties.

c. Review the report properties: Name, Description, Category (Performance module or functional area such as
Development Plans, Goal Plans, Reviews, or Talent Profile), Data Model, Report Template file (RTF format), output file
formats to be allowed when end-users generate the report, and standard report selection parameters (e.g. population)
to appear on the Create Report dialog when end-users generate the report.

d. If needed, set up access permissions for the report based on User Groups or User Roles.

e. If needed, select or deselect Activate to make the report available/not available for use in Performance. Reports
activated are added to the Reports list for the zone, are available to end users to run, and can subsequently be
deactivated by the administrator.

f. Save any changes.

Native Reporting Administration

Administrators use the following Configuration section and subsections for creating and managing report elements.
These include data model and report definitions, and report requests, for both delivered and custom reports:
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Native Reporting Management in Configuration

Configuration > [Taleo Performance] Administration > [Native Reporting] Administration > [Reporting Management]

Subsection Name

Data Model Definitions

Report Definitions

Request Management

Description

Data model definitions are predefined sets of related reporting entities used to support reporting on
Performance module areas. This subsection displays the names of delivered and custom data model
definitions (e.g. Development Plan, Goal Plan, Review or Talent Profile). It has two main tabs:
1. Data Model Definition Management is used to manage data model definitions for delivered and
custom data model definitions.
2. Data Model Definition Sampling provides the ability to download sample data models in XML
files. These XML files are referenced in report definitions for delivered and custom reports.

Displays a list of the available delivered and custom report definitions. Also provides the ability to
configure custom report definitions; including the name and description, data model, template file,
output file format(s), group and role-base access permissions, standard report parameters, and
activate/deactivate status.

Displays a list of native reporting requests previously run, based on these filters: request identifier,
date, owner and status.

Native Reports Group and Role-based Permissions

The Report Definition page provides administrators the ability to create access restrictions for native reports based on

groups and roles.

Restriction access controls a user's ability to run a report. Group restrictions are based on administrator created groups
containing specific subsets of users. Role restrictions are based on Performance roles:

- EMPLOYEE

» HIGHER_MANAGER
- HRADMIN

- MANAGER

- MATRIX_MANAGER
- MENTOR

Both restriction types, groups and roles, are usable for the same report definition. Only employees fitting the configured
restrictions will be able to run a restricted report.

Setting Group Report Access Restrictions

The report definition must first be created.

Configuration > [Taleo Performance] Administration > [Native Reporting] Administration > Report Definitions
1. Inthe Report Definitions section select the report definition Name from the list.
2. On the Report Definition - [Domain] page, next to User Groups, click Add.
3. Use the Refine By selector and associated text entry field to search for the desired user group(s) you want to

limit access to the report to.

ORACLE
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4. Select the checkbox next to the desired user group(s) you want to limit access to the report to.

5. Once all desired groups are chosen, click Select.

Restrictions display in the User Groups section of the Report Definition - [Domain] page.

Only users fitting the configured restrictions will be able to run a restricted report.

To lift a group restriction click the Remove button next to the restriction listed in the User Groups section of the Report
Definition - [Domain] page.

Setting Role Report Access Restrictions

The report definition must first be created.

Configuration > [Taleo Performance] Administration > [Native Reporting] Administration > Report Definitions
1. In the Report Definitions section select the report definition Name from the list.
2. On the Report Definition - [Domain] page, next to User Roles, click Add.
3. Select the checkbox next to the desired user role(s) you want to limit access to the report to.
4. Once all desired roles are chosen, click Select.

Restrictions display in the User Roles section of the Report Definition - [Domain] page.

Only users fitting the configured restrictions will be able to run a restricted report.

To lift a role restriction click the Remove button next to the restriction listed in the User Roles section of the Report
Definition - [Domain] page.

Native Reporting Data Domains

Native Reporting utilizes delivered data domains to provide structure for delivered reports. Delivered data domains also
facilitate and simplify the creation of custom reports. Administrators can also create custom data domains to expand
the datasets available for custom reports.

Glossary

The following terms are used in Native Reporting.

Term Definition

Domain A hierarchy of data models and datasets, with connected common fields (joins). A domain includes
these basic attributes: Name, Code, Base Data Model and Description. The elements of a domain
are related together around a common business process or module. For example: Review, Goal or
Succession.

Data Model A hierarchy of datasets (including entities such as dataset fields) connected together by a logical data
join, and used in report layout and generation.

Dataset An entity for reporting, containing a list of exposed fields from a common data model or category
(such as Employee, Goal Plan or Review fields).

Component An entity that is common across datasets in Performance (such as Comments or Position), and can be
connected to multiple datasets.

Delivered Data Domains
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Organization Chart (limited availability - a customizable data model is not available for the Organization Chart)

Succession
Review
Talent Pool
Talent Profile

A list of these delivered domains, plus any created custom domains appears in configuration on the Data Model

Definitions for Deployment page.

Delivered Data Models

Data models delivered for use in native reporting include these areas of Performance:

Candidate

Career*

Comments
Development*
Development Metrics
Employee*

Employee Goal Metrics
Employee Manager
Employee Measurement
Feedback

Goal*

Goal Measurement
Job Role

Position*

Position Manager

Requisition (partial availability)

Review*

Review Content
Review Measurement
Review Metrics
Succession*

Talent Pool*

Talent Profile Measurement*

Talent Profile*

User

ORACLE
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?’ Note: * These models are the "base" data models from which you can build custom data models.

Native Reporting Custom Data Model Definitions

Native Reporting allows administrators to create custom data model definitions, and perform cross-domain referencing
in the definitions, using the Data Model Definition and Data Model Editor pages in Configuration.
Custom data model definitions provide users the ability to:

- Choose the connection points to bind different data domains and data models together under a custom data
model definition.

- Select which data models and datasets are to be used in a custom data model definition.

- Create reports with information drawn from across data domains and data models.

For example, a custom data model definition could contain datasets from the Talent Profile domain, plus additional
Development domain datasets.

Custom Data Model Definition Creation

You can create custom data models to expand the datasets (fields) available for making custom reports. There are
several base data models from where you can start creating a custom data model definition.

- Career
Development Plan
Employee
Employee Measurement *
- Goal Plan
Position
Review
+ Succession Plan
- Talent Pool

- Talent Profile

*The Review Measurement Data Model and the Goal Measurement Data Model are not base data models, but can be
joined with the Employee Measurement Data Model to emphasize Review and Goal-centric metrics. When this data
join is made, the default 5,000 row output restriction typically associated with employee data is lifted and increased to
65,000 allowing for enhanced or aggregated reporting across entire organizations and larger employee populations.
While these measurement models do include some of the most essential fields and additional basic data applicable

to reviews and goals, they are primarily to be used to obtain metrics across an employee base that exceeds 5,000
records. Additionally, more data can be obtained by joining either of the Measurement Data Models with the Employee
Measurement Data Model. If more detailed information from reviews or goals for less than 5,000 employees is needed,
you should use the Review Data Model or the Goal Data Model, not these measurement models.

Choosing the base data model to begin with is driven by two main considerations:

1. What subject areas (domains) will the report be built on?
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2. What selection parameters will the user need to enter to run the report?

With respect to subject area selection, best practices are:

- For a report drawing data from a single domain, choose that domain as the base model. For example, for a
strictly review oriented report, choose the review base model. Or for a goal oriented report, choose the goal
base model. Such custom reports might differ from the delivered reports due to factors such as dataset (field)
selection and layout.

- For areport drawing data from multiple domains, use the employee, position or talent pool data model as
the base since they can connect to most of the other domains. Such custom reports will differ from delivered
reports not only due to field selection and layout, but also due to their cross-domain referencing.

With respect to report parameter selection, reports can have three types of population selection parameters:
Employees, Positions and Talent Pools. The base data model for a report should be chosen based on what populations
the user will want to see in the report:

- Employees - Values include Direct Reports, Direct Reports + One Level, All My Employees, Specific Employees
and Talent Pool.

- Positions - Values include All My Positions and Specific Positions.
- Talent Pools - Values include All My Talent Pools and Select Talent Pools.
Customers can select which User Defined Fields (UDFs) are included in their custom data models. By default, when you

add a new data set to an existing data model, all of its UDFs are also added. However, you can deselect unwanted UDFs
from those data models.

The following diagram shows the main connections between some of the base data models (shaded) and other
available data models. It also shows the report entry parameters available to run a report for each base model chosen.
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Creating a Custom Data Model Definition
The following steps outline the workflow for custom domain and data model creation:

Prerequisite

- You must be an administrative user for Oracle Taleo Performance with access to the Configuration module.

Configuration > [Taleo Performance] Administration > [Native Reporting] Administration > [Reporting
Management] Data Model Definitions > [Data Model Definitions for Deployment]

1. Loginto the Configuration module and navigate to the Data Model Definitions for Deployment page, and click
the Data Model Definition Management tab.

2. Under Data Model Definition Management click Create to begin the process of creating the custom data model
definition.

3. On the Data Model Definition Editor page enter the Name, Code, Description and select a Base Data Model for
the custom data model definition. (For example, you might begin by selecting the Employee data model as the
base model.) Then Save.
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4. The Data Model Definition - [Name] page opens, displaying the newly created domain's Properties at the top.
The Data Model Content section below displays a tree hierarchy for the base data model, Talent Profile.

5. To begin customizing the data model, click Edit next to Data Model Content.

6. On the Data Model Editor page the full dataset content for the base model is displayed in a collapsible/
expandable tree hierarchy. At first, all datasets for the base model are selected at the root.

o Use the Checkboxes to indicate which datasets to include in the model.
o Use Add (+) buttons to add model hierarchy to the data model.

o Data models are only presented as connectible when there is a logical entity relation (join). You do not
have to be concerned about whether or not joins are valid, combinations are predefined and limited by
the system.

o Use X buttons to remove model hierarchy.

o Asyou work with the levels in the hierarchy, view the selectable datasets in the window to the right. There
is a maximum limitation of 60 selectable datasets.

7. Save any changes.
Click Activate.

9. The active domain and data model can now be used to create custom reports, in the Report Definitions page in
Configuration.

o

Editing an Existing Data Model Definition

You want to edit an existing data model definition.

Configuration > [Taleo Performance] Administration > [Native Reporting] Administration > [Reporting
Management] Data Model Definitions > [Data Model Definitions for Deployment] Data Model Definition
Management
1. Locate the desired data model definition in the list of existing definitions, and click on it.
The Data Model Definition - [Name] page opens.
2. Optional. You can make the following types of changes.

a. Click Delete to remove an inactive definition from the database. This cannot be undone. You cannot
delete an active data model definition.

b. Click Activate/Deactivate to change the definition's status. You cannot deactivate a data model definition
if there is an active report definition referring to it.

c. Click Edit next to Properties, and in that section you can edit the Name, Code and Description.

d. Click Edit next to Data Model Content, and in that section you can edit the model content for an inactive
data domain. You cannot edit an active data model definition.

e. Save your changes as you go.

When a data model definition is edited and the changes saved, the prior version of the definition is lost. If you need to
maintain historical copies of all versions of the data model definition it is recommended you use the duplicate function
instead.

Any existing report definitions referencing an edited data model definition are also affected by the change(s).

Duplicating an Existing Data Model Definition

You want to make a copy of and edit an existing data model definition, active or inactive, while maintaining the existing
version.
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Configuration > [Taleo Performance] Administration > [Native Reporting] Administration > [Reporting
Management] Data Model Definitions > [Data Model Definitions for Deployment] Data Model Definition
Management

1. Locate the desired data model definition in the list of existing definitions, and click on it.

The Data Model Definition - [Name] page opens.
2. Click Duplicate.

The system makes a duplicate copy of the data model definition while changing the Code with a pre-appended
number to distinguish the copied version from the original.
3. Optional. You can make the following types of changes.
a. Click Delete to remove the newly created definition from the database. This cannot be undone.
b. Click Activate/Deactivate to change the definition's status. A data model definition cannot be deactivated
if there is a report definition referring it.
c. Click Edit next to Properties, and in the Properties section you can edit the Name, Code and Description.
Keep the Code unique from any other versions in the system.
d. Click Edit next to Data Model Content, and you can edit the model content.
e. Save your changes as you go.

While the data model definition is copied, edited and saved with a new code; the prior version of the definition having a
different code is kept in the database also.

Native Reporting Custom Report Creation

In addition to the delivered native reports, custom reports can be created and run from within Oracle Taleo Performance
using the Native Reporting feature.

Beginning in Feature Pack 13C Native Reporting is based on the Oracle Business Intelligence Publisher (Bl Publisher
or BIP). Customer system administrators can use the Oracle Bl Publisher plug-in, in association with Oracle Taleo
Performance's Configuration module, to create custom reports.

Bl Publisher provides a plug-in utility for Microsoft Word that automates layout design. It enables you to connect to

Bl Publisher, access data, and upload templates directly from a Microsoft Word session. The Rich Text Format (RTF)

also supports advanced formatting commands and layout options. RTF templates support a variety of output types,
including: HTML, PDF, PPT, RTF and XLS.

Editing a Report Definition

The report definition you want to edit must already exist in the system and have inactive status. You cannot edit an
active status report definition.

Configuration > [Taleo Performance] Administration > [Native Reporting] Administration > [Reporting
Management] Report Definitions
1. Locate the desired report definition name on the list and click it to open the Report Definition - [Name] page.
2. Optional. You can make the following types of changes.
a. Click Delete to remove an inactive definition from the database. This cannot be undone. You cannot
delete an active report definition.
b. Click Activate to change the definition's status.
c. Click Edit next to Properties. The Report Definition Editor page opens. You can edit the Name, Category,
Description, Template File, File Formats and Standard Report Parameters. You cannot edit the Data Model
Definition field.
d. Save your changes as you go.
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3. Optional. On the Report Definition - [Name] page you can click Add next to User Group or User Role to edit the
report access restrictions.

When a report definition is edited and the changes saved, the prior version of the definition is lost. If you need to
maintain historical copies of all versions of the report definition it is recommended you use the duplicate function
instead.

Duplicating a Report Definition
The report definition you want to duplicate must already exist in the system.

Configuration > [Taleo Performance] Administration > [Native Reporting] Administration > [Reporting
Management] Report Definitions
1. Locate the desired report definition in the list of existing definitions, and click on it.

The Report Definition - [Name] page opens.

2. Click Duplicate.
The system makes a duplicate copy of the report definition; while changing the Name by appending the word
Duplicate to it, and changing the Status to Inactive. This distinguishes the copied version from the original.

3. Optional. You can make the following types of changes.

a. Click Delete to remove the newly created definition from the database. This cannot be undone.

b. Click Activate to change the definition's status.

c. Click Edit next to Properties to open the Report Definition Editor page. You can edit the Name, Category,
Description, Template File, File Formats, and Standard Report Parameters. Keep the Name unique from
any other versions in the system. You cannot edit the Data Model Definition field.

d. Save your changes as you go.

4. Optional. On the Report Definition - [Name] page you can click Add next to User Group or User Role to edit the
report access restrictions.

While the report definition is copied, edited and saved with a new name; the prior version of the definition having a
different name is kept in the database also.

Showing Compensation Data in Taleo Performance

Compensation history data can be configured to display within Taleo Performance.

The talent model includes compensation data elements so that compensation data may be displayed within the Taleo
Performance application. This compensation data can come from Taleo Compensation or from an external HRMS/ERP
system.

The compensation history data is displayed according to metric configuration, availability, and user security access in
the following areas:

- Talent Profile - Displays compensation history data.
Performance Snapshot Card - Displays compensation data in the Compensation section of the snapshot card.
- Talent Browser - Displays salary, bonus, and stock information for employees.

When compensation history data is available, and the related metric has been configured to display, the following
information is provided in Taleo Performance, when available:

Employee's current salary
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- Employee's salary increase, new salary and effective date
- Employee's bonus amount, bonus plan, target bonus amount and effective date

- Employee's stock grant amount, total non-vested stock and grant date

Compensation history is available from Taleo Compensation through an integration. If Taleo Compensation is activated
in the zone and the integration is configured, the system will automatically transfer all compensation history data into
SmartOrg on a daily basis. If Taleo Compensation is not activated, the client can use the standard integration tools to
transfer the data from an outside ERP system.

Configuration

The following permissions must be granted to individual users to view or manage the Compensation History Data
feature in Taleo Performance.

User Type Permission
Name Location

View Compensation Data Configuration > [SmartOrg] Administration > User Type > User Account
>Compensation>Compensation>Compensation Data

Manage Compensation Data Configuration > [SmartOrg] Administration > User Type > User Account
>Compensation>Compensation>Compensation Data

Available Compensation Metrics
Name Location

Compensation - Current Salary Configuration > [Taleo Performance] Administration > [Employee
Management] Metrics Configuration

Compensation - Salary Increase Configuration > [Taleo Performance] Administration > [Employee
Management] Metrics Configuration

Compensation - Target Bonus Configuration > [Taleo Performance] Administration > [Employee
Management] Metrics Configuration

Compensation - Non-vested Stock Configuration > [Taleo Performance] Administration > [Employee
Management] Metrics Configuration

Taleo Performance and Recruiting Unification

Managers can access Taleo Recruiting information and functions directly from Taleo Performance, enabling them to
work with — and create — requisitions.

- From the Talent Browser, you can view a summary of the open positions and open requisitions you own and
subsequently choose to view the requisition or its candidates in Taleo Recruiting
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- Also from Talent Browser, you can initiate the requisition creation process, from where the Requisition Wizard is
launched and you are taken to Taleo Recruiting to complete the task

- From Talent Search results, you can add employees and candidates to your open requisitions directly in Taleo
Performance

Configuration

The Taleo Recruiting module must be enabled and the following user permissions are needed.

User Type Permission

Name Description

Recruiting > Candidates > Match candidates to requisitions Required to be able to add someone to a requisition from search results.
Recruiting > Requisitions > View requisitions Required to be able to view open requisitions.

Recruiting > Requisitions > Create requisitions Required to be able to create requisitions from the Organization Chart.
Recruiting > Requisitions > Allow access to... The user must have at least one of the five allow access requisition type

permissions to create a new requisition.
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8 Performance Review Administration

Configuring Performance Management

Performance Review Management View

When performance reviews are accessed via the Navigation bar > More dropdown > Team Reviews link, the user is
presented with a list of reviews, which offers a new management view that can be used to display a specific group of
reviews and to take action upon multiple reviews at once if needed.

The management view of performance reviews is similar to the view offered to administrators in the HR Administrator
Tools, but with different filters. This view is only available when reviews are accessed via the Team Review link for users
who have the appropriate user type permission.

This management view is the solution for managers who need to have access to aggregated review information on
employees they are responsible for. Instead of working on each individual employee review, the management view
allows the user to have an overall appreciation of the review process and perform review related actions or tasks
(individually or in batch).

The performance review management view is the starting point to perform calibration of reviews.

The performance review management view also offers a filter panel with various fields and metrics available to user.
This allows the user to narrow down the displayed reviews according to a desired criteria. The user can then reduce the
scope of employee reviews he has access to and view the resulting reviews in any of the views offered - list, matrix or
chart. The list view is displayed by default. As for the matrix and chart views, their availability depends on whether the
performance review template has been configured to include these views or not.

The actions that can be performed depend on the user's user type permissions and the permissions granted upon
review configuration.

Configuration
This feature is optional. The related user type permission must be granted.

The access to this management view of performance reviews is only available via the Navigation bar, More dropdown,
Team Reviews link.

User type permissions required to entitle users to access the management view of performance reviews:

Permissions Configuration > [SmartOrg] Administration > [Users] User Accounts
Permission Name Setting Description

Performance > Performance Reviews > Access via Manager Center This permission grants the user access to the Performance Review
Management view, from the 'Team Reviews' link displayed under the
Navigation bar's More dropdown. heading. However, the user needs
viewing and/or managing rights to performance reviews to be able to
view/manage reviews.
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Permissions Configuration > [SmartOrg] Administration > [Users] User Accounts

Permission Name Setting Description

Performance > Performance Reviews > View This permission is required for the user to have the right to view reviews.

Performance > Performance Reviews > Manage This permission is required for the user to have the right to manage
reviews.

In the Performance Reviews section of Taleo Performance Administration, there is a new link called 'Performance
Review Template'. This template determines the chart and matrix views to be available in the performance review
management view. There is only one default performance review template configuration that is applied for all users.
This template is always active and cannot be deleted.

Defining the Performance Review Management View

The performance review template allows to define the matrices and charts that are to be available to users when
accessing performance reviews via the Team Reviews.

To be able to add charts and metrics to the template, charts and matrices need to have been created first.
Configuration > [Taleo Performance] Administration > [Performance Reviews] Performance Review Template

1. In the Performance Review Template page, click Add next to Matrices.

2. Inthe Matrix Selector, select all the matrices that you want users to be able to use when viewing performance
reviews and calibrate employee metrics or review ratings and click Select.

3. Define the matrix to be shown by default when opening the matrix view and reorder the available matrices as
desired.

4. Click Add next to Charts.

5. Inthe Chart Selector, select all the charts that you want users to be able to use when viewing performance
reviews and calibrate review ratings and click Select.

6. Define the chart to be shown by default when opening the chart view and reorder the available charts as
desired.

The selected matrices and charts will be available in the performance review management view for users who have
access to this review.

Performance Chart Mode

The chart mode is available to the performance review and talent pool pages